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KIRISH

Web-saytlarni yaratish va undan foydalanish talim tizimida ham 
muhim ahamiyat kasb etadi. TaMimda web-saytlardan nafaqat tijorat 
yoki namoyish vositasi sifatida, balki bilim berish maqsadlarida ham 
foydalaniladi. Albatta bunda ta’lim masofadan turib amalga oshiriladi. 
Bunday talim berish jarayoni o'qituvchi va o'quvchi to'g'ridan-to'g'ri 
muloqot qilmasdan olib boriladi. Buning uchun talim beruvchi (oliy 
o'quv yurti, maktab va boshqalar) o'qitiladigan predmetga tegishli 
malumotlarni web-sahifalarga har xil ko4rinishlarda (matn. rasm, 
jadval, animatsiya, tovush li ma’lumot va xatto video tasma ko'rinishida) 
joylashi kerak. O'quvchi esa dunyoning xohlagan joyidan turib 
Internet orqali bu ma’lumotlardan bilim olishi mumkin. TaMimning 
bunday korinishi masofaviy ta’lim deb yuritiladi. Bugungi kunda 
masofaviy ta'lim dunyoning ko4plab rivojlangan davlatlarida qo'llanilib 
kelinmoqda. Masofaviy ta ’limdan foydalanish natijasida vaqt va pulni 
tejash, ortiqcha ovvoragarchiliklarsiz bilim olish imkoniyatlariga 
ega bolinadi. Bunday imkoniyatlarni bizga web-sahifalar yaratib 
beradi. Ma lum predmetga tegishli ma’lumotlarni (matn, rasm, jadval, 
animatsiya va boshqalarni) sahifalarga jovlab, ularni doimiy ravishda 
toMdirib, yangilab borish, o'quvchilarni bilimlarini baholash uchun 
nazorat test savollarini kiritish imkoniyatlari mavjud. Buning natijasida 
o'quvchining oigan biliinini nazora^qilish, baholash imkoniyatlari 
paydo bo’ladi. Bu esa web-texnologiyadan ta’limda foydalanishning eng 
optimal variantlaridan biri hisoblanadi.

Ushbu qo‘llanmada ara  shunday Web-saytlarni yaratishda qo'llani- 
ladigan Macromedia Dreamweaver. Macromedia Flash, Corel Draw, 
Adobe PhotoShop dasturlari va HTML -  gipermatnlarni belgilash



tilidan foydalanish imkoniyatlari haqida ma’lumot berilgan. Professional 
dasturlar qatoriga kiruvchi Dreamweaver dasturi o'zining barcha 
im koniyatlari bilan har qanday murakkablik va masshtabdagi Web- 
sahifalarni yaratish va o‘zgartirishga qodir. U vizual loyihalash 
(W YSIW YG ) rejimini ta’minlab, dastlabki inatnli WEB -  hujjatlarning 
juda aniq ishlashi bilan ajralib turadi va katta tarmoqli loyihalarni 
qo‘llab-quvvatlovchi ichki qurilgan vositalarga ega.

Dasturda matnlar hamda obyektlarning obrazlari ustida olib 
boriladigan ishlar bevosita kodlashtirishdan ustun turadigan gipermatnli 
hujja tlar yaratish usulini vizual deb atash qabul qilingan. Dastur 
nafaqat vizual loyihalash vositalarining kuchli bazasiga ega. balki 
web -  sahifalarni deyarli maxsus ko'rib chiqish dasturlari yordamida 
aks ettirishga ham qodir: Microsoft Internet Explorer yoki Netscape 
Navigator.

Dastur web-dizayn sohasida gipermatnli hujjatlarni to'g'ridan-to’g 'ri 
kodlashtirish yordamida yaratishni afzal ko'ruvchi mutaxassislarga 
ham ma'qul keladi. Dreamweaver qobig'iga gipermatnlarni belgilovchi 
diskreptorlar bilan ishlash uchun zarur barcha uskunalarga ega toMiq 
funksional H T M L  tahrirlagichi integratsiya qilingan.

Dreamweaver dasturi «ochiq arxitektura» prinsiplariga asoslangan. 
Bu amaliy dasturni interfeysi (Application Programming Interface, API) 
to4liq ochiq ekanligini bildiradi. Uning yordamida tashqi dasturchilar 
hamda dasturiy ta’minot bilan shug^ullanuvchi firmalar, dastur va uning 
interfeysiga radikal funksional o'zgartirishlar kiritishi: yangi uskuna 
qo4shish. menyu palitrasi yoki boMimini yaratish. yangi obyekt yoki 
multimedia ro ligini dasturlashtirish va hokazolar.

Dreamweaver tizim i tarkibiga multimedia roliklarini qo'yishga 
mo’ljallangan qo'shimcha dastur kiradi. shuning uchun Flash -  
texnologiyaning interfaol imkoniyatlarini tahrirlagichdan chiqmay turib 
ko‘rib chiqish mumkin.

Ta’ lim  tizi.mida esa, axborot texnologiyalarini qo'llab, ta'lim- 
tarbiya berish va unga tegishli barcha jarayonlarni axborotlashtirish 
bilan ta ’ lim samaradorligini oshirishga olib kelinadi. Bunda -  axborot 
texnologiyalaridan dars jarayonidagi ko'rgazmalilik imkoniyatlari oshib 
o'quvcliilarning mazmunni tushunish darajasi ortadi. O'quvchi dars 
vaqtida biror murakkab jarayonni ko‘z oldiga keltirishi qiyin boiib. uni
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tasavvur qila olmaydi. Ana shunday paytda kompyuterning maxsus 
dasturlari yordamida shu murakkab jarayonni aynan o'zidek qilib 
tasvirlab berish mumkin. Bunda o'quvchilarda ushbu murakkab jarayon 
haqidagi tasavvurni hosil qiladi. Bu kabi dasturlar ko‘pincha inson ko‘zi 
bilan ko'ra olmaydigan (masalan, mashina dvigateli ichidagi harakatlar. 
odam qon aylanish tiz im i va boshqalar) murakkab jarayonlarni tasvirlab 
berish uchun xizm at qiladi. Bunday dasturlarga misol qilib Flash 
M X, 3D M A X  kabi dasturlarni aytishimiz mumkin. Ushbu dasturlar 
yordamida nafaqat murakkab jarayonlarning tasvirlarini, balki barcha 
turdagi elektron darsliklarni yaratish imkoniyatlari ham mavjud. 
Ayniqsa animatsiyali ma'lumotlarni keltirish va bezashda keng qo4llash 
mumkin.

Ushbu qo’ llanmada shuningdek Flash M X  dasturini o'rganishga 
bag'ishlangan ma’ lumotlar ham berilgan. Qo'llanmada dastur imko
niyatlari. uning interfeysi, flash-film lar, flash-saytlar yaratish va 
ulardan turli jarayonlarda foydalanish to'g'risidagi ma’ lumotlar berilgan. 
Bundan tashqari web dizaynning eng muhim ajralmas qismlaridan 
biri bo'lgan kompyuter grafikasi haqida ham ma’ lumot beriladi. Bizga 
ma’ lumki web m uharrirlar saytning asosini yaratishda ishlatilsa, 
uni rasmlar. grafik lar va tu r li illustratsiyalar bilan boyitish uchun esa 
grafik muharrirlariga murojat qilamiz. Bunda Adobe PhotoShop, Corel 
Draw kabi grafik m uharrirlarning o'rni tengsiz. Qo'llanmani yozishda 
aynan bu dasturlarning tanlab olinishiga sabab, birinchidan ularning 
professional dasturlar qatoriga kirishi boMsa, ikkinchidan Adobe 
PhotoShop rastrli grafika bilan, Corel Draw esa vektorli grafika bilan 
ishlashga mo’ljallanganligi uchundir.



I-bob. WEB-DIZAYN

1.1. Web-dizayn. Web-dizayn qo‘llaniladigan dasturlash vositalar

Dizayn (ingliz tilidan design injener-konstruktor, lotinchadan 
designare o'ichab koïmoq, o4lchab bermoq) -  bu ijodiy faoliyat bo'lib. 
uning asosiy maqsadi sanoat buyuinlarini formai sifatini belgilaydi. 
Bu sifat shuningdek buyumning tashqi qirralarini cfz ichiga olish bilan 
birga, asosan shu tuzilmaviy va funksional aloqadorlik xaridor hamda 
ishlab chiqaruvchi ko'zi bilan qaraganda buyumni yagona holatga 
keltiradi. Dizayn sanoat ishlab chiqarishi bilan bogiangan insonni o'rab 
turgan atrof-muhitning barcha jabhalarini qursliab oladi [21], [22]. [23].

Dizaynning turlari -  dizaynerlik faolivati lovihalash predmetining 
farqlanishi, loyiha ishining maqsadlari va metodlari hamda uning 
yakuniy natijasi bilan farqlanadi. Dizaynning quyidagi turlari 
mavjud:

-  grafik diza\Tn,
-  sanoat dizayn,
-  web-dizayn.
Grafik dizayn
Grafik dizavnda — informatsion grafika. reklama va boshqalar 

bilan ishlanadi. Web-dizayn va grafik dizayn nomining oxshashligiga 
qaramasdan, dizaynning turli yo'nalishlari liisoblanadi. Web-dizayn 
maUumotni saytda tasvirlash uchun ishlatiladi. Ammo grafik dizayn 
bilan web-dizayn o'zaro bogMangan. Grafik dizaynda tayyorlangan 
illyustratsiyalar saytlarni bezashda keng ishlatiladi. Grafik dizayn aslida 
foydalanuvchiga uzatiladigan ma’lumotni qabul qilinishini loyihalashi 
kerak. Grafik dizaynning yo'nalishlari:

1. Firma stili,
2. Shriftlar,
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3. Plakat.
4. Grafik reklama,
5. Kitobiy grafika,
6 . Gazeta grafikasi,
7. Jurnal grafikasi.
Sanoat dizayni -  maishiy buyumlar va asbob-uskunalarni ishlab 

chiqishda. mashinasozlik obyektlarida, transport vositalarida va bosh- 
qalarda ishlatiladi.

Bulardan tashqari dizaynning bir qancha ko'rinishlari mavjud. 
Bular: arxitektura dizayni, kiyim va aksessuarlar dizayni, art- 
dizayn, reklama dizayni.

Web-dizayn (ingliz tilidan olingan boiib , web-design -  vveb- 
sahifani loyihalash ma'nosini bildiradi) -  bu web-sahifani jihoz- 
lanishidir. Web dizayn sayt uchun huddi poligrafiya dizayni va qog'ozli 
nashrlar dastgohlari singari muhim rol o'ynaydi. Web-dizayn deganda 
nafaqat web sayt uchun grafikli elementlarni varatish, balki uning 
strukturasini loyihalash. unda harakatlanish vositalari, ya‘ni butun 
saytni yaratish tushuniladi. Shu sababli ham biz ushbu qoMlanmada 
nafaqat web muharrirlarni, balki grafik muharrirlar, animator das- 
turlarni ham gapirib o'tishni ma’qul ko'rdik.

Sayt qancha ajoyib bezatilgan boimasin, unda qulay va tu- 
shunarli harakatlanish chizmasi mavjud boimasa, hammabop ke- 
rakli matnlar boimasa, agar sayt yaxshi dasturchilar tomonidan 
tavyorlangan samarali dasturiy vositalarga ega boimasa -  bunday 
sayt tezda o'z foydalanuvchilarini yo‘qotadi va undagi noqulaylik 
(hattoki u professional va munosib stilda tavyorlangan boisa ham) 
muvofaqiyatsizlikka mahkum boiadi. Yaxshi web-dizayn saytning 
sahifalarini hamohanglik bilan birlashtiradi. Boshqacha aytganda, web- 
dizayn saytning joylashish o 'rn in i belgilaydi.

Web-dizaynni o'rganishda quyidagi uchta tushuncha muhim 
ahamiyat kasb etadi: Web-sahifa, Web-sayt va Web-server.

Web-sahifa -  o'zining unikal adresiga ega boigan va maxsus 
ko'rish dasturi yordamida (brauzer) kokriluvchi hujjatdir. Unga matn, 
grafika, ovoz, video voki animatsiya maiumotlar birlashmasi -  
multimediyali xujjatlar, boshqa hujjatlarga gipermurojaatlar kirishi 
mumkin.
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Web-sayt -  bir qancha web-sahifalarning mantiqiy birlashmasi. 
Inglizcha «site» (tarjimasi «joy») so'zining cf zbekcha talaffuzi. Umum- 
jahon cfrgimchak to'ri maiunn axborot topish mumkin boigan va 
noyob URL bilan belgilangan virtual joy. Mazkur URL web-saytning 
bosh sahifasi manzilini koi'satadi. O'z navbatida. bosh sahifada web- 
saytning boshqa sahifalari yoki boshqa saytlarga murojaatlar boladi. 
Web-sayt sahifalari HTML. ASP. PHP. JSP. grafik va boshqa fayllardan 
tashkil topgan bolishi mumkin. Web-saytni ochish uchun brauzer 
dasturidan fovdalaniladi. Web-sayt shaxsiy. tijorat. axborot va boshqa 
ko4rinishlarda bo‘lishi mumkin.

Web-server — tannoqqa ulangan kompyuter va undagi dastur 
hisoblanib. umumiy resurslarni mijozga taqdim etish yoki ularni 
boshqarish vazifalarini bajaraái. Web-serverlar malumotlar bazalari 
va multimediyali maiumothrni bir biriga moslashtiradi. Web- 
serverda Web-sahifa va Web-saytlar saqlanadi. Web-server -  Internet 
yoki Internetga ulangan umumfoydalanishdagi axborot serveri. Unda 
hujjatlar va fayllar -  audio, video, grafik va matn fayllari -  saqlanib. 
ular foydalanuvchilarga HTTP vositalar orqali taqdim etiladi. Web
server nomi u umumjahon tarmogMning qismi boigani uchun kelib 
chiqqan. Maxsus dasturiv ta'minotga ega bo'lgan, bir yoki bir necha 
web-sayt fayllarini saqlash va ularga ishlov berish mumkin. Bir necha 
web-sayt bitta kompyuterda ishlaganda. web-server deganda web- 
sayt ishlovchi virtual makon (dasturiv ta’minot va kompyuterdagi joy) 
tushuniladi. Shunga ko'ra ko'pchilik uchun «web-server» deganda 
«web-sayt» tushuniladi. Ko4p axborotni saqlovchi web-saytlar bir 
paytning o’zida bir necha kompyuterda saqlanishi va ularga ishlov 
berilishi mumkin. Web-server mijozlarning vveb-saytga soioviga javob 
beradi.

Bu tushunchalarga qo'shimcha web hujjat tushunchasini ham koi'ib 
oiamiz.

Odatda. maxsus HTML (Hypertext Markup Language) tilidagi 
hujjat. Web-hujjat jahon oi*giinchak uyasining asosini tashkil qiladi. 
Ular gipermatndan iborat boiib, foydalanuvchiga ajratib ko'rsatilgan 
so4z yoki jumlaga qaratib, înaiumotlarni o'qish. hujjatning boshqa 
qistniga yoki ayni hujjat bilan giperhavola yordamida bogiangan 
boshqa web-hujjatga o'tish imkonini beradi. Web-hujjat, shuningdek.
8



matn. tasvir. tovush, videolarni mujassamlovchi gipermuhit maiumotni 
ham o‘z ichiga olishi mumkin. Web-hujjatni ochish, ularni cfqish yoki 
aks ettirish Internet brauzerlari vordamida amalga oshiriladi. Web- 
hujjat tushunchasi «web-sahifalar» va «web-saytlar» tushunchalari 
bilan chambarchas bogiiq. Odatda «web-sahifa» atamasi web-hujjat 
atamasiningsinonimini bildiradi, «web-savt» atamasi esa yagona mavzu 
ostida birlashtirilgan yoki bitta tashkilot, m uallif yoki foydalanuvchiga 
tegishli boigan sahifalar majmuasiga tegishlidir.

Munosib web-dizavnni yaratishda qatnashuvchi quyidagi element- 
larni sanab o'tish mumkin:

Shrift -  web sayt ichida imkoni boricha bitta shrift, yoki odatda 
ikki-uchta bir-biriga o'xshash (oson qorishadigan) shriftlarni qo'shib 
ishlatish mumkin boigan xususiyatlar va tanlangan fonda o‘qish 
mumkin boigan ranglarga ega boiishi lozim.

Abzats -  imkoni boricha web saytning barcha sahifalarida 
matn va boshqa vizual materiallarni tekislashning (sozlashning) bir 
ko'rinishlarida boiish i maqsadga muvofiq.

Web-saytning rangli sxemasi -  sahifaning oddiy matnini. havola 
va tashrif buvurilgan havolalarni taqdim qilishning uch x il ranglarini 
belgilaydi. Rangli sxema, yoki turli mavzudagi saytning boiim lari 
uchun bunday sxemalarning bir nechta ko'rinishi saytning barcha 
sahifalarida takrorlanishi lozim.

Web-dizayn o'zida belgilangan rangli va mantiqiy sxemani bir- 
lashtirgan qandavdir g ra fik li jihozlashni nazarda tutadiki. shuning 
uchun ish bosliida savtni jihozlashning umumiy konsepsiyasini o'ylab 
ko'rish kerak boiadi. Barcha grafik elementlarni ikkita katta sinfga 
ajratish mumkin: chizilgan va biror real voqelik fotosuratlari. Saytni 
bezash ishlarida bu ikk i tipni aralashtirib yubormaslik yoki ularni 
web saytning tematik yoki mantiqiy qismlariga to 'g 'ri taqsimlash 
maqsadga mu\ofiq. Shuni alohida ta’kidlab o'tish kerakki. saytda har 
qandav tipdagi fotu surallarni illustralsiya sifatida ishlatishdan oldin. 
ularni tegishli tarzda qavta ishlash (rang va tonda tuzatish, korreksiya) 
zar ur.

Web-dizavnning asosiy maqsadi -  saytni egasiga foyda (moddiy, 
ma‘naviy) keltiradigan ko'rinishda taqdim qilishdan iborat. Foyda sayt 
orqali mollarni to 'gi'idan-to 'g 'ri sotish orqali boiishi. shuningdek unga
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qo4shimcha firmalami. mahsulotlarni reklama orqali yangi mijozlarni 
o4ziga tortish yo4li bilan ham kelishi mumkin. Ta'limda esa bularga 
qo'shimcha o;quv resurslarini yetkazib berish. ta’limni boshqarish 
ishlarini amalga oshirish mumkin.

Bizga ma’lumki web-dizayner boshqa kasblarga nisbatan yosh 
(yangi) kasb hisoblanadi. Internetga boMgan talabning ortishi bilan, 
saytlarning dizayniga bo'lgan talab va web-dizaynerlar soni ham ortib 
bormoqda.

Endi web loyihalarning asosiy tiplari va ularni har birini vizual 
bezashga qo'yiladigan talablar bilan tanishib chiqamiz. Saytlar tarkibiga 
kcfra quyidagi asosiy tiplarga boMinadi:

Uy sahifasi (Домашняя страница) tushunchasining bir nechta 
ko'rinishi mavjud:

1. Alohida shaxsga tegishli web-sayt. Bu saytda shaxs haqidagi 
bir necha mavzudagi ma'lumotlar, matnlar, foto jamlanmalar berilishi 
mumkin. Odatda bunday saytlarga turli sohalarning (masalan, fan- 
texnika, madaniyat, sport va boshqa sohalarda) mashhur kishilari ega 
boiadi.

2. Brauzerda birinchi yuklanadigan web-sahifa. Saytdan foydalanish 
undan boshlanadi. Odatda, foydalanuvchi o4zining qayerda ekanligi va 
saytning boshqa sahifalarida nimalarni ko'rishi mumkinligi haqida uy 
sahifasidan ma’lu mot oladi. Brauzer tomonidan dastur yuklangandan 
so4ng terminalda paydo boiadigan web-sahifaning. portalning, maj- 
muaning birinchi sahifasi. Odatda, prezentatsiya va navigatsiya bo'yicha 
ham asosiy ish bajaradi.

Prezentatsion sayt -  nomidan ko'rinib turibdiki. sayt firma / 
xizmatlar / mahsulotlar haqidagi ma’lumotlarni taqdim qiladi. Ma'him 
sondagi sahifalami o'zida birlashtirib, kamdan-kam holatda yangilanadi. 
Saytning asosiy vazifasi -  taqdim qilinavotgan xizmatlar va uning 
afzalliklarini tashrif buyuruvchilargacha vizual jihozlash yordamida 
maksimal tezlik va samara bilan yetkazib bera olishdan iborat. Bunday 
loyihalar tartib qoidalar bo'yicha aniq. noyob dizayn, grafikli jihozlanish 
matnli ma’lumotlar oldida ustunlik qiladi.

Misol sifatida http://w\v\v. loyalstudios.com va http://www.de- 
signchapel.com saytlarida keltirilgan sahifalami aytish mumkin.

Korporativ saytlar -  tashkilotning (firmalar. korporatsivalar) inter
net tarmog4idagi vakolatxonasi hisoblanadi va binobarin, bunday
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loyihalarda eng asosiy talab maium otni ya’ni grafika yoki matnning 
jihozlanishiga qaratiladi.

Informatsion resurslar -  bu elektron kutubxonalar va gazetalar. 
Bunday tipdagi saytlarda ma’ lumotlar bir sutkada bir necha marta 
yangilanadi. MaMumotlarning hajmi juda ham katta, va bunday saytlarni 
ishlab chiqishda shuni ta'kidlash kerakki, tashrif buyuruvchi saytni 
tomosha qilish uchun emas -  ular mazmuni uchun kelishadi. Yangiliklar 
nashri (misol uchun — http://www.cnews.ru) yoki http://sight.nmi.ru 
singari rasmlar galereyasida, loyihaning bosh maqsadi -  yuqori tezlikda 
maiumotni tashrif buyuruvchiga taqdim qilish yoki bu maiumotni 
qidirish imkoniyatidan iborat. Har qanday grafikli bezaklar sahifaning 
hajmini oshirib yuboradi -  ya’ni sahifaning yuklanish vaqtini oshirib 
yuboradi. Shuning uchun mumkin qadar bunday loyihalarda dizayn 
matnli ko‘rinishda ishlab chiqiladi. Kartinkalar, fotografiyalar, grafiklar, 
sxemalar illustratsiyalar hisoblanadi.

Elektron tijorat -  axborot texnologiyalariga asoslangan biznes 
hisoblanadi. Elektron tijorat (ingliz tilidan e-commerce) -  internetda 
o'zining sayti va virtual magazini, shuningdek o4zining (firma yoki 
kompaniyaning) boshqaruv tizimi mavjudligi bilan asoslanadi. Elektron 
tijoratga quyidagilar kiradi:

-  elektron m aium ot almashish (Electronic Data Interchange, EDI),
-  elektron jamg'arma ko’chirish (Electronic Funds Transfer, EFS),
-  elektron savdo (e-trade),
-  elektron karmon (e-cash),
-  elektron marketing (e-marketing),
-  elektron banking (e-banking),
-  elektron sug'urta xizmatlari (e-insurance).

Web-dizaynda qo‘llaniladigan dasturiy vositalar

Bugungi kunning talablaridan kelib chiqib toiaqonli web-saytlar 
yaratishda bir qancha turdagi dasturiy vositalardan foydalaniiadi. Ularni 
tokrtta katta guruhga ajratish mumkin (1.1-rasm) [11], [12], [13].

Undan tashqari web muharrirlarning ham turlari juda kokp. Ular 
o'zining imkoniyati. tezkorligi, interfeysi va boshqa xususiyatlari 
bilan farqlanadi. 1-jadvalda shunday dasturlardan asosiylari kel- 
tirilgan.
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l.l-rasm. Web saytlar yaratishda qo'llaniladigan dastur iy vositalar guruhlari.

1.1-jadval
Web-muharrirlar ro‘yxati

jYo dastur nomi izoh

1 . Bloknot (Notepad) Windows operatsion tizimi standart vositala- 
ridan bo;lib, undan HTML tilini yaxshi bilgan 
o'rganuvchilar foydalanadi.

2 . HomeSite 4.5 HTML-muharrir. Teglarni ranglar bilan ajratish, 
bir vaqtning o4zida bir nechta favlda qidirish. 
almashtirish va boshqalar.

n UltraEdit-32 Dasturchilar uchun keng imkoniyatli matn 
muharriri. Bir vaqtning o'zida bir nechta favlni 
tahrirlash imkoniyati mavjud.

4. Web Page Maker Dastur Software Inc mahsuloti hisoblanadi. 
Qisqa vaqt ichida web-sahifa yaratish va 
yuklash imkoniyatini beradi. Unda HTML tilini 
bilish shart emas.

5. DTM Lome 1.2 Ish boshlovchilar va professionals uchun 
oddiy, tezkor va qulay HTML-muharrir.
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6 . Artisteer.2.3.0.10943 Dastlabki web-dizaynni avtomatlashtirgan das- 
tur. Photoshop, CSS, HTMLlarni bilish talab 
qilinmaydi.

7. Codelobster 
PHP Edition 3.3

Juda qulay PHP, HTML, CSS muharriri

8 . Amaya web-brauzer va HTML-muharrir The World 
Wide Web Consortium (W3C) -  tomonidan 
ishlab chiqilgan.

9. NeonHTML O'zida vizual uskunalarni birlashtirgan HTML 
va CSS muharrir.

10 . Serif WebPlus X2 Professional darajadagi web-saytlar yaratishga 
moijallangan web-dizayn dasturi

11. PHP Designer 2008 
Professional 6 .2.5.2

PHP tilida ish boshlayotgan va professional 
foydalanuvchilar uchun dastur PHPdan tash- 
qari, dasturda HTML, MySQL, XML, CSS, 
JavaScript. VBScript. JAVA, C, Python va 
Rubylarni ham ishlatish mumkin.

1 2 . Dreamweaver CS4 Murakkab strukturali web-saytlarni loyihalash, 
yaratish va boshqarishga moijallangan profes
sional dastur.

13. Wap Editor 0.6d Qulay va ko4p funksiyali web-sahifalar yara
tishga moijallangan dastur.

14. BestAddress 
HTML Editor 2008 
Professional 12.12.0

Ko;p funksiyali HTML-muharrir. Dasturda 
DHTML kodlari yordamida menyu yaratish 
imkoniyatlari mavjud.

15. DzSoft PHP Editor 
4.2.1

PHP -  skriptlar yozishga va HTML-sahifalar 
yaratishga moijallangan dastur.

16. SaveChm 1.2 Rasmli web-sahifalarni tezkorlik bilan CHM 
(Windows-help) formatida saqlovchi dastur.

\7. Menu Editor 
1.0.3.231

Web-saytlarda harakatlanish uchtm qulay men- 
yularni yaratishga moijallangan dastur

18. Quick Page 2008 
(3.0.3.254)

Web-saytlar yaratishga moijallangan profes
sional dasturiy vosita.

19. AAA Web Album Bu dasturiy vosita web-sahifalar uchun foto 
albomlar yaratish uchun moijallangan.

13



davomi

2 0 . Multiple File Search 
and Replace 2.0

Bir vaqtning o'zida web-saytning bir nechta 
fayllari bilan ishlashga moijallangan dasturiy 
vosita

2 1 . Incomedia Website 
Evolution X5 7.0.9

Foydalanish uchun qulay bo‘lgan, tushunarli 
interfeys va qadamba-qadam vordamchidan 
foydalanib bir necha minutda web-sayt yaratish 
mumkin

2 2 . Arachnophilia
5.3.2177

Java asosida qurilgan HTML-muharrir Sun M i
crosystems mahsuloti hisoblanadi

23. Web Page Maker 
v2.5 Rus

Dasturning arxivida bir qancha tayyor sayt 
shablonlari mavjud boiib, bir necha daqiqada 
HTML sahifalar yaratish imkonini beradi

24. Incomedia WebSite 
X5 Evolution 7.0

Shaxsiy web-saytlar yaratishga mo‘ljallangan 
dastur

25. AceHTML Pro 
V6.03.0

Web-saytlar yaratish va ularga xizmat ko‘r- 
satuvchi dasturlar paketi

26. Sothink
DHTMLMenu 8.3 
build 71210

Web-ustalar uchun mo'ljallangan dasturlar pa
keti

27. HtmlReader 2.5 html-sahifalarni yaratish. tuzatish va ko'rishga 
moijallangan dastur.

28. PHP Designer 2008 
Professional vö.O.O

PHP, HTML, XHTML. CSS, Perl. C*. jav- 
Script, VB, java va SQL muharriri.

29. Atani 4.3.4 Rus Web-sahifalar uchun bannerlar yaratishga mo'l- 
jallangan dastur

30. Sothink
DHTMLMenu

DHTML menyular yaratishga mo'ljallangan 
dastur. Dasturdan foydalanishda DHTML yoki 
JavaScript bilish talab qilinmaydi

31. TIGER CMS vl.O 
Lite

Shaxsiy web-sahifalar yaratishga mo'ljallangan 
dastur

Web-dizaynda qo‘llaniladigan bir qancha dasturiv vositalar va yana 
ko'plab uskunaviy dasturlar, turli dasturlash tillari mavjud. Eng ko‘p 
qo;llaniladigan tillarga misol qilib, HTML-gipermatnlarni belgilash tili, 
PHP, ASP, Java, JavaScript, DHTML va boshqa tillarni aytish mumkin.
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^JavaScript ]

- [  M ijo z  to m o n id a n  ]----- [AdobeFlash (ActionScript) ]

^SilverLighT]

1.2-rctsm. Web-dasturlasli tillarining guruhlarga boiinishi.

Web-dasturlash tillari ikki guruhga boiinadi: mijoz va server tillari. 
Biz yuqorida web-ser verga ta r if  berdik. Unga ko;ra server sizning 
saytingiz saqlanadigan, brauzerning so‘rovlari qayta ishlanadigan 
qaysidir sahifadagi dasturlar saqlanadi. Und an tashqari serverga 
quyidagicha ta'rif berish mumkin: Server -  tarmoq ishini ta’minlovchi 
maxsus kompyuter. Server disklarida kompyuterlarni birgalikda ishlash 
imkonini beruvchi dasturlar. inaMumotlar omborlari va boshqalar 
saqalanadi. Bundan tashqari serverlar modemli va faksli aloqalarni, 
ma’lumotlarni bosmaga chiqarish ishlarini amalga oshiradi. Serverda 
joylashgan dasturlardan foydalanish doirasi umumiy masalaning 
qo’yilishiga ko'ra cheklangan bo'lishi mumkin.

Mijoz tomonidagi senariylar 
JavaScript nima?

Mijoz tillaridan eng ko'p tarqalgani JavaScript tili bo'lib, Netscape 
(Netscape Navigator, wwvv.netscape.com) SunMicrosystems (www.sun. 
com) kompaniyalari hamkorligida ishlab chiqilgan. JavaScript faol 
HTML-sahifalar uchun senariylar yozishga mo'ljallangan. JavaScript 
avtonom ravishda ishlaydigan ilovalarni yaratishga moijallanmagan. 
JavaScriptdagi dasturlar bevosita HTML-hujjat kodi ichiga quriladi va 
brauzerda sahifani yuklanishi vaqtida faollashadi. Sodda qilib aytganda 
HTMLning cheklangan, sodda iinkoniyatlarini kengaytirish va toiaqonli
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sahifalar yaratishga mcfljallangan. JavaScript yordamida odatda 
ma'lumotli va muloqot oynalarini chiqarish. animatsiyalarni ko’rsatish 
kabi vazifalarni bajarish mumkin. Bundan tashqari, JavaScript- 
senariyda ba'zan o ‘zi ishlab turgan brauzer va platforma tipini aniqlash 
mumkin. JavaScript-senarivlar fovdalanuvchi tomonidan kiritilayotgan 
ma’lumotlarni to'g'riligini tekshirishda ham qulay hisoblanadi.

ActionScript nima?

ActionScript — obyektga yo'naltirilgan dasturlash tili bo'lib. Flash- 
ilovalar tarkibida interfaollik, malumotlarni qayta ishlash va boshqa 
lco'plab imkoniyatlarni beradigan ECMAScript dialektlaridan biri 
hisoblanadi.

Silverlight nima?

Microsoft Silverlight -  bu dasturiy platforma boMib, RIA (Rich 
Internet application)ga xos bo‘lgan animatsivalar, vektorli grafika va 
audio-video roliklardan tarkib topgan ilovalarni yuklash imkonini 
beradigan brauzer uchun plaginlarni o'z ichiga oladi. Bu esa 
Silverlight barcha brauzerlarda WMV. WMA va MP3 kabi formatlarni 
Windows Media Player singari qo'shimcha komponentlarsiz ijro qilish 
imkoniyatini beradi. Dasturning 2.0 versiyasi 2008 yil oktvabrda ishlab 
chiqilgan bo‘lib, unga .NET tillari bilan ishlash imkoniyati qo‘shilgan. 
Bundan tashqari Microsoft kompaniyasi 2009-yil iyulda IDE bilan 
integratsiyalashgan Silverlight 3 va Microsoft Expression Studio 3 
dasturlarini ishlab chiqdi.

Silverlight platformasi Windows 2000. Windows XP. Windows 
Server 2003, Windows Vista, Windows 7. Mac OS X 10.4. Mac OS 
X  10.5. Mac OS X 10.6 operatsion tizimlariga va Internet Explorer 
6.0/7.0/8.0. Mozilla Firefox 1.52.0/3. Safari 3.1. Google Chrome 3.0, 
Opera 9.50 brauzerlariga mo'ljallangan.

VBScript nima?

VBScript tili Microsoft korporatsiyasi tomonidan yaratilgan bolib. 
Visual Basic tilining bir qismi hisoblanadi. VBScript tili Internet 
Explorer va Microsoft Internet Information Server (IlS)lar bilan
16



ishlashga mo'ljallangan tildir. VBScript tilining JavaScript tili bilan 
umumiy qismlari bir nechta. Jumladan. u aynan Microsoft Internet 
Explorer bilan ishlash va uning qo‘llanish sohasini cheklay olish 
imkoniyatiga ega. VBScript interpretatorli (sharhlovchi, izohlovchi, 
tushuntirib beruvchi) til hisoblanib, Microsoftning Web-texnologiyalari 
(masalan ASP (Active Server Page)) bilan hamkorlikda ishlay 
oladi. Shunga qaramay VBScript klient tomonida ishlovchi senariy 
hisoblanadi. ASP esa server tomonida ishlaydi.

Server tomonidagi senariylar

Dasturning ishlashi to'liq sayt joylashtirilgan serverga bog'liq. 
Server tillarini ishlashining muhim jihatlaridan biri bu serverda 
tartiblangan holda saqlanuvchi va xohlagan paytda chaqirilishi mumkin 
bo'lgan ma’lumotlarni bevosita ma’lumotlar bazalarini boshqarish 
tizimlari bilan o'zaro bog’langan holda faoliyat yuritadi. Eng ko'p 
ishlatiladigan ma’lumotlar bazasini boshqarish tizimlari quyidagilar: 
Firebird. IBM DB2. IBM DB2 Express-С, Microsoft SQL Server. 
Microsoft SQL Server Express, mSQL, MySQL, Oracle. PostgreSQL 
SQLite. Sybase Adaptive Server Enterprise.

Server tomonida bajarilishi kerak boigan senariylar odatda sayt 
papkasining ichidagi maxsus papkaga joylashtiriladi. Foydalanuvchi 
so4roviga asosan server bu senariyni bajaradi. Bajarilgan senariy natijasi 
web-serverga uzatiladi va undan so'ng mijoz (klient)ga uzatiladi. Server 
tomonidagi senariylarni tashkil etish uchun odatda Perl, ASP, PHP, JSP, 
SSI kabi tillar va texnologiyalardan foydalaniladi.

Perl nima?

Perl -  bu protsedurali dasturlash tili boMib, juda keng qamrovli 
topshiriqlarni yechish uchun mo'ljallangan universal uskunadir. 
Perl boshqa to'laqonli tillar singari platformalarga, operatsion tizim 
Vä boshqa vositalarga bogHiq bo'lmagan fímksiyalar va qoidalar 
to’plamiga ega yadrodan tashkil topgan. Perl tili Web-ilovalar 
yaratishda eng ommabop tillardan biri hisoblanadi. Matnlarni qidirish 
va tahrirlash. fayllar bilan qulay ishlay olish qoidalari uchun Perl tili 
Internetning asosiy tillaridan biri bo'lib qoldi. Perl -  interpretatorli til 
hisoblanadi, shu bois unda y aratilgan^enariylar ishlashLuchjin^erver
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koinpyuterda Perl-interpretator o'rnatilgan boiishi kerak. Bevosita 
Perl-kodning interpretatsiya qilinish jarayoni uning samaradorligini 
pasavtiradi. Bugungi kunda Perlning asosiy yutuqlaridan, lining barcha 
platformalar uchun ishlay olishi va uning barcha resurslari bepul 
tarqatilayotganligidir. Ko'pgina web-serverlar UNIXda ishlaydi, Perl 
interpretator esa bu operatsion tizimning bir qismi hisoblanadi.

ASP nima?

ASP (Active Server Pages) -  maiumotlar bazalari tashkil etish 
va ular bilan ishlash vazifalarini bajarishda juda moslashuvchan. 
qulav vositadir. ASP vositalari server tomonida ishlaydi va HTML- 
kod va senariylar kabi favllarni qavta ishlaydi. ASP texnologivasi 
VBScript, Java va JavaScript tillarini qoilab quvvatlaydi. ASP- 
kod joylashtirilgan Web-sahifalar favllari kengavtmasi .asp boiadi. 
A SP texnologiya Windows NT va Microsoft IIS web-serveriga 
moMjallangan boiib, imkoniyatlari va samaradorligi yuqori boiganligi 
bois ko'pgina kompaniyalar o*z vositalariga ASPni qoilab-quvvatlash 
imkoniyatlarini kiritmoqdalar. Ko'pgina HTML-muharrirlar. masalan. 
Adobe GoLive ham ASPni qoilab-quvvatlaydi. ASP texnologivasi 
bir nechta qulayliklarni o4zida jamlagan: HTML-hujjatni dinamik 
generatsiyalaydi, fonnalarni qoilab-quvvatlaydi. maiumotlar bazasiga 
ruxisatni tashkil etadi va u bilan ishlay oladi. ASP -  dasturlash tili 
ham, ilova ham emas. u interfaol web-sahifa hosil qilish texnologivasi 
hisoblanadi.

PHPnima?

PHP -  bu serverda qayta ishlanuvchi senariylar tilidir. ASP kabi 
PHP kodlar ham bevosita HTML-hujjatni tarkibiga qo’shiladi. Ushbu 
tilning nomi Personal Home Page Tools so^zlarining qisqartmasidan 
olingan. PHPda C va Perl tillarida uchragan bir qator muammolar hal 
etilgan. Bundan tashqari, PHP maiumotlar bazasi bilan ishlash uchun 
juda qulay vositadir. Umuman olganda Perl, PHP -  ochiq tizimli tillar 
hisoblanadi va ularni dasturchilar modernizatsiyalashtira oladi.

Ko'pgina boshqa dasturlash tillaridan farqli ravishda. PHP qandaydir 
taslikilot yoki kuchli dasturchi tomonidan yaratilgan emas. Uni oddiy
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foydalanuvchi Rasmus Lerdorf 1994-yili opining bosh sahifasini 
interfaol uslubda ko4rsatish uchun yaratgan. Unga Personal Home Page 
(PHP -  shaxsiy bosh sahifa) deb nom bergan.

1995-yili Rasmus PHPni o'zining HTML formalari bilan ishlaydigan 
boshqa dastur bilan umumlashtirib PHP/FI Version 2 («Form 
Interpretator») hosil qildi. 1997-yilga borib PHPdan foydalanuvchi 
saytlar 50 mingdan oshdi. Shundan so’ng web texnologiya ustalari 
PHP g'oyasi asosida mukammal til yaratishga Ziva Suraski va Endi 
Gutmans asoschiligida kirishildi. PHPni samarali deb hisoblanmagani 
uchun deyarli noldan boshlab. mavjud C va Perl tillaridan ibrat olib 
PHP3 talqinini yaratildi. 1999-yilga kelib PHP asosida qurilgan saytlar 
milliondan oshib ketdi. 2000-yilda esa Zend Technologies shirkati yangi 
ko'pgina funksiyalarni qo‘shgan holda PHP 4 sharhlovchisini yaratdi.

PHP — web texnologiya tili. PHPni o'rganish uchun avval HTML 
va dasturlash tilidan habardor bo'lish talab qilinadi. HTML/CSS va 
JavaScript tillarini mukammal biladiganlar uchun PHPni o'rganish 
murakkablik tug'dirmaydi. PHPning vazifasi HTML faylini yaratib 
berish. JavaScript yordamida bajariladigan ko'pgina operatsiyalarni 
PHP orqali ham amalga oshirish mumkin.

JavaScript — mijoz tomonda bajariladi, PHP esa serverda bajariladi. 
PHPda yozilgan kod serverning o‘zida bajarilib. klientga HTML 
shaklida etib boradi. Bu havfsizlik jihatdan ancha maqsadga muvofiq.

JavaScript yordamida kod yozish, ma’lumot uzatish va qabul qilishni 
biroz tezlashtirsa-da. kodni mijoz ko‘rish imkoniyatiga ega bo4ladi.

«PHPda liar qanday dasturni bajarsa bo'ladi» -  degan edi uning 
yaratuvchisi. Birinchi navbatda PHP tili server tomonidan bajariladigan 
skriptlar yaratish uchun foydalaniladi va aynan shuning uchun u 
yaratilgan. PHP tili ixtiyoriy CGI-skriptlari masalalarini yechishga va 
bundan tashqari html formali ma lumotlarni qayta ishlashga hamda 
dinamik ravishda html sahifalarni ishlab chiqishga qodir. Biroq PHP tili 
foydalaniladigan boshqa sohafar ham mavjud. Bu sohalarni biz uehta 
asosiy qismga bo'lamiz:

Birinchi soha -  biz vuqorida aytib o‘tganimizdek, server tomonidan 
bajariladigan ilovalar (skriptlar) yaratish. PHP tili bunday turdagi 
skriptlarni yaratish uchun juda keng qo'llaniladi. Bunday ish kokrsatish 
uchun PHP-skriptlarni qayta ishlovchi va skriptlarni qayta ishlovchi
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web-server, skriptlarni natijasini ko'rish uchun brauzer va albatta php- 
kod in i yozish uchun qanday bo'lsa ham matn muharriri kerak bo'ladi. 
PHP- skriptlarni qayta ishlovchi CGI-dasturlar ko4rinishida yoki server 
m odullari ko'rinishida tarqalgan.

Ikkinchi soha -  buyruqlar satrida bajariladigan skriptlarni yara- 
tish. Ya’ni PHP tili vordamida biror-bir kompvuterda brauzer va 
web-serverlardan mustaqil ravishda o’zi bajariladigan skriptlarni 
ham yaratish mumkin. Bu ishlarni bajarish uchun hech bo'lmaganda 
PHP-skriptlarni qayta ishlovchi (bu holatda biz uni buyruqlar satri 
in te rpretatori (CLL command line interpreter) deb ataymiz) talab 
etiladi. Bunday ishlash uslubi turli masalalarni rejalashtirish vordamida 
bajarilishi uchun kerak bo'lgan skriptlar yoki oddiy matnni qayta 
ishlash uchun kerak bo4gan masalaga o'xshash ishlaydi.

XJchinchi soha -  bu mijoz tomonidan bajariladigan GUI-ilovalarni 
(g ra iik  interfeys) yaratish. Bu soha PHP tilin i endigina o'rganayotgan 
foydalanuvchilar uchun uncha muhim bo'lmagan sohadir.

PHP t ilin i qo'llanilish sohalari keng va turlichadir. Yuqoridagi 
masalalarni yecha oladigan boshqa turlicha dasturlash tilla ri ham 
mavjud. Unda nima uchun PHP tilin i o'rganishimiz kerak? U til bizga 
n im a beradi? Birinchidan, PHP t ili o'rganish uchun juda qulay. PHP 
t i l in i  sintaksisi asosiv qoidalari va ishlash prinsipi bilan yetarlicha 
tanishib chiqib o'zingizni shaxsiy dasturingizni tuzib ko’rib. so'ngra 
uni boshqa dasturlash tillarida tuzilgan variantlari bilan solishtirsangiz 
bunga guvoh bo'lasiz. Ikkinchidan, PHP tili barcha bizga ma’lum 
platformalarda, barcha operatsion tizimlarda hamda turlicha serverlarda 
erkin ishlav oladi.

PHP dasturlash t ilin i turli dasturlash tillari o'rtasidagi o4zaro 
aloqasiga diqqatni qaratsak. bunga Java dasturlash tilin i aytib o'tish 
lozim, chunki Java dasturlash t i l i  obyektlarini PHP t ili o‘z obyektlari 
sifatida qaravdi. Obyektlarga murojaat sifatida CORBA kengaytmasidan 
foydalaniladi.

JSP

JSP (JavaServerPage) texnologiyasi o'zining funksional imkoniyat- 
lariga ko‘ra ASPga o'xshashdir. Asosiv farqi shundaki. bunda VBScript 
va JavaScript bilan birga Java t i l i  ham qo41anila oladi. Shunga qaramay
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JSP Javadan oldinroq qo'llanilgan va ushbu texnologiya mukammal 
Web-ilovalar yaratish uchun yetarli imkoniyatga ega.

SSI

SSI (Server Side Include) HTML-faylni dastlab serverda qayta 
ishlaydi va lindan so'ng uni mijozga uzatadi. Dastlabki qayta ishlash 
vaqtida hujjatga dinamik generatsiya qilingan ma'lumotlar qo'shiladi. 
Masalan joriy vaqt haqidagi ma’lumot. Umuman olganda SSI 
texnologivasi HTML-faylning tarkibiga qcTshimchalar qo'shishga 
moMjallangan HTMLning qismi hisoblanadi.

DHTML nima?

DHTML (dinamik HTML) — bu serverga ortiqcha bogManishlarsiz 
interfaol Web-sahifalar yaratish imkonini beradigan vositalar to’p- 
lam idir.

DHTML tili HTM L va JavaScriptlardan farqli ravishda bir qancha 
qo'shimcha internet texnologiyalariga ega. Dinamik HTML -  Netscape 
va Microsoft tomonidan o'ylab topilgan tijorat termini boMib, unda 
Web-brauzerlarning dinamik imkoniyatini kengaytirish maqsadida 
kiritilgan. Bu texnologiyalar HTML yordamida Web-sahifa yaratishdagi 
mavjud imkoniyatning cheklanganligi va ana shu cheklovdan o'tib 
ketish uchun yaratilgan yoki qo'shilgan hisoblanadi. Chunki bizga 
ma'lumki HTMLning faqatgina o'zidan foydalanib bugungi kunda 
mukammal Web-sahifalar yaratib boMmaydi. Boshqacha aytganda 
mavjud Internetda matnli ma'lumotlar va grafik ma’lumotlarga 
moMjallangan juda yaxshi texnologiyalar mavjud edi. Ammo multimedia 
imkoniyatlariga ko'nikib qolgan odamlar esa bunga ko'nika olmadi. Shu 
sababli Internet imkon iyatlarini kengaytirish kerak edi.

DHTML asosida yaratilgan sahifa serverdagi qo'shimcha ma’
lumotlarga murojaat qilmasdan turib ham o‘zgarish imkoniyatiga ega. 
DHTML cfzida turli xildagT standartlarga (CSS, BUM. JavaScript va 
gipermatnlarni belgilash tillariga) asoslangan kombinatsiyalarni namoyon 
qiladi. Bu standartlarning kombinatsiyasi sizning web-sahifangizni 
interfaolligini oshirish imkonini beradi. Boshqacha aytganda. sahifaga 
tashrif buyurgan foydalanuvchi uning tashqi ko‘rinishi va mazmunini 
serverga murojaatlarsiz o'zgartira olish imkoniyatidir.
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1.2. HTML tili haqida

Bizga ma'lumki, har qanday murakkablikdagi web-saytlar HTML 
tiliga asoslangan bo‘lib, bu tilni bilmasdan turib tcrlaqonli web-saytlar 
yaratib bo‘lmaydi. Endi HTML tilining asoslari bilan tanishib chiqamiz.

HTML (Hyper Text Markup Language) -  giper matnlarni belgilash 
tili degan ma’noni aaglatadi. HTML -  web sahifada matn, tasvir va 
boshqa m a’lumotlarni qanday ko‘rinishda joylashtirilishini belgilovchi 
vosita. Bu til 1989-yilda Jenevada Tim Berners-Li (Tim Berners-Lee) 
tomonidan yaratilgan. Keyiachalik Tim Berners-Li «Internet otasi» 
n.omiga sazovor bo’lgan. Til dasturlash tili emas, faqat Web-sahifa 
yaratish uchun mo'ljallangan. Web-sahifada biror ma’lumotlarni qavta 
ishlash algoritmlarini o'rnatish uchun Java tilida tuzilgan dasturlardan 
foydalaniladi.

Ushbu ma’lumotlardan foydalanib, ko‘zda tutilgan asosiy maqsad 
—HTML haqida asosiy tushunchalarni misollar yordamida tushuntirib 
berish, HTMLning bir-ozqiyin bo4gan elementlari hisoblanmish jadval 
tuzish, freymlardan foydalanish va sahifaga tasvirlarni joylashtirish. 
sahifalarni bir-biriga faol havolalar orqali bog‘lash usullarini ko‘rsatib 
berishdan iborat.

Teg tushunchasi

HTML sahifa — bu oddiy matn fayl boiib. HTML kengavtmasiga 
ega. HTML sahifani yaratish uchun maxsus dastur shart emas. Har 
qanday matn muharriri yordamida HTML sahifa yaratish mumkin. 
Ana shunday matn tahrirlovchi oddiy dasturlardan biri bo‘lgan Notepad 
(Блокнот) standart holatda Windows mo’hitida mavjud. HTML 
sahifaning asosiy elementlaridan biri boigan teglar haqida dastlabki 
tushunchalar bilan tanishib chiqamiz.

HTML teg

HTML teg bu HTML hujjatdagi turli elementlarni (matn. tasvir 
va boshqalar) web sahifada qanday ko’rinishda aks etishi lozimligini 
brauzerda ko‘rsatuvchi buyruqlar hisoblanadi. Teglar ma’lum o'lcham 
va  vazifani bajaruvchi buvruqlardir.
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Teg quyidagi kcrrinishda bo'ladi: <TEG> hujjat elementi </TEG> 
Ko'rib turganingizdek teg lar < > uch burchaksimon qo’shtironoq 

(burchak qavs) ichiga olib yoziladi. Uch burchaksimon qokshtironoq 
ichiga teg nomi va un ing  atributlari yoziladi.

Quyida teg va un ing  atribut vozilishiga misol keltirilgan:
<B> <FONT CO LOR = «red>» Hello World! </FONT> </B>
Misolda keltirilgan teglar H TM L hujjatga kiritilgan Hello World! 

jumla qizil rangda, ajratilib yoziladi. Teglar orasida kiritilgan matn. teg 
atributida qanday vazifalar berilgan bo’ lsa. shu vazifaga bo'ysungan 
holda ekranda hosil b o lad i. Bu misolda Hello World! jumlasiga 
nisbatan ikkita teg ishlatilgan. 1 -  teg <B> va 2 -  teg <FONT> Hello 
World! jumlasidan keyin yana ikk i teg </B> va </FONT> yozilgan. 
Bularning farqi shundaki. birinchi ikkita teg ochuvchi va jumladan 
so'ng yozilgan ikk ita  teg esa jum la oldida yozilgan teglarni davomi 
va’ni yopuvchi tegdir. Yopuvchi teglarning vazifasi ochilgan teg ta'sir 
mavdoni tugaganligini belgilashdan iborat. H TM L hujjatda deyarli 
barcha teglarni yopish lozim . ’/* belgisini qo'yish orqali yopuvchi teg 
yasaladi.

Eslatma: har doim eng oxirgi ochilgan tegni birinchi navbatda 
yopishni unutmang. Teglarning ochilishi va yopilish tartibini almashtirib 
yubormang. Aks holda xa to lik la r kelib chiqishi mumkin.

Endi e 'tiboriin izn i <FO NT COLOR=«red»> ga qaratamiz. FONT 
(shrift) teg nomi. COLOR (rang) -  esa tegning tarkibidagi qo'shimcha 
atribut, red (qizil) —  rangning belgisi. Bu teg matnni qizil harflar bilan 
yozilishini anglatadi. Ayni misolda ranglarni o'zgartirish uchun red so*zi 
o'rniga boshqa rang nom ini kiritish kifoya. Matn shu zahoti siz kiritgan 
rang bilan ifodalanadi. LJshbu teg va uning qo’shimcha atributlari 
qanday yozilishini eslab qoling. Bu sizga keyinchalik ham as qotadi. 
Teglarning atributi bir nechta bo'lishi mumkin va ularni kiritganda har 
-b irio ras ida  bo'sh katakcha ya'ni probel qoldirishni esdan chiqarmang.

HTMLda teglarni ishlatish shartlari

Siz yuqorida teg tushunchasi haqida qisqacha tushunchaga ega 
bo'lgansiz. H T M L  teglarni ishlatganda ularni to‘g‘ri yozish muhim 
ahamiyatga ega. Quyida teglarni to'g'ri yozish va ishlatish shartlari 
haqida so‘z yuritam iz. Bu borada quyidagi qoidalar mavjud:



• Barcha teglar uch burchakli qo‘shtimoq ichida yoziladi
*<TEG>\

Ochuvchi teg -  uch burchakli qo'shtirnoq. teg nomi va uning 
qo‘shimcha atributlari (zarur bo'lgan taqdirda). Yopuvchi teg -  
uchburchakli q o ‘shtirnoq, V sleshbelgisi va teg nomi.

• Probel orqali yoziluvchi teglar atributlari.
Teg nomidan so'ng uning qo'shimcha crlchamlari bo'lishi mumkin. 

Barcha atributlar probel orqali ajratib yoziladi. Bitta harf hajmidagi 
bo‘sh joy qoldirilish HTMLda probelni aiiglatadi.

<TEG 1 — atribut=yuklatilgan vazifa 2 — atribut=yuklatilgan va- 
zifa...>

• Q o‘shtirnoq ichida yoziluvchi yuklatilgan vazifalar ma’nosi.
M a’lum vazifani bajaruvchi buyruqlar tenglik belgisidan 

so'ng qo‘shtirnoq «...» ichida yoziladi. Agar probel ishlatilmagan 
taqdirda qo‘shtirnoqni tushirib qoldirish mumkin. <FONT SIZE=2 
FACE =  «Times Roman»> Har hil hatoliklar kelib chiqishini oldini olish 
uchun qo'shtirnoqlarni ishlatish maqsadga muvofiq.

• A.ksariyat teglar yakunlash buyrug‘iai talab qiladi.
Agar siz tegni yopmagan taqdiringizda aksariyat hollarda hatolik 

kelib chiqmavdi. Ammo ochilgan teg atributlari butun hujjatga ta’sir 
qiladi. Jadval ichida yopilmagan taqdirda buhatolileni keltirib chiqarishi 
mumkin. Bu haqda jadvallar tuzish boMimida so’z yuritamiz.

• Teglarni yopish qoidasi
Har doim teglarni qat’iv tartibga rioya qilgan holda voping. Birinchi 

navbatda eng oxiri ochilgan teg yopiladi va shu tariqa navbati bo'vicha 
barchasi yopiladi. <TEG1> <TEG2> <TEG3> ... </TEG3> </TEG2> 
</TEGl>

• Teg harflar yozish shartlari.
HTIML hujjatda teglarni katta yoki kichik harflar bilan yozilishi 

hech qanday ahamiyatga ega emas. Hamma teglarni katta yoki 
kichik harflar bilan yozishingiz mumkin. Hattoki mana bunday 
<teg></Teg> Sizga maslahatimiz: barcha teglarni bir hil shaklda 
yozgan ma’qul.

• Teg atributlarini yozish tartibi qanday boMishi ahamiyatsiz.
Teg tarkibidagi atributlar qanday tartibda yozishingiz hech qanday 

o‘zgarishlarga sabab boimaydi. Quyidagi ikki variant ham to*g‘ri:
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<TEG 1 -  a íribut=  y ukla tilgan vazifa. 2 -  atribuí = yuklatilgan va- 
zifa. 3 -  atribuí = y uklatilgan vaz ifa . >

<TEG 3 -  a irib u t= yu k la tilg a n  vazifa. 1 -  aíribut = y uklatilgan va
zifa. 2  -  atribut = yuklatilgan v a z ifa >

HTML >veb-sahifa yaratish

Siz bilan birgalikda eng sodda H TM L sahifa yaratishga harakat 
qilib ko'ramiz. Buning uchun bizga Noiepad (Блокнот) matn muharriri 
kerak boladi. Dasturni ishga tushirish uchun asosiy menyu Start 
(Пуск) > Programs (Программы) > Accessories (Стандартные) > 
Notepad (Блокнот) buyrug ’in i  ianlang.

Quyida keliirilgan H T M L  teglarni Noiepad (Блокнот^а qanday 
bo‘lsa shundavligicha vozing:

<HTML>
<HEAD>
<TITLE> Eng sodda ko'rinishdagi H TM L sahifa!</TITLE> 
</HEAD>
<BODY BGCOLOR = «vvh iie»>
<B><FONT COLOR=«red>»Salom!</FONT></B><BR>
Bu mening ilk HTML sahifam.
</BODY>
</HTM L>
Navbatdagi amalga oshiradigan ishimiz, uni kompyuier xoiirasiga 

saqlash. Buning uchun INotepad (Блокнот) dasiuri File (Файл) menyusi 
tarkibidagi Save As... (Сохранить как...) buyrug'ini tanlang va fayl 
saqlanishi lozim bo'lgan papkani ianlang hamda faylni nomi.html 
kengayimasi bilan saqlang.

Eslatma: har qanday H T M L  sahifa html yoki htm kengayimasiga 
ega boiadi. Faylni ko m p yu ie r xoiirasiga saqlagach, uni brauzer 
dasturlari yordamida och ish ing iz  mumkin. Brauzer dasturlari internet 
ishlashini ta’m inlovchi maxsus dasturîar hisoblanib, gipermatnni 
owqish. web-resurslarda navig;atsiyalash va ko4rib chiqish dasturidir. 
Web-brauzeri gipermatnlarni o'qishdan tashqari, tovushni va video 
maTumotlarni qaytadan chiqarish, ya'ni, gipermediani qayta chiqarish, 
larmoqning boshqa kom pvuterla ri bilan ulanishni o¿rnatish va ularda 
ishlayoigan serverlarga vveb-hujjailarga so'rovlarni yuborish, iarmoqning
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boshqa foydalanuvchilari bilan muloqot tashkil qilish va uni quvvatlash 
kab i qo'shimcha imkoniyatlarga ega bo'lishi mumkin. Eng ommaviy 
tarqalgan web-brauzerlarga misol qilib Internet Explorer, Opera, Avant 
Brauzer, IMozilla kabi dasturlarni avtishimiz mumkin. 1.2-jadval 
brauzer dasturlarning royxati va imkoniyatlari keltirilgan.

L2-jadval

Brauzer d as tu rla ri ro 4 x a ti

N2 Brauzer nomi: Imkoniyatlari

1. Opéra 10.63 Opera Software kompaniyasi dasturidir. Bu dastur 
43 tildagi foydalanuvchilar uchun mo;ljallangan 
bo'lib, Windows, Linux va Mac operatsion 
tizimlarida ishlaydi.

2 . M ozilla Firefox Mozilla Firefox -  tezlcor, ko’p funksiyali brauzer 
dasturi. Firefox dasturida bir oynada bir nechta 
sahifani ochish mumkin. Shuningdek, siz 
giper havolalarni shu sahifani (siz ayni paytda 
ko‘rib turgan sahifani) tark etmasdan turib 
ochish imkoniyatiga ega bo'lasiz. Brauzer web 
standartlarni juda yaxshi qoilab, unda juda qulav 
interfeys mavjud va o'zida qidiruv paneli (Google 
va boshqalar) joylashgan.

3. Google Chrome Google Chrome -  bu brauzer, murakkab tex- 
nologiyalarni va sodda dizavnni birlashtirgan 
va bu esa Internetda ishlashni tezlashtiradi va 
xavfsizligini oshiradi.

4. Apple Safari Apple Inc. kompaniyasining brauzer dasturi 
hisoblanadi. Dastlab dastur Mac OS operatsion 
tizimi uchun ishlab chiqilgan edi. Dasturda ko‘p 
ovnalik interfeys mavjud bolib. unda xavfsizlik 
uskunalari bilan boyitilgan.

5. Maxtlion Internet-brauzer dasturi. Maxthon web-sahifalarni 
ko‘p oynali rejimda ko‘rish imkonini beradi. 
Dasturning asosiy xususiyatlaridan biri ko*p sonli 
bog'lanishlar imkoniyati mavjud.

26



6. Avant Browser Bu brauzer ham ko'p oynali rejimda ishlaydi. 
Ya’ni asosiy oyna ichida ko'plab oynalarni ochish 
imkoniyati mavjud. Avant Browser dasturida 
sichqoncha tugmasini bir bosish bilan grafiklar, 
video, tovushlar va Flash animatsiyalarni yuk- 
lashni taqiqlash yoki aksincha ruxsat berish 
imkoniyati mavjud.

7. Netscape Navigator Dastur o'zining oddiv va yengil sozlanadigan 
foydalanuvchi interfeysi bilan va tezkorligi, ish- 
lashga qulayligi hamda web-sahifalarni ko'rishni 
boshqarish imkonivatlari kengaytirilgan.

Bizga maTumki yaratilgan web-sahifalarni ishlatib ko'rishda 
o‘zim iz bilgan yoki bilm agan holda brauzer dasturiga murojaat qilamiz. 
Ana shu paytda yaratilgan web sahifani ochish uchun uning fayli 
ustida sichqonchaning chap tugmasini ikki marta ketma-ket bosish 
yetarli. Bundan tashqari avva l brauzer dasturini (Internet Explorer) 
ishga tushirib olib. keyin esa File > Open buyrug4ini berish orqali 
ham faylni ishga tushirish mumkin. Hammamizga ma’lumki, web 
sahifani yaratish vaqtida uning qanday dizaynda chiqayotganini ko'rish 
uchun biz brauzer dasturlariga qayta -  qayta murojaat qilamiz. Ayrim 
professional dasturlarda (Dreamweaver va boshqalar) natijani kobrish 
uchun to'g'ridan-to'g'ri inaxsus tugma bosiladi. Bunda to¿g‘ridan- 
to'g'ri belgilangan brauzerda sahifa yuklanadi. Bu haqida Dreamweaver 
dasturida batafsil ma'lumot beramiz.

HTML hujjatning asosiy strukturasi

Siz varatgan ilk H TM L sahifa asosida HTML hujjat asosiy 
strukturasini tahlil qilam iz. Kompyuter xotirasiga saqlangan HTML 
hujjatni Notepad dasturi yordamida oching. Har qanday HTML hujjat 
ichki qismi quyidagilardan tashkil topgan bo4ladi:

<HTML>
bu teg HTML hujjatni ochish (boshlash) uchun xizmat qiladi va u 

HTML hujjatning birinchi ochuvchi va oxirgi yopuvchi teg hisoblanadi. 
Boshqacha aytganda web sahifaning boshlanish va tugash chegarasini 
ifodalaydi. Uning yagona vazifasi, mazkur hujjatni ochayotgan dasturga 
bu fayl HTML hujjatligi haqida axborot berishdan iborat.
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<HEAD>
H E A D  tegidan so'ng HTML hujjatning tizimli axborotlari haqida 

ma’lum ot beradi. Bizning misolimizdagi yagona tizimli axborot -  
TITLE tegi hisoblanadi.

< T IT L E >
B u  teg ochuvchi teg <HEAD> va yopuvchi teg </HEAD> orasida 

yoziladi. Ochuvchi va yopuvchi TITLE orasida kiritilgan axborot siz 
yaratayotgan hujjat nomini anglatadi. Siz kiritgan nom brauzer dasturi 
tom onidan va internetdagi qidiruv tizimlari tomonidan ishlatiladi. Biz 
keltirilgan misolda «Eng sodda ko'rinishdagi HTML sahifa!» matni 
brauzer dasturi yuqori qismida ya'ni sarlavha satrida namoyish etiladi.

<BODY>
BO D Y  ochuvchi va yopuvchi teglari orasida yozilganlarning 

barchasi sizning HTML hujjatingizning tanasi hisoblanadi. Agar siz 
ushbu teg orasiga matn yozsangiz yoki tasvir kiritsangiz -  bularning 
barchasini brauzer ekranda namoyish etadi.

Н аг qanday HTML hujjat quyida keltirilgan tartibda yozilishi shart:
<H TM L> HTML hujjat boshi <HEAD> Hujjat nomlanishining 

boshlanishi <TITLE> ... </TITLE> HTML sahifa nomi (sarlavhasi) 
<H E A D > Hujjat nomlanishining yakunlanishi <BODY BGCO- 
LOR =  «white»> Hujjat tanasining boshlanishi ... </BODY> Hujjat 
tanasining yakunlanishi </HTML> HTML hujjat yakuni.

HTML sahifaga tasvir jovlashtirish

Internet bilan ishlovchi dasturlar tasvirlarni (grafik elementlarni) 
och ish  im koniga ega boMishi bilan internetda mavjud sahifalarning 
deyarli barchasi tasvirli axborotlarni nashr eta boshladi. Siz yaratgan 
w eb-sahifa qiziqarli va chiroyii dizayn asosiga qurilgan bo’Isa uning 
o‘quvchilari soni shubhasiz ortadi. Tasvirlar yordamida harakatlanuvchi 
tugmalar va G if animatsiyalarni kiritish mumkin. Biroq tasvirlar bilan 
ishlashda ularni hajmi va formatiga e ’tibor berish kerak. Hozirgi paytda 
internetga joylashtirilayotgan deyarli barcha sahifalarda ishlatilayotgan 
tasvirlar formati *.JPEG yoki *.GIF ni tashkil etadi. Bunga asosiy 
sabab, bu formatdagi tasvirlar hajmi juda kichik. Bu formatdagi 
tasvirlar ishlatilganda web-sahifa hajmi ortib ketmaydi va sizning web
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sahifangizdan foydalanuvchi sahifani internetda ochilishini uzoq vaqt 
kutmaydi.

Agar siz boshqa formatdagi tasvirlardan web-sahifani bezashda 
fovdalansangiz uning hajmi ortib ketadi va undan foydalanuvchilarga 
sahifani ochishda muaminolar keltirib chiqaradi. Web-sahifani 
bezatishda lining dizayniga ^.GIF formatdagi tasvirlardan foydalaning. 
Boshqa maqsadlarda *.JPEG dan foydalanishingiz mumkin.

<img> tegini qo41ash qoidalari

<IMG> tegi bilan bog6iiq bo‘lgan, quyida keltirilgan asosiy qoidalar 
bilan tanishib chiqing va o'z sahifangizni yaratishda ushbu qoidalarga 
doim rioya qilishga harakat qiling.

• Tasvir nomi va joylashgan o‘rnini yozganda harflarning bir 
hilda boiishini ta’minlash katta ahamiyatga ega. Tasvir joylashgan 
papka nomi va tasvirning nom ini kiritganda harflarni bir hilda yozilishi 
shart. Biror bir harfni tushirib qoldirish yoki hato yozilishi tasvirni 
ochishda hatoliklarni keltirib chiqaradi.

• Tasvir yoki papka nomini kiritganda probel ishlatmang. Web- 
sahifani yaratayotganingizda fayllar yoki papkalar nomini kiritganda 
probel (bo*sh joy) ishlatmang. Agar siz kiritgan nom ikki yoki undan 
ortiq so'zlardan iborat bofclsa. probel o4rnida (pastgi chiziqcha) 
ishlatishingiz inumkin. Masalan: .../Chet_elga_sayohat/Ispaniya/Ma- 
laga_01.jpeg

• Internetda ishlatiluvchi tasvir formatlari. Hozirgi paytda 
internetda ikki hil formatdagi tasvirlar keng qollanilib kelinmoqda. Bu 
formatlar: GIF (bu formatdagi tasvirlar *.gif qisqartmasiga ega) hamda 
JPEG (bu formatdagi tasvirlar esa *. jpg yoki *jpeg qisqartmasiga ega). 
Siz ham ushbu formatdagi tasvirlardan foydalaning. Boshqa formatdagi 
tasvirlarni aksariyat brauzerlar ocha olmaydi.

• Har doim WIDTH va HEIGHT atribular ini kiritishga 
harakat qiling. Bu sizning vveb-sahifangizni ochilishini tezlashtiradi 
va tasvirlarni asi o'lchamda boMishini ta'minlavdi.

• Tasvir hajmini sun’iy kichraytirish. WIDTH va HEIGHT orqali 
tasvirning real atribut oMchamlarini kichraytirish mumkin. Ammo 
bu usuldan iloji boricha kainroq foydalanish kerak. Eng yaxshi usul
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tasvirni real o4chamini grafik muharrirlar yordamida kichraytirishdir. 
Bu usul tasvirning ochilish vaqtini kamaytiradi.

• Tasvir hajmini sun’iy kattalashtirish. Tasvir o‘lchami kat- 
talashtirilganda yoki kichraytirilganda uning sifatida o'zgarish 
sod ir boiadi. Agar siz o'lchamlarni o'zgartirganda bo'yi va enini 
proportsionalligiga e’tibor bermasangiz. tasvir sifatini buzilishiga 
olib  keladi. WIDTH va HEIGHT atributlari orqali tasvir hajmini 
kattalashtirganda, real o'lchamni 2 marta, 3 marta va shu tariqa 
oshishiga erishish kerak. Masalan, tasvirning real olchami WIDTH = 
= «100». HEIGTH=«200» ga teng bo'lsa. uni ikki marta kattalashtir
ganda W IDTH =«200», HEIGTH=«400» ga teng bo4lishi shart. Bu usul 
tasvir sifatidagi salbiy o‘zgarishlarni bir oz yumshatadi. Shuningdek, 
a y n i holatni tasvir o4chamini kichraytirishda ham qo'llash maqsadga 
mirvofiq.

• Har doim ALT atributini qollang.
Har doim ALTdan sokng tasvirga aloqador qo'shimcha axborotni 

kiritishga harakat qiling. Buning asosiy sababi, siz joylashtirgan tasvir 
ochilmagan taqdirda, Internetdan foydalanuvchi siz kiritgan tasvir 
izohini o'qiydi va minimum axborotga ega bo‘ladi.

Giperhavolalar -  web-hujjatlarni bir-biriga bog‘lash

Web-sahifaga tasvir jovlashtirishni o;zlashtirib olganingizdan so'ng, 
endigi navbatda havolalar haqida tushuncha olishning ayni mavrudi. 
Havolalar tufayli internet hozirgi mavqeiga erishdi. Havolalar yordamida 
ik k i va undan ortiq (cheksiz) web-sahifalarni bir-biriga bogTashingiz 
mam kin. Havola rus tilida «ссылка» deb ataladi. Havolaga bosish 
orqali siz ikkinchi sahifani ochishingiz mumkin. Havolalar yordamida 
web-sahifangiz uchun menyu tuzishingiz mumkin. Havolalar sizning 
web-sahifangizdan foydalanuvchini sahifa bo’ylab tom ma'noda sayohat 
qilishi imkonini beradi va unga to'g'ri yo ln i ko'rsatib turadi.

Havolalar

Havola -  bu HTML hujjatning boshqa HTML hujjat bilan bog'lovchi 
qismi. Unga kursorni bosishingiz bilan ikkinchi HTML hujjat ekranda 
namoyon bo'ladi. Shuningdek. havoladan (agar siz yaratgan bir sahifada
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juda ham ko*p matn kiritilgan boisa) bitta sahifa ichida boshqa HTML 
hujjatni ochmasdan turib ham foydalanish mumkin. Sizga maslahatimiz, 
agar bitta sahifaga jovlashtirmoqchi boigan matn juda ham ko'p boisa, 
uni iloji boricha turli b o iak larga boigan holda, bir nechta HTML 
faylga joyiashtiring. Shunday qilsangiz, web-sahifadan foydalanish oson 
kechadi.

Navbatdagi sahifalar bilan tanishib chiqqach siz havolalarni ishlatish 
usullarini va havola tuzish uchun qanday HTML teglardan foydalanish 
zarurligini bilib olasiz.

Havolalar tuzish usullari

Havolalarni ta'sir doirasi va ularni qaysi sahifa bilan bogiash  
vazifasini <A> ochuvchi hamda </A> yopuvchi teglari orasida bel- 
gilanadi. Ushbu teglar orasida uning atributlari va kalit so'z 
joylashtiriladi.

Ushbu teg orasida nim alarni joyiashtirish mumkin? Deyarli 
hamma narsani. Bu matn, tasvir, jadval va hatto harakatlanuvchi 
tasvir ham boTishi m umkin. U lardan qaysi birini joyiashtirish  
o'zingizga havola.

Bu boiimda oldimizga qo'ygan maqsadimiz havolalar tuzish. 
Maqsadga erishishning eng oson  usuli barchasini oddiy misollardan 
boshlash. Shunga amal qilgan holda sizga havola tuzishning eng oddiy 
misolini keltiramiz:

<A HREF = «pictures.h tm l”>Bu sahifada mening hayotim bilan 
bogiiq tasvirlar j oylashgan </A>

Natija mana bunday koiin ishda boiadi:
B u sahifada rn en in z h a y o tim  b ilan  b o ç ‘liq  tasv irlar io v la sh sa n .

so'zini bosishingiz bilan p ic tu r e s .h tm l  sahifasi ekranda namoyon 
boiadi. <A> tegining qo'shimcha atribuí boigan HREF sizni p ic tu re s . 
h tm l sahifasiga olib  boradi.

Tasvirlarni havola sifatida namoyon etish uchun <A> va </A> teglari 
orasida <IMG> tegi vordamida tasvirda qaysi faylni nimani qo;yish va 
u jovlashgan papkaga y o in i ko'rsating.

<A HREF =  «pictures.HTML»> <IMG SRC = «img/photo.jpg» 
WIDTH = «100» HEIGHT = «100» ALT=«M ening foto galereyam»> 
</A>
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Havolalar — <A> tegining qo‘shimcha atributlari tasnifi

Boshqa HTML teglari kabi <A> tegining ham qo'shimcha atributi 
mavjud. Quyida ushbu buyruqlarning tasnifi keltirilgan.

HREF

Bu atribuí yordamida havola qilinishi lozim boigan HTML hujjat 
nomi va uning joylashgan joyi belgilanadi. Bu atribut <IMG> tegining 
SRC atribuii kabi bir hil vazifani bajaradi. <IMG> tegining SRC 
atributi yordamida tasvir nomi va u joylashgan papkaga y o i ko‘rsatilsa. 
HREF yordamida HTML hujjat nomi va u joylashgan papkaga v o i 
tasvirlanadi.

TARGET

Bu atribut HTML hujjatni aynan o'slia ovnada yoki alohida oynada 
voki qaysi freymda ochilishini belgilaydi. TARGET atributining 
q o ‘shimcha oichamlari: Jblank -  brauzerda siz ishlab turgan oynadan 
tashqari yangi oynada koisatilgan hujjatni ochish.

_top -  web sahifada freymlar ishlatilgan boisa, havolada 
kcTrsatilgan hujjatni faol oynada freymlar strukturasini buzgan holda 
ochadi. Ochilgan oynada freym alomatlari mavjud boimaydi.

^parent — havolada ko4rsatilgan hujjatni avval ochilgan oynada 
ochiladi.

_self -  havola qaysi freym yoki freymdan holi sahifada ishlatilgan 
b o isa  aynan o‘sha sahifada ochadi.

<A HREF =  «pictures.html» TARGET = «_blank»>Bu sahifada</A> 
m ening hayotim bilan bogiiq tasvirlar joylashgan. <BR> Bu sahifada 
s iz  <A HREF =  «about.html» TARGET=«_top»> men haqimda </A> 
qiziqarli maiumotlarni o'qishingiz mumkin.

Natija mana bunday ko'rinishda boiadi:
Bu sahifada mening hayotim bilan bogiiq tasvirlar joylashgan. 

Sahifada siz men haqimda qiziqarli ma’lumotlarni o'qishingiz mumkin. 
Ushbu havolalardan biriga bosib. siz havolada belgilangan HTML 
hujjatdagi maiumotlarni o'qishingiz mumkin.
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E-MAIL havola

E-mail (Elektron pochta) manzillarni faollashtirish uchun havola 
tuzish mumkin. E-m ail m anzil ko'rsatilgan havolani bosish bilan 
kompyuterga o'rnatilgan elektron pochtalar bilan ishlovchi dastur 
faollashadi va unda havolada ko'rsatilgan elektron pochta manzili 
koisatilgan vangi oyna hosil b o lad i va siz ko'rsatilgan manzilga xat 
jo'natishingiz mum kin.

E-mail manzilni havola sifatida belgilash uchun HREF atributi 
o'rnida mailto: elektron pochta manzili yoziladi. Misol uchun:

Mening <A H R EF = «mai lto: tsamar@mail.ru»> elektron poch- 
tam^a</A> ushbu o'quv qoMlanma haqidagi fikr -  mulohazalaringizni 
yozing!

Natija mana bunday ko'rinishda boiadi:
Mening elektron poshtamga ushbu o‘quv qoilanma haqidagi fikr- 

mulohazalaringizni yozing!

Havolalar yozishning asosiy qoidalari

Quyida havola tuzishda bilishingiz lozim boMgan oddiy qoidalar 
yozilgan. Ularni diqqat bilan o 4qib chiqing va eslab qolishga harakat 
qiling. Havola tuzishda bu qoidalarga amal qilsangiz, siz tuzgan 
havolalar hatoliklarsiz ishlaydi.

• Harflarning bir Hilda vozish va fayl yoki papka nomini to‘g‘ri 
ko‘rsating. Havola tuzilganda en g  katta e'tiborni siz murojaat qilmoqchi 
boigan faylga olib boruvchi y o i  aniq va tofcg*ri ko'rsatilishi lozim. 
Bunda papka va fayl nomiga katta e’tibor qarating. Ularning nomida 
arzimagan hatolikka yo‘1 qo'ysangiz havola ishlamaydi. Aytayiik biror 
bir harfni tushib qolishi yoki bosh harf o'rniga kichik harf bilan yozilsa 
hatolik yuz berishi muqarrar. Shu bois, havola tuzishda aniqlik katta 
ahamiyatga ega.

• Fayl va papka nomini kiritganda probel ishlatmang. Web- 
sahifa varatish jaraycmida fayl v a  papkalarni nomi tkki va undan ortiq 
so'zdan iborat bo'Isa so'zlar orasida va oxirida probel ishlatmang. 
Probel ishlatilgan fayl yoki papkaga havola murojat qilganda hatolik 
sodir boMadi.

• Kalit so‘zlarga havola tuzish. Biror hujjat ichidagi kalit so‘zga 
havola tuzganda, en g  avvalo kalit so4zni <A> tegining NAME buyrug'i
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yordamida belgilab olish lozim. So'ngra shu tegning HREF atributi 
orqali u joylashgan favl noini (agar kalit so'z boshqa faylda joylashgan 
b o isa ) va kalit so;z manzilini ko'rsating HREF = «favl aomi.HTML# 
kalit so'z».

• FTP server va E-M AIL uchun maxsus havola. FTP serverda 
joylashgan faylga havola tuzganda ’FTP://? bilan boshlanuvchi manzilni 
yozing. E-M A IL havola tuzganda esa «mailto: e-mail manzil»ni 
yozing.

Matnlarni tahrirlash

Matn tahrirlashni o'zlashtirib olishingizni osonlaslitirish uchun 
uni ikkiga bo'lib tushuntirishni lozim topdik. Ularning har biri matn 
tahrirlashda ishlatiladigan HTML teglarni batafsil tahlili misollar 
yordamida ak s ettirilgan.

• M atnning alohida bolaklarini tahrirlovchi teglar;
• M atnning virik boTaldarini tahrirlovchi teglar.

Matnning alohida boMaklarini tahrirlovchi teglar

Quyida tasnifi keltirilgan barcha matn tahrirlash uchun ishlatiluvchi 
teglar ochilgandan so'ng ularni yopish shart. Ochilgan tegning ta'sir 
doirasi u yopilgunga qadar davom etadi. Agar siz tegni yopishni 
unutsangiz, uning ta'sir doirasi hujjat oxirigacha davom etadi. Barcha 
teglash quyidagi tartibda yoziladi: <TEG1><TEG2> Kerakli matn </ 
TEG2></TEG1>. Har doim eng oxiri ochilgan tegni birinchi boiib  
yopishni unutmang.

<B> Kerakli matn </B>
Bu teg orasida yozilgan matn qalin harflar bilan belgilanadi.
< l> K e r a k li  m atn< /\>
Matn o 'n g  tomonga egiltirib yoziladi.
<BIG>Kerakli matn</BIG>
Matnni kattalashtirish. Yozilgan matn boshqalariga nisbatan 

kattalashtirilgan harflar bilan belgilanadi.
<SM ALL>K erakli matn</SMALL>
Matnni kichraytirish. Yozilgan matn boshqalariga nisbatan ki- 

chiklashtirilgan holda belgilanadi.
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<ST RIKE>Kcrakli-matn</STRIKE>
Teg orasida yozilgan matn ustidan chiziq tortiladi.
<STRO\G>Kerakli matn</STRONG>
Matn ichidagi ayrim so'zlarni kuchli ajratib ko'rsatish uchun 

ish latiladi.
Kerakli <SUB> </SUB>main
Ko'rinib turganidek bu teg orasida kiritilgan matn, matn chizig'idan 

pastda kichik harflar bilan yoziladi (indeks).
Kerakli < S U P > ^ /S IJP >
Yuqorida keltirilgan tegning teskari shakldagisi boMib. u matnni 

yuqorida kichik harflar bilan yozilishini ta’minlavdi (daraja).
<U>Kerakli matn</L’>
Yozilgan matn ostida chiziq tortiladi. Bu teg vordamida ayrim 

so'zlarni belgilab ko'rsatish mumkin.
<CENTER>Kerakli matn</CENTER>
Bu teg kiritilgan matnn i sahifa o'rtasida boiishini ta’minlaydi. Agar 

bu teg jadval ichida qoMlansa, u holda bu jadval katakchasi ichidagi 
inatnga ta'sir etadi. Bu tegni jadval ichida qoMlash usullari haqida 
jadvallar bilan ishlash bo'limida tushuntirib o'tamiz.

<BR>
Bu teg matn qatorlarini surish uchun xizmat qiladi. Ma’lum 

jumladan so’ng ikkinchi jumlani yangi qatordan boshlamoqchi 
bo'lsangiz. jumla so‘ngida ushbu tegni yozing.

Endi hech boim aganda bitta qo'shimcha buyruqqa ega bo‘lgan 
teglar bilan tanishib chiqamiz.

<FOIVT>Kerakli matn</FONT>
Bu teg harfning qo'shimcha atributlarini belgilash uchun ishlatiladi. 

Quyida ushbu tegning eng ko'p qoilaniladigan qo‘shimcha atributlari 
bilan tanishib chiqamiz:

SIZE

Harf o'ichamini belgilashda qo‘llaniladi. Matndagi harflar o'ichamini
1 dan boshlab xohlagan son bilan belgilash mumkin.

Masalan: <FONT SIZE = «5»>Salom!</FONT> Bu mening web 
sahifam. <FONT SIZE = «2»>(Izoh)</FONT>
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Bundan tashqari siz SIZE olchamlarini plyus + va minus - bilan 
ham belgilashingiz mumkin. Bu usul qo’llanganda harf o‘lchami 
ishlatilayotgan harfga nisbatan katta yoki kichik belgilanadi. Misol 
uchun siz 3 ga teng kattalikdagi harfdan foydaianayotgan boMsangiz, 
SIZE=«+2» harf oMchami SIZE=«5» ga. SIZE=«—1» o’lchami esa 
SIZE= «2» ga teng boiadi.

COLOR

Bu atributdan so'ng rang nomi yoki rangni belgilovehi olti xonali 
lotin harflari hamda raqamli kod kiritiladi va shu tariqa harf rangi 
belgilanadi. Turli brauzerlar turli rang nomlarini belgilay oladi. Rang 
nomlari ingliz tilida kiritiladi. Rang nomi va ko'rinishini yodlab 
olishingiz uchun ularning har birini aomi o‘sha rangda belgilangan. 
Bu ranglarni Netscape Navigator va Internet Explorer brauzerlari 
muammosiz taniydi va o‘qiy oladi.

Rangni belgilovehi lotin alifbosi va raqamli kod ■#' simvol bilan 
boshlanadi. Raqamlardan 1 dan 9 gacha yoki A dan F gacha boigan  
lotin harflarini ishlatish mumkin. Rang kodi qanday bolishidan qat'iy 
nazar u RGB (RED — qizil, GREEN — yashil, BLUE -  ko'k) ranglar 
tizimida aks ettiriladi. Raagni belgilash uchun uchta rangni bir- 
biriga qo‘shish lozim. Har bir rang ulushini 0 dan 255 gacha bo'lgan 
miqdorda belgilanadi. Misol uchun toza qizil rangni belgilash 
uchun qizil rang miqdorini 255 ga, yashil va ko"k ranglar miqdorini 
esa 0 ga tenglashtirish lozim va bu mana bunday yoziladi <FONT 
COLOR=#FFOOOO>. Olti xonali alifboli -  raqamli kodini qoilash juda 
ham qiyin. Shu bois ranglar kodini belgilab beruvchi jadvalimizdan 
fovdalanishingiz mumkin.

FACE

Matnni qanday shriftda yozilishini belgilash uchun shrift nomi 
keltiri ladi. SHrift nomi koinpyuterda o‘rnatilgan bo'lishi kerak yoki 
umumiy ishlatiladigan shriftlardan foydalanish mumkin. Agar siz 
qo‘llagan shrift fovdalanuvchining kompyuterida topilmagan taqdirda 
brauzer standart shriftni tanlaydi.

Masalan:
<FONT FACE=«Arial>»Salom!</FOMT>
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<FÖNT FACE =  «Times N ew  Roman, Arial, Courier New»>Bu 
meiiing web sahifam.</FONT>

Siz har doim <FONT> tegining FACE atributini tanlaganingizda, 
stardart shrift turlaridan foydalaning. M isol uchun Windows muhitida 
ishlovchi barcha kompvuterda o'rnatiladigan standart shriftlar quyida- 
gilardan iborat:

Windows: Arial Arial Black. Arial Narrow, Courier, Courier New, 
Garamond, Helvetica Times. Times New Roman.

Aytaylik siz T im es va Times N ew  Roman shriftining boshqacha 
tur ini tanlagan boMsangiz, u holda foydalanuvchi kompyuterida bu 
shrift o'rnatilmagan bo‘lsa, brauzer siz tanlagan shriftni standart Times 
New Roman shriftiga almashtiradi.

Matnning yirik bo‘laklarini tahrirlovchi teglar

Endi siz bilan matndagi yirik  bloklar va abzatslarni tahrirlovchi 
teglar va ularning qo'shimcha buyruqlarining ishlash tartibini o‘rganib 
chiqamiz.

<PLAINTEXT>
Ushbu tegdan so'ng kiritilgan barcha HTML teglarning ta’sirini 

butunlay kesadi v a  ular huddi ekranda ko'rsatilishi lozim bo'lgan 
matn kabi aks etadi. Bu teg boshqa teglardan tubdan farq qiladi va 
uni yopish shart em as. Agar matnda ayrim HTML teglarni ekranda 
brauzer aks ettirishini xohlasangiz bu tegdan foydalanishingiz mumkin. 
Biroq yuqorida aytganimizdek bu tegdan so‘ng matnni HTML teglar 
yordamida tahrirlash mumkin emas. Chunki ularni brauzer huddi 
oddiy matn kabi tushunadi. Agar siz </PLAINTEXT> tegini kiritgan 
taqdiringizda ham bu <PLAINTEXT> ta’sir doirasini cheklay olmaydi. 
Web sahifangizda HTML teglarni matn shaklida aks ettirmoqchi 
boMsangiz, u holda uch burchakli qo‘shtirnoq ‘<’ o;rnida &LT; simvolini 
qo‘ Hang.

<ADDRESS>
Kerakli matn 
</ADDRESS>
Teg o‘z nomi bilan adres ya’ni manzillarni belgilash uchun 

ishlatiladi. Bu teglar orasida yozilgan manzilni har qaysi brauzer o'zi
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x.ohlagan tarzda namoyish etadi. Teg yopilganidan so'ng kiritilgan matn 
yangi satrdan boshlanadi.

<BLO CK Q U O TE>
Kerakli matn 
</BLO C K Q U O TE>
Bu teg matndagi paragraf va satrlarni belgilash uchun qo'llanadi. 
<H1>. <H 2>. <H3>, <H4>. <H5> v a <H6>
yuqoridagi oltita teg sarlavhalarni belgilash uchun qoilaniladi. 

Sarlavhalar qalin harflarda yoziladi. Bu teglarning bir-biridan farqi 
alarning o‘lchamlarida. 1 dan 6 gacha boMgan sonlar sarlavha 
o ‘lchamlarini katta-kichikligini quyida keltirilgan tartibda belgilaydi: 

Sarlavha H I 
Sarlavha H 2

Sarlavha H 6  
<P>
Kerakli matn 
< /P >
Bu teg paragraflarni belgilaydi. Paragraf boshi va ohirida bo‘sh 

qator qoldiradi.

ALIGN

<P> tegining qo'shimcha atributi b o iib  u papagraf ichida yozilgan 
matnni tekislash uchun ishlatiladi. Bu atributning qo'shimcha 
oMchamlari ALIGN — LEFT (matnni chap burchakdan tekislaydi). 
RIGHT (o'ng tomonga tekislaydi). CENTER (sahifa markaziga 
tekislaydi) va JUSTIFY (matnni sahifa eni bo'ylab tekislaydi). JUSTIFY 
ishlatilganda brauzer matnni chap va o'ng tomon bo'ylab bir xilda 
tekislab chiqishga harakat qiladi. Bu jaravonda so'zlar orasi cho'zilib 
ketishi ham mumkin.

<PR E >
Kerakli matn 
</P R E >
Bu teg yordamida siz matnni qanday kiritgan bo‘lsangiz shunday 

ko^'inishda b o iish i ta’minlaiiadi. Quyida keltirilgan ikki misolda buni 
yaqqol ko'rish mumkin. <PRE> tegidan tashqarida yozilgan matnda 
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probel necha marta ishlatilishidan qat’iy nazar u bittaga hisoblanadi. 
<PRE> tegi tarkibida kiritilgan matn qandav boMsa shundayligicha 
ekranda ko‘rinadi.

Hujjat asosiy qismini tahrirlash

Bu boMimda hujjat tanas ini belgilab beruvchi <BODY> tegi va 
uning qo'shimcha buyruqlari haqida scfz boradi. <BODY> tegini 
oldingi boMimlarda qisqacha tanishtirib o'tgan edik. Bu teg bevosita 
HTML hujjatni ekranda ko'rinishi lozim boMgan matn. tasvir va boshqa 
elementlarni o‘z ichiga qamrab oladi. <BODY> ochuvchi hamda </ 
BODY> yopuvchi teglari orasida barcha muhim elementlar joylashadi. 
Bu tegning qanday qcrshimcha buyruqlarini quyida birgalikda ko6rib 
chiqamiz.

BGCOLOR

Sahifaning orqa foni rangini belgilash uchun ishlatiladi. Bunda 
rangning ingliz tilidagi nom i yoki harf va sonlardan iborat kod 
qo'llaniladi.

BACKGROUND

Sahifaning orqa foni uchun qo'llaniluvchi tasvir nomi va u 
joylashgan papkaga yoMni ko'rsatishda qo'llaniladi. Tasvir joylashgan 
papkaga yolni ko'rsatish haqidagi malumotlarni «HTML safifaga tasvir 
joylashtirish» bo'limida o'qishingiz mumkin.

TEXT

Hujjatda yozilgan matn harflarini qanday rangda boTishini rang 
kodlarini kiritish orqali belgilab beradi. Agar siz ushbu atribut 
ishlatmagan taqdiringizda matn rangi qora rangda boTadi.

LINK

Bu atribut qoTlanilgan sahifadagi havola rangi teg o'lchamlarida 
qaysi rang kodi yoki nomi berilgan bo'lsa, o'sha rangda ekranda 
namoyon boiadi.
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VLINK
Bu atribut yordamida ishlatilgan havolalarni belgilab ko'rsatish 

uchun qoilaniladi. Siz foydalanuvchilar adashib ketmasligi va havolada 
ko‘rsatilgan sahifaga qayta kirmasligi hamda hali qo'llanilmagan 
havolalarni qoilanilgan havolalardan ajratib ko'rsatish uchun ish- 
latishingiz mumkin.

ALINK
Bu atribut kursor yordamida tanlangan va sichqoncha chap tugmasi 

bosilgan paytda havola rangini o‘zgartirish uchun ishlatiladi.
Siz hozir o ‘qigan sahifada <BODY> tegining barcha qo'shimcha 

atributlari quyidagi tartibda qo‘llaniladi.
<BODY BGCC)LOR=#003399 TEXT= black LINK=blue ALINK= 

=red  V L IN K =#006666>

R o‘y\atlar tuzish

Sahifada matndagi ay rim elementlarni ro‘yxatlangan tartibda yozish 
qiyin emas va bundan tashqari o'quvchi matn bilan tanishib chiqishida 
qulavliklar yaratib beradi. Siz huddi Microsoft Word matn muharririda 
ro‘yxatlarni qanday tuzsangiz huddi shu ko'rinishda HTML hujjatda 
ham  maxsus teglar yordamida belgilash imkoniga egasiz.

Bu bo'limda ro‘yxatlangan tartibda matnni kiritish usullari bilan 
tanishib chiqamiz:

<RO'YXATNI OCHUVCHI TEG>
< Ro'yxat elementining tegi > Matn
< /  R O ‘ Y X A T N I  Y O P U V C H I  T E G  >

Tartiblangan ro'yxat: Tartiblanmagan ro‘yxat:
1. Ro'yxat elementi 1 • Ro’yxat elementi 1
2. Ro'yxat elementi 2 • Ro'yxat elementi 2
3. Ro'yxat elementi 3 • Ro'yxat elementi 3
Matn ro‘yxatini belgilovchi teglar tarkibida siz HTMLning boshqa 

matn tahrirlash uchun qo‘llaniluvchi teglarini ishlatishingiz mumkin.

Ro‘yxatlar tuzish -  ro‘yxatni tartiblash
Matn bo'laklarini tartiblashda sonlar yoki harflar bilan belgilash 

mumkin. Shuningdek ayni jarayonda simvollardan ham foydalanish 
imkoni mavjud.
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Matn boMaklarini tartiblashda <OL> ochuvchi va </OL> yopuvchi 
teglaridan foydalaniladi. Ushbu teglar ichida tartiblanuvchi matn oldiga 
<LI> atributi yoziladi. <O L> tegining yagona qo‘shimcha o‘lchami 
TYPE bo'lib, u tartiblovchi belgi kcrrinishini aniqlab beradi.

Arab raqamlari bilan belgilash:

HTML kodi 
<OL TYPE=1>  
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>

Natija
Matn 1 
Matn 2 
Matn 3

Rim raqamlari bilan belgilash:

HTML kodi 
<OL TYPE = I> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>

Natija 
I. Matn 1 

II. Matn 2 
III Matn 3

Rim harflari bilan belgilash:

HTML kodi 
<OL TYPE = i> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>

Natija
i. Matn 1

ii. Matn 2
iii. Matn 3

Bosh harfalari bilan belgilash:

HTML kodi 
<OL TY PE=A >  
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>

A. Matn 1
B. Matn 2
C. Matn 3
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Kichik harflar bilan belgilash:

HTML kodi 
<OL TYPE = a> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</OL>

Natija
a. Matn 1
b. Matn 2
c. M atn3

Ro‘yxat tuzish -  tartiblanmagan ro‘yxat
Tartiblanmagan ro‘yxat tuzishda <UL> va </UL> vopuvchi 

teglaridan foydalaniladi. Ro'vxat ichidagi tartib <LI> atributi bilan 
belgilanadi. <U L > tegi uchun ham TYPE oMchami ishlatiladi. TYPE 
o ich am i 3 xil turdagi ro'yxat kirita oladi:

Doirasimon belgi yordamida tartiblash:

HTML kodi 
<UL TYPE = circle> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>

Matn 1 
Matn 2 
Matn 3

HTML kodi 
<UL T Y PE = disc> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>

Nuqtasimon belgi yordamida tartiblash:

Natija
Matn 1 
Matn 2 
Matn 3

To‘g'ri to'rtburchaksimon belgi yordamida tartiblash:
HTM L kodi 

<UL TYPE =  square> 
<LI> Matn 1 
<LI> Matn 2 
<LI> Matn 3 
</UL>

Matn 1 
Matn 2 
Matn 3

Natija
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Ro‘yxat tuzish -  aniqlashtiruvchi ro‘yxatlar

Aniqlaslitiruvchi ro'yxat va uning izohidan iborat matnni tartibli 
tuzish uchun bir-necha teglar ishlatiladi.

Aniqlashtiruvchi ro'yxatni <D L > ochuvchi va </DL> yopuvchi tegi 
yordamida am alga oshiriladi. Aniqlashtiruvchi ro'yxat nomi <DT> 
tegidan so'ng yoziladi va uni izohlovchi matn esa <DD> tegidan so'ng 
kiritiladi. <DL> tegi qo'shimcha oichamlarga ega emas.

Aniqlaslitiruvchi ro‘yxat:
<DL>
<DT> Aniqlashtiruvchi asosiy so'z yoki jumla 
<DD> Izoh beruvchi matn
</DL>

Jadval tuzish

Jadvai tuzish -  HTML bo’yicha o'zlashtirish qiyin boigan boiim - 
lardan biri. Shu bois bu boMimni jadval tuzishni eng sodda usullaridan 
boshlaymiz. Web-sahifani mukammal darajada varatishni xohlasangiz. 
unda jadval tuzishni chuqur o'rganib olishingiz kerak. Qisqa qilib 
avtganda jadvallar yordamida sahifani o'zingiz xohlagan tarzda 
boshqara olishingiz mumkin. Jadval ichiga nafaqat matn. balki tasvir va 
boshqa elementlarni tartibli joylashtirish mumkin.

Jadval tuzish -  umumiy qoidalar

Jadval tuzishda ishlatiladigan teglarni tasniflashdan avval, oddiy 
jadval tuzish sxemasi bilan tanishib chiqsak. Har qanday jadval 
quyidagi sxema bo'yicha tuziladi:

<JADVALNI OCHUVCHI TEG >
<JADVAL QATORINI OCHUVCHI TEG>
<JADVAL BO-LAGIN1 OCHUVCHI TEG>
Matn, tasv ir yoki jadval
c/JADVAL BO-LAGINI YOPUVCHI TEG>
</JADVAL QATORINI YOPUVCHI TEG>
</JADVALNI YOPUVCHI TEG >
Har qanday jadvalda qatorlar va ustunlar mavjud bo'ladi. Jadvalning 

boiakchalarida esa axborot kiritilishi mumkin. Yuqorida keltirilgan
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misoldan ko'rinib turibdiki. bitta ustun, bitta qator va bitta katakchadan 
iborat jadvalni tuzish uchun jadval ochiladi va vopiladi. Bitta ustundan 
iborat va bir nechta qatorni o‘z ichiga oigan jadvalni tuzish uchun. 
jadval qatorini ochuvchi va yopuvchi teglar orasiga bir nechta jadval 
katakchalarini ochuvchi va yopuvchi teglarini kiritish lozim.

Oddiy jadvallar tuzish

Jadval tuzish usullarini tushunib olish uchun dastavval eng oddiy 
jadvalni tuzishni o'rganamiz. Biz tuzmoqchi bo'lgan jadval uchta 
ustundan iborat boiadi va har bir ustunda 3 dona katakchalar o'rin 
oladi. Jadvalning birinchi ustunini «Mahsulot». ikkinchisini esa -  
«Rangi», uchinchisini «Narhi» deb nomlavmiz. B iz tuzgan jadval mana 
bunday ko‘rinishda bo‘Iadi:

1 . 3 - j a d v a l

Mahsulot Rangi Narhi (so'in)
Qalam Qora 100

Qalam ochgich Qora 500

Endi ushbu jadvalni tuzishda qanday HTML teglardan foyda- 
lanilganligini ko'rib chiqamiz:

<TABLE>
<TR>
<TD>Mahsulot</TD>
<TD>Rang i</TD>
<TD>Narhi(co'm.)<TD>
</TR>
<TR>
<TD>Qalam</TD>
<TD>Qora</TD>
<TD>100</TD>
</TR>
<TR>
<TD>Qalam ochgichi</TD>
<TD>Qora</TD>
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<TD>500</TD>
</TR>
</TABLE>
Jadvalni och u vch iteg
1 -  qatorni ochuvchi teg
1 -  Jadval b o ia g in i ochuvchi va yopuvchi teg
2 -  Jadval bo'lagini ochuvchi va yopuvchi teg
3 -  Jadval bo'lagini ochuvchi va yopuvchi teg
1 -  qatorni yopuvchi teg
Jadvalni yopuvchi t e g
Misolda ko'rinib turibdiki. jadvalni <TABLE> va </TABLE> teg- 

lari yordainida ochiladi va yopiladi. Qatorlar uchun <TR> va </TR> 
teglari qoMlaniladi, < T D >  va </TD> teglari esa jadval ustunlarini 
(katakchalarini) belgilash uchun ishlatiladi.

Jadval chizish — HTML teg o‘lchamlari

Murakkab jadvallar tuzishni boshlashdan avval <TABLE>, <TR> 
va <TD> teglariga qisqacha ta sn if  berib o'tamiz. Mazkur uchta teg 
bilan qollaniladigan b ir  x ildagi oMchamlar mavjud bo‘lib, faqatgina 
ularning farqli tomoni, ularning ta’sir doiralarining chegaralanishidadir.

BGCOLOR

Atribut vordamida jadvalning orqa fonida qanday rang qo'llanilishi 
belgilanadi.

BACKGROUND

Jadvaldagi bo'lakcha foni sifatida berilayotgan tasvirni joylashgan 
joy  va uning nomini belgilash uchun ishlatiladi. Agar siz bu atributni 
<TABLE> tegidan s o ‘ng qo ilasan giz, u holda siz tanlagan tasvir 
jadvaldagi har bir kataklar foni sifatida qo‘llaniladi. <TR> tegidan so'ng 
qo‘ llanilganda, mazkur qatorda joylashgan hamma katakchalar uchun, 
<TD> tegidan so'ng qo'llanilganda esa aniq biror katakchagacha fon 
o‘niatiladi.

WIDTH

Jadval eni (kengligi)ning o ‘lchami (umumiy jadval uchun xos). 
Bu olcham bilan jadvaldagi ma'lum bir ustuncha yoki bo‘lakning
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kenglig in i piksel yohud foiz oMchamida belgilash mumkin. Bu 
oMcham <TA BLE> voki <TR> tegi bilan qoMlanilgan taqdirda ham 
b ir  xil ko'rinishdagi. ya'ni siz  bergan oichamlarni hisobga olgan 
holda jadval enining kengligini belgilavdi. Shuni doim vodda tutish 
lozim ki, s i z  bu oichamdan foydalangan holda jadval enining kengligin i 
belgilaganingizda bir xildagi o6lchov turidan foydalanishingiz maqsadga 
muvofiq. A gar siz jadval kengligini piksellarda belgilasangiz (misol 
uchun W ID T H =«100»). bosliqa oMchovlar ham pikselda belgilanishi 
lozim . A gar jadval kengligi foizlar hisobida berilsa (misol uchun 
W ID TH  =  <<50%»), boshqa oMchovlar ham foiz hisobida berilishi lozim. 
A yni hollarda brauzer siz yaratgan jadvalni ekranning teng yarmi, ya'ni 
50% ga joylashtiradi.

HEIGHT

Jadvalning. qator voki katakchalarning balandligi oichovlarini 
piksellar y o k i foiz hisobida belgilash uchun qo'llaniladi.

BORDER

Jadval ustuni va qatorlari kesishmalarini belgilovchi chiziqlarni 
qalin ligin i piksellar hisobida belgilash uchun qo'llaniladi. Agar jadval 
ch iziq larin i nolga teng qilib belgilansa BORDER (BORDER=0) chiziq 
(border) brauzerda ko'rinmaydigan bo" lib qoladi.

ALIGN

Jadvalning ekranga nisbatan joylashish o ’rnini belgilavdi. Agar 
jadval ichida qo'shimcha jadval tuzilgan bo'lsa. u holda ichki jadvalga 
bu atribut kiritilganda, ichki jadval joylashishi o'rni tashqi jadvalga 
nisbatan belgilanadi. ALIGNJning quyidagi qo'shimcha oMcham lari 
mavjud: A.LIGN -  center (Jadvalni markaz bo’ylab joylashtirish). left 
(chap burchak bo’ylab jovlashtirish) va right (o'ng burchak bo'ylab 
joylashtirish).

CELLPAODING

Katakcha enining kengligini piksellar yordamida kengaytirish yoki 
toraytirish.
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CELLSPACING

Jadvaldagi katakchalar chegara enining piksellar yordamida ken- 
gaytirishi yoki toraytirishi.

Misol:
<TABLE BORDER = 0 W IDTH = 100% CELLSPACING = 5 
CELLPADD1NG = 5 BG CO LO R=blue>
<TR BGCOLOR=yellow>
<TD>Mahsulot</TD>
<TD>Narhi</TD>
</TR>
<TR BGCOLOR=vvhite>
<TD>Qalam</TD>
<TD>100 so'm </TD>
</TR>
</TABLE>

ALIGN

Jadvaldagi har bir katakchaning ichidagi elementlarni gorizontal 
tarzda tartiblash uchun qollaniladi. Uning mavjud oMchamlari quyida- 
gilardan iborat: — left (chap tom onga tekislash), right (o‘ng tomonga 
tekislash) va center (markaz k ry la b  tekislash).

VALIGN

Jadvaldagi har bir katakchaning ichidagi elementlarni vertikal tarzda 
tartiblash uchun qoilan ilad i. U n ing mavjud o‘lchamlari quyidagilardan 
iborat: -  top (katakning vuqori qismiga nisbatan), middle (yuqori va 
quyi qismiga nisbatan markazga tekislash).

Jadval tuzish qoidalari
Bu sahifada jadval tuzish jarayonida siz amal qilishingiz lozim  

boMgan eng asosiv q o ida va maslahatlar keltirilgan.
• <TABLE>, <TR> va <TD> teglarini tartibiga rioya qiling 
Har doim jadval tuzish sxem asini buzmaslikka harakat qiling. Avval 

aytib o’tilgandek en g  avvalo jadvalni oching so'ngra jadval qatorlari va 
ustunlarini tuzing va eng oxirida jadvalni yoping. Ushbu tartib buzilgan 
taqdirda turli hatoliklar kelib chiqishi mumkin.
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• <TABLE> tegini jadval so‘ngida yoping
Agar <TABLE> tegini yopmasangiz kutilinagan hatoliklar vujudga 

keladi. Masalan, Netscape Navigator siz tuzgan jadvalni ekranda 
umuman ko‘rsatmaydi.

• Ustunda joylashgan qatorlar soni
Har bir qatorda kataklaming soni bir xilda bo'lishiga e'tibor bering. 

B u  tartibga, agar siz ayrim kataklarga hech qanday axborot kiritmagan 
taqdiringizda ham ularni yaratish lozim. Bunday holatlarda bo'sh 
katakchalarni mana bunday ko’rinishdayozish lozim: <TD>&nbsp;</TD>. 
'&nbsp;' simvoli brauzerga mazkur katakda hech qanday axborot mavjud 
em asligi haqida xabar beradi. Agar ushbu simvol yozilmagan taqdirda 
brauzer bu katakni aks ettirmaydi va <TD> tegida BGCOLOR atribuí 
ishlatilgan taqdirda fon rangi ifoda etilmaydi va hatolik yuz beradi.

• Har bir jadval tegini yangi qatorda yozing
Jadval tuzishda adashib ketmaslik uchun har bir jadval qatori, ustuni 

v a  katakchalar belgilanganda ularni bir-biridati ajratib yozishga harakat 
qiling. Quyida ana shu holatga misol keltirilgai.

<TABLE>
<TR>
<TD> ... < /T D >
<TD> ... </T D >
<TD> ... < /T D >
</TR>
<TR>
<TD> ... < /T D >
<TD> ... < /T D >
<TD> ... < /T D >
</TR>
</TABLE>
Ushbu qoidalarga rioya qilsangiz jadval tuzishda turli qiyinchi- 

liklarga duch kelmaysiz hamda siz tuzgan jadvallarda hatoliklar 
b o ‘lmaydi.

Murakkab jadvallar tuzish

Oddiy jadval tuzish usullarini o‘rganib oldingiz. <TD> tegining hali 
s iz  bilmagan ba!zi qiziq o’lchamlari mavjud bo'lib ularni qo‘shish orqali
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ajoyib natijalarga erishish mumkin. Aytaylik siz quyida keltirilgan 
jadvalga o'xshash jadval tuzm oqchisiz (1.4-jadval).

1 . 4 - j a d v a l

№> M ah su lo t nomi N arh i (5о‘га)

1 Qalam ► 100
2 Ruchka 150
л
J Daftar 400

Jami : 650 so4!« f.

Ftibor bergan bo'lsangiz jadvalning so'ngidagi qator boshqalaridan 
farqli o'Iaroq bitta katakchadan iborat. Biz avval aytib o‘tganimizdek 
jadvaldagi barcha kataklar soni bir xil emas. Bu misolda oxirgi 
qatordagi uchta kataklar bir-biri bilan birlashtirilgan xolos. Buni <TD> 
tegining COLSPAN yordamida am alga oshirish mumkin.

COLSPAN

Jadvaldagi bir qator voki ustundagi bir nechta kataklarni bir- 
lashtiradi. Bu atribut o'ichamiga siz nechta katakchani birlashirmoqchi 
bo'lsangiz, ularning sonini kiritishingiz lozim. Quyida, yuqoridagi 
jadvalda bu usul qanday amalga oshirilganini ko‘rsatib beruvchi misol 
keltiramiz. Bu misolda jadvalning aynan COLSPAN atributi qo'llanilgan 
qismigina yozilgan:

<TR> ’
<TD COLSPAN = 3 BGCOLOR=red>
<FONT COLOR = white>Jam i: 650 so'm</FONT>
</TD>
</TR>

HTML kodlarga izoh

HTML kodlarni tahrirlashni oson kechishini ta’minlash uchun turli 
izohlarni kiritish maqsadga mirvofiq. Izohlar yordamida siz HTML 
kodlarni qayerda boshlanib, qayerda yakunlanganini muntazam kuzatib 
boras iz va adashib ketmaysiz.
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Murakkab web-sahifalar tuzganda ishlatiladigan HTML kodlar 
so n i cheksiz ko'payib ketishi mumkin. Bunday paytda HTML kodlarni 
qayerdan boshlanib qayerda yakun topganini adashtirib yuborisliingiz 
aniq. Shu sababli teg ochilganda va u vopilganda izoh bilan belgilab 
borish lozim. Quyidagi misolda izohli HTML kodlar tizimi keltirilgan: 

<BODY BAC KG ROU N D =  img/back.gif>
<!—HTML hujjat boshlanishi—>
<TABLE BO RDER=0 CELLPADDING = 0 C'ELLSPACING=0 

W IDTH = 100%>
<!-Tashqi jadval boshlanishi—>
<TR>
<TD W IDTH  = «1%» VALIGN = «top»>
<IMG SRC = «iing/p.gif» WIDTH= «160» HEIGHT = «1» ALT= 

= «  »><BR>
<!—Sahifaning chap ustuui—>
<FONT COLOR = white>$ayt menyusi:</FONT>
<!—CHap ustun yakuni-->
</TD>
<TD W IDTH=«2% »></TD>
<TD W ID T H = «94%» VALIGN=«top»>
<!—Sahifaning markaziy ustuni-->
web sahifaning asosiv matni.
<BR><BR><BR><BR><BR><BR><BR><BR><BR><BR><BR> 
<!—Markaziv ustun yaknni-->
</TD>
<TD W IDTH=«2% »> </TD>
<TD W IDTH=«1% » VALIGN =«top»>
<IMG SRC =«img/p.gif» W IDTH=«100» HEIGHT = «1» ALT= 

= «  »><BR>
<!—Sahifaning o‘ng ustuni—>
<TABLE BO RDER=«0» CELLPADDING= « 1 » CELLSPACING= 

= «0» W ID TH = «100» BGCOLOR=«#336699»>
<!—0 ‘ng ustundagi rekktmali jadval—>
<TR>
<!—Reklama sarlavhasi—>
<TD><FO NT COLOR=«#eOeOff»>Reklama:</FONT></TD> 
</TR>
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<TR>
<TD>
<TABLE BOR DER = «0» CELLPADDING=«0» CELLSPACING= 

=«0» WIDTH=«100% » BGCOLOR=«#fOfOfO»>
<TR>
<TD BGCOLOR = «#cccc33»>
<!--Reklama matni—>
<FONT SIZE =  «2»>Reklam a matni va tasvirni shu yerga joylash- 

tirishingiz mumkin 
</FONT>
</TD>
</TR>
</TABLE>
</TD>
</TR>
</TABLE>
<!—0 ‘ng ustun yakuni--^
</TD>
</TR>
</TABLE>
<!--Tashqi jadval yakuni-->
</BODY>
<!—HTML hujjat yakuni—>
Bu ifodalar sizga jadvalli sahifani oson tahlil qilish imkonini 

beradi hamda turli crzgarishlar kiritgan taqdiringizda, uni qaysi joyda 
boMishini aniq belgilay olasiz.

Ba’zida o'zingiz ham mana shunday sxemalarni tuzishingiz mumkin 
va sahifa tayyor boMgach, kiritilgan izohlarni o‘chirib tashlang. Bunda 
kiritilgan izoh quyidagi tartibda yozilishi lozim: izoh —

Freym lar bilan ishlash imkoniyatlari

Freym -  brauzer oynasidagi mustaqil to‘g‘ri to‘rtburchak shakTidagi 
maydon bo'lib. u o 'z  ichiga boshqa alohida mustaqil HTML hujjatlarni 
birlashtira oladi.

Endi siz har bir oynasida alohida mustaqil HTML hujjatlarni ochish 
imkonini beruvchi freym lam i tuzish usullari bilan tanishib chiqasiz. 
Freymlar brauzerdagi yangi oyna emas, balki bu alohida oyna yoki
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ramka boiib , u brauzerning ochilib turgan oynasi ichida aks ettiriladi. 
Bu bo'limda, bir freymdan ikkinchi freymlami bir-biriga havolalar 
vordamida bog'lash usullarini talilil qilib chiqamiz.

Freymlar tuzish

Siz internetdan fovdalanish jarayonida freymlar ishlatilgan web 
sahifani ko’rgansiz. Aytaylik bu sahifada uchta freymdan foydalanilgan.

Ko4rib turganingizdek bu sahifa uchta freymdan iborat ustunlarga 
boblingan. CHap ustunda joylashgan freymda navigatsion menvu. 
vuqoridan o'ngdagisida reklama va crngdan pastdagi freymda esa web 
sahifa asosiy matni o'rin oladi. Chap ustunda joylashgan havolalarga 
bosish bilan, havolalari hujjatning o'ngdan pastida joylashgan freymda 
ochiladi.

Ushbu freymlar qoilanilgan sahifaning umumiv tuzilishini ko*rib 
chiqsak:

<FRAMESET> -  freymlar tuzilishini belgilovchi ochuvchi teg 
(freymset)

<FRAME> -  birinchi freym
<FRAM E> -  ikkinchi freym
</FRAM ESET> -  freymsetni yopuvchi teg
Sxemada k o ’rinib turganidek, har gal <FRAMESET> tegi yor- 

damida freymlar tuzilishini belgilash lozim. Shundan so'ng bevosita 
freymlar <FRAME> tegiga navbat keladi. Oxirgi navbatda </ 
FR-AMESET> freymset yopuvchi teg yoziladi.

Hozircha bu oddiy sxemani eslab qoling. Murakkab freymlar 
qo4llanilgan sahifalar haqida ushbu bolim da keyinroq ma’lumot 
beramiz.

Freymlar -  oddiy misol

Xullas, freymlar bilan ko'rsatilgan oddiy misolni ko‘rib chiqamiz. 
Ishni boshlashdan oldin, oddiy HTML formatida ikkita hujjat yarating. 
Birinchi hujjatga «Freym-1» ikkinchisiga esa «Freym-2» deb yozing va 
ularni frem l.H TM L va frem2.HTML deb nomlang. Bu ikkita fayllar 
bizning misolim izda ikki freymlar uchun asosiy manba bo'lib xizmat 
qiladi. Endi esa  HTML formatida keyingi hujjatni yarating.
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<HTML>
<HEAD>
<TITLE>freymlar</TITLE>
</HEAD>
<FRAMESET COLS = «200»  *>
<FRAME N A M E = left SRC = «framel .HTML»>
<FRAME N A M E  = right SRC = «frame2.HTML»>
</FRAMESET>
<NOFRAMES>
Sizning brauzeringiz freymlarni tushunmavdi.
</NOFRAMES>
</HTML>
Demak siz ham o'zingizning birinchi sahifangizni freymlar 

yordamida yaratdingiz. Endi shu yaratgan sahifangizni frameset.html 
deb nomlab oldin yaratilgan framel.html va frame2.html fayllar turgan 
papkada saqlang v a  frameset.html faylini crz brauzeringizda oching.

Birinchi navbatda. e'tibor bergan boisangiz HTML formatidagi 
freytnlardan iborat sahifada <BODY> tegi mavjud emas. Bu esa juda 
muhimdir. Agar siz <BODY> tegini ishlatsangiz u holda, hamma 
<FRAMESET> va <FRAM E> teglari brauzeringiz tomonidan 
o’chiriladi. Undan tashqari <NO FRAM ES> tegi shunday holatga 
moMjallangan-ki, bu holatda sizn ing  brauzeringiz freymlarni qollab- 
quvvatlamavdi.

Freymlar -  oddiy freym

Bizning m isolim izda <FRAM ESET> va <FRAME> teglarini oddiy 
o'lchamlarda ishlatgan edik. Endigi navbatda biz freymlar yordamida 
o'z sahifamizda nimalarni o'zgartira olishimizni ko¿rib chiqavlik. 
frameset.html sahifasini brauzerda yoki HTML teglarni tahrirlovchi 
dasturda oching. Foydalanuvchi sizning freymlaringizni oichamlarini 
cfzgarfira olmaydigan qilishingiz mumkin. Siz hozir freym 
chegaralariga sichqoncha ko'rsatkichini belgilab uning o'lchamlarini 
xohlagan tarzda o'zgartirishingiz mumkin.

NORESIZE
<FRAME> tegin ing parametr ushbu freymni o;zgartirib bo"l- 

masligini anglatadi.
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Misol:
<FRAM E N A M E = left SRC =  «frainel.html» NORESIZE>
<FRAM E NA M E= right SRC = «frame2.html» NORESIZE>
Keyingi holatlarda, agar siz freymlar orasidagi chegaralarni 

belgilash uchun siz <FRAMESET> tegining quvidagi atributini ish- 
latishingiz zarur.

BORDER
<FRAM ESET> tegi freymlar chegaralari orasidagi masofani 

piksellarda ifodalaydi. Frevm orasidagi chegarani umuman boim asligi 
uchun shu o'lcharani nolga tenglashtiramiz.

Misol:
<FRAM ESET COLS = «200».* BORDER=«0»>
<FR A M E > tegining yana bir muhim atributi
SCROLLING
<FR A M E > tegi mavjud freymda sahifalash chizig'ini mavjudligi 

yoki mavjud emasligini belgilaydi. Bu parametrning yes, no va auto 
belgilari bu freymda sahifalash chizigMni borligini, yo'qligini va agar 
kerak bo‘lsa ishlatilishini ko‘rsatadi.

Misol:
<FRAME N A M E = «left» SRC=«framel.html»NORESIZE SCROL- 

L IN G =«auto»>
<FRAM ENAM E=«right» SRC=«frame2.html»]MORESIZE SCROL

LING = «y'es»>
<FR AM ESET> tegining quvidagi atributlarini siz bilishingiz za

rur:
COLS
<FRAM ESET> tegining bu parametri gorizontal freymlarning 

chapdan o'ngga tuzilishini ko‘rsatadi. Freymlarning kengligi piksellarda 
yoki foizlarda beriladi va bir-biridan tinish belgisi bilan ajratiladi.

simvol shuni ko‘rsatadiki, qolgan umumiy maydon shu frevmga 
ajratilishini anglatadi.

Misol:
<FRAM ESET COLS = «200», *, 100>
Bu m isolda uchta freym mavjud bo‘lib. birinchisi-200 piksel. 

oxirgisi —100 piksel, ikkinchisi (o‘rtadagi freym) -  qolgan maydonning 
hammasi shu frevm uchun ajratilgan.

54



<FRAMESET COLS = 20% , 100, 50, *>
Bu misolda esa to'rtta freym  bo‘lib, birinchisi maydonning 20%ni, 

ikkinchisi -  100 pikselli. uchinchisi -  50 pikselli, to‘rtinchisi esa qolgan 
maydonni tashkil etadi.

' r o w s

<FRAMESET> tegin ing bu parametri freymlarning vertikal 
tepadan pastga bo'lgan tuzi 1 ishini ko‘rsatadi. O'lchami raqamlar bilan 
beriladi. Bu freymlarning balandligi piksellarda yoki foizlarda beriladi 
va bit- biridan tinish belgisi bilan ajratiladi. simvol shuni ko'rsatadiki 
u umumiy qolgan maydonni shu freymga ajratilishini anglatadi.

Misol:
<FRAMESET ROWS = 50% , 50%>
Balandligi ekranning 50% tashkil qiluvchi ikkita freym. Anglash 

qivin emaskL bu ifodani ROAD'S parametrida, simvol orqali quyidagicha 
vozish mum kin 50%, *.

Freymlar -  murakkab freymlar tuzish

Ushbu b olim nin g boshida siz tanishib chiqqan, freymlarga 
bo’lingan sahifaga yana bir bor murojaat qilsak (1.3-rasm). Berilgan 
sahifada uchta freym  b o lib , bu freymlar tarkibida gorizontal hamda 
vertikal holatdagi freymlar mavjud. Bu sahifani yaratish uchun biz 
nima qilishimiz kerak? Dem ak hammasini bir boshdan boshlaymiz.

Murakkab tarkibli freymlarni yaratishimiz uchun. biz jadvallarni 
qanday yo‘1 bilan yaratgan bo'lsak shu yo4l bilan yaratishimiz 
qulavroqdir. Oq qogo'zga freym lar tuzilishi 
andczasini chizib oling va shu freymlarni 
raqamlab chiqiag. B izning misolimizda 
freymlar tuzilishi quyidagicha bo*ladi:

Freymlarni quyidagicha raqamlaymiz: 
chapdan o ‘ngga. tepadan pastga qarab. Endigi 
navbatni yangi sahifani yaratishga bersak.
Bizning misolimizda yolg’iz: <FRAMESET> 
tegi orqali freymlar strukturasini bel-
gilay olmaysiz. nega deganda birgina 1.3-rcism. Freymlarga 
<FRAMESET> tegida freymlarni birgalikda b o iin gan  sahifa.



gorizontal (COLS) va vertical (ROWS) joylashtirishning iloji vo'q. Gap 
shundaki bir nechta <FRAMESET> teglarni quyidagicha ishlatiladi 

<HTM L>
<H EA D >
-<TITLE>freymlar</TITLE>
</H E A D >
-<FRAMESET COLS = 150,* BORDER = 0>
-<FRAME SRC = left.html SCROLLlNG=yes NORESIZE> 
<FR AM ESET ROWS = 70,* BORDER=0>
<FR AM E SRC=top.html SCROLLING = auto NAME = top 

NORESIZE>
<FR AM E SRC = content.html SCROLLING=ves NAME = content 

NORESIZE>
</FR A M ESET>
</FR A M ESET>
<NO FR AM ES>
Sizning brauzeringiz bu freymlarni qoilab quvvatlainavdi.
< /N  OF R AM E S>
</H T M L >
Birinchi <FRAMESET> tegi ekranni ikkita freymga. ya'ni o n g  va 

chap freymlarga ajratadi. Ikkinchi <FRAMESET> tegi esa o'ng qism 
(o'ng freym)ni yana ikkita tepa va past freymga ajratadi. Ketma-ketlik. 
tartibi HTML formatida oldin ko'rsatib o'tiiganidek boiishi shart. 
Birinchi navbatda birinchi <FRAMESET> tegi. Birinchi freym (o'ng 
freym). Undan keyin ikkinchi freym kelishi kerak edi. Ammo biz 
ikkinchi <FRAMESET> tegi vordamida uni yana ikkiga bo‘ldik. ya’ni 
biz ikkinchi freym (chap freym)ga yana ikkita freymni vertikal holda 
(ROWS = 70,*) joylashtirgan bo'lainiz. Keyin ikkita freym keladi va 
ikkala <FRAMESET> teglari yopiladi. Mana endi natija quyidagicha 
b olad i, ya’ni chap freymda left.html o‘ng tomomdagi fre\ mning y uqori 
qismida top.html va undan yuqori qismida content.html freymlar 
vuklanadi.

Freymlar -  havolalar tuzish
Belgilangan maxsus freymda HTML hujjatni ochilishi uchun 

havolani qanday tuzish lozira? Bu juda ham oson. Buning uchun. freym 
ishlat iladigan sahifa yaratilganda, freym nomini berib o‘tish lozim.
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NAME
<FRAME> tegin ing bu atributi mazkur freym nomini belgilaydi. 

Freym nomlari ushbu freym ga boshqa freymdan havola tuzish uchun 
qo‘llaniladi.

Bizning m isolim  izda quyidagi kodlar qo'llanilgan:
<FRAMESET C O L S =  150,* BO RDER=0>
<FRAME SRC =  left.html NAM E = left SCROLLING= yes NORE- 

SIZE>
<FRAM ESETROW S = 70.* BO RDER=0>
<FRAME SRC =  top.html 7S'AME=top SCROLLING = auto NORE- 

SIZE>
<FRAME SRC =  content.html NAM E = content SCROLLING= уes>
</FRAMESET>
</FRAMESET>
Natijada quyidagi nomlardagi freymlar vujudga keladi: left, top 

va content. Endi chap  freymdagi havoladan asosiv freymda hujjatni 
ochilishi uchun <A > tegining TARGET parametrini content teng qilib 
belgilash lozim, ya'ni:

<A HREF= l.htm l TARGET=content>l-Punkt </A>
Shakllar hosil q ilish  (Форма)
Siz internetda k o ‘p marta shakllarga duch kelgan bo’lsangiz kerak. 

Bu qog‘ozdagi anketaning elektron varianti, o‘zida matn kiritish 
maydonlarini, savollarga javob variantlari va boshqa shakl elementlarini 
mujassam qiladi. Shakllar sayt egasi va foydalanuvchilar orasida aloqa 
o'rnatish uchun kerak.

Shakllar yordamida saytingiz orqali, misol uchun, ovoz berish, 
foydalanuvchilarning ayrim savollar bo‘yicha fikrini bilish va shunga 
o’xshash masalalarni hal qilishingiz mumkin.

Shakllarning umumiy sxemasi
Quyida liar qanday shaklni yaratish umumiy sxemasi berilgan.
<FORM>
shakl maydonidaei teglar
</F0RM >
Ko‘rib turganingizdek. ochuvchi <FORM> va yopuvchi</FORM> 

teglari orasiga shakl maydonlari teglarini qo‘yish yetarlidir. Keyingi 
sahifada turli shakl maydonlari bilan tanishamiz.
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Turli shakl mavdonlari

Shakl maydonlari qanday boiadi va ular nima ish bajaradi?
Matn qatori (TYPE = TEXT)
Bu qator ko'p boimagan simvollardan iborat erkin kcrrinishdagi 

m a ’lumotni (matnni) kiritish uchun foydalaniladi.
Misol:
<INPUT TYPE = TEXT NAME = Tekst SIZE = 20 VALUE = «Siz- 

ning matn»>
Shundav qilib matn qatori <INPUT> tegi va TYPE = TEXT para- 

metrlari yordamida yaratiladi. Shu tegning boshqa parametrlari nimani 
bildiradi?

NAME
Serverga jo'natiladigan o'zgaruvchining nomi. Foydalanuvchi ki- 

ritgan matn natijada shu nomli o‘zgaruvchiga beriladi. HTMLda 
shakllar yaratish serverda dasturlash bilan uzluksiz bogMiq. Serverda 
foydalanuvchilaringizdan ma'lumotlarni shu dastur orqali qabul qi- 
lishingiz m um kin.

SIZE

Matn qatorining simvol kcrrinishdagi kengligi. Bizning misolda 
bu parametrning ifodasi 20 ga teng. Buning ma’nosi kiritilayotgan 
matnning kengligi 20 simvoldan iborat. Foydalanuvchi undan ko’p 
simvollardan iborat bo;lgan matnni kiritishi mumkin. lekin 20 tadan 
ortiq sim vol ko'rinmaydi. Klaviaturadagi y o snaltiruvchi tugmachalar 
yordamida m atnni boshi yoki oxiriga o'tish mumkin.

VALUE

Bu parametr ifodasi oldindan matn mavdoniga kiritilgan boiadi. 
U ni o'zgartirish yoki o;chirish mumkin.

Javob varianti (TYPE = RADIO)
Foydalanuvchi bir qancha javob variantlari orasidan faqat bitta 

variantni tanlashi mumkin.
Misol:
Jinsi:
<INPUT TYPE = RADIO NAME = Jins VALUE = «Erkak»>Er.
<INPUT TYPE = RADIO NAME = Jins VALUE = «Ayol»>Ay.
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Natija:
Jinsi: Er. Ay.
Ko'rib turganingizdek javob variantlari <INPUT> tegi TYPE = 

= RADIO atributi orqali yaratiladi. Diqqat qiling, javob variantlaridagi 
NAME atiibutining ifodalari bir xil bo‘lishi kerak, aks holda brauzer 
bularni harxil savol deb qabul qiladi.

V A L U E

Bu ifoda o'zgaruvchining ifodasi ko'rinishida jo'natiladi (bizning 
misolda, agar Er. tanlansa Jins o;zgaruvchining ifodasi 'Erkak' ga teng 
boMadi).

Tasdiqlash (T Y P E  = CHECKBOX)
Ay rim ifodalarni yoki javob variantlarini belgilash uchun ishlatiladi. 
Misol:
Jinsi:
<INPUT TYPE =C H E C K B O X  NAM E=AddM e VALUE = «Obuna 

boiish»>
Ha, men sizn ing  saytingizdan yangiliklar olishni istayman 
Natija:
Ha, men sizn ing  saytingizdan yangiliklar olishni istayman 
Tasdiq lash <IN P U T > teg i TYPE = CHECKBOX atributi yordamida 

yaratiladi. B izning m isolda, agar foydalanuvchi kvadratga belgi 
qo'ysa (tasdiqlasa) A ddM e o ’zgaruvchining ifodasi «Obuna bo’lish»ga 
teng boladi. Aks holda AddM e o‘zgaruvchisiga hech qanday ifoda 
berilmaydi.

Harakatlanuvchi menyu (SELECT)
Bir qancha javob  variantlaridan birini tanlash uchun harakatlanuvchi 

menyu ko'rinishida ifodalanadi.
Misol:
Yoshi:
<SELECT N A M E  = A ge>
<OPTION V A L U E  = 10>10 dan kam 
O PT IO N  V A L U E  =11-20>11-20 
<OPTION>21 d a n  ko‘p 
</SELECT>
Natija:
Yoshi:
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Harakatlanuvchi menyu <SELECT> tegi. menvuning javob va- 
riantlari esa <OPTION> tegi yordamida yaratiladi.

N A M E
<SE L E C T > tegining atributi, o'zgaruvcliining nomini ifodalaydi. 

Bu o'zgaruvchiga tanlangan javob variantining ifodasi beriladi. Bizning 
holatda o^garuvchining nomi Age.

"VALUE
<O PT IO N > tegining atributi, shu variant tanlanganda parametr 

ifodasi o4zgaruvchiga beriladi. Agar bu atribuí belgilangan boM- 
m asa  (uchinchi <OPTION> tegiga o'xshab), o'zgaruvchining ifodasi 
<OPTION> tegidan keyin kelgan matn bo'ladi. Agar bizning miso- 
lim izda uchinchi variantni tanlasak Age o'zgaruvchining ifodasi 21 dan 
ko*p, agar bir inchi variantni tanlasak ifoda ;10‘ boMadi.

<OPTION>tegidan so'ng berilgan matn ekranda harakatlanuvchi 
m enyu varianti sifatida ko‘rinadi. Key in <OPTION> tegini yopish shart 
em as.

Matn maydoni (TEXTAR.EA)

M atn m aydoni foydalanuvchi tomonidan ko‘p sonli simvollardan 
iborat m atnni kiritish uchun foydalaniladi.

M isol:
Sizning mulohazalaringiz:
<TEXTA REA NAME ^Comments COLS=20 ROWS = 5>
O 'z mulohazalaringizni kiriting
</TEXT A  RE A>
Natija:
Sizning mulohazalaringiz:
Matn m aydoni <rEXTAREA> tegi orqali yaratiladi. Ochuvchi va 

yopuvchi teg lar orasidagi hamma matnlar shu matn maydoni ichiga 
yoziladi.

COLS

Matn m aydonining simvol ko'rinishidagi kengligi.

ROWS

Matn m aydonining qator ko'rinishidagi balandligi.
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Shaklni tozalash va jo'natish tugmachasi

Foydalanuvchi to'ldirilgan shaklni jo’natish uchun tasdiqlovchi 
tugmacha yaratish kerak. hamda shakl maydonini tozalash tugmasini 
yaratishi mumkin. Shu boTim boshida jo'natish va tozalash tugmasini 
qanday ko'rinishga ega ekanligini ko4rdingiz.

Jo'natish tugmachasi (TYPE =  SUBMIT)
Foydalanuvchining shaklda belgilangan ma'lumotlarini tasdiqlab, 

shu ma lumotlarni serverga jo'natish uchun qoMlaniladi.
Misol:
<INPUT TYPE =  SUBMIT VALU E = «Shaklni jo‘natish»>
Natija:
'Shaklni jo'natish’ nomli tugmacha
Jo'natish tugmachasi <IN PU T> tegi yordamida TYPE = SUBMIT 

atributini ishlatgan holda yaratiladi. Natijada VALUE parametrida 
belgilangan vozuv bilan tugmacha yaratiladi. Tugmacha bosilganda 
shakldagi ma'lumotlar serverga jo'natiladi.

Tozalash tugmachasi (TYPE =  RESET)
Shakl maydonidagi maMumotlarni tozalash uchun qollaniladi.
Misol:
<1NPUT TYPE =  RESET VALUE = «Shaklni tozalash)»
Natija:
'Shaklni tozalash' nomli tugmacha
Shakl maydonini tozalash tugmachasi <INPUT> tegi yordamida 

TYPE = RESET atributini ishlatgan holda belgilanadi. Natijada VALUE 
atributida belgilangan yozuv bilan tugmacha yaratiladi. Tugmacha 
bosilganda shakldagi ma'lumotlar to la  o'chiriladi.

Ko‘rinmas shakl maydoni

Yana bir turdagi shakl maydoni bor -  bu ko'rinmas shakl maydoni. 
Btr nraydoir ma'lumotlar aimashinuvi uchun ishlatiladi. KoMnmas 
maydonni foydalanuvchi ko*ra va  o'zgartira olmaydi.

Ko6rinmas may don (INPUT TYPE = HIDDEN)
Shakl maydoni ekranda ko'rinmaydi, uning ifodasi sahifa yara- 

tilishida beriladi va foydalanuvchi shaklni to'ldirish jarayonida 
o'zgartirib bo'lmaydi.
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Misol:
<INPUT TYPE = HIDDEN NAME = Page VALUE = «1 sahifa»> 
Ko'rinmas shakl maydoni <INPUT> tegi yordani ida va TYPE = 

=  HIDDEN atributini ishlatgan holda yaratiladi. Berilgan misolda 
shaklni jo ‘natish vaqtida Page o‘zgaruvchisiga ‘1 sahifa' ifodasi 
beriladi. B uning natijasida, agar toMdiriladigan sahifalaringiz ko‘p 
b o :lsa, qaysi sahifadagi shakldan ma’lumot jo'natilganini aniqlashingiz 
m um kin.

FORM tegining atributlari va shaklni jo‘natish

Shu bo‘lim  boshida eslatib o‘tganimizdek, shakl yaratish dastur- 
lash bilan uzluksiz bog'liq. Boshqacha qilib aytganda shakldagi 
m a ’Iumotlarni qayta ishlash dasturlashsiz iloji vo'q. M a’Iumotlarni 
qayta ishlash natijasi siz ko'rsatgan email manzili bo'yicha jo'na- 
tilad i.

Keling, sizning saytingizdagi shakl ma’lumotlari dastur orqali qayrta 
ishlanishi uchun nima qilishni ko‘rib chiqay lik. Natija siz ko'rsatgan 
em ail manzili bo‘yicha shu formatda jo'natiladi.

0 ‘zgaruvchi: Kiritilgan ma’lumot
Buning uchun saytingizda xohlagan shaklni shu ko'rinishda yara- 

tish ingiz zarur:
<FORM METHOD = POST ACTION = http://.....com/mail.php3> 
<INPUT T Y P E = HIDDEN NAME = recipient VALUE = EMAIL> 
<INPUT T Y P E = HIDDEN NA M E= subject VALUE=MAVZU> 
<INPUT T Y P E = HIDDEN N A M E= ty pe VALUE = TUR>
<INPUT TYPE = HIDDEN N A M E= return VALUE = MANZIL> 
<INPUT TYPE=H IDDEN N AM E= alpha VALUE=a>
Sizning shaklingiz 
</FORM >
Endi shu HTML kodni o‘z  sahifangizga ko‘chiring va keyingi 

s o ‘zlarni o‘zgartiring:
EMAIL -  natija jo'natiladigan email manzil;
M AVZU — Xat mavzusi (Subject);
TUR -  Sizning pochtangiz turi, HTML deb vozing, agar aniq 

bilm asangiz TEX T deb yozing;
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MANZIL -  foydalanuvchi shaklni toldirgandan keyin ko‘rishi kerak 
bo'lgan sahifa manzili;

Keyin. 'Sizning shaklingiz* so’zini cTrniga o4z shaklingizni qo'ying. 
Dastur qanday ishlashini ko’rish uchun o‘zingizni email manzilingizni 
kiriting va Tekshiruv5 tugmasini bosing.

HTMLda simvollar jadvali

Avrim simvollarni to'g'ridan-to'g'ri yozib bo'lmaydi. Chunki ularni 
brauzer aks ettirib bera olinaydi. Undan tashqari ko'plab simvollar 
klaviaturada mavjud emas. Bu ikki turdagi simvollarni brauzerda 
aks ettirish uchun son va shriftlar kombinatsiyasidan foydalaniladi. 
ASCII simvollar deb ataluvchi simvollarning son va shriftlardan iborat 
kombinatsiyasi mavjud.

Saval va topshiriqlar:

1. W eb -d izay n  n im a ?
2. Diza} nning qanday turlari bor?
3. Web-diza\ nda qanday dasturing vositalar ishlatiladi?
4. NTML nima? lining asosiv strukturasi nimalardan iborat?
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Il-bob. DREAMWEAVER DASTURINING IMKONIYATLARI

Dreamweaverning MX versiyasi bu nafaqat interfevsning tashqi 
kcfrinishi yangilangani. balki radikal texnologik yangilangan, gi- 
permatnli belgilash tili imkoniyatlari kengaygan. Unda Web-sahifa 
maketlarini yaratish uchun yangi ashyolar paydo bo‘ldi. Jumladan, 
tiziinga Flash obyektlarni qo'yish buyruqlari qo'shilgan va WEB uzellar 
bilan boshqarish va  turli jamoaviv ishlarni loyihalashda rivojlanishga 
imkon beradi. Endi Dreamweaver MX bilan batafsil tanishib chiqamiz.

B elgili kodlar bilan ishlash vositalari sezilarli darajada rivojlandi. 
MX—versiyasi bu ixtiyoriy murakkablikdagi dastlabki matn bilan ishlash 
uchun kuchli bazaga ega bcrlgan gipermatnli dasturlashning to'laqonli 
qobig'idir. Asosiy imkoniyatlarini sanab chiqamiz:

1) Hujjatning oynasi endi har xil rejimlarda ishlashi mumkin. 
Design V iew  (Режим планировки) rejimida, foydalanuvchi HTML 
sahifa maketini taxminan shunday ko'rinishda ko'rish mumkin. 
Code V iew  (Режим разметки) rejimida esa hujjatning oynasida 
belgili matn sahifasining barcha deskriptorlari. senariylari va 
kommentariyalari tasvirlanadi. Dasturning bu rejimlari orasida kichik 
koordinatsiya mavjud. Kodlarni o'zgartirish maket modifikatsiyasiga. 
vizual rejimda rejalashtirish yoki formatlashga o'zgartirish kiritish 
imkonini beradi;

2) Dreamweaver tizimi qobig'iga barcha zaruriy qurilmalarga ega 
bo'lgan toiaqonli kodlar tahrirlagichidan iborat dastur integratsiya 
qilingan. Unda HTML hujjatlarining dastlabki matnlari bilan ishlashni 
yengillashtiruvchi vositalar: kiritilgan teglarning sarlavhalari. turli 
kodlarni rangli belgilash, tez qidirib topish vositalari aks etgan. 
Sintaktik noto4g ;ri loyihalarni aniqlash. uzun qatorlarni avtomatik 
ko'chirish, avtokorreksiya rejimi yo'lga qo'yilgan. Dastur vositalari 
yordamida nafaqat gipermatnli sahifalarni. balki matnli ko'rinishga ega
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har qanday hujjatlarni, dasturlar, senariylar, oddiy matnlar, XML belgili 
hujjatlar va boshqalarni tahlil qilish mumkin.

3) Gipermatnlarni belgilash kodlari bilan ishlashni ma'lumot 
paneli ancha soddalashtiradi. Bu dastur ichiga qurilgan interfaol ma'lu- 
motnoma gipermatnli belgilash tilining barcha standart loyihalarini va 
u bilan bog'langan vositalarni: diskreptorlar, atributlar, ierarxik stildagi 
o'ziga xosliklarning deklaratsiyalari (Cascading Style Sheet), Java Script 
tilining sintaktik loyihalarini qisqa va lcfnda shaklda tavsiflaydi.

Tajribadan ma'lumki xatto eng tajribali, HTML tilini chuqur 
biladigan Web-ustasi ham bu til standartiga kiruvchi yuzlab kodlar va 
atributlarni eslab qolishga qodir emas. Ma’lumotlar paneli deskriptorni 
aniq va ravshan tavsiflab beradi, uning atributlari hamda kcfrib chiqish 
dasturining turli versiyalari b ilan  mos tushishi haqida ma’lumot beradi.

4) Java Script senariylar
Java Script dasturlash tilida  yozilgan senariylardagi yashirin xa- 

tolarni aniqlash imkoni beriladi. Bu vosita nafaqat hozirgi vaqtda 
WEB-dasturlash sohasida qo^llaniladigan ko'p sonli analizatorlar uchun 
qiyin bo'lmagan, sintaksis xatolarni aniqlashga qodir. Kodlarni tuzatish 
vaqtida dastur ichiga qurilgan nazorat nuqtalari va qadamba-qadam 
bajariladigan dastur kofcrsatmalari hamda o'zgaruvchilarning holatini 
nazorat mexanizmlariga ham ega.

Doimo sezilarli potentsialga ega bo‘lgan vizual loyihalash tah- 
rirlagichining uskunalari van a bir vosita bilan boy itildi. Bu gipermatnli 
sahifalarni rejalashtirish vayaratish  uchun mo'ljallangan maxsus dastur 
ishchi rejimidir. U  sahifani aks ettirishning maxsus rejimi (Layout Viev) 
va ikkita uskuna ko'rinishida amalga oshirilgan boiib. ular vordamida 
maket elementlarini chizish mumkin.

Tahrirlagichning oldingi versiyalari vektorli animatsiyalashgan 
tasvirlar sohasida birinchilar qatorida boigan Flash dasturi bilan juda 
yaxshi o'zaro aloqada bo'lishi bilan ajralib turgan. Dasturning joriy 
versivasiga animatsiyalashgan obyektlarni generatsiya qilishning 
ikkita asosiy buyrug'i integratsiya qilingan. Endi bevosita dastur 
oynasida interfaol tugma yoki «jonli matn» yaratish mumkin. Bunga 
o'xshash obyektlarni kiritishning texnik tomoni o'ta soddalashtirilgan 
va loyihalashtirishdan ko^ra ko'proq anketalashtirishga o'xshab 
ketadi. Fovdalanuvchidan Flash -  texnologiya sohasida chuqur
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biliinlar talab qilinmaydi. U faqat muloqot oynasi sohasini to'ldirishi 
kerak. Zamonaviy dasturlarning ko'pchiligi animatsiyalashgan Flash
-  grafikani aniq aks ettiradi. Bu tipdagi obyektlar a‘lo darajada 
masshtablanishi bilan ajralib turadi va tarmoq bo‘ylab uzatishda ham, 
diskda saqlashda ham juda kam resurs talab qiladi. Dasturga kiritilgan 
yangiliklarni qisqacha sanab o'tamiz:

— ierarxik stildagi o‘ziga xosliklar (CSS) bilan ishlash vositalari 
seziiarli darajada takomillashtirilgan.

— Macromedia firmasi tomonidan ishlab chiqilgan Fire woks 
graft к muharriri bilan Dreamweaver dasturining integratsiyasi yanada 
rivoj lantirildi.

— yangi A ssets (resurslar) palitrasi yaratildi. U dasturda bitta WEB
-  tu  gunning bir necha sahifasi tomonidan birgalikda ishlatiladigan 
turli xildagi ma’lumotlarning omborxonasi vazifasini bajaradi. Bular 
tasvirlar, animatsiva roliklari, rang lar, senariylar, kutubxonalar va 
boshqalar bcflishi mumkin. Saqlanayotgan resurslarni turli sahifalarning 
talab qilinadigan sohalarida joyini o'zgartirisli (yoki surish) vo'li bilan 
jovlashtirish mumkin.

Site Report (Отчет о сайте) buyrug'i loyiha holati haqidagi batafsil 
hisobotni hosil qiladi. Hisobot o'ziga kop sonli giperbogManishli 
hujjatlarni biriktiradi:

— tahrirlagichga versiyalarni va dasturiy ta'minotni vangilashni 
boshqarishni nazorat qilishning vetakchi dasturiy vositasi bowlgan 
M icrosoft Source Safe paketli integratsiva vositalari qo’shilgan. Bu 
narsa Dreamweaver tizimini Internet uchun murakkab loyihalarni 
ishlab chiquvchi jamoalar uchun asosiv uskuna sifatida qo’llanilishiga 
asos boladi.

— dasturning bu versiyasi WEBDav bavonnomasini toiaqonli 
qo4llab-quvvatlaydi. Bu versiyalarni boshqarish va taqsimlangan ishni 
tashkil qilish boVicha kengaytirilgan imkoniyatlarga ega bo'lgan klassik 
bayonnomasidir.

— interfeysni standartlashtirish va savqal berish bo'yicha kat- 
ta ish  qilindi. Macromedia firmasi ko'pgina dasturlarning tashqi 
ko'rinishi noturg'un palitralarning yagona konsepsiyasiga asoslanadi. 
Muharrirning oxirgi versiyasida palitralarning ko'rinishi standart- 
lashtirilgan. Ularning devarli hammasi tarkibiy majmuaviv palitralarga
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birlashish imkoniyatiga ega bold  i lar. Oldingi versiyalarning ro4yxatga 
olishdagi ba’zi kamchiliklar bartaraf etildi.

-  klaviatura kombinatsiyalari bir shaklga keltirildi. Ular web- 
dizayn uchun Macromedia firmasi tomonidan ishlab chiqilgan. bar- 
cha dasturlash vositalari uchun umumiy bo'lgan ichki standartga 
moslashtirilgan. Ichiga qurilgan boshqaruv tizimi yordamida tugma- 
larning harqanday tuzilishini o‘zgartirish mumkin.

Savol va topshiriqlan

1. D ream w eav er M X  d a s tu r i n im a  m a q sa d d a  q o ‘llan ilad i?
2. D astu rn ing  q a n d a y  y a n g i im k o n iy a t la r i  m av ju d ?
3. D astu r a v v a lg i w e b -m u h a r r ir la r id a n  n im as i b ilan  farq  q ilad i?

2.1. Dasturni o‘rnatish va ishga tushirish

Tajribali foydalanuvchi dasturni o'rnatish jarayonida o'zi uchun 
hech qanday yangilik ko'rmaydi. Distributiv diskda Dreamweaver MX 
Installer.exe (инсталятор) faylini qidirib topish va ishga tushirish lozim 
(avto yuklanish bo4magan holatda). Windowsning ko‘pchilik ilovalari 
kabi bu dastur ham bir necha bosqichda o'rnatiladi. Ularning har biri 
alohida muloqot oynasidan iborat.

Dasturni o'rnatishning asosiy bosqichlarini ketma-ket sanab o'tamiz
[3], [4]:

-  Extracting Files. Bu bosqichda DREAMWEAVER tizimdagi 
qurilmalar va dasturning instalyatori ishlashi uchun zarur bo'lgan 
fayllar arxivdan ochiladi. Bosqich foydalanuvchining aralashuvini talab 
qilmavdi.

-  Welcome (X ush kelibsiz). O'rnatishning birinchi bosqichi bo'lib. 
unda foydalanuvchi tanlangan dastur va uni installyatsiya qilish 
qoidalari haqida asosiy ma’lumotlarni oladi.

-  License Agreement (Litsenziya shartnomasi). Ifckmchi bosqichda 
litsenziya shartnomasi va muallifning dasturiy mahsulotiga huquqlari 
bilan tanishish taklif etiladi. Foydalanuvchi taklif qilinayotgan 
majburiyatlarni qabul qilishi yoki rad etishi kerak.

-  Macromedia Dreamweaver Serialization (dasturni ro’yxatdan 
o'tkazish). Uchinchi bosqichda muloqot oynasi hosil bo'ladi, uning

67



yordamida foydalanuvchining гекл/izitlari va dasturning serial nomerini 
kiritish zarur bo'ladi.

-  Choose Destination Location (joylashuv). Bu bosqichda dasturni 
o4rnatish uchun disk va papkani olish zarur bcrladi. Taklif qilinganidan 
farq qiluvchi manzilni ko'rsatish Windows tizimi uchun standart boigan  
faol disk va katalogni tanlash yo;li bilan berish mumkin. Buning uchun 
Browse tugm asini bosish kerak.

-  Default Editor o'rnatishning bu bosqichida Dreamweaver dasturi 
keyin ishlatiladigan asosiy tahrirlash fayllarini tanlashni taklif qiladi.

-  Select Program Folder (Dastur papkasini tanlash). Bunda foy- 
dalanuvchi dasturni ishga tushiruvchi yorliq joylashgan papkani 
kcfrsatish kerak bo'ladi. 0 4rnatishning keyingi barcha operatsiyalari 
foydalanuvchining aralashuvini talab etmaydi. Instalyator arxivlarni 
ochadi, kataloglar va kichik kataloglar tiziminiyaratadi. unga ish uchun 
zarur boigan barcha fayllardan nusxa kowchiradi va ekranga gipermatnli 
fay Ini dastur imkoniyatlarining tavsifi, foydali ma’lumotlar manbalari 
haqida qisqacha ma'lumotlar bilan chiqarib beradi.

Dasturni ishga tushirish

Paket o'rnatilgandan keyin Windows bosh menyusiga Dream- 
weaverni yuklash va unga tegishli favllar maxsus boiim i qo'shiladi. Har 
qanday holatda ham dasturni yuklash buyrug'i: Пуск > Программы > 
Macromedia > Dreamweaver MX ko'rinishida boUadi.

Dasturni yuklashni bir nechta universal usullari mavjud. Bu bizga 
oddiy Microsoft Office paketi dasturlaridan hain ma'lum.

Savol va topshiriqlar:

1. Dreamweaver MX dasturini o'rnatish ketma-ketligini aytib bering?
2. Dasturni o*zingiz mustaqil ravishda o’rnating?
3. Dasturni ishga tushirish ketma-ketligini aytib bering?
4. Dasturni ishga tushirishning yana qanday usullari bor?

2.2. Interfeys. Dastur oynasi qismlari

Interfeys deganda informatikada dasturdagi turli komponentlar 
va foydalanuvchi o'rtasidagi o'zaro aloqani ta’minlovchi vositalar va 
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qoidalar yig'indisi tushuniladi. Dreamweaver paketi taklif etadigan 
muomala usuli zam onaviy foydalanuvchi uchun odatiy boMib qolgan 
grafik oynali interfeys prinsiplariga asoslanadi. Dreamweaver paketi 
o*sha sinfdagi boshqa dasturlar bilan taqqoslaganda ancha aniq. 
moslashuvchan va shu bilan b ir  paytda kuchli interfeys hisoblanadi. 
Palitralar, ko'p sonli klaviatura kombinatsiyalari va menyu qatori uning 
asosiy vositalari hisoblanadi. Barcha operatsiyalar to’xtatilgach ekranda 
qoladigan oynalarni palitralari (Palette) yoki panellar (panel) deb atash 
qabul qilingan. Ekranning m axsus ajratilgan pozitsiyalarida emas. balki 
ixtiyoriy joyida joylasha oladigan oynalar ko'chib yuruvchi palitralar 
(floating plette) deb ataladi. Dreamweaver dasturi muloqot oynalarining 
ko'pchiligi ko'chib yuruvchi palitralar ko'rinishida ishlaydi. Palitralar 
va panellar orasidagi k ichik farqlar dasturni tavsiflash uchun sezilarli 
ahamiyatga ega em as. Shuning uchun kelgusida bu atamalarni 
sincnimlar sifatida qo'llaym iz.

Deyarli barcha palitralar birlashish xususiyatiga ega. Bu har xil 
pal itralarni bitta m uloqot oynasida joylashtirish mumkinligini bildiradi. 
Birlashtirish amali turli m avzu yoki buyruqlarga tegishli boshqaruv 
vositalariga ega b o ig a n  ko4p  funksiyali terma palitralarni olish 
imkoniyatini beradi. B irlashish xususiyatiga ega bo4lgan palitralarni 
(ular dasturda ko'pchilikni tashkil etadi) modulli (dockable) palitralar 
debataymiz. Bir nechta alohida modullardan iborat murakkab palitralar 
terma (tabbed) palitralar deb ataladi.

2.1-rasmda tokrtta och iq  m uloqot oynali dasturning tashqi ko'rinishi 
ko'rsatilgan. Boshqaruvning e n g  talab qilinuvchi vositasi so'zsiz. 
Properties inspector (x:ossalar nazoratchisi) palitrasi hisoblanadi. Uning 
yordamida HTML sahifalarida obyektlarni formatlash va HTML 
sahifasidagi obyektlarni tahrirlash bo'yicha ko'plab amallar bajariladi. 
Behavieros (rejimlar) palitrasi — bu modul ko'chib yuruvchi palitraga 
misol boiadi. Dreamweaver dasturi turli loyiha masalalarini hal qilishga 
mo'ljallangan obyektlarga ega.

Rasmda ikkita od diy  modulli Layers va History palitralardan 
iborat bo'lgan tenna palitraga misol keltirilgan. Objekts palitrasi 
tashqi obyektlar: rasmlar. jadvallar, qatlamlar. freymlar va boshqa 
obyektlarni qo'yish uchun mo¿ ljallangan. Rasmda ko'rsatilgan boshqa 
barcha boshqaruv elem entlari hujjat oynasining ajralmas tashkil etuvchi
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2.1-rasm. Dastur oynasining ko'rinishi.

qism i hisoblanadi. Texnik tizimlarning ishonchli ishlashi. dasturiy 
mahsulotlarni interfevslarining qulayligi asosida to‘g ‘ri tashkil qilingan. 
D ream weaver paketi formatlash va tahrirlashning deyarli barcha 
asosiy buyruqlari uchun airnlga oshirishning bir necha xil usullarini 
ta k lif  etadi. Keng formatli ekranlarning egalari barcha buyruqlarni 
palitralar v a  panellar yordamida bajarishlari mumkin. Bundan mahrum 
foydalanuvchilarga esa dastur menvu (jatori buyruqlarini va klaviatura 
tugmalari kombinatsiyalaridaa foydalanishadi.
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Hujjat oynasi

Hujjat oynasi — bu gipermatnli hujjatlar yaratiladigan ish may- 
doni hisoblanadi (2.2-rasm ). U HTML sahifasi o‘z ichiga oigan 
matnlar, rasmlar, jadvallar. shakllar va boshqa obyektlarni saqlaydi. 
Dreamweaver, W YSIW YG  sinfiga kiruvchi tahrirlagich dastur 
hisoblanadi. Bu uzun atama inglizcha What you see is what you 
get (siz nimani kobrayotgan bo4lsangiz shuni olasiz) iborasining bosh 
harflaridan tuzilgan. B u  narsa HTML sahifasining hujjat oynasida 
aks ettirilishi uning vanada ommaviyroq ko‘rib chiqish dasturlari
-  Microsoft Internet Explorer va Netscape Navigator brauzerlarida 
ifodalanishidan uncha farq qilmasligini bildiradi. HTML kodlari 
bilan to'g'ridan-to'g'ri ishlash yuqori professionallik hisoblanishiga 
qaramay. hatto eng tajribali WEB-dizayner ham grafik interfeys va 
WYSIWYG rejimida hujjat yaratishda beradigan qulayliklardan voz  
kecha olmaydi.

Ko‘pchilik W indows ilovalaridan farqli ularoq Dreamweaver dasturi 
bitta dastur oynasida bir necha hujjatlar bilan ish lay olmaydi. Tanlab 
olingan parametrlarni cfrnatishdan kelib chiqib yangi hujjat dasturning 
alohida oynasiga joylashtiriladi yoki joriy oynada avval ochilgan hujjat 
o'rnini egallaydi. Bundav ish rejimida dastur oynasi va hujjat oynasi 
orasida deyarli farq yo'q. Shuning uchun ham biz kelgusida bu nomlarni 
sinonimlar sifatida ishlatamiz.

Ш  U n t i t l e d  D o c u m e n t  (1 1  n l i t l e d - 1  )  - D  r e a r o  w e a v e r Ш Ш  .  ! □ !  x |

File Edit View Insert Modify Text Commands Site Window Help

<¿>: j l  j f - ^ 4 Title: Untitled Document с  <?$>  ; i

1

<body> ¡447 x 90 ▼ j1K / 1 sec ¿¡3ft j j  C

I

2 . 2 - r c i s m .  Hujjat oynasi.
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Ish rejimlari

W YSIW YG rejimida gipennatnli hujjat yaratish oddiy matn mu- 
harriri bilan ishlashdan ko‘p farq qilmavdi.

M atnni kiritish va formatkshning bazaviy amallari, obyektlarni 
joylashtirish buyruqlari, navigatsiya va tanlash texnikasining barcha 
amallari Dreamweaver dasturida so'nggi bir necha vil davomida 
vizual muhitda ustunlik qilish usulida amalga oshirib kelinmoqda. 
Foydalanuvchi loyihalash yechimlarini HTML tili vositalari tomonidan 
qanday yo'lga qo'yilishi haqida o'ylab o'tirmasdan tahrirlash va 
formatlashning odatdagi vositalaridan fovdalanib ishlashi mumkin. 
Dreamweaver paketi dastlabki matnni avtomatik ravishda yaratadi. 
unda hujjatning ma’lumot bilan toMdirilishi va ro’vxatga olinishi bilan 
gipermatnni belgilash tilining kodlari yoziladi.

Yaratuvchanlik ishining katta qismi WYSIWYG rejimida baja- 
rilishi m um kinligiga qaramay ba'zan to^ridan-to'g'ri kodlashga 
murojaat qilishga to^g'ri keladi. Buning bir nechta sababi bor. Asosan. 
bu belgilash kodlarini juda ehtiyotkorlik bilan sozlash zarurligidir. 
Bundan tashqari HTML tili standartida yuzdan ortiq deskriptorlar 
haqida eslatib o4iladi. Ularning har biri bir nechta atributlar va 
modifikatorlarga ega boiish i mumkin. Gipennatnli belgilashning 
eng ko‘p talab qilinadigan vositalari Dreamweaver tizimi interfeysi 
doirasida joylashtirilgan.

Dreamweaver dasturining hamma versiyalari, birinchisidan boshlab. 
foydalanuvchiga belgilash kodlarini to‘gTidan-to‘g sri tahrirlash imkonini 
beradi. B u  ish uchun qanday vositalar qo'llaniladi?

Birinchidan. bu maxsus ichiga qurilgan Code Inspector (kodlar 
inspektori) tahrirlagich boiib. u Dreamweaver dasturini eng bi- 
rinchi versiyalarida ham mavjud edi va bu oxirgi versiyalarda vaqt 
davomida faqatgina dizavniga o4zgartirishlar kiritildi. Ikkinchidan. 
foydalanuvchi HTML tiliga tashqi tahrirlagichlarni ulash imkoniyatiga 
ega. Turli dasturlar: universal vazifali (masalan. Bloknot) oddiy matn 
tahrirlagichlaridan boshlab. to murakkab gipennatnli hujjatlar bilan 
ishlashga mo'ljallangan (Allaire Home Stile) yuqori darajali dastur 
vositalarigacha bu rolni bajarishi mumkin. Dasturning MX versivasida 
juda qulaŷ  yangilik — hujjat oymsining ish rejimi paydo bo'ladi. Hujjat 
oynasi uchta rejim yoki ko'rinishlardan birida boiishi mumkin.
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,3-rctstn. H u jja tn ing  belgili rejimida ko'rinishi.

2.3-rasm. Belgi lash rejim idagi hujjat oynasi Code and View  
(belgilash va rejalashtirish rejimi). Bu aralash rejim bo‘lib, unda hujjat 
oynasi ikkita qism ga boMinadi. Bir qismda gipermatnli belgilash kodlari 
aks etadi, boshqasida dastur sahifani barcha obyektlar va formatlash 
atributlari bilan rej alashtirishni ko‘rsatadi. 2.4-rasmda bo'sh sahifali 
ajratilgan hujjat oynasi ko‘rsatilgan.

Ish rejimini o'zgartirishning bir necha usuli bor. Birinchidan, bu 
menyu qatori buyruqlari: V ie w  > Code, View' -  Design, View -  Code 
and Design. Ikkinchidan. uskunalar panelida bir rejimidan boshqasiga 
tez o tish imkonini beruvchi tugmalar bor. Va nihoyat, Ctrl + Tab 
tugmalar kombinatsiyasi yordam ida rejalashtirish rejimidan belgilash 
rejimiga va aksincha. yoki ajratilgan oynaning bir qismidan boshqasiga 
otish  mumkin.

Ajratilgan hujjat oyn asi qismlarining o'Ichamlarini o'zgartirish 
mumkin. Buning uchun ko'rsatkich yordamida ajratuvchi chiziqni 
ko‘chirish kerak bo‘la d i. O xirgi paytlarda dasturchilar orasida «dastlabki 
matn» ataniasi paydo b o ld i. Yuqori saviyali dasturlash tilida yozilgan 
dastur ishlab chiqishning dastlabki bosqichlarida shunday deb ataladi. 
Bu atama giperm atnli hujjatning kodli qismi va ko4rinadigan obrazi
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2.4 -rasm .  Bo'sh sahifali hujjatning aralash rejimda ko'rinishi.

o'rtasida m ayjud boigan munosabatlardan tashkil topadi. Hujjatning 
H T M L  tilida  yozilishini dastlabki matn deb ataymiz.

Menyu qa tori

M enyu  qatori -  bu Wmdcrwsning ixtiyoriy ilovasining zaruriy 
atributidir. LJ buyruqlar yordamida, muloqot oynalariga, tugmalarga 
yoel ochadi,, ular yordamida hujjat yaratish, dasturni sozlash. 
vizuaLlashtir ish jarayonini boshqarish kabi dasturning barcha 
funksional imkoniyatlarini o'z ichiga olgan samarali ishlar bajariladi. 
M en yu  qatorining har bir bandi vazifasi jihatidan bir-biriga yaqin 
kiritilgan m en yu  va kichik menyular ierarxiyasini hosil qiluvchi 
buyruqlar guruhin i birlashtiradi. Bu bandlarning qisqacha tavsifini 
keltiram iz.

• F ile m enyusi (Файл) fayilar bilan bog'liq buyruqlarni. gipermatnli 
hujjatlar shablonlari bilan ishlash, eksport qilish. import qilish va 
brauzer dasturlarida ko'rish buyruqlarini o‘z ichiga oladi.

• E dit (Правка) menyusiga tahrirlash va qidirish bilan bog'liq 
buyruqlar kiradi.
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• View (Вид) m enyusi interfeysning yordamchi elementlarini 
л a gipermatnli hujjat obyektlarining ko'rinishlari ustida ishlovchi 
buyruqlami o'z ichiga oladi.

• Insert (Вставка) m enyusiga har-xil obyektlarni import qilish 
buyruqlari kiradi: rasmlar, jadvallar, shakllar, qatlamlar, maxsus belgilar 
va boshqalar.

• Modify (Изменить) menyusi o*z ichiga gipermatnli hujjat 
obyektlari atributlarini o'zgartirish buyruqlarini oladi.

• Text (Текст) m enyusi matnli fragmentlarni hosil qilish va ularni 
formatlash bilan bogTiq buyruqlarni o‘z ichiga oladi.

• Commands (Команды) menyusi gipermatnli hujjatlarni avtomatik 
qayta ishlash buyruqlarini o 4z ichiga oladi.

• Menyu qatorining Site (Сайт) boTimi sayt bilan ishlash vositalari 
va gipermatnli hujjatlar bilan bogiiq  murakkab tizimlar vositalarini o‘z 
ichiga oigan.

• Window (Окно) m enyusi dasturga tegishli palitralar, panellar va 
muloqot oynalarini oTnatish va aksincha olib tashlash bilan bog'liq 
buyruqlarni o*z ichiga oladi.

• Help (Справка) m enyusida dasturdan foydalanish haqidagi 
interfaol ma'lumotlarni chaqirish, elektron qoTlanmani chaqirish kabi 
buyruqlar joylashgan.

Uskunalar paneli

Uskunalar paneli dasturning asosiy dispetcherlik pulti vazifasini 
bajaradi (2.5-rasm). U eng ko4p ishlatiladigan buyruqlar va tahrirlash 
resurslarini chaqirish tugrnalarini birlashtiradi. Bu ixchamgina panel 
kiritilgan menyu va kichik menyular tizimi navigatsiyasi bilan bog'liq 
sarf-harajatlarni anchagina qisqartiradi.

Unda joylashgan barcha boshqaruv elementlarini sanab o'tamiz 
(chapdan o'ngga):

• Code View (Режим разметки) -  gipermatnli hujjatning faqat 
belgili kodlari tasvirlanadi (dizayni tasvirlanmaydi).

JU Д] I Title: Un,i(led Document ©, | С W  {}T S0,

2  D - r a s m .  U skunalar paneli.
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• C ode and Design View (Режим разметки и планировки). 
Tugmasi bosilganda hujjat oynasi ikki qisinga ajraladi: birinchi oynada 
belgili kodlar beriladi. ikkinchi oynada esa gipermatnli sahifaning 
dizayni. ya'ni tashqi ko'rinishi beriladi.

• D esign  V iew  (Режим планировки). Dasturda ishlaslining vizual
-  W YSIW YG  rejimiga o‘tish tugmasi.

• Title (Заголовок) — bu matnli maydon hujjatning sarlavhasini 
kiritishga moMjallangan.

• File Management (Управление файлами) -  tarmoqda ma'lumot 
almashish uchun xizmat qiladigan fayllar bilan ishlash buvruqlaridan 
tarkib topgan menyuni ochish tugmasi.

• Preview/Debug in Browser (Просмотр/отладка в браузе
ре) — tugmasi gipermatnli hujjatni ko'rish va undagi Java Script 
kodlarini tanlangan brauzerda ishlash yoki ishlamasligini tekshiruvchi 
buyruqlaridan iborat menyuni ochadi.

• Refresh Design View (Обновить страницу) -  bu buvruq beril- 
gandan so'ng, hujjatning belgili matnlarida boMgan barcha o'zgarishlar 
loyihalash rejimiga uzatiladi. Ana shu vaqtda kodlarni interpritatsiyasi 
va siataksik tekshiruv boshlanadi. Xato fragmentlari sariq rangda 
ko'rsatiladi. To’g'rilari esa sahifada tasvirlanadi.

• Reference (Справка) -  tugmasi elektron ma’lumotli qo'llanmani 
ekranga chiqarib beradi. Bu qoMlanmada gipermatnli belgilash tili 
deskriptorlari ifodalangan.

• C ode Navigation (Навигация по кодам) -  tugmasi Java Script 
tilida yozilgan belgili kodlarni tuzatishni boshqaruv buyruqlaridan 
tarkib topgan menyuni ochadi.

• V iew  Options (Параметры отображения) -  tugmasi hujjat 
oynasining qo6shimcha elementlari vizualizatsiyasini boshqaruvchi buy- 
ruqlar menyusini ochadi. Bu menyuga asosiy menyu qatoridagi View  
m enyusining bir necha buyruqlari kiradi.

Sahifalar oMchamlarini belgilash

Virtual to'plam hech qanday tartib-qoidalarga va standartlarga 
bo'ysunmasdan, tarqoq holda rivojlanadi. Bu esa ishlab chiquvchilar 
va dasturchilar uchun ko'p sonli qiyinchiliklar manbai bo'lishi
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«Internet almashuvi»ning juda tez o'sishi sabablaridan biridir. Aslida 
sahifaga voki saytni ishlavotganda muallif o*z asarini turli kompyuter 
tizimlarida aks etishi m um kinligini yodda tutishi kerak. Agar u tashrif 
buyuruvchilarini (fovdalanuvchilarini) yo‘qotishni istamasa. u holda har 
xil o'lchamli va  har xil texnologiyalarni qoMlovchi (elektron-nur trubka 
bazasida bo lishi shart emas) monitorlarda hujjatning aniq va qisqa 
ifodalanishihaqida o‘ylab koTish kerak.

Onlaynli hujjatlarni k o ïib  chiqishda brauzer oynasi oichamlarini 
o‘zgartirishga majbur qiluvchi boshqa sabablar ham bor. Har bir savodli 
inson o’qish tezligi boshqa sabablardan tashqari qator uzunligiga ham 
bogliqliginitushunadi. Agar qatorlar biror me’yordan sezilarli farq qilsa 
o'qilganning qabul qilinishi murakkablashadi. Psixologik tadqiqotlar 
ko'rsatishicha, matn qatorining optimal uzunligi alfavit simvollari 
soni bilan uzviy bogiiq. Qulay o'qish zonasini aniqlash uchun alfavit 
o'lchamini 1,5 dan 2 gacha qiymatni qabul qiladigan koeffitsiyentga 
ko'paytirish kerak. Bu narsa rus tilida matn qatorlari 70 simvoldan 
uzun bo'lmasligini bildiradi. K o bp fovdalanuvchilar bunday formulaning 
mavjudligi haqida o'ylab koïm aydilar va xaddan tashqari uzun qatorlar 
paydo bolishining oldini olish uchun brauzer oynasining oichamlarini 
cheklab qo'yadilar.

Dreamweaver paketini yaratuvchilari dasturni turli oichamdagi 
monitorlarda hujjat qanday ko'rinishga ega boiishini tasavvur qilish 
imkonini beruvchi maxsus vosita bilan ta'minlab qo'yganlar.

Holat qatorining o ’rta qismida (2.2-rasm) hujjat oynasining joriy 
o'lchamlari piksellarda chiqariladigan maydon joylashgan. Birinchi 
son-kenglik qiymatini, ikkinchi son balandlikni oMchamini ifodalaydi. 
Agar mavdonning ixtivoriy nuqtasida sichqoncha tugmasini bosilsa, u 
liolda Windows va Macintosh platformalarida hisoblash tizimlarining 
eng ommaviy konfiguratsiyalari uchun yettita standart olchamga 
ega bo’lgan yetti muloqot oy nasi chiqadi. O'lchainni belgilash uchun 
oynaning tegishli qatorini tanlash yetarli.

Menyuning birinchi band i hujjat sohasining 592 pikselga teng 
boigan kengligini belgilaydi v a  sohaning joriy balandligini o'zgarishsiz 
qoldiradi. Edite Sizees (O icham larni to*g¿rilash)ning oxirgi bandi 
hujjat oynasining oicham larin i tanlash va ularni standartlar ro‘yxatiga 
kiritish imkonini beradi. Ekranda Preferences (Sozlashlar) muloqot
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oynasi paydo bo‘ladi. unda Width (kenglik, eni) rnaydonida kenglik, 
HEIGHT (balandlik) maydonda esa soha balandligi belgilanadi. 
Yangi standartning matnli tavsifi Description (tavsiya) rnaydonida 
ko6rsatiladi.

Barcha o'lchamlar dastur oynasining xizmat elementlarini: oTchov 
chiziqlari va menyu qatorini inobatga olmasdan hisoblab chiqiladi. 
Faqatgina hujjat va uning obyektlari uchun ajratilgan ishchi soha 
hisobga olinadi.

Palitra va tez yuklanish paneli
Tez ishga tushirish palitrasi (Launcher) -  bu asosiy muloqot 

oynalari va dasturlar panellarini ekranga chiqarish uchun mo'ljallangan 
yordamchi, xizmatchi palitra. Palitrani aks ettirish uchun Windows > 
Launcher buyrug'ini bajarish kerak. Bu buyruqning takroran bajarilishi 
palitrani ekrandan olib tashlaydi.

Palitraning Launcher (tez ishga tushirish) tugmasini bosish natija- 
sid a  ekranga shu nomdagi muloqot oynasi chiqadi. Agar ochilgan 
palitra ekranning oldingi qavatida joylashgan boMsa, buyruq tugmasini 
takroran bosish uni yopilishiga olib keladi. Agar faol palitra hech 
bo'lmaganda qisman boshqa obvektlar bilan to'silgam bo'lsa. u oldingi 
qavatga o'tadi.

Palitra yettita eng ko‘p talab qilinadigan dastur komponentlarining 
tez ishga tushirish tugmalarini birlashtiradi:

Site (Сайт) — katta saytlarni boshqarish uchun muloqot oynasi. 
murakkab kesishuvli bogTanishlarga ega gipermatnli hujjatlar tizimi 
uchun mo‘ljallangan.

• Assets (Библиотека) -  bu nom harfma-harf tarjimada faollar 
y o k i fondlar ma’nolarini beradi. Bu panel dasturda kutubxona rolini 
o4ynaydi. U gipermatnli hujjatlar dizayniga tegishli elementlarni o'zida 
saqlaydi. Bu elementlarga: tasvirlar, ranglar. tashqi bogManishlar, Flash
-  roliklari, shablonlar va boshqalar kiradi.

• HTML Styles (Стили HTML) -  bu palitra matnli qator va 
abzatslar uchun HTML belgili stillar bilan ishlashga mo’ljallangan.

• CSS Styles (Каскадные листы стилей) -  bu palitra stillarni 
kaskadli sahifalar bilan boshqarish uchun xizmat qiladi. Keyinchalik 
bu jumlani «ierarxik stillar spetsifikatsiyasi» ko'rinishida ham 
qo¿ llaymiz.
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• Behaviors (Режимы) — palitrasi gipermatnli sahifalarni inter- 
faolligini boshqarish vositalarini o'zida birlashtirgan. Senariy sahifani 
ko’rish jarayonida ro4 beradigan hodisalar asosida quriladi. Bu 
jarayoiming chizmasida ko’plab interfaol effektlar yig'iladi: oddiy 
animatsiyalashgan tugmalardan tortib maiumotlar bazasini qayta 
ishlashning nnirakkab protseduralarigacha.

• History (Предыстория) -  palitrasi foydalanuvchining HTML 
hujjatni tahrirlashdagi xatti-harakatlarini yozib boradi va saqlaydi. 
Tahrirlash jarayonidagi operatsivalarni bekor qilish imkonini beradi va 
avrim zanjirli ketma-ketliklarni buyruq ko'rinishida saqlaydi.

• Code Inspector (Инспектор кода). Dasturning eng muhim 
palitralaridan biri. HTML kodining ichki tahrirlagichi boiib  Dream- 
weaverning grafikli rejimiga o'zaro boglangan.

Tez ishga tushirish palitrasining o'ng tomondagi pastki burchagida 
to'g'ri burchakli tugma joylashgan. Bu vosita palitraning yo4nalishini 
o'zgartirishga moljallangan. Tez ishga tushirish palitrasini o'zgartirish 
mumkin. Buning uchun Edit > Preferences buyrugbini berish kerak. 
Dasturning asosiy sozlashlariga ega boigan muloqot oynasi ochiladi. 
Unda Panels (panellar) kategorivasini tanlab oling va palitra ichidagi 
Show in Launche (tez ishga tushirish palitrasida ko'rsating) boiim ida  
beriladigan vositalar yordamida o'zgartiring. Holat qatorining o'ng 
qismida (2.2-rasm) joylashgan.

Kontekstli menyu

Kontekstli m enyu W indows operatsion tizimining boshlovchi 
foydalanuvchilari uchun ham  yaxshi tanish. Boshqaruvning bu 
stand art usuli ushbu operatsion tizim i boshqaruvida ishlovchi 
ko'pchilik ilovalar (dasturlar) tomonidan ko'p qoilaniladi. Uning 
mohiyati sodda. Sichqonchaning o'ng tugmasini hujjat oynasining 
obyekti ustida bosilsa, ekranga obyekt turiga bogMiq boMgan 
mazmundagi menyu chiqadi. Bu menyuda shu obyektga tegishli yoki 
ushbu holatda talab qilinishi ko*proq ehtimolligi bor boklgan buyruqlar 
to’plangan.

Dreamweaver dasturining barcha versiyalarida kontekstli menyu 
mavjud. Kontekstli menyuning oUchami va‘ni buyruqlari safi kengaydi, 
qokshimcha darajalarga ega boMdi va endi har qanday holatda
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Paragraph Format
L is t

A lign

F o n t

Style
C SS Styles

S ize

Templates 

Element View

E d it Tag < b o dy> ... Shift+F5 

Q uick Tag Editor...

M ake Link

Target Frame 

C reate  New Snippet

P aste  Ctrl+V

Paste  Special...

Design Notes for P age...

P age Properties...

2.(5-rasm. Kontekstli menvu.

chaqirilishi mumkin. 2.6-rasmda oyna 
ixtiyoriy b(Tsh nuqtasida sichqonchaning 
o‘ng tugmasi bosilsa dastur chiqarib 
beradigan kontekstli menyuga mi sol 
keltirilgan.

Property Inspector palitrasi

Property Inspector (Инспектор 
свойств) palitrasi -  bu dasturning aso- 
siy uskunasidir. HTML sahifasida 
joylashgan obyektlar atributlarini o'z- 
gartirish ishlarining asosiy qismini 
uning yordamida bajariladi. (2.7-rasm).

Property Inspector palitrasi ko'chib 
yuruvchi palitradan iborat bo'lib. uning 
tarkibi bajarilavotgan operatsiyaga, tan- 
langan obvekt turiga va kursorning 
holatiga qarab. mos ravishda o4zgarib 
turadi. Palitrani ekranga chiqarish uchun 
quyidagi Window > Properties (Окно
> Свойства) buyruqni berish yoki 
CTRL+-F3 tugmalar kombinatsiyasini 
bosish kerak. Bu buyruqni qaytadan 
berish palitrani ekrandan olib tashlaydi.
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Palitraning asosiy maydonlari va tugmalarini sanab o4tamiz. 
Palitraning shu boshqaruv elem entlari matnni formatlash va gipermatnli 
bogianishlarni hosil qilishga tegishli vazifalarni o'z ichiga oladi:

• Format (Формат) ro'yxati matnning standart strukturali tiplaridan 
birini tanlash imkonini beradi (1).

• Link (Ссылка) ushbu hujjatga tegishli giperbogManishlar 
ro'yxatini o*zida saqlaydi. H ar bir bog'lanishni bir necha marta qoilash  
mumkin. Ya'ni bir marta tuzilgan bog'lanishni, boshqa faol hududlarga 
ham takror qoilash  mumkin (2).

• Matn fragmenti shriftini belgilash imkonini beradi. Bu ro‘y- 
xatning punktlari shriftlar to'plamidan iborat bo'lib. qo4llanilishiga 
qarab joylashgan (3).

• Size (Размер) ro’yxati shrift o'lchamini tanlash uchun mo;l- 
jallangan (4).

• Standart ranglar palitrasini chaqirish tugmasi. Bu palitra tan- 
langan matnli fragment rangini tanlash imkonini beradi (5).

• Tanlangan rangning kodi tasvirlangan yoki kiritiladigan maydon
(6)-

• Shriftni holatini tanlash tugmasi. Ko'rinishi va funksiyasi standart 
boshqa dasturlardagidek (7).

• Matnni tekislash tipini tanlash tugmalari (8).
• Interfaol yordamni chaqirish tugmasi (9).
• Marker-ko'rsatkich. U n i tegishli fayl yoki simvolga surish bilan 

gipermatnli bogianish hosil qilinadi (10).
• Select File (Выбрать файл) muloqot oynasini ochish tugmasi. 

Fayllar tizimida harakatlanish va gipermatnli bogianishlarni asosi 
bo'lib xizmat qiladigan hujjatni tanlash (11).

• Target (Назначение) ro'yxati gipermatnli bogianishda ko'r- 
satilgan hujjatni ekranda yuklanish usulini tanlash imkonini beradi. Shu 
boiim da havolali hujjat chiqish oynasi yoki freymni belgilanadi (12).

• Ko;pchilik tahrirlagich dasturlarda standart ko'rinishda, matnli va 
HTML, ro'yxatlarni belgilash va nomerlash tugmasi (13).

• List Item (Раздел списка) tugmasi List Properties (Свойства спи
ска) muloqot oynasini ochish uchun ishlatiladi. Bu oyna barcha tipdagi 
ro‘yxatlarni tahrirlashga m oijallangan (14).

• Ikkita tugma. matnli fragmentlarni gorizontal surilishini bosh- 
qaradi (15).
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• Kodlarni ekspress-tahrirlash oynasini chaqirish tugmasi (16).
• Expander arrow (Расширение) palitra oichamlarini o'zgartirish 

uchun xizmat qiladi. Uning yordamida Property Inspector (Инспектор 
свойств) palitrasini ochish va yopish mumkin (17).

Property Inspector paneli yordamida bajariladigan buyruqlarning 
ko‘pchiligi qayta ishlanayotgan obyektlar: rasm, matn yoki jadvallarga 
tegishlilari paydo bo'ladi. Xossalar panelida harakatlanish uchun TAB 
tugm asini bosish yoki kerakli qismga sichqonchani chap tugmasini 
bosish  kerak. Tanlangan boiim da kerakli ko'rsatkichni kiritib. ENTER 
tugm asini bosish uni o*rnatilishi uchun yetarli.

Property Inspector panelining ko‘plab boshqaruv elementlari 
o'zida matnli yoki raqamli maydonlar kombinatsiyasi va bekiladigan 
royxatlaridan iborat. So^'algan qiymatni klaviaturadan terish yoki 
menvvidan tanlash vo'li bilan tegishli parametrlarni ornatish uchun eng 
qulay usul hisoblanadi.

Dreamweaver o'zining bir qancha qo'shimcha funksivalari bilan 
foydalanuvchilarga manzur bo'ldi: birinchidan, Dreamweaver barcha 
palitralari erkin holatda turadi. Ularni qayerga surib qo'ysangiz 
o'sha joyda joylasha oladi. Bu esa monitorning ish inaydoni xududini 
boshqaruvning xizmatchi elementlari va hujjatning oynasiga eng 
optimal bo’lish imkonini beradi. Ikki monitorli tizimda ishlaydigan 
foydalanuvchilar barcha yordamchi oyna va palitralami bitta monitorga 
jovlab? ikkinchisida esa hujjatlar bilan ishlashi mumkin. Ikkinchidan, 
dastur palitralari birlashish xususiyatiga ega. Uchinchidan. barcha 
ochiq palitralarni dastur ish stolidan olib tashlovchi buyruq mavjud. 
Bu operatsiyalarni F4 tugmasini bosish bilan ham bajarish mumkin. Bu 
tugmani takror bosish esa yana tiklash imkonini beradi.

Obyektlar palitrasi

Faqatgina eng oddiy gipermatnli hujjatlar o4zida havola bo'yicha 
boshqa hujjatlarga o'tuvchi buyruqlar biriktirilgan gipermatnli 
fragmentlarni birlashtiradi. Amino ko'pchilik zamonaviy HTML 
sahifalari multimedialashib bormoqda. Ya'ni ularning tarkibiga quyidagi 
tashqi obyektlar kiradi: multimediali fayllar, ijro etish vositalari, 
kartinkalar. animatsiya fayllari va boshqalar. Objects (Палитра объек-
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tob) palitrasi ana shunday tashqi obyektlarni yaratish va qo'yish uchun 
xizmat qiladi. Bu palitrani ekranga chiqarish uchun Window > Objects 
(Окно > Объекты) buyrug‘in i bajarish kerak. Xuddi shu buyruqni 
klaviaturadan CTRL +F2 tugmalar kombinatsiyasini bosish bilan ham 
berish mumkin. Bu buyruqni takror berish palitrani ekrandan olib 
tashlaydi.

Palitra vettita nomdagi qismlardan iborat. Bular: Characters, Com
mon, Forms, Frames, Head, Invisibles, Special.

• Characters (Специальные символы). Klaviaturada uchramay- 
digan maxsus simvollarni qo'yish (savdo markasi, kopirayt va bosh
qalar).

• Common (Общие) -  bo'lim i eng ko‘p qo'llaniladigan obyektlarni 
birlashtiradi. Bu jadvallar. rasmlar, gorizontal chizg4ich. joriy ka- 
lendardagi sana lar va boshqalar.

• Forms (Формы). Formalar va elementlar, ularning tashkil qiluv- 
chilari: yoqib-o'chiruvchilar, ro^yxatlar, matn maydonlari va boshqalar.

• Frames (Фреймы). Frey miar tizimini yaratish. Har xil 
ko’rinishdagi freymlar qismlaridan tarkib topgan freymlar tizmini hosil 
qilish. Ya'ni yaratilayotgan saytni sahifasini freymlarga boiib  olish.

• Head (Заголовок) -  gipermatnli hujjatning sarlavha qismiga tav- 
sif berish.

• Invisibles (Скрытые объекты). HTML sahifani brauzer dastur- 
larida namoyish qilishda, ko'rinmaydigan yashirin obyektlarni joylash.
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B u  palitraning eng kichik qismi bo'lib, u faqat uchta tipdagi obyektlarni 
qo^shib beradi: simvollari, izohlar va senariylar.

• Special (Специальные объекты) -  bu bo4im o’zida maxsus 
obyektlarni qo'yish tugmalarini birlashtiradi. Bularga appletlar, ActiveX 
obyektlari va boshqa tashqi toTdiruvchilarni (plagins) kiritish mumkin.

Palitraning pastki qismida ikki guruhga boiingan to'rtta tugma 
joylashgan: Layout (Компоновка) va View (Вид). Ular maketlash 
rejimiga o’tish va sahifannig strukturasini tezda yaratishga imkon 
beradi. Bu elementlar bilan qisqacha tanishib o’tamiz:

• Draw Layout Cell (Создание макетной ячейки) -  maketli ka- 
takcha yaratish uskunasini faollashtiradi.

• Draw Layout Table (Создание макетной таблицы). Maketli 
jadval yaratish uskunasini faollashtiradi.

• Standard View (Стандартный режим). Hujjat bilan ishlashning 
standart rejimiga o'tish.

• Layout View (Режим макетирования) -  Hujjatni maketlash reji
m iga o4tish.

Ushbu boMimni nomi palitra sarlavhasi qatori ostida tasvirlanadi. 
BoMimni ochish uchun shu nomni sichqoncha chap tiigmasi bilan 
bo sing. Ochilgan menyudan foydalanuvchi kerakli qismni tanlashi 
mumkin. Palitraning ayrim bo'limlarida hamma tugmalar ham 
tasvirlanmaydi. Masalan. Common (Общие) bo'limi yigirmaga yaqin 
tugmani o'z ichiga oladi, ularning hammasi ham palitra oynasiga 
sig'maydi. Boshqa tugmalarni koTish uchun prokrutkadan foydalanish 
(prokrutkani vazifasini palitraning chetida joylashgan strelkali tugmalar 
bajaradi) yoki muloqot oynasining olchamini kattalashtirish kerak.

Aksariyat hollarda obyektlarni qo'vish uchun qo'shimcha para- 
metrlarni kiritishga to’g'ri keladi. Bunday holatlarda ekranda foy
dalanuvchi tanlashi yoki ma'lumot kiritishi mumkin bo’lgan muloqot 
oynasi paydo bo'ladi. Bu oynaga foydalanuvchi obyektning kerakli 
obyektlarini tanlashi yoki kiritishi kerak.

Kodlar nazoratchisi bilan ishlash

Ko'p sonli HTML tahrirlagichlari sinfi orasida Dreamweaver dasturi 
gipermatnli hujjatlar kodlari bilan ishlash imkonivatlari jihatidan keskin
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farq qiladi. Foydalanuvchining HTML kodlarni qoida tahrirlashdan 
qutilishi eng katta yutuq va tezkorlikni ta minlab berdi.

Kodlar bilan to^ridan-tcfg'ri ishlash, yashirin xatolarni iden- 
tifikatsiya qilish, ortiqcha kodni bartaraf etish, gipermatnning 
tanlangan fragmentiga tezkor o'zgartirish kiritish, hujjatning struk- 
turasini yoki uning formatlanishini optimallashtirish imkoniyatlari 
mavjud.

Dreamweaver paketi tarkibida gipermatnli hujjatlarni belgilash 
kodlarini ko'rish va tahrirlashga moMjallangan maxsus vositasi mavjud. 
Bu vosita Code Inspector (Инспектор кода) deb nomlanadi. Uni 
quyidagi usullar bilan o'rnatish mumkin: birinchidan, Window > Code 
Inspector (Окно > Инспектор кода) buyrug‘ini berish yo'li bilan, 
ikkinchidan, bu F 10 tugm asini bosish y o ii bilan. Bu buyruqlar takror 
bosilganda Code Inspector yana ish stolidan yo'qoladi.

2.9-rasmda Kodlarni nazorat qilish oynasi ko'rsatilgan. Palitrada 
kodlarning belgilanishini tanishtirishni View Options (Параметры ото
бражения) tugmasi yordamida ochiladigan buyruqlar boshqaradi. Bu 
buyruqlarni ko%rib chiqamiz:

[ 1 .him ■ Code Inspector

I[< !> Code Inspector] (? )| ►

s- u j a .
■ <  I I ! L t > 7 'C r r n T r > "  ----------- " . i

</HE AD >
< b о dy fc e zkc\ г о u n d = /Fu N JРул >
<ut>
<li)|<t»<toni fa ce="Times Nev*/ Roman LYR" size=3><a ">Z. U

оздание web-узfia<Y></tont> </b>
</li>
<ul>

- <-li > <ictftt bne^'Ttr'nA '? N ew R o m g n  CYR11 ?:TZ6= > 2 . 1 .
П p и e к T n p о в ей и e < / ? > < /t о nt >

<ul>
<hxtont tace-’Tirnes New Roman l'y R" size=J><a hi6î=“# :!''>C

â

2 . 9 - r c i s n i .  K odlar nazoratchisi.
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•  Word Wrap (Перенос по словам). Kod qatorini ko’chirish rejimi. 
A gar u yoqilgan bo'lsa, HTML tili bayonmmasi tahrirlagich oynasining 
o'lchamiga yetganda avtomatik ravishda yangi qatorga o;tadi.

•  Line Numbers (Номера строк) -  nomerlashni o'rnatish buy- 
ru g4 . Agar bu rejim o‘rnatilgan bo‘lsa. har bir qator tartib bilan 
nomerlanadi.

•  Highlight Invalid HTML (Пометка некорректных кодов). Bu 
buyruq sintaktik xatoga ega konstruktsiyalarni Property Inspector 
panelida va hujjatning oynasida sariq rangda ajratish rejimini faol- 
lashtiradi. Shundaa so'ng Property Inspector xato haqida xabar beradi 
va ayrim hollarda uni tuzatish uchun ko'rsatmalar beradi.

•  Syntax Coloring (Раскраска синтаксических конструкция). Bu 
rejimda belgili kodlar turli xil ranglarga ajratiladi. Bu esa hujjatning 
kiritiladigan matni va belgili kodlarini tez ajratib olishga imkon 
beradi. Bundan tashqari Dreamweaver dasturi HTML tilining har bir 
deskriptori uchun alohida rang belgilash imkoniyatiga ega. Ranglarni 
belgilashning dastur asosiy ko'rsatkichlarini Code Colors (Цвета кода) 
bo‘lim ida amalga oshiriladi.

•  Auto Indent (Автоматический отступ) buyrugi kodlar na- 
zoratchisi oynasiga kiritilgan belgilash diskreptorlari uchun avtomatik 
joy qoldirish rejimini faollashtiradi.

Kodlar nazoratchisi oynasining o‘ng qjsmida uchburchak formada 
tugm a joylashgan. U hujjatning mavjud matnlariga xizmat qiladigan 
buyruqlardan iborat menyuni chaqiradi. Bu buyruqlarni sanab o'tamiz:

•  Find and Replace (Найти и заменить). Qidirish va almashtirish 
vazifasini bajaradi.

•  Find Next (Найти далее). Avval qidirilgan namunani mavjud 
parametr asosida qidirish. Bunda qidirish va almashtirish muloqot 
oynasi chiqmasdan to'g'ridan-to'g'ri amalga oshiriladi.

•  Reference (Справочное руководство). HTML, JavaScript va CSS 
manbalari asosidagi ma’lumotli qo'llanmani chaqiradi.

•  Set Breakpoint (Вставить контрольную точку). Matn kursori 
pozitsiyasida nazorat nuqtasini belgilaydi.

•  Remove All Breakpoint (Удалить все контрольные точки). 
Hujjatning mavjud matnidan barcha nazorat nuqtalarini olib tashlaydi.

•  Cut (Вырезать). Tanlangan kodli fragmentni buferga qirqib olish.
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• Сору (Копировать). Tanlangan kodli fragmentni nusxasini bu- 
ferga olish.

• Paste (Вставить). Buferga olingan fragmentni qo'yish.
Kodlar nazoratchisini matn muharriri uchun biroz g'ayri oddiy 

holda muvaffaqiyatli qo'llash mumkin. Dreamweaver dasturi ASCII 
sinwollarini qo'llash bilan vozilgan fayllarni. masalan oddiy matnli 
fayllarni voki dasturning dastlabki matnini muvaffaqiyatli o'qiydi. 
Bunday hujjatlar Open (Открыть) buyrug'i yordamida ochiladi va kodli 
rejimda ishlaydigan oyna hujjatiga yuklanadi. Bunda dasturning ba'zi 
resurslariga kirish mumkin boMmay qoladi.

Dasturning kutubxonasi

Kutubxonalar -  bu gipermatnli sahifaning dizayniga tegishli ko‘p 
marta qocllaniladigan elementlarni saqlash vositasidir. Bu elementlarga: 
tasvirlar. bogManishlar. matn bo'laklari va boshqalar kiradi. Dream
weaver dasturida esa kutubxonaning ishlash prinsipi biroz boshqacha. 
Dastlab kutubxonaga saqlashning bitta elementi hisoblangan. 
obyekt voki obyektlarga tegish li gipermatnli belgilash fragmentlari 
saqlanadi. Dreamweaver dasturida kutubxona elementlari maxsus 
Library papkasida saqlanadi. Bu papka saytning asosiy papkasi ichida 
joylashadi. Har bir W eb-uzel o'zining standart elementlari va ularni 
saqlash papkasini tashkil qiluvchi shaxsiy kutubxonasiga ega. Ular bilan 
ishlash uchun palitraning Assets (Ресурсы) bo'limidan foydalaniladi 
(2.10-rasm). Kutubxonalar bilan boshqarish ishlarining asosiy qisniini 
palitraning Assets (Ресурсы) bo'limi buvruqlari yordamida amalga 
oshiriladi.

Dreamweaverda kutubxonalarning asosiy imkoniyatlarini sanab 
o'tamiz:

• Kutubxona elementi deb <body> deskriptori orasida yotgan har 
qanday fragmentni aytish mumkin;

• Kutubxona elementlari qoMlanilishida cheksiz imkoniyatlarga 
ega. Ularni gipermatnli sahifalarga hech qanday tahrirlashsiz qo'yish 
mumkin:

• Kutubxona elementlariga o'zgartirish kiritilsa, ularni boshqa 
gipermatnli sahifalar va hujjatlarda qoMlashda saqlanib qoladi.
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Assets for Site 'V

Refw^ceT CQ0 Assets! Ф  ►

Ш Library

CZXEfiВД This is a blank Library item.
% To get started, click the Lair Edit button and add content.

ill.i
1©» Name | Size] Full Path

i  1 1KB /Library/1 Ibi
ID

rr-\ -j
m  2 1 KB /Library/2. Ibi

[ш S  3 0KB /Library/З. Ibi 1

*
r- _ ~ J . о щ и а

2 . 1 Q - r a s m .  Palitraning Assets b o lim i.

• Sahifalardagi kutubxona namunasi va uning nusxalari orasidagi 
aloqani uzishga ruxsat etiladi.

• Dastur alohida saytlar o ‘rtasida kutubxona elementlarini almashish 
buyruqlariga ega.

• Kutubxonalar dinamik xususiyatga ega bo'lgan obyektlarni 
saqlash xususiyatiga ega.

• Л/aqt diagrammalari (timeline) va stillarning kaskadli sahifalari 
kutubxonada saqlanishi murnkin emas.

Holat qatori va uni o‘rnatish

Status Bar (Строка состояния) bu kichik b oiim  dasturning holat 
qatori ko'rinishi ko'rsatkichlarini belgilaydi (2.11-rasm). Bu element 
hujjat oynasining pastki qismida joylashgan. Odatda bu qatorda 
joriy oyna o'lchami haqidagi ma’lumotlar va uning yuklanishi uchun
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Status Bar

Window Sizes: Width Height I Description | ж
600 300 1640 x 480.. Max..
760 420 (800x600, Max...
795 470 (832 x 624, Max.
955 600 (1024 x 768, M...
544 378

1
[WebTV)

▼

Connection Speed: (28.3 Kilobits per Second 

Launcher: |7 Show Launcher in Status Bar

2.11-rasm. Status Bar boiimi.

ketadigan vaqt ko*rsatiladi. Undan tashqari holat qatorining o‘ng qismini 
tez vuklanish paneli egallavdi:

Window Sizes (Размеры окна). Gipermatnli sahifalar har xil 
o'lchamdagi oynalarda tasvirlanishi mumkin. Window Sizes (Раз
меры окна) paneli standart oMchamlar ro'yxatini toidirish uchun 
moijallangan. Barcha tahrirlash amallari klaviaturadan shu panelning 
tegishli maydonlariga kiritish yordamida bajariladi.

Connection Speed Kilobits Per Second (Скорость соединения, 
Кбит/с). Bu maydonga server bilan bog'lanishning taxminiy tezligi 
kiritiladi. Bu joriy sahifani taxminiy yuklanish vaqtini belgilaydi. 
Odatda 28.8 Kbit/s tezlik o4rnatilgan boiadi.

• Show Launcher in Status Bar (Панель быстрого запуска в 
строке состояния) bu bayroqcha tez yuklanish panelini holat qatorida 
chiqishini boshqaradi.

Scivol va topshiriqlar:

1. Dreamweaver dasturida kodlar bilan ishlashning qanday imkoniyatlari 
bor?

2. Kodlar nazoratchisini o^rnatish usullarini sanab bering?
3. Kodlar nazoratchisi nirna va uning vazifalari nimalardan iborat?
4. Dasturning kutubxonasi nima?
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2.3. Fayllar bilan ishlash

Dasturning fayllarni ochish texnikasi Windows tizimida ishlaydigan 
boshqa dasturlardan farqi yo‘q. Buning uchun File > Open (Файл
> Открыть) biiyrugMni berish kerak. Bu buyruqni klaviaturadan 
CTRL+0 tugmalar kombinatsiyasini bosish bilan ham bajarish mumkin. 
Bundan tashqari dasturda fayllarni ochishning surib kelish usuli ham 
mavjud. HTML fayl belgisini sichqoncha yordamida surib kelib. hujjat 
oynasining ixtiyoriy yeriga tashlansa fayl ochiladi. Dasturda bir vaqtda 
bir nechta oyna bilan ishlash imkoniyati faqatgina kompyuterning bcrsh 
xotirasi bilan mos ravishda cheklanadi. Agar dasturda bo'sh sahifa bilan 
ish boshlangan bo'lsa, u holda yangi fayl har qanday holatda uni o'rnini 
egallaydi.

Dreamweaver dasturi ochiladigan HTML sahifalarida sintaktik 
xatolarni tekshiradi. Dastur standart HTML gipermatnli belgilash 
tili asosida yozilgan barcha kengaytmali fayllarni ocha oladi. Ularga 
quyidagilar kiradi: .HTM. .HTML, -ASP, .CFM, .CFML. .TXT, .SHTM, 
.SHTML, .STM, .LASSO. .XML. .CSS, .PHP.

Fayllarni saqlash

Dreamweaverda fayllarni saqlash ham Windows tizimining boshqa 
standart dasturlaridagi singari amalga oshiriladi. Buning uchun: File
> Save (Файл > Сохранить) yoki File > Save as (Файл > Сохранить 
как) buyruqlarini berish kerak. Birinchi buyruqni CTRL-bS tugmalar 
kombinatsiyasini bosish bilan ham bajarish mumkin. Bu buyruq 
shu nomdagi muloqot oynasini hosil qiladi. Oynada foydalanuvchi 
tomonidan faylning nomi, tipi va saqlash joy i belgilanadi.

Gipermatnli hujjatlar fayl lari Windows operatsion tizimida .htm 
kengaytma oladi, Macintosh platformasida esa .html kengavtma oladi. 
A m m o bu kengaytmadagi fayllarni dasturlarda ochish va saqlash 
buyruqlari bajarilishi teng kuchli. Dasturda ochilishi mumkin bo'lgan 
barcha tipdagi fayllar. xuddi shu dasturda saqlanadi ham.

Tabiiy sharoitda yoki ilmiy laboratoriyalarda o'tadigan ko'pgina fizik 
jarayonlar qaytmas liisoblanadi. Bu tabiatshunoslikda olamning butun 
ilmiy manzarasini shakllantiruvchi fundamental qoidalaridan biridir. 
Zamonaviy hisoblash mashinalari insonni bu falsafiv kategorivadan
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qisman qutqarishga qodir. Ko^pchilik zamonaviy dasturlar qoniqarsiz 
natijani bekor qilishga imkon beradi. Ya’ni hujjatning avvalgi holatiga 
qavtish. qabul qilingan qarorlarni qadamba-qadam orqaga qaytarish 
imkonini beradi.

Dreamweaver dasturida buning uchun Edit > Undo (Правка > От
мена) buyrug‘ini bajarish yoki CTRL+Z tugmalar kombinatsiyasini 
bosish yetarli.

Dastur bekor qilishni bir nechta o'zaro bog'langan ketma-ket 
qadamda amalga oshiradi. Bu ketma-ketlik qadamlarining soni 
dasturning tegishli kowrsatkichida ifodalangan songa teng; odatda bu 
son 100 ga teng.

Bu sonni quyidagicha o'zgartirish mumkin:
1. Edit>Preferences (Правка>Настройки) -  buvrug‘ini bering;
2. General (Общие) kategoriyasini oching;
3. Maximum Number of History Steps (Максимальное число 

записей журнала) maydoniga o4zingiz saqlamoqchi bo'lgan ketma- 
ketliklar maksimal sonini kiriting.

Tahrirlash ishlari va buyruqlarini yozish va saqlash foydalanuv- 
chidan qo shimcha hisoblash manbalarini talab qiladi.

Undo (Отмена) buvrug'i «eng muhim izlarni» bekor qilish 
imkoniyatini beradi. Ammo bu usul bilan jarayonni bir necha bor 
bajarib «bekor qilish» buyrug'idan yaxshi natija olib bo^maydi. Chunki 
uning vordamida faqatgina en g  muhim izlarni bekor qilish mumkin 
xolos. Bundan tashqari? ay rim buyruqlarni bu usul bilan bekor qilib 
bo'lmaydi. Bekor qilib bo'lmaydigan buyruqlarni orqaga qaytarish 
yoki ancha oldin bajarilgan operatsiyalarni qaytarish uchun File > 
Revert (Файл > Вернуться к сохраненному) buyrug‘idan foydalanish 
mumkin. Bu buyruq hujjatni oxirgi saqlangan holatini tiklab beradi.

Buyruqni ishlatish yo4i oddiy. Qaytarib bo4lmaydigan buyruqlar 
mavjud ketma-ketlikni tiklashga berishdan oldin hujjatni diskka saqlab 
olish kerak. Agar ish yaxshi natija bermasa, u holda Revert (Файл > Вер
нуться к сохраненному) buyrugbi hujjatni o‘sha holatida tiklab beradi.

Dasturda bajarilgan operatsiyalarni takrorlash ham mumkin. 
Edit >  Redo (Правка > Повторить) buyrug‘i oxirgi buyruqni yoki 
tahrirlash ishlarini takroran bajaradi. Bu buyruqni CTRL+Y tugmalar 
kombinatsiyasi vordamida ham berish mumkin.
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Shuni esda tutish kerakki, dasturning ish bayonnomasiga faqatgina 
natijaviy operatsiyalar yoziladi, masalan: simvollarni kiritish va 
o4chirish, obyektlarni qo‘yish. formatlash buvruqlari va boshqalar. 
Faqat shunday holatlarni bekor qilish yoki takrorlash mumkin. Kcfplab 
yordamchi tipdagi buyruqlarni bekor qilib yoki takrorlab bo'lmaydi. 
Kursorni surish, obyektlarni belgilash, hujjatni saqlash va boshqalar 
shular jumlasidan.

Savol va topish iriq la r:

1. Dasturda fayllarni ochish yo'llarini sanab bering?
2. Dastur yordamida qanday kengaytmali fayllarni ochish mumkin?
3. Dasturning fayllarni saqlash usullarini aytib bering?
4. Dasturning bekor qilish va takrorlash imkoniyatlarini sanab bering?

2.4. Web-uzel yaratish

Jahon o'rgimchak uyasining (World Wide Web) barcha informatsion 
manbalarini ikkita katta sinfga boMish qabul qilingan: sahifalar va 
uzellar yoki saytlar. Biz yuqorida web -  sahifalar ta'rifi bilan tanishdik.

Web-uzellar ya'ni saytlar -  deganda o'ziga sahifalarni birlashtirgan 
tizim  tushuniladi. Boshqacha aytganda uzel deganda minglab hujjatlarni 
o4zida birlashtirgan, ko'psonli bog'lanishga ega. multimediali murakkab 
tizim  tushuniladi.

Dreamweaver paketi -  bu ko'p qirrali dastur. Uni alohida sahifalar 
yaratish uchun oddiy gipermatnli hujjatlar tahrirlagichi sifatida ham 
ishlatish mumkin. Bundan tashqari dastur har qanday murakkablikdagi 
Web-uzellarni ham yarata oladi.

Chiziqli struktura

Kompyuter paydo boMgunga qadar barcha chop etiladigan: badiiy 
kitoblar, qo4llanmalai\ ma'lumotnomalar, texnik ko'rsatmalar chiziqli 
strukturaga misol bo'la olar edi. Bugungi kunga kelib bularni multimediali 
qo'llanmalar va elektron ko;rsatmalar ko’rinishida qo'llanmoqda. 
Chiziqli zanjir elektron magazinda buyurtma berishni rasmiylashtirish 
qadamlari. ayrim tarmoq manbalariga kirish uchun ro'yxatdan o'tish yoki 
rasmiylashtirish ketma-ketliklarini tushunish mumkin.
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2.12-rasm. Chiziqii struktura.

Chiziqli strukturaga kirish nuqtasi boiib  birinchi sahifa xizmat 
qiladi. Bu bosh sahifa odatda index.htm yoki main.htm deb nomlanadi. 
Bu esa kitob yoki jurnallardagi muqova rolini bajaradi. Bu sahifa bir 
vaqtning o hzida ham namoy ish bob, ham tanishtiruv sahifasi, ham 
ma’lumotli sahifa boMmogl lozitn. Qidiruv mashinalari har bir sahifani 
alohida indekslaydi. Shuning uchun barcha ichki sahifalarni bosh 
sahifaga o'tkazadigan harakatlanish tugmalari bilan toidirish kerak.

Iyerarxik struktura

Savtlar yaratishning zanjirli prinsipi sahifalar joylashuviga va ular 
orasidagi bir-biriga o'tishlarga qat’iy cheklashlar qo'yishga asoslanadi.

L , u

2.13-rasm. Iyerarxik struktura.
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Iyerarxik bo'ysunish prinsipi bo'yicha qurilgan tugunlar ancha katta 
moslashuvchanlikka ega. Kcrplab korxonalar. tashkilotlar Iyerarxik 
struktura chizm asi asosida qurilgan. Bu esa Iyerarxik strukturaning 
kamchiliklari va yutuqlari yaxshi o^'ganilganidan darak beradi. Bu 
strukturani ba’zan daraxtsimon struktura ham deyilib. bitta bosh o'zak 
(butun saytga kirish nuqtasi hisoblangan) sahifaga ega boiadi.

Har qanday ichki sahifa informatsion manba hisoblanib bosh sahifa 
bilan mantiqiy bog'langan bo'ladi.

K o‘p bog‘lanishli struktura

Ko‘p bogianish li strukturada hech qanday cheklanishlar boslmaydi. 
Ya'ni har bir sahifa boshqa barcha sahifalar bilan bog;langan bo'lishi 
kerak. Katta saytlarda tashrif buyuruvchilarning moMjal olishi uchun 
maxsus indeksatsiya tizimlari yoki saytning aylanish kartasi ifodalanishi 
kerak.

L — U

l ' ^

u u u u

2.14-rasm. Ko’p bog'lanishli struktura.

Materialning taqsimoti

Materialning Web-uzelda bo'limlar bo’yicha taqsimoti mantiqiy 
ravishda amalga oshirilishi kerak. Har bir sahifaga faqat belgilangan 
predmet yoki mavzudagi material joylanishi kerak. Tanlangan
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giperinatn ostida aynan shu mavzudagi hujjat borligi foydalanuvchining 
ishonchini vanada orttiradi. Ay rim hollarda buning aksini, va’ni 
tanlangan gipermatnga xos bo'lmagan hujjatning ochilishini ham ko'rish 
mumkin.

Saytni qismlarga boiishda ham maMumotning katta-kichikligiga, 
ma‘lum mavzu yoki predmetga xosligiga qarab boMish ham maqsadga 
muvofiqdir. Yuqorida aytilgandek biror sahifada bir predmet yoki 
mavzuga xos b o igan  matnlar bilan birga, rasmlar, jadvallar, ani- 
matsiyalar va boshqa ko'rinishdagi materiallarning ham shu boiim ga  
xosligi katta ahamiyatga ega. Ma’lumotlarning mos kelmasligi foyda- 
lanuvchilaming ishonchini yo'qotib, ularning sonini keskin kamaytirib 
yuboradi. Bunday holatga tushib qolmaslik uchun Web-dizaynerdan 
qunt bilan ishlashni talab qiladi. Agarda tayyorlanayotgan saytdagi 
materiallar Web-dizaynerga notanish mavzuda bo'lsa, u holda o'sha 
sohadagi biror yetuk mutaxassis bilan hamkorlikda ishlashga to‘g ‘ri 
keladi.

Web-saytlarni internetga joylash uchun manzil berish

Saytlarga internetda manzil berish uchun URL (Uniform Resource 
Locator) deb nomlanadigan ibora qo'llaniladi. URL-internetga mu- 
rojaat qilishning eng oddiy usuli boMib, u manzilni ifodalaydi. URL 
manzilidan ixtivoriy sondagi foydalanuvchi bir vaqtning o'zida 
foydalanishi mumkin. URL manzili qat'iy format asosida voziladi (2.15- 
rasm).

Протокол: / /  хост :порт /  путь /  файл #фрагмент

2.15-vasm. U RL manzili striikturasi.

Manzilni toiiqroq tushunish uchun quyidagi misolni ko‘rib chi- 
qamiz:

http://www.pedagog.uz/index.php

bu URL manzili tarkibiy qismlari quyidagicha:
http — resursdan foydalanishda gipermatn bayonnomasi ishlati- 

lavotganini bildiradi.

95

http://www.pedagog.uz/index.php


www.pedagog.uz -  malumotlar joylashgan Internet savt nomini 
bildiradi.

Index.php -  faylning kompyuterdagi to'la nomini bildiradi.
Manzilning asosiy tashkil qiluvchilarini ko'rib chiqamiz:
• Протокол — bayonnoma. Internet -  mijozlari va serverlarining 

bog'lanishi usulini tavsiflovchi qism. Odatda http (HyperText Transfer 
Protocol) gipermatnli uzatish maxsus bayounomasidan foydalaniladi. 
M anzil kichik lotin harflari bilan yoziladi (http://).

• И мя сервера. Bunda joylanadigan maMumotlarni saqlaydigan 
hisoblash tizimining (bu hisoblash tizimini server deb nom lash qabul 
qilingan) nomi ko'rsatiladi. Serverga berilgan ta’rifda ham -  tarmoq 
ishini nazorat qiluvchi kompyuter deb aytilganligi bejiz emas. Server 
nomi domen nomi kabi www bilan yoki usiz yozilishi mumkin. 
Masalan. www.macromedia.com. Boshqacha usulda nomni IP -  adres 
ko'rinishida ifodalash mumkin. Masalan. 199.227.52.143.

• Порт. Port raqamini ko'rsatish bitta server ichidagi jarayonni 
adresatsiya qilish uchun talab etiladi. Biroz vaqtdan keyin port 
ishlatiladi va uning raqamini tushirib qoldirish mumkin.

• Путь поиска. Kataloglar va ostki kataloglar zanjiri, faylning 
joylashgan o'rnini belgilaydi. Bu zanjirning elementlari «/» simvoli 
bilan ajratiladi.

• Файл. Faylning nomi uning kengaytmasi bilan birga yoziladi 
(faqat kengaytma so’ralgan platformada). Agarda faylning nomi tushirib 
qoldirilgan bo‘lsa, u holda Web-brauzer ko4rsatiladigan favlni qidiradi. 
Brauzer reaksiyasi va uning keyingi harakatlari faylning nomini 
kengaytirishga b og‘liq boTadi. Masalan, grafik fayllari GIF yoki JPG 
ko'rish dasturiga tasvirlarning yuklanishini boshlab beradi. Arxiv 
fayllar (ZIP, R A R  va boshqalar) bilan uyg^nlashgan kengaytmalar -  
m yoz kompyaiterida faylning saqlanishini boshlab beradi.

• Фрагмент. URL adresining fakultativ qismi. U # (panjara) 
maxsus simvoli bilan boshlanadi. Bu belgi gipermatnli hujjatning 
lavhasini ajratib ko'rsatuvchi maxsus belgidir. Tarkibga qcrshib qo'vish 
sim voli nomining kiritilishi butun sahifaga emas, balki uning ma'lum 
bir qismiga murojaat qilish imkonini beradi.

http bayonnomasi bo'yicha bogTanish Internet tarmog'ida eng ko'p 
tarqalgan usul. Internetdagi obyektlarning manzillarL aloqaning boshqa

96

http://www.pedagog.uz
http://www.macromedia.com


• Yuqoriga va pastga qaragan strelkalar esa tanlangan shriftni 
ro'yxatdagi holatini o'zgartirish, ya’ni yuqoriga va pastga yurish im- 
konini beradi.

Matn o‘lchamini belgilash

HTM Ida matn oMchamini qanday belgilash bilan tanishib chi- 
qamiz. Buning uchun <font> deskriptorida size atributi qoMlaniladi. 
Masalan, <font size = «4»> O'lchamni belgilashning absolyut tizimi </ 
font>. Bundan tashqari <body> deskriptori yordamida ham <basefont 
size = «qiymat»> shriftni belgilash mumkin. Bunda sizening qiy- 
matiga birdan to yettigacha bo'lgan har qanday qiymatni qo'yish 
mumkin.

Kattalashadigan o'lchamlarda esa size atributi qiymati oldiga + 
(kattalashtirish) yoki -  (kichiklashtirish) belgisi qo'yiladi. Nisbiy ti- 
zimda shriftni oMchamini o'zgartirishga misol keltiramiz:

<font size = «+l»>Nisbiy tizimda o'lchairK/fonP*
Shrift o’lchamini quyidagi y o l  bilan o'zgartirish mumkin:
1. Matnni belgilang yoki kiritiladigan joyga kursorni qo'ying.
2. Absolyut olcham ni belgilash uchun Text > Size (Текст > Раз

мер) buyrugMni bering yoki nisbiy tizimida o'lchamni berish uchun Text
> Size Change (Текст > Изменить размер) buyrug'ini bering. Ikkala 
buyruqni ham Property Inspector (Инспектор свойств) palitrasidan 
berish mumkin. Palitraning Size (Размер) ro'yxatida shrift olchamini 
o'zgartirishning barcha imkoniyatlari ko'rsatilgan.

3. Absolyut yoki o’sish oMchamini tanlang.

Matnlarga rang berish

Agar matnga biror rang berilmagan bo'lsa, u holda Windows 
operatsion tizimidagi yoki brauzerda tanlangan rang tasvirlanadi. 
Ko'prncha bu rang qora rang boMadi. Butun massivning simvollariga 
rang hujjatning asosiy ko'rsatkichlarida belgilanadi. Kokpincha hujjat 
varatib olingach, bu kabi ko’rsatkichlar kiritilib olinadi. Buning uchun 
yuqorida ko'rganimizdek M odify > Page Properties (Изменить > 
Свойства страницы) buyrug'ini berish kerak (CTRL+J). Har qanday 
simvollar to'plamiga alohida rang berish mumkin. Ranglarni saqlash
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uchun <font> deskriptorida color atributi ishlatiladi. Masalan, yashil- 
ko'k rangini belgilovchi kod quyidagicha yoziladi:

<font color=«#66FFFF»>bu moviy rangning kodi</font>
Shuni esda tutish kerakki HTML tilida rang o;n oltilik sanoq tizimi 

kodlari yordamida belgilanadi. Palitraning avrim elementlari o'zining 
nomiga ega. masalan green (ko'k). red (qizil) va boshqalar.

Dasturda ranglarni tanlashni Property Inspector (Инспектор 
свойств) palitrasidan foydalanib ham uskunaviy yo;l bilan belgilash 
mumkin. Bu jarayon xuddi boshqa matn muharrirlarida bajarilgandek 
boradi.

Matn maydoni -  sahifaning asosiy qismi hisoblanadi. Chunki har 
qanday Web-sahifaning asosiy belgilovchi qismi matnlar hisoblanadi.

Matnli maydonlar uch xil ko^inishda bo'ladi (2.22-rasm):
• Single line (Однострочное). Qisqa xabar yoki javoblarni kiritish 

uchun xizmat qiladi.
• Multi line (Многострочное). Ixtivoriy uzunlikdagi xabarni 

kiritish uchun mo’ljallangan.

Matnli maydonlar

поле

Нно гострочное  
тек стов ое поле

F

Submit I [7 jn ОИСК Обзор... I
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• Password (Пароль). Parolni kiritish uchun mo'ljallangan.
Matnning uchala ko’rinishi ham bitta buyruq yordamida qo'yiladi.

Ularni tiplarga ajratish esa Property Inspector (Инспектор свойств) 
palitrasi yordamida amalga oshiriladi. Buning uchun shu nomlardagi 
uchta qayta ulagich xizmat qiladi.

Single line main maydoni

Bitta qatordan tarkib topgan oddiy matn maydoni. U <input> 
deskriptori yordamida belgilanadi. Quyidagi misolda shunday obvektni 
ifodalovchi belgili kod qatori keltirilgan:

<input type = «text» name = «maydon_nomi»>

bu yerda type atributi may donning tipini bildiradi, name atributi esa 
obyektning nomini bildiradi.

Oddiy matn maydoni bilan bog4liq ko'rsatkichlar bilan tanishib 
chiqamiz:

• Text Field (Текстовое поле). Palitraning bu bo4limi matn may- 
donining nomini belgilaydi. Bu yerda maxsus belgilardan foydalanish, 
bir nomni takrorlash va maydonni bo'sh qoldirish ham mumkin emas.

• Char Width (Ширина в символах). Matn maydonining enini 
simvollar soni bo‘yicha belgilash. Odatda bu oicham 20 ta simvolni 
tashkil qiladi.

• Max Chars (Максимальный объем). Matn maydoniga kiriti- 
ladigan simvollarning maksinial soni.

• Init Val (Начальное значение). Bu maydonga qarab ko'rish 
dasturi sahifani birinchi yuklashdan kevin olib chiqadigan matn 
qatorini kiritish mumkin.

Password matn maydoni

Kiritilgan simvollarning oynada aks etmasligini ta’minlash maq- 
sadga mtvofiq bo'lgan holatlar ham mavjud. Ko^prncha bunday zamrat 
maxfiy axborotlarni, masalan. parollar yoki kalit so'zlarni kiritishda 
yuzaga keladi.

Password (Пароль) matn maydoniga kiritilgan ma’lumot faqat 
yulduzchalar ko'rinishida tasvirlanadi. Matn maydoni bunday xususivati 
bilan boshqa tipdagi matn maydonlaridan keskin farq qilib turadi.
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Multi Line matn maydoni

Katta hajmdagi matnli ma'lumotlarni kiritish uchun Multi Line 
(Многострочное) tipidagi maydonlar ishlatiladi. Bunday tipdagi 
obyektlarni varatish uchun, sahifaga matn maydoni qo'yish kerak. 
masalan Insert > Form Objects > Text Field (Вставка > Объекты форм
> Текстовое поле) buyrug'i yordamida. Xossalar paneli ochish va bu 
palitradan Multi Line (Многострочное) qayta ulagichni oling. Natijada, 
bir qatorli matn maydoni ko‘p qatorli matn maydoniga avlanadi. Uning 
uzunligi 18 simvoldan, balandligi esa 3 qatordan iborat.

B u  tipdagi obyektlar ishlash uchun yana Property Inspector (Ин
спектор свойств) palitrasiga murojat qilamiz:

• Text Field (Текстовое поле) -  ko'pqatorli maydonning nomi.
• Char Width (Ширина в символах) -  matn maydonining simvol- 

larda belgilanadigan kengligi.
• Num Lines (Число строк) -  matn maydonining qatorlar soni.
• Int Val (Начальное значение) -  maydonining boshlang'ich qiy- 

mati.
• Wrap (Перенос по словом) -  ko*p qatorli matn mavdonida 

matnni yangi qatorga ko'chirish imkoniyatlarini belgilaydi.

Savol va topshfriqlar:

1. Matnlarni formatlash jarayonida shriftni belgilash uchun qaysi 
deskriptordan foydalaniladi?

2. Shriftlar ro'vxatini tahrirlash ketma-keligini aytib bering?
3. Matn o'lchamini belgilash uchun qaysi deskriptordan foydalaniladi?
4. Matnlarga rang berish ketma-ketligini aytib bering?

2.10. Grafikli formatdagi fayllar bilan ishlash

Grafik tasvirlar ishtirokisiz tuziladigan hujjatlar juda kamchilikni 
tashkil qiladi. Ayniqsa Web -  sahifalarini rasmlar, logotiplarsiz tasavvur 
ham qilib bo4maydi. Bu kabi grafikli ma'lumotlarning turlari juda ham 
ko'p. Ularni faqat formati bo‘yicha ajratish mumkin. Masalan, birgina 
rasm degan ma?lumot ostida har xil formatdagi fayllar yotadi. Faylning 
formati deganda ma’lumotni yozish va saqlash uchun belgilangan
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standart qoidalar to'plami tushuniladi. Hozirda o'nlab grafikli formatlar 
mavjudki. ular turli tizimlarda har xil maqsadda qo'llaniladi. Grafikli 
formatlar uchta sinfga bcflinadi. Bular: rastrli, vektorli. metafaylli. Bu 
formatlar haqida keyingi boblarda batafsil ma’lumot berilgan.

Dasturning rasmlarni qo’yish imkoniyatlari

Rasmlar Web-sahifalarga jilo beruvchi vositalar hisoblanadi. 
Rasmlarni qo'yish -  bu oddiy texnik operatsiya hisoblanadi. Dasturda 
rasmlarni qo‘yishning bir nechta yo'llari bor. Avval rasmni qo‘yish 
buyruqlaridan bir ini tanlaymiz:

• Objects (Объекты) palitrasini oching, Common (Общие) bo*li- 
miga o‘ting? palitraning yuqori -  chap qismida joylashgan Insert Image 
(Вставка изображения) tugm asini bosing.

• Insert > Image (Вставка >  Изображение) buyrugMni bering.
• CTRL+ALT-rl tugmalar kombinatsiyasidan foydalaning.
• Tasvirni A ssets (Фонды) palitrasidan hujjat oynasining kerakli 

qismiga ko4chiring.
• Saytning dispetcheri oynasidan rasmning belgisini olib hujjatning 

oynasiga tashlang.
• Rasmni ish stolidan hujjat oynasining kerakli joyiga tashlang.
HTML tilida esa bu vazifalarni <img> deskriptori bajaradi. Bu

deskriptor rasmning barcha ko'rsatkichlarini belgilaydigan bir nechta 
atributlarni o;z ichiga oladi. Q uyidagi misolda deskriptor o'ziga to'q- 
qizta atributni bogklagan:

<img src = «Tem p/anim l.gif» \vidth = «170» height= «180» alt= 
= «Tushuncha» border = « l»  name = «ins» align = «right» vspace = «50» 
hspace = «60»>

Shuningdek qo'yilgan rasmga ramka ham qo'yish mumkin:
<img src = « 1 0.jpg» border =  «1»>
Bu misolda border atributi ramkaning qalinligini bildiradi.

Rasmni fon sifatida qo‘yish

Biz yuqorida gipermatnli hujjatning parametrlarida fonga rang 
tanlash. fonga rasm qo‘yish bilan tanishib chiqdik. Endi rasmlarni fon 
sifatida qo'yish bilan batafsil tanishib chiqamiz:
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1. Modify >  Page Properties (Изменить > Свойства страницы) 
buyrug‘ini bering.

2. Background Image (Фоновый рисунок) maydonida rasm faylini 
k o ‘rsating.

Xuddi shu vazifani HTML tilida <body> deskriptori vordamida 
bajariladi. Masalan, <bodv background = «iinage.jpg»> bunda rasm huj- 
jat saqlangan katalogda joylashgan.

<body background = «www.images.com/source/back.gif»> fragmenti 
esa  internetning ko'rsatilgan manzilidagi rasmni fon sifatida qo’vib 
be radi.

Interfaol rasmlar

Hozirgi kunga kelib rasmlar va animatsivalarsiz sahifalarni 
uchratish juda qiyin. Aksariyat Web-sahifalar animatsiyalar. animatsion 
tugmalar yoki harakatlanish tugmalaru rasmlar, interfaol rasmlar bilan 
boyitilgan.

Interfaol rasmlar so*zi «rollover image» iborasidan olingan bo'lib 
so^zma-so'z tarjimada «tasvirni ko'chirib o'tkazish» ma'nosini bil- 
diradi. Agar W eb-sahifada biror rasm ustiga sichqon ko'rsatkichini 
o lib  borganingizda boshqa rasm paydo bo'lsa bilingki u rasm 
interfaol rasmdir. Interfaol rasmlarni qo'yish quyidagi y o i bilan 
bajariladi:

1. Matn kursorini rasm qo4yiladigan joyga qo’ying.
2. Insert > Interactive Image > Rollover Image (Вставка > Дина

мические изображения > Интерактивное изображение) buvrug'ini 
bering. 2.23-rasmda ko'rsatilgan muloqot oynasi hosil bo’ladi.

3. Bu muloqot oynasining tegishli maydonlarini toidiring:
° Image Name (Имя изображения) maydonda rasmning nomi 

ko^rsatiladi.
0 Original Image (Исходное изображение). Joriy holatda ko'- 

rinadigan rasmning nomi ko'rsatiladi.
° Rollover Image (Интерактивное изображение). Sichqon ko'rsat- 

kichi kelishi bilan almashinadigan rasmni nomini ifodalaydi.
0 Preload Rollover Image (Предварительная загрузка) -  bu 

bayroqcha rasmni kobrish dasturlarida yuklash rejimini ishga tu- 
shiradi.
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Insert Rollover Image

Image Name: PffiEBBET

Original Image: [

Rollover Image: f Browse... |

I* ' Preload Rollover Image

When Clicked, Go To URL: \ Browse... |

2.23-rcism. Interfaol rasmni qo’yish oynasi.

с When Clicked Go To URL (переход по адрес}) -  bu yerda 
gipermatnli o'tish buy rug' i saqlanadi.

4. Tegishli ko'rsatkichlar kiritilgandan so'ng OK tugmachasini 
bosing yoki klaviaturadan ENTER tugmasini bosing.

Dreamweaver dasturi rasmlarning dinamik almashinuvini ko'rsat- 
mavdi. Bu jarayonni faqat brauzer dasturlarida ko'rish mumkin. Brauzer 
dasturlarini chaqirishning eng qisqa yo‘li F12 tugmasini bosishdir.

Jadvallar -  matnli \ a  grafikli maMumotlarni saqlash uchun tayyor 
forma hisoblanadi. Bundan tashqari sahifalarda rasmlarni birlashtirish 
uchun, matn ostiga rasm qo'yish uchun ham jadval kataklaridan 
foydalanish mumkin. Qatordagi ikkita yonma-yon joylashgan katak- 
chalardan kolonka sifatida foydalansa boiadi. Bir katakli jadvaldan

Savol va topslxiriqlar:

1. Rastrli fo rm atla r nim a?
2. V ektorli fo rm atlar n im a?

3. Metafay lia r nima?

4. Sahifaga rasm qo’y is h  ke tm a-ke tlig in i aytib  bering?

2.11. Jadvallar qo‘yish va ular bilan ishlash
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tortib to  murakkab jadvalgacha — bularning barchasi qatoi\ ustun, 
katakchalarning oddiy koinbinatsiyasidan tuzilgaa.

HTM L tilida jadvalga tegishli barcha amallar yoki ma’lumotlar 
<table> </table> deskriptorlar juftligi orqali ifodalanadi. Bu deskrip- 
torning ko‘plab atributlari mavjud. Bu atributlar yordamida jadvalning 
eni? foni rangi, chegarasi. tekislash, maydon. kataklar orasidagi masofa 
va boshqa ko4rsatkichlarni belgilash mumkin. Biz yuqorida HTMLda 
jadvallarni qo'yishning barcha imkoniyatlari bilan tanishib chiqdik. 
Endi esa Dreamweaverda jadval qcTyish bilan tanishib chiqamiz.

Jadval qo'yish -  bu uncha qiyin bo'lmagan texnik jarayondir. 
Dreamweaverda jadval qo;yish uchun quyidagi ketma-ketlik bajariladi:

1. Jadval quyilishi kerak bcflgan joyga kursorni qo4ying.
2. Insert > Table (Вставка > Таблица) buyrug‘ini bering. Bu 

buyruqni bajarishning alternativ variantlari ham bor:
о CTRL-t-ALT+T tugmalar kombinatsiyasi;
о Object (Объекты) palitrasidagi Common (Обшие) bo'limining 

Insert Table (Вставить таблицу) tugmasini bosisli bilan;
3. Insert Table (Вставка таблицы) muloqot ovnasi maydonlarini 

to4diring (2.24-rasm). Bu oynaning boshqaruv elementlarini ko'rib 
chiqamiz:

Jadval qo‘yish

Rom: В— Cell Padding:
OK I

Cancel
Columns: Cell Spacing:

Help

Width: p5

Border: [T
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о Rows (Строки). Jadvalning qatorlari soni.
° Colums (Столбцы). Jadvalning ustunlari soni.
0 Width (Ширина). Jadvalning eni.
° Border (Рамка). Наг b ir  katakchaning va butun jadvalning 

chegara ramkalari en i. Piksellarda beriladi.
° Cell Padding (Поля ячейки). Katakcha chegarasi va ichidagi 

ma'lumot orasidagi maydon kattaligi.
° Cell Spacing (Расстояние между ячейками). Kataklar orasidagi 

masofa.
4. OK tugmasini bosing.
Ixtiyoriv ko'rsatkichli jadval qokyilgandan keyin, uni toMdirish 

vaqtida voki undan keyin ham crzgartirish mumkin.

Jadvalli ma’lumotlarni import qilish

Dreamweaver dasturida tashqi matnli fayllarni o'qish va undagi 
jadvallarni o'girib olish uchun maxsus buyruqlar mavjud. Jadvalli 
ma'lumotlarni import qilish quyidagicha amalga oshiriladi:

1. File > Import > Import Tabular Data (Файл > Импорт > Импорт 
табличных данны х) b uyrugin i bering.

2. Import Table Data (И мпорт табличных данных) muloqot oynasi 
hosil bo'ladi (2 .26 -rasm). Bu muloqot oynasining asosiy boshqaruv 
elementlari bilan tanishib chiqamiz:

о Data File (Файл данных). Bu maydonga jadvalli ma’lumot 
joylashgan fay Ini qidirish uchun to'liq yoT ko‘rsatiladi.

° Delimiter (Разделитель). Bu ro'yxatda matnli fayldagi jadvalni 
boluvchisi kiritiladi. Ro‘yxat o'z ichiga quyidagi bandlarni oladi: Tab 
(Символ табуляции), Com m a (Запятая), Semicolon (Точка с запя
той), Colon (Двоеточие), Other (Другой).

° Fit to Data (П одбирается по данным). Agar bu qayta ulagich 
o'rnatilgan bo‘lsa, jadval kengiligi har bir ustunda eng uzun qator 
oicham i bo‘yicha tanlab olinadi.

о Set (Равна). Agar bu qayta ulagich o'rnatilgan bo'lsa, u holda 
jadvalning enini oldindan belgilash mumkin bo'ladi.

° Cell Padding (Поля ячейки). Katakcha tashkil etuvchilari va 
chegarasi orasidagi masofani belgilaydi.
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Formal None 

Link

v  _Д Def ault Font

Cell Ногг Default v  V 

4 1 Vert Default v  H

v  Size None v  I ^ 

v  Q < _ j Targe;

No Vrap ¡^2 Bq 

Header Bg ^ Brdr

(i'j
\i

2.25-rastn. Property Inspector palitrasi.

Г1ШД1ШИМ11

Browse...Data File: (file.///Ll/Sook/Chapter 2/1.him 

Delimiter: ) Tab ~^|

Table Width: Fit to Data

^  Set: | (percent

Cell Padding: | Format Top Row: | [No Fornatting] ^ 1

Cell Spacing: j Border: 1

OK

Cancel

Help

2.26-rasm. Jadvalli ma'Iumotlarni import qilish.

c Cell Spacing (Расстояние между ячейками). Jadvalning yonma- 
y o n  turgan kataklari orasidagi masofani belgilavdi.

о Format Top Row (Форматирование верхней строки). Jad
valn ing  birinchi qatorini formatlash uchun to'rtta variantni taklif qi- 
lad i.

c Border (Рамка). Bu yerda jadvalning chegaraviy ramkasining 
qalinligi belgilanadi. Agar ramka zarur bo'lmasa u holda bu maydonda 
nol ko'rsatish kerak.

3. OK tugm asini bosing.
Agar m uloqot oynasida ko'rsatilgan jadval tashkil qiluvchilari matnli 

fayldagi jadval tashkil qiluvchilariga to'g^i kelmasa, u holda jadvalni 
import qilish n o to ^ r i bajariladi. Aniqroq aytganda jadval buzilgan 
holda ko'chadi.
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Savol va topshiriqlar:

1. Jadvallar bilan ishlashda qaysi deskriptorlardan foydalaniladi?
2. Jadval qo'yish ketma-ketligini aytib bering?
3. Jadvalli ma'lumotlarni import qilish qanday amalga oshiriladi?
4. Jadvalga qator \ok i ustun qo'shish va ularni o‘chirish qanday amalga 

oshiriladi?

2.12, Sahifalarni brauzerlarda ko‘rish

Dreamweaver HTM L -  sahifalarni vizual tahrirlash dasturlari sin- 
figa kiradi. Dreamweaver dasturi HTML sahifalarni maxsus dasturlar 
yordamida tabiiy tasvirlarga yaqin ko'rinishda ko'rsata oladi. Bunday 
dasturlar brauzer dasturlari deb vuritiladi. Biz bu dasturlar haqida 
yuqorida batafsil ma'lumot bergan edik. Brauzerlarda ko'rish ketma- 
ketligi bilan tanishib chiqamiz:

1. Sahifani brauzerda ko4rish uchun File > Preview in Browser 
(Файл >  Просмотр в браузере) buyrug'ini bering;

2. Ochilgan ovnadan brauzerni tanlang:
Bu buyruq hujjat oynasida ham. uzel dispetcheri oynasida ham 

mavjud. Asosiy brauzerni yuklash uchun F12 tugmasi xizmat qiladi. 
Asosiy va yordamchi brauzerlarni tanlash quyidagicha:

1. File > Preview in  Browser > Edit Browsers List (Файл > про
смотр в браузере > Изменить список браузеров) yoki Edit > 
Preferences (Правка > Настройки) buyrug’ini bering. Qaysi buyruqni 
berishdan qat’iy nazar, ekranda Preferences (Настройки) muloqot oynasi 
hosil bo4ladi;

2. Bii muloqot oynasida barcha tegishli ko'rsatkichlarni kiriting va 
ularni o'rnatilishi uchun OK tugmasini bosing.

• -  belgisi ostidagi tugma. hisobga olingan ko'rish dasturlari 
ro’yxatiga yangi brauzerni qo'shadi;

• -  belgisi ostidagi tugma tanlangan brauzerni ro4yxatdan o6chi=- 
radi;

• Edit (Изменить) tugm asi ro'yxatga olingan brauzer parametrlarini 
o'zgartirishga imkon beradi;

• Primary Browser (Первичный браузер) bavroqchasi ro'yxatda 
tanlangan dasturni birinchi darajali brauzerga aylantiradi (birinchi 
darajali brauzerni chaqirish uchun F12 tugmasini bosish kerak);
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• Secondary Browser (Вторичный браузер) bayroqchasi ikkin- 
chi darajali brauzerni tanlaydi. Bu vazifa CTRL-F12 tugmalar 
kombinatsiyasi yordamida bajariladi;

• Preview Using Local Server (Просмотр нелокальном серве
ре) bayroqcha yordamida lokal server yordamida sahifalarni ko'rish 
rejimini crrnatish yoki olib tashlash mumkin. Barcha serverga tegishli 
dasturiy tam inot lokal kompyuterga oldindan o’rnatilgan bo'lishi lozim.

Dasturning bunday imkoniyatlari web-sahifani tayyorlash ja- 
rayonining o‘zida ko4rish uchun qulaylik yaratib beradi. Bunda 
foydalanuvchi nafaqat bitta, balki bir nechta brauzerdan bittasini tanlash 
imkoniyatiga ega bo‘ladi. Brauzerlar sahifani bir xil ko'rsatsada, ammo 
ulardan foydalanish, boshqarish va interfeys har xil bo’ladi. Shuning 
uchun ham foydalanuvchi o*zi xohlagan brauzerni tanlash imkoniyatiga 
ega bo'ladi.

Savol va topshiriqlar:

1. Sahifani brauzer dasturida ko’rish uchun qanday buyruq beriladi?
2. Asosiy va yordamchi brauzerlarni tanlash ketma-ketligini aytib be

ring?
3. Preferences (Настройки) muloqot oynasi tuzilishini tushuntirib 

bering?
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Ill-bob. KOMPYUTER GRAFIKASI VA DIZAYN

3.1. Kompyuter grafikasi va dizayn

Bizga m alum ki web dizaynning ajralmas qismi bu kompyuter 
grafikasi hisoblanadi. Boshqacha aytganda kompyuter grafikasi 
yordamida saytiarni dizayn i mukamallashtiriladi. Saytlarni be- 
zash uchun turli xil illustratsiyalar (rasmlar. grafiklar, roliklar. 
animatsiyalar. bannerlar va boshqalar) yaratishda va tayyor grafik 
formatdagi ma'lumotlarni o'zgartirishda kompyuter grafikasidan 
keng foydalaniladi. Kompyuter grafikasi va uning tarkibiy qismi 
bowlgan grafik va turli tasvirlar axborot texnologiyasida muhim o’rinni 
egallaydi. P ed a g o g ik a  o liy  ta ' l im  n tu assasa larida  ta 'lim  o layotgan  
ta labalarga  k o m p y u te r  g ra f ik a  va dizayn  fa n la r in i o (rg a n ish , 
alarga  grafik a x b o ro t te x n o lo g iy a la r i b a q id a g i b ilim larn i b era d i va  
p ro fessio n a l f ao liy a tid a  u!arelan sa m a ra li fo yd a la n ish g a  ta yyo rla yd i. 
B osh qach a  a y tg a n d a  lia r  q a n d a y  boUajak o ‘qituvchi, k e la jakda  
c o in in g  fa n i  b o y ic l ta  e le k tro n  o'quv resu rsla rin i y a ra ta  o lish i 
kerak. B u  bilan  esa  ta 'lim  sa m a ra d o rlig ig a  erish iladi. 0 (q itu vch i 
clasturlash tex n o lo g iya s id a n  y a x s h i  x a b a rd o r  b o 6lish i lozim . A m m o  
u y  a raigan re su rs la r i  ta la b a la r n i o 'ziga  to rta  digan dizayn  b ilan  
boyitilm agan  bo'Isa , u holcia h a r  qan day dastu riy  m ah su lo tn in g  
d q itish  ja ra y o n id a g i sa m a ra d o r lig i  p a s t  b o ‘ladL S h u n in g  uchun  
ham  dasturlash  b ila n  birga k o m p y u te r  g ra fik a sin i h am  m u k a m m a l 
c'rganish  talab q i l in a d i .

Kompyuter grafikasi va dizayn fanidagi materallarni o;rganish 
natijasida quyidagilarni bajara olish mumkin:

-  rasmlar bilan ishlash:
-  ko'p bo'gïn li statik rasmlar bilan ishlash;
-  grafik muharrirlar imkoniyatlaridan fovdalanish;



-  turli maqsadlardagi graftkli paketlarni qo'llagan holda rang- 
barang grafik obyektlarni varatish;

-  nashrga tasvirlarni tayvorlash.
Kompyuter grafikasi fani asosan elektron rasm va tasvirlar bilan 

ishlashni cfrgatadi. Hozirgi kunda grafik dasturlar soni juda ko*p 
boMib ular ishlash prinsipiga ko4ra har xil grafikada ishlashi inumkin. 
Masalan: Rastrli grafika bikn ishlovchi dasturlar Paint, Adobe 
Photoshop, CorelPhotoPaint va boshqalar (grafik muharrirlarning 
um um iy ro‘yxati 3.1-jadval).

3.1-jacival

Grafik muharrirlar ro‘yxati

№. Grafik muharrir Izoh

1. Adobe Photoshop Rastrli grafikani qayta ishlash uchun 
mo'ljallangan

2. TwistedBrush Pro Studio 
15.74

Tasvirlarni chizish va tahrirlashga 
mo'ljallangan grafik muharrir

3. CorelDraw Graphics Suite X4 Vektorli grafika bilan ishlashga mo*l- 
jallangan grafik muharrir

4. CorelDraw Graphics Suite X4 3D-modellashtirish. animatsiya va vi- 
zualizatsiya uchun mo'ljallangan

5. Adobe Flash CS3 Professional Professional animatsiyali Flash-fay 1- 
larni varatish uchun moMjallangan 
dastur.

6. Paint.NET Grafik muharrir (standart Paint das- 
turini o’rnini bosuvchi)

7. AutoCAD 2010 Eng murakkab loyihalarni chizishga 
mo'ljallangan dastur

8. Adobe Illustrator С S3 Har qanday murakkablikdagi vektorli 
tasvirlarni yaratishga mo'ljallangan

9. Adobe Creative Suite 5
Master Collection..................................... !

Loyihalarni chizish va qayta ishlashga 
mo'ljallangan dastur
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10. ZBrush 3.0 Ikki va uch o‘lchamli loyihalashga 
mo'ljallangan grafik muharrir

11. The GIMP Rastrli grafik muharrir

12. Adobe InDesign CS3 Har qanday dizayndagi chop etiladigan 
va Internet nashrlarini loyihalashga 
moijallangan professional dastur

13. Xara Xtreme Pro rastrli va vektorli grafikani qoilagan 
holda professional web-grafikani 
yaratish uchun mo'ljallangan grafik 
muharrir

14. Adobe Firew orks С S3 Web-saytlar uchun grafikani tayyor- 
lashga va mo'ljallangan grafik mu
harrir

15. Corel Painter 11 Ill\ ustratsiyalar chizish va tayyor- 
lashga mo'ljallangan dastur

Rastrli grafik muharrirlarida har bir tasvir nuqta ya'ni piksel asosida 
quriladi. Bu dasturlar yordamida yaratilgan fayllar *.bmp, *.jpg, *.psd, 
*.tif \a  boshqa formatlarda saqlanishi mumkin. Bu turdagi fayllar 
ranglari vorqinligining juda sifatliligi bilan ajralib turadi, ularning 
kamchiligi sifatida esa tasvirni kattalashtirish bilan uning sifati yo'qolib 
borishini va xotiradan ko4p joy egallashligini aytib o4tish lozim. Shuning 
uchun ko'pincha ulardan tayyor rasmlarni qavta ishlashda foydalanish 
tavsiya qilinadi.

3.2. Axborot va uni taqdim etishning turli ko‘rinishlari

Hozirgi kunda inson faoliyatining turli sohalari ichida o'zining 
muhimligi bilan ajralib turuvchi soha -  bu tashkiliy, ya'ni ishlab 
chiqarish va xo'jalik hamda ijtimoiy jarayonlarni boshqaruv sohasidir. 
Busiz barcha sohalarda faoliyat yuritib bo'lmaydi. Boshqaruv axboroti 
jarayon hisoblanib, tizimlar holatini qanday o'zgarishiga qarab qo'yilgan 
maqsadga erishish uchun vetakchi yo'nalishdir. Har qanday tizim to‘g ‘ri 
va teskari aloqa taniovilidan iborat.
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Ma’lumki, insonlar bir-biriga axborotlarni uzatish jarayonida matn, 
jadval, tovush va tasvir ko'rinishdagi signallardan foydalanadi.

Axborotlarni uzatish turli xil usullarda, ya’ni xabarchi yordamida, 
pochta orqali. transport vositalari vordamida. aloqa tarmog'idan uzoq 
masofaga uzatish yordamida amalga oshiriladi. Aloqa tarmog'i bo’yicha 
uzoq m asofaga uzatish usulida malumotlarni uzatish vaqtini sezilarli 
darajada kamaytiradi. Buning uchun maxsus texnika vositalari mavjud. 
Axborotlarni y ig ‘ish va hisobga olishni texnik vositalari ish joyida 
o‘rnatilgan datchiklar yordamida axborotlarni avtomatik ravishda 
yig‘adi, hamda kompyuterga uzatadi.

Matn ko‘rinishda berilgan axborotlarni qayta ishlash texnologiyalari

Ma’lumki, eng ko'p tarqalgan kompyuter texnologiyalari quyi- 
dagilardan iborat:

-  matnli malumotlarni tahrir qilish;
-  jadval v a  grafik ko'rinishdagi ma’lumotlarga ishlov berish.
Matnlar bilan ishlash uchun matn muharrirlaridan foydalaniladi.

Hozirgi paytda ko'plab matn muharrirlari ishlab chiqilgan. Umuman 
ularning vazifasi bitta ammo, beradigan imkoniyatlari va ularni 
amalga oshirish vositalari turlicha. Bu grafik muharrirlari va elektron 
jadvallarga ham tegishlidir.

Formatlash vositasining yordamidan foydalanib hujjatni tashqi 
ko'rinishini yaratish, stilini cfzgartirish. tagiga chizish. kursiv harflarini 
ajratish, simvollar o’lchamlarini o'zgartirish, satr boshini ajratishi, 
ularni o‘ng, chap tomonlari va markazga nisbatan tekislash va ramka 
(hoshiya) ichiga olish mumkin.

Jadval ko^inishda berilgan axborotlarni qayta ishlash texnologiyalari

Jadval ko‘rinishidagi hujjatlar har qanday korxonada hujjat 
aylanishining katta qismini tashkil qiladi. Elektron jadval kompyuter 
xotirasida joylashgan ikki o£lchamli massivning satrlari va ustunlarini 
o;zida ifodalaydi.

Jadval muharrirlari koplab moliyaviy va ma’muriy masalalarni 
yechish imkonini beradi. Masalan, oylik maoshni hisoblash va boshqa 
hisobga olish masalalari: sotuv hajmini, bozor o'sishini. daromadlarni
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uslublarini va bayonnomalarini o 'z  ichiga olishi mumkin. Ulardan bir 
nechtasini sanab o'tamiz.

2. l-jadvcd

Bayonnoma
nomi

Yozish
qoidasi Qo‘llanish sohasi

FTP ftp:// Fayllarni uzatish bayonnomasi. FTR-serveri bilan 
bogianish uchun qo41aniladi

File file:// Kompyuter yoki lokal tarmoqda berilgan fayl- 
larga boglanish bayonnomasi

Gopher gopher:// Gopher serveriga bog'lanish bayonnomasi

JavaScript javascript: JavaScript tilida yozilgan dasturni chaqirish

Mailto mailto: Elektron pochta manzili

Newt news: Telekonferensiyalarga bog'lanish bayonnomasi

Telnet telnet:
i

kompyuterga bog'lanish bayonnomasi

Internetning bugungi om m aviyligini tushuntiruvchi sabablardan 
biri HTTP bavonnomasi imkoniyatlarining kengligidir. 0 ‘zidan avvalgi 
avlodlarining ba’zi bayonnomalarini u butunlay yutib yuboradi. 
Ba'zilarini esa shunchaki siqib chiqaradi va ko‘rgazmali grafik inter- 
feys yordamida qo'llab-quvvatlash yo‘li bilan yaxshiroq imkoniyat 
yaratadi.

Lakai uzel yaratish. Uzel kartasi

Dreamweaver dasturida saytlar va sahifalar yaratishning har 
xil yoilari bor. Bulardan saytlarni yaratish bo'yicha eng mashhur 
texnologiyani ko'rib chiqamiz. Buning uchun quyidagi ketma-ketlikni 
bajaramiz:

• saytning lokal versiyasini yaratish;
7 -  ¡’eJ a g o g ik  w eb-J izayn 91



• lokal versiyani Internet tarmog'iga joylash.
Lokal uzel -  bu foydalanuvclii yoki foydalanuvchilarning kompyu- 

terida joylashgan haqiqiy virtual Web-uzelning versiyasidir. Lokal uzel 
tarmoqdan koTinmaydi. unga faqat mualliflarigina bogHana olishlari 
rnumkin.

Lokal uzelning ma'lumotlari diskdagi belgilangan katalog ichida 
saqlanadi. Bu katalog vazifasini diskdagi har qanday katalog bajarishi 
mumkin. Yangi lokal uzel hosil qilish uchun quyidagi ketma-ketliklarni 
bajaring:

1. Site > New Site (Сайт > Создать) buyrug'ini bering. Ekranda 
2.16-rasmda ko'rsatilgan Site Definition (Определение сайта) muloqot 
oynasi hosil bo^adi.

2. Ovnaning chap qismidan Local info (Информация о локальном 
узле) boiim in i tanlang. Maydonning qiymatini kiriting.

3. Remote Info (Сведения об удаленном сервере) kategoriyasiga 
sayt saqlanayotgan server haqidagi ma'lumotlarni kiriting.

Category Local Info

Fiem-ve ln;o 
Design Note*
Site Map Layoi.jf 
File View Column* Local Root Folder: jr •'•Program Fi!e$\Macrornedia\Dreamweav _J 

V? Refresh Local File List Automatically

Site Name:

HT TP Address: [hiï^
This address enables the Link Checker to 
detect HTTP links that refer to your own 
site.

Cache: F7 Enable Cache
The cache maintains file and asset 
information in the site. This speeds up the 
Asset panel, link management, and Site Map 
features.

OK I Cancel | Help |
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4. Muloqot oynasining yuqorida sanalgan maydonlar to"ldirilishi 
shart. Site Map Layout (Планировка карты узла). Design Notes 
(Комментарии разработчика) v a  File View Columns (Колонки ото
бражения файловых атрибутов) maydonlari toMdirilishi shart emas 
(foydalanuvchi o'z xohishiga qarab toldirishi mumkin).

5. Barcha kerakli ma’lumotlar kiritilgach OK tugmasini sichqoncha 
yordamida bosing yoki ENTER tugm asini bosing.

Uzel kartasi

Uzel kartasi -  lokal uzel yaratishning qulay interfaol vositasi 
hisoblanib, unda ko’plab texnik qiyinchiliklarga ega bo'lgan topshiriqlar 
grafikli ko‘rinishda yengillik bilan amalga oshiriladi. Bu rejimda 
saytning kartasi tasvirlanadi. U zel dispetcheri oynasi ikki qismga 
boiingan. Chap tomonda uzelning kartasi kiritiladi (Kartada -  sahifa 
belgilari HTML fayllarni ifodalaydi). Ffujjatlar orasidagi gipermatnli 
bog'lanishlarni strelkalar ifodalaydi.

O'ng tomonda esa uzelning fayllar va kataloglar ro’yxati beriladi. 
Kartaning ko‘rinishi organizatsion diagrammani eslatib yuboradi. Kartada 
ikki darajani ko*rish mumkin. Yuqori darajani uzelning asosiy sahifasi 
egallaydi. Quyi darajada esa unga tegishli va o'zaro giperbog'lanishga ega 
sahifalar tushuniladi. Uzelning gipermatnli hujjatlaridagi bogManishlar 
ko'k rangda tasvirlanadi. Agar bogManishda ko'rsatilgan fayl kengaytmasi 
.HTM, .HTML va boshqa shu formatdagilardan farq qilsa u holda yashil 
rangda tasvirlanadi. Agar bogManishda qo‘pol xatoliklar bo'lsa. u holda 
bog'lanish qizil rangda ifodalanadi. Tashqi fayllar, boshqa fayllarda 
jovlashgan fayllar va maxsus bog'lanishlar (masalan, mailto: yoki 
javascript:) globus ko'rinishidagi maxsus belgi oladi. Bulardan tashqari 
agar ko'k rangli belgi qo‘yilgan boMsa -  bu fayl foydalanuvchining o‘zi 
tomonidan taqiqlanganini bildiradi. Q ulf belgisi ostidagi belgi faqat 
o'qish uchun moijallangan fayllarni bitdiradi.

Savol v a  topshiriqlar:

1. Lokal uzel nima?
2. Lokal uzel hosil qilish ketma-ketligini avtib bering?
3. Uzel kartasi nima?
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2.5. Hujjatlarga havolalar o‘rnatish va olib tashlash

Tegishli hujjatga havola o'rnatish unchalik murakkab emas. Bun- 
da foydalanuvchini chalkashtiradigan eng asosiy muammo -  bu ope- 
ratsiyani bajarish usul va uslublarining ko'pligidir. Qachonki biror 
hujjatga yoki sahifaga havola o'rnatmoqchi bo;lsangiz, buning uchun 
quyidagi uch holatdan birini belgilash kerak. Ular bir-bii idan faylning 
holati va yuklanish texnikasi bilan farq qiladi.

• Havola uchun ko'rsatilgan hujjat uzelning hisobidagi obyekt 
sanaladi. Ya’ni faylning nomi fayllar va papkalar ro'yxatidan iborat 
uzelning kartasi va panelida ifodalanadi. Bunday favlga havola o'rnatish 
uchun asosiy hujjatni tanlash. sichqoncha yordamida marker ko'rsat- 
kich bog'lab olib. uni tegishli hujjatga olib o'tish lozim. Marker- 
ko'rsatkich -  bu havola o’rnatish uchun maxsus interfaol vosita hi- 
soblanadi. Markerni uzel dispetcherining har qandav paneliga (kartaga 
yoki fayllar nryxatiga) surib kelish mumkin.

• Butun hujjat saytning tarkibiga kiradi, ammo uning ro'y- 
xatidan o'tmagan. Ya’ni uning nomi o*ng paneldagi fayllar ro'yxatida 
mavjud, ammo u uzel kartasida yo'q. Bunday holatlarda marker кот- 
satkichni o'ng panel ustiga surish va uni fayl nomi ustiga tashlash 
kerak.

• Butun hujjat saytga kirmagan. Bunday holatda marker-ko'rsat- 
kichini surishni teskari yo'nalishini qo'llash kerak.

Havolani obzgartirish

Havolalarni o‘zgartirish uchun eski boglanishga tegishli ko'rsat- 
kichlarni o'chirib tashlab, yangi faylga tegishli ko'rsatkichlarni kiritish 
mumkin. Ammo Dreamweaverda buni o’zgartirish uchun maxsus 
vositalar mavjud:

1. Uzel kartasidan hujjat belgisini tanlang;
2. Uzel dispetcheri oynasidan Site > Change Link (Сайт > Из

менить ссылку) buyrug'ini bering. Xuddi shu buyruqni -  CTRL^L 
tugmalar kombinatsiyasi yordamida ham berish mumkin;

3. Select HTML Files (Выбор гипертекстовых файлов) muloqot 
oynasi ochiladi. Unda yangi faylning nomi va joylashgan katalogini 
k o ’rsatish kerak:
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Ichange Link Sitew ide (Site - Unnamed Site 3 copy) ]

Change All Links T o: OK

1 - I Cancel
Into Links To:

1 Help 1

2.17-rasm. Bog'lanishni yangilash.

4. Fayl tanlangandan keyin, Dreamweaver dasturi Update Files 
(Обновление файлов) muloqot oynasi ochiladi. Barcha o^garishlarni 
qo4shish uchun Update (Обновить) tugmasini bosing.

Agar bir nechta hujjatlar bilan bitta hujjat o‘rtasida bogManish 
o ’rnatmoqchi b o isan giz  buning uchun maxsus buyruq mavjud. Bu 
buyruq yordamida barcha obvektlardagi havolalarni global tarzda 
o'zgartirish mumkin. U barcha gipermatnli havolalardagi ko'rsatilgan 
faylni nomini 0 ‘zgartirib chiqadi.

1. Uzel dispetcheri oynasi ni oching;
2. O'zgartirilishi kerak bo'lgan hujjatni oling;
3. Site > Change Link Sitewide (Сайт > Изменить связи по всему 

сайту) buyrug'ini bering. Shu nomdagi muloqot oynasi ochiladi (2.18- 
rasm).

Change Link Sitew ide (S ite  - Unnamed Sile 3 copy)

Change All Links To:

- Г

Into Links To:

OK

Cancel

Help

2.18-rasm. H avo lan i global o'zgaitinsh .
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1. Tanlangan faylning nomi Change All Links To (Изменить все 
ссылки на) maydonida ifodalanadi. Yangi faylning nomini Into Links 
To (На ссылки на) maydoniga kiritish yoki standart protseduralar 
yordamida tanlash mumkin.

2. OK tugmasini (кнопка) bosing yoki ENTER (клавиша) tug- 
masini bosing.

3. Update Files (Обновление файлов) muloqot oynasi ochiladi, 
bunda bog'lanishga ega va ayni vaqtda yangilanishni talab etadigan, 
fay liar nomi aks etadi. Favllarni tanlang va ularga tegishli havolani 
o4rnating.

Change Link Sitewide (Изменить связи по всему сайту) buyrug‘i 
ham  havolalarni ommaviy alinashtirish uchun juda qulay. Masalan. 
bunday almashtirishlarni ko'pincha saytning barcha sahifalaridagi 
elektron pochta adresini almashtirish uchun qo'llash mumkin.

1. Change A ll Links To (Изменить все ссылки на) maydoniga 
o'zgartirilishi kerak bolgan havolani toiiqkiriting.

2. Into Links To (На ссылки) maydoniga to‘liq yangi havolani 
kiriting.

3. OK tugmasini bosing.

Havolani olib tasblash

Havolani olib tashlashni bir nechta usullari mavjud. Masalan. 
havolaga tegishli, ya'ni manba hisoblangan hujjat favlini ochish va 
uni oddiy yo4l bilan oxhirib tashlash mumkin. Bu usul balki noqulay 
tuyulishi mumkin, ammo maksimal aniqlikda bo'ladi. Uzel dispetcheri 
orqali amalga oshiriladigan bogianishni olib tashlash usulini kobrib 
chiqamiz:

1. Uzel dispetcheri oynasini oching;
2. Uzel kartasidan bogTanishni ko'rsatuvchi hujjat belgisini oling;
3. Site > Remove Link (Сайг > Удалить ссылку) buyrug’ini bering. 

Bu buyruqning klaviaturada ikkita ekvivalenti bor: CTRL-bSHIFT-^L 
tugmalar kombinatsiyasi yordamida ham berish mumkin.

Sarlavhani o‘zgartirish

Dreamweaver dasturi HTML hujjatining sarlavhasini uzel dis
petcheri oynasida almashtirish (o'zgartirish) imkonini beradi. Shuni esa 
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tutish kerakki gipermatnli hujjatning sarlavhasini <title> deskriptori 
belgilaydi. Bu matn qatori hujjatning nomi hisoblanadi va qidiruv 
tizimlarida hujjatni indeksatsiyalashda muhim rol o'ynaydi. Eng 
mashhur internet Explorer va Netscape Navigator brauzerlar sarlavhani 
dastur oynasining sarlavha qatoriga chiqarib beradi.

Sarlavhani o'zgartirish uchun quyidagilarni amalga oshirish kerak:
1. Uzel dispetcherini oching (ALT+F8).
2. View > Show Page Titles (Вид > Показать заголовки стра

ниц) buyrug'ini bering. Bu buyruqni CTRL+SHIFT^-T tugmalar 
kombinatsiyasi yordamida ham berish mumkin. Natijada uzel kartasida 
gipermatnli fayllar nomi o'rnida ularning sarlavhasi beriladi.

3. Hujjatni tan lang va File > Rename (Файл > Переименовать) 
buy rug" ini bering yoki klaviaturadan F2 tugmasini bosing.

4. Yangi sarlavhani kiriting va ENTER tugmasini bosing.

Savol va topshiriqlar:

1. Giperhavola n im a?

2. G iperm atn nima?
3. Ixtiyoriy hujjatga havola o'rnatish tartibini aytib bering?
4. Havolani o’zgartirish ketma-ketligini aytib bering?

2.6. Dasturning HTML bilan ishlash imkoniyatlari

Dreamweaver dasturining foydalanuvchilari gipermatnli hujjatlar- 
ning koplab tahrirlash operatsiyalarini to ^ r id a n -to ^ r i HTML 
deskriptorlari yordamida bajarishi mumkin. HTML tili haqida 
biz yuqorida batafsii ma'lumot oldik. Bu tilning elementlarini 
deskriptorlar yoki teglar deb nomlash qabul qilingan. Ingliz tilidan 
tag (yorliq, belgi va boshqa ma’nolarni beradi). Deskriptorlarni 
saqlash uchun ASCII belgilari qo'llaniladi. Shuning uchun har 
qanday gipermatnli hujjatni belgilashni har qanday oddiy matn 
muharrirlarida bajarish mumkin. Buning uchun xatto Блок
нот dasturi ham yetarli. HTML tilining kodlari hujjatning matnli 
massivlari qismi hisoblanadi.

Endi deskriptorlar bilan tanishib chiqamiz. Deskriptorlar ikki xil 
bo’ladi. Yakka va juft deskriptorlar. Juft deskriptorlar ayrim xollarda
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konteynerlar deyiladi. Hujjatga tegishli matnlar va uning belgili 
kodlarini ajratish uchun, HTML tili kodlari burchakli qavslarda 
yoziladi. Masalan, <br> yoki <p>. Juft deskriptorlar (konteynerlar) 
o‘z ich iga  deskriptorlar juftligini, ochiladigan (boshlang‘ich) va 
yopiladigan (oxirgi) deskriptorlarni oladi. Bu juftliklar <tag> </tag> 
ko'rinishida yozilib, o‘z qiymatini juftlik orasidagi hujjat fragmentiga 
o'tkazadi. Boshqacha aytganda kontevner juftliklari orasiga hujjat 
fragmenti yoziladi. Deskriptorlar ana shu fragment uchun ishlaydi 
xolos. Yakka deskriptorlarda yopiladigan teg bcrlmaydi. Masalan, 
<hr> deskriptori gorizontal chiziq hosil qiladi, <br> -  esa matnli 
qatorni ifodalaydi, eng muhim yakka deskriptorlardan biri <img> 
maxsus kodi hisobalanadi. U rasmlarni qo'yiladigan holatini va 
joylashuvini belgilaydi.

Endi Dreamweaver dasturida shablon asosida yangi hujjat hosil 
qilamiz. Vangi hujjatning bo'sh (to'ldirilmagan) bo‘lishi hammamizga 
ma'lum. Quyida bundav sahifaning Dreamweaver dasturidagi 
gipermatnli belgilari keltirilgan:

<htm l>
<head>
<title>TJntitled Document</title>
<meta http-equiv-»Content-Type» content-»text/html; charset = iso- 

8859- 1»>
</head>
<body bgcolor=«#FFFFFF»>
</bodv> </html>
Bundagi deskriptorlarning vazifalari bilan HTMLda tanishib 

chiqdik. L ’ndan tashqari <meta> deskriptorining charset atributi 
internetda tanlangan simvollarni namovishini ta’minlovchi kodirovkani 
ifodalaydi. Odatda yangi shablondagi (iso-8859-1) kodli to'plam kiril 
sim vollariai ifodalay olmaydi.

Deskriptorlarni kiritish qoidalari

B elgilash kodlarini to‘g‘ridai-to‘g'ri kiritish hujjatning faqat max- 
sus rejimida amalga oshiriladi. Bu rejimga o‘tishning bir nechta 
imkoniyatlari bor. Ulardan ayrimlarini ko’rib chiqarniz:
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• Window > Code Inspector buyrug'ini bering. Xuddi shu buyruqni 
FlO tugmachasini bosish yordamida ham berish mumkin;

• Uskunalar panelining chap qismida joylashgan Code View (Ре
жим разметки) tugm asini bosib kodlarni tasvirlash rejimiga o'tish 
mumkin:

• Uskunalar panelidagi chapdan ikkinchi Code and Design View  
(Режим разметки и планировки) tugmani bosish bilan hujjat oynasini 
ikki qismga bo'lish mumkin.

Kodlar nazoratchisida joriy hujjatning kodlari tasvirlanadi. Bel- 
gilashda qoilaniladigan kobpchilik deskriptorlar alohida rangda 
tasvirlanadi. Deskriptorlarning ranglari dasturning asosiy ko‘rsat- 
kichlariga kiradi. Ranglarni foydalanuvchining xohishiga qarab 
o4zgartirish mumkin. Agar foydalanuvchi hujjat ustida biror tahrirlash 
ishlarini olib bormoqchi b o isa  u holda F5 tugmasini bosish yoki View
> Design View (В и д  > Обновить) buyrug'ini berish kerak. Bu buyruq 
hujjatning kodlarni belgilash rejimidan tahrirlash rejimiga o'tkazadi. 
Tahrirlash rejimidagi obyektlarni qo'yish, formatlash buyruqlari va 
har qanday o'zgarishlar darhol kodlar inspektoriga ko'chadi. Agar 
tahrirlash rejimida biror obyekt yoki fragmentni belgilasangiz, 
kodlarni belgilash rejimida ham shu obyekt yoki fragmentga tegishli 
kodlar belgilanadi. B u  esa dasturda ikki yoqlama ishlash imkoniyatini 
ta’minlab beradi.

Kodlardan nusxa olish

Dreamweaverda boshqa HTML tahrirlagichlari bilan gipermatnli 
belgilashdagi kodlarni almashish imkoniyati mavjud. Buning uchun 
Windows operatsion tizimining ko'pchilik dasturlarida mavjud ЬоЧ- 
gan, belgilangan fragmentdan nusxa olish va qo'yishning standart 
buyruqlaridan foydalaniladi. Aytaylik HomeSite dasturida ochilgan 
gipermatnli hujjatning belgilash kodlaridan nusxa olishimiz kerak:

Nusxa olish uchun Edit > Copy (Правка > Копировать) yoki 
CTRL+C tugmalar kombinatsivasidan foydalanamiz;

Buferga olingan nusxani qo’vish uchun Edit > Paste (Правка > 
Вставить) yoki CTRL+V tugmalar kombinatsivasidan foydalanamiz.

Matr muharrirlarida tanlangan fragmentni sichqon yordamida surish 
yoTi bilan ko'paytirish imkoniyati mavjud. Bu imkoniyat Dreamweaver
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dasturida ham  ishlaydi. Buning uchun CTRL tugmasini bosgan holda 
belgilangan fragmentni sichqon ko'rsatkichi bilan kerakli joyga surib 
ko'paytirish mumkin.

Savol va topshiriqiar:

1. HTML so'zining lug'aviy manosi qanday?
2. Deskriptorlar nima?
3. Deskriptorlarning qanday ko’rinishlari mavjud?
4. Deskriptorlarni kiritishni tushuntirib bering?

2.7. Hujjatning o‘lchamlarini belgilash

Dasturda yaratilgan har qanday yangi hujjat bo'm-bo'sh oq 
rangdagi fon li sahifadan iborat bcrladi. Hujjatda ish boshlashdan oldin 
uning bir qancha muhim parametrlarini kiritib olish kerak. Bular ish 
maydonining oichami, fon rangi; hujjat sarlavhasi. havola ranglaridir. 
Bu parametrlarni ish jarayonining ixtiyoriy vaqtida ham crzgartirish 
mumkin. Sanalgan barcha parametrlarni yagona Page Properties (Свой
ства страницы) muloqot oynasi yordamida kiritiladi (2.19-rasm). Bu 
muloqot oynasini bir necha vollar bilan ochish mumkin:

• Dastur menyu qatoridan Modify > Page Properties (Изменить > 
Свойства страницы) buyrugMni berish bilan;

• CTRL+-J tugmalar kombinatsiyasini bosish bilan;
• Kontekstli menyudan Page Properties (Изменить > Свойства 

страницы) buyrug'ini berish bilan.
Endi Page Properties (Свойства страницы) muloqot oynasining 

boshqaruv elementlari bilan tanishib chiqamiz:
• Title (Заголовок). Sahifaning sarlavhasini kiritish uchun xizmat 

qiladi.
• B ackground Image (Фоновый рисунок). Hujjatga fon sifatida 

qo'yiladigan rasm ko'rsatiladi.
• B ackground (Фоновый цвет). Sahifaning fon rangini tanlash 

imkoniyatini beradi.
• Text (Текст). Shriftning rangini tanlash imkoniyatini beradi.
• Links (Ссылки). Bu bo’limda giperhavolalar rangi va grafikli 

havolalar ramkasi rangi belgilanadi.
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Page Properties Щ

litte: (ö~

BackgcuridImage: j lile /■■'•'i_|/Boc4 1/F0N JPG 

Background: ! J

Srowse...

Text: i j f

Links: j f  

Left Margin: |

Toß Margin: |

Visited Links: ! J  [ 

Active Links: ;~J[ 

Margin Width: | 

Margit] Height: |

Document Encoding: ] Cyrillic lV/indom-1251J j ]  Reload |

Tracing Image: | Browse... 

Image Transparency: ------------T — ~ — i— Г 7 “ “  } юо*
Transparent Opaque

Document Folder: C:\WIN D0WS\Pa6o4Hü стол\

Site Folder: C:\WIN DOWS \Рабочий стол\

OK

Apply

Cancel

Help

2.19-rcism. Page Properties muloqot oynasi.

• Visited L inks (Просмотренные ссылки). Brauzerda ko'rilgan 
havolalar rangini tanlash.

• Active Links (Активные ссылки). Faol havola rangini belgilash.
• Left Margin (Левое поле). Sahifaning chap tomonidan qol- 

diriladigan mavdonni pikselda belgilaydi.
• Top Margin (Верхнее поле). Sahifaning yuqori qismidan qol- 

diriladigan mavdonni pikselda belgilaydi.
• Margin Width (Ш ирина полей). Sahifa maydoni enini bel

gilaydi.
• Margin Height (Вы сота полей). Sahifa maydoni bo‘yini bel

gilaydi.
• Document Encoding (Кодировка документа). Kiril simvol- 

laridan iborat sahifalar tuzish uchun juda muhim ko‘rsatkich. Chunki 
uning yordamida qanday simvollarni brauzer dasturlarida tasvirlab
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berish ko'rsatiladi. Rus alifbosini faqat quyidagi to'rtta kodirovka 
tasvirlab bera oladi xolos ISO-8859-5, MacCyrillic. KOI8-R va 
Windows-1251.

• R eload (Повторная загрузка). Tugmasi yordamida hujjatning 
grafik tahrirlash ishlari bilan bogiiq oxirgi saqlangan ko'rinishni tiklash 
imkonini beradi.

• Tracing Image (Трафаретное изображение). Sahifaning dizayni 
bilan ishlashda namuna sifatida ishlatiladigan tasvirlarni ifodalaydi. Bu 
tasvirlar sahifani ko'rish rejimida ko'rinmaydi.

• Im age Transparency (Прозрачность изображения). Iz qoldirish 
uchun tanlab olingan rasmning shaffoflik darajasi belgilanadi.

• Document Folder (Папка документа). Hujjatning qaysi katalogda 
joylashganini ko4rsatib turadi.

• S ite  Folder (Корневая папка узла). Tegishli Web-uzelning o’zak 
katalogiga to iiq  yo;l ko'rsatadi.

Yuqoridagi ko^satkichlar tanlangandan so'ng. barcha o'zgarishlarni 
saqlab, ularni ko’rish uchun File > Preview in Browser (Файл > Про
смотр в браузере) buyrugi beriladi.

Gorizontal va vertikal chizgMch

Goriz;ontal va vertical chizgich hujjat bilan ishlashda o'lchash va 
etalon vazifalarini bajaradi. Chizg'ichga qarab obyektlarning oichainini 
boshqa obvektlarga nisbatan joylashuvini ko'rish mumkin. Boshqaruvda 
chizg4ichlar maxsus buyruq yordamida o'rnatiladi. Buning uchun View
> Rulers (Вид > Линейки) buyrug'ini berish kerak. Bu menyuning 
punktlarini sanab o4amiz.

• Show  (Показать) buyrug'i chizgMchni o'rnatib beradi. Bu 
buyruqni -  CTRL+ALT^R tugmalar kombinatsiyasi yordamida hain 
bajarish mumkin. Buyruqni takror berish chizg'ichni ekrandan olib 
tashlaydi.

• P ixels (Пикселы). Inches (Дюймы), Centimeters (Сантиметры)
-  buyruqlari oMcham birligini tanlash imkonini beradi.

• Reset Origin (Восстановить начало координат). Koordinatalar 
boshini sahifaning ixtiyoriy nuqtasi bilan bog‘lash mumkin. Buning 
uchun chiziqlar kesishuvida joylashgan krest shaklidagi markerni
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hujjatning ixtiyoriy joviga olib 0 ‘tish yetarli. Ushbu buyruqning ba- 
jarilishi sanoq nuqtasini dastlabki vaziyatga qaytaradi.

Montaj to‘ri

Montaj to'ri -  hujjat elementlarini tekislash va joylashtirish uchun 
moijal olish vositasidir. Hujjat elementlariga: matn, rasmlar, jadvallar 
va boshqalar kiradi. Montaj to’ri sahifani rejalashtirishning eng asosiy 
vositasidir. Loyihaning dizayn bilan bogiiq  ishlari tugagach to'rni olib 
tashlash mumkin. To'rni yana ekranga chiqarish uchun View > Grid
> Show Grid (Вид > Разметочная сетка > Показать сетку) buyrug‘i 
beriladi yoki CTRL+ALT-1-G tugmalar kombinatsiyasi bosiladi. Olib 
tashlash uchun shu buyruq takror beriladi.

View > Grid > Edit Grid (Вид > Разметочная сетка > Настроить 
сетку) buyrug’i 2.20-rasmda ko'rsatilgan muloqot oynasini ekranga 
chiqaradi. Uning tarkibiv qism i bilan tanishib chiqamiz: 

о Color (Цвет) -  to'r rangini tanlash imkonini beradi.
° Show Grid (Показать сетку) -  to'rni o'rnatish yoki olib tashlash.
° Spacing (Расстояния) -  o'lchash birligi va chiziqlar orasidagi 

bo'linish qadamini belgilaydi.
о Display (Отображение) -  to'r chiziqlari ko'rinishini belgilaydi.

Color: I OK

Г  Show Grid 

Г  Snap to Grid
Cancel

Apply

Spacing:

Display: (• Lines 
С  Dots Help

2.20-rasm. Montaj to’rini o'rnatish.
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Savol va topshiriqlar:

1. Hujjat oichamlarini belgilash uchun qaysi buyruqdan foydalaniladi?
Bu buyruqning mos kombinatsion tugmalarini ayting?

2. Page Properties muloqot oynasi qismlari vazifalarini aytib bering?
3. Chizg‘ich va lining vazifalari nimalardan iborat?
4. Montaj to'ri nima va uning vazifalari nimalardan iborat?

2.8. Dreamweaverning ro'yxatlar bilan ishlash imkoniyatlari

Ro^yxatlarni nomerlash deb -  bo’lim yoki qismlar ketma-ketligini 
tartibga soluvchi va ularning har biri navbatdagi yangi son bilan 
tartiblanishini tushunish mumkin. HTML tilida ro'y^atlarni hosil 
qilish bilan biz yuqorida batafsil tanishib chiqdik. Bundan tashqari 
tartiblangan ro'yxatlar asosida murakkab iyerarxik ro'yxatni tuzish 
mumkin. Bunda murakkab ro'yxatning qismlari bo'lib quvi (oddiy) 
ro'yxatlar olinadi.

Nomerlangan ro'yxatlar quyidagi yo;l bilan hosil qilinadi.
1. Hujjatning bir nechta tizimli bo'lagini oling. Bundav bolaklarga 

abzatslar, har qanday standart sarlavhalar yoki boshqa ro'yxatlarning 
bo'limlarini kiritish mumkin.

2. Dreamweaver
3. Homesite
4. Hotmetal Pro
Text > List > Ordered List (Текст > Список > Нумерованный спи

сок) buyrug‘ini bering. Bu buyruqni CTRL+F3 tugmalar kombinatsiyasi 
yordamida ham berish mumkin.

Belgili ro‘yxatlarni yaratish

B elgili ro'yxatlar deb -  ma’lum belgi ostida ketma-ket boMimlarni 
sanash tushuniladi. Bunday ro'yxatlarni HTMLda hosil qilish bilan biz 
yuqorida tanishib chiqdik.

Brauzerlarning oxirgi versiyalarida ro‘yxatlarni belgilash uchun 
type atributi bor. Bu atributni quyidagi qiymatlarini qoMlash mum
kin: circle (aylana), disk (disk), square (kvadrat). Ya’ni ro'yxatning 
har bir bo'limi shu belgilar bilan belgilanadi. Bundan tashqari kichik

110



xajmdagi rasmlarni ham ro'yxatning maxsus belgisi sifatida qo4llash 
mumkin.

Betartib rcfyxatlarni yaratish tartibi quyidagicha:
I. Hujjatning bir nechta bir-biriga qo4shni strukturali bloklarini 

tanlang. Text >  List > Unordered List buyrugMni bering. Bu buyruqni 
CTRL+F3 tugmalar kombinatsiyasi vordamida ham bajarish mumkin.

• Toshkent
• Samarqand
• Buxoro
• Xorazm

S avo l va topshiriqlar:

1. Ro'yxatlarni belgilash deganda nimani tushunasiz?
2. HTML tilida ro'yxatlar qaysi deskriptor vordamida hosil qilinadi?
3. Belgili rokyxatlar qanday hosil qilinadi?

2.9. Matnlarni formatlash. Shriftlar

Bizga boshqa dasturlardan belgilangan matnni yoki butun hujjatdagi 
matnni shriftini o'zgartirish ma'lum. Endi ana shu jarayonni HTML 
tilida qanday bajarilishini k o brib chiqamiz. Bu vazifani HTMLda 
maxsus deskriptor <font> vordamida bajariladi. Uning qiymatlari 
bo'lib bir nechta shriftlar nomi ishlatilishi mumkin, masalan: <font 
face = «Courier. Helvetica, sans-serif'>Shriftni belgilash </font>.

Shriftlarni belgilashni texnik tomoni esa matn muharrirlaridan hech 
ham farq qilmaydi:

1. Matnni belgilang yoki matn kursorini hujjatning shrifti o'zgarishi 
kerak boigan joyiga qo’ying;

2. Text > Font (Текст >  11 [рифт) buyrug'ini bering va kerakli 
shriftni tanlang. Xuddi shu ishni Property Inspector (Инспектор 
свойств) palitrasi yordamida ham bajarish mumkin.

Tanlangan shriftning nomi shriftlar ro'yxatining nomi hisoblanadi.

Shriftlar ro^yxatini tahrirlash

Shriftlar to'plami ro'yxatiga foydalanuvchi o'z xohishiga qarab 
yangi shriftlar qo'shishi yoki qo'llanilmaydigan shriftlarni olib tashlashi 
ham mumkin:
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Edit Pont List ■ К З

j t J j l J  Font List:
Courier New, Courier, mono A

1 0K 1

Georgia, Times New Roman, Times, serif 
Verdana, Arial, H elvehca, sans-serif 
Times U2b Roman 
Geneva, Arial, Helvetica, sans-serif

1 Cancel 1

Щ ( Add fonts tn list below )

Available Fonts:

H H  v

0

Arial
Arial Black 
Arial Narrow 
Arial Unicode MS 
Batang

EE3

A

V

1 Help 1

2.21-rasm. Shriftlar to'plamini tahrirlash muloqot oynasi.

1. Text > Font > Edit Font List (Текст > Шрифт > Редактировать 
список шрифтов) buyrug‘ini bering. Bu buyruqni CTRL+F3 tugmalar 
kombinatsiyasini bosish bilan ham bajarish mumkin. Buyruqni berish 
natijasida Edit Font List muloqot oynasi hosil bo'ladi.

2. Bu oyna yordamida foyrdalanuvchi o6ziga kerakli shriftlar ro'y- 
xatini qaytadan tuzib olishi mumkin.

3. Ishni tugallashdan oldin muloqot oynasida OK tugmasi bosiladi.
• Muloqot oynasining tugma va maydonlari bilan tanishib chi- 

qamiz:
• Font List (Список шрифтов). Muloqot oynasining bu boMimida 

ayni vaqtdagi ro'yxatga tegishli shriftlar berilgan. Endi qo'shiladigan 
shriftlar esa ro‘yxatning eng oxiriga joylashadi.

• Chosen Font (Выбранные шрифты). Tanlangan shriftlar nomi.
• Available Fonts (Наличные шрифты). Ushbu hisoblash tizimida 

o‘rnatilgan shriftlar ro‘yxati. Bu shriftlardan birortasini tanlangan 
shriftlar to'plamiga qo'shish uchun, oynadagi chapni ko'rsatish yo'nalish 
tugmasini bosish kerak.

• To'plamdagi tanlangan shriftni o'chirish uchun « -»  belgili 
tugmani, to'plamga yangi shrift qo‘shish uchun «+» belgili tugmani 
bosish kerak.
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tahlil qilish: foiz stavkalari va soliqlarini tahlil qilish; moliyaviy 
deklaratsivalar va balans jadvalarini tayyorlash; sotish hajmini va 
strukturasini hisobga olish uchun hisobchi daftarini yuritish; smeta 
kalkulyatsiyasi; pul cheklarini hisobga olish; budjetga va statistikaga 
oid hisoblashlar.

Tasvir ko‘rinisbda berilgan axborotlarni qayta ishlash texnologiyalari

lxtiyoriy matn yoki hujjatda grafiklar, diagrammalar, chizmalai\ 
rasmlar, yorliqlarini kiritish ehtiyoji grafik muharrirlarini varatish 
zaruriyatini hosil qiladi. Grafik muharrirlar qurol vositalardan iborat 
boiib, ular o'ziga mos axborot texnologiyalardan foydalanib grafik 
obrazlarini varatish va o'zgartirish imkoniyatlarini beradi.

Axborot texnologiyalarida grafik muharrirlar quyidagi turlardan 
fovdalanadi:

-  tijoratgrafikasi:
-  tasviriy grafika;
-  ilmiy grafika.
Tijorat grafikasining axborot texnologiyasi aylanma diagrammalar, 

ustunli gistogrammalar, chiziqli grafiklar hamda boshqa tipdagi ikki 
va uch o’lchamli grafik ko'rinishda elektron jadvalli muharrirlarida, 
ma’lumotlar bazalarida va alohida lokal fayllarda saqlanayotgan axbo
rotlarni ekranga akslantiradi.

Tasviriy grafikaning texnologiyasi turli xil matnli hujjatlar uchun 
regulyar va noregulyar struktura ko'rinishdagi foydalanuvchining 
rasmlari (piksei grafikasi) tasvirini yaratish imkoniyatlarini beradi. 
Tasviriy grafika texnologiyasini amalga oshiruvchi muharrirlar 
foydalanuvchiga chiziq qalinligi va rangi. palitra quymasi. matnni yozish 
uchun shrifL oldin yaratilgan grafik obrazlarini tanlash uchun vosita 
beradi. Bundan tashqari, foydalanuvchi rasmni o'chirish, qirqish va 
uning qismini bir joydan boshqasiga surishi mumkin. Ammo, tasvirlarni 
slaydda, maxsus effektlar v a  ularni jonlantirish rejimida kolrish 
imkoniyatlarini beruvchi (CorelDraw. Stonyboard, 3DStudioMAX va 
boshqalar) informatsion grafik texnologiyalar ham bor.

Ilmiy grafikaning texnologiyasi kartografiya masalalari, kimyo- 
viy, matematik va boshqa formulalarni o‘z ichiga oluvchi ilmiy 
hisoblashlarni bezab joylashtirish uchun xizmat qiladi.
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Kompyuter grafikasi qo’llaniladigan asosiv sohalarni ko'rsatib 
o'tamiz:

1) Grafiklarni chizish;
2) Kartografik-geografik. tabiiy yoki iqtisodiy hodisalarni o’zaro 

chegaradosh mamlakatlar. viloyatlar, oMkalar va shu kabilarni aniq 
tasviri;

3) Chizma va konstruktorlik ishlarini avtoniatlashtirish:
4) Modellashtirisli va multiplikatsiya;
5) Turli texnologik jarayonlarni boshqarish -  real dunvo massh- 

tabida interfaol rejimda ishlash. Texnologik jarayonni eng kerakli 
nuqtalariga o‘rnatilgan dastlabki axborot manbai boMgan datchiklardan 
kelayotgan axborotlar qiymatini vizual idrok qilish;

6) Nashr ishlarini avtoniatlashtirish va chop etishni elektron usuli. 
Reklama va san’at -  qandavdir fikrni ifodalash va estetik yoqimli 
tas’virlar orqali jamoani diqqatini tortish.

Tasvir ko 'rinishda berilgan axborotlarni qayta ishlashning 
umumiy masalalan

Tasvir ko‘rinishida berilgan axborotlarni kompvuterda qayta ishlash 
texnologiyasi xilma-xil bo‘lib. juda ko‘p amaliy masalalarni ha! qilishga 
tatbiq etiladi. Axborotlarni qayta ishlashning bu sohasini quyidagi uch 
yo'nalishga ajratiladi:

1. Kompyuter grafikasi (COMPUTER GRAPHICS);
2. Tasvirlarni qayta ishlash (IMAGE PROCESSING);
3. Tasvirlarni tanib olish (COMPUTER VISION).
Tasvir ko'rinishga ega boMmagan axborotlarni vizuallashtirish (ya'ni 

tasvirni yaratish) masalalari bilan kom pyu ter g ra fik a si (C O M PU TE R  
G R A P H IC S ) shug‘ullanadi.

Vizuallashtirish tasvirlanishi zarur bo'lgan obyektning tasnifi 
(modeli) asosida bajariladi. Hozirgi paytda vizuallashtirish usullari va 
algoritmlari juda ko‘p bo‘lib. ular nimani va qanday qilib aks ettirish 
bilan bir-biridan farq qiladi.

Vizuallashtirishga misollar (murakkablashib borish tartibida) sifatida 
quvidagilarni koTsatish tnuinkin:

— funksivalar grafigi;
— diagrammalari;
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— geografik xaritalar;
— animatsiyalar.
Shuni takidlab o;tish kerakki. grafiklar vaqtga nisbatan o'zgarmas 

(statik) boladi.
Tasvirlarni qayta ishlash (IMAGE PROCESSING) -  bu tasvir- 

lami almashtirish bilan bog •liq masalalar. Tasvirlarni qayta ishlash 
algoritmlari uchun boshlang'ich ma’lumotlar ham tasvirlar. natija ham 
tasvirlar husoblanadi.

Grafik ma’lumotlarni tasvirlash 

1. K om pyu ter g ra fik a si tu r la r i
Kompyuter grafikasi tasvirlarni shakllantirish usullariga bog'liq 

holda 3 turga bo'linadi:
1. Rastrli grafika;
2. Vektor I i grafika;
3. Fraktal grafika .
Ular bir-birlaridan tasvir ko'rinishdagi axborotlarni hosil qilish va 

qayta ishlash texnologiyalari bilan farq qiladi.
Rastrli grafika vositasida shakllangan tasvir asosan elektron va 

poligrafiya nashriyotlarida qcTllaniladi. Rastrli tasvir ikki oMchovli 
massiv (matritsa) ko‘rinishdagi nuqtalar to‘plamidan iborat bolib, ular 
piksellar deb ataladi. Rastrli tasvirning eng kichik elementi peksildan 
iborat (3.1-rasm).

Uning atributlari boshqa piksellarning 
atributlari bilan bog4liq emas. Komp- 
ynterda qoMlaniladigan operatsion tizim- 
laining imkonitiyaga ko‘ra. 480x640,
800x600, 1024x768 va undan ko'proq 
pikselga ega boMgan tasvirlar joylashishi 
mumkin. Tasvirning oMchamiga ko^ra 
uning imkoniyati ham oshib boradi.
Ekranning imkoniyati parametrik boiib. 
bir dyuynidagi nuqtalar soni bilan bel- 
gilanadi. Rastrli grafik vositalari bilan 
bajarilgan (tayyorlangan) tasvirlar juda

3.1-rasm. Rastrli grafikada 
piksellarning ko'rinishi.
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kam  hollardagina kompyuter dasturlaridan foydalanib ishlab chiqiladi. 
B u  maqsadda professional rassom chizgan rasm yoki fotografiya texnik 
vositalar yordamida kompyuterga kiritiladi.

Oxirgi paytda rastrli tasvirlarni kompyuterga kiritish uchun 
raqamli foto va videokameralardan foydalanilmoqda. Shu sababli rastr 
grafikasini asosiy maqsadi tasvirni yaratish emas. balki mavjud tasvirni 
qayta ishlashdir.

Rastrli grafikning ijobiy tomonlari sifatida quvidagilarni ko'rsatish 
mumkin:

□ universalligi (bu formada har qanday tasvirni taqdim etish 
mumkin);

□ shakllantirishning soddaligi;
□ rang jilolarini berish aniqligining yuqoriligi.
Ushbu usulning salbiv tomonlari sifatida quvidagilarni ko'rsatish 

mumkin:
□ rastrli grafik bloklar hajmining juda kattaligi;
□ ularning masshtabi o'zgarganda tasvir sifatining pasayishi.
Rastrli grafikada har bir tasvirni kodlash va saqlash uchun katta

hajmdagi xotira talab etiladi. Tasvirdagi juda kichik obvektlarni ko'rish 
uchun uning masshtabini kattalashtirib bo’lmaydi. Bu rastrli tasvirlarni 
qayta ishlash jarayonida ba'zi bir muammolarni paydo bo'lishiga olib 
keladi.

Rastrli tasvirlar quyidagi tiplarga bo‘linadi: binar, kulrang, palitrali, 
to’liq  kulrang. Bunda tasvirning elementlari faqat ikki qiymatni (0-yoki 
1) qabul qilish mumkin. Bu tasvirlar turlicha paydo bo‘lishi mumkin. 
Anim o ko'p hollarda kulrang, palitrali va turli rangli tasvirlarni 
o‘zgarmas voki adektiv chegaraviy son bilan binar tasvirga almashtirish 
natijasida paydo bo‘ladi. Binar tasvirlarni saqlasli uchun juda ham 
katta joy talab qilinadi. Ularning har bir elementi uchun 1 bit joy kerak 
bo‘ladi. Kulrang tasvirning elementlari maMum bir rang intensivligining 
turli xil qivmatlarini qabul qiladi. Odatda bu tasvirlarning har bir 
elementini saqlash uchun 8 bit ishlatiladi. Kulrang tasvirlar turli xil 
amaiiy masalalarni hal qilishda eng ko'p qoilaniladigan tasvirlardan 
biri hisoblanadi.

Palitrali tasvirlarning har bir elementiga ranglar xaritasining bir 
katakchasidagi rang mos qcryiladi. Palitra -  bu ikki oichovli massiv

132



bo'lib, uning qatorlariga turli ranglar, har bir ustunlariga esa ma'lum bir 
rangning intensivligi joylashtiriladi.

ToMiq rangli tasvirlar elementlari rangni tashkil etuvchi yorqinliklari 
haqidagi axborotni o'zini saqlaydi. Shu bilan u palitrali tasvirlardan 
farq qiladi. A m aliy masalalar yechishda qaysi tipdagi tasvirni tanlash 
masalasining o’z ig a  xos x:ususiyatlaridan bogiab. tasvirdagi zarur 
axborotni qanchalik to’liq ifodalanishi bilan xarakterlanadi.

Vektorli grafik a  vositasida shakllangan tasvir sodda grafik 
obyektlar to'plamidan tuzilgan boMib, uning tipik elementiga mos 
keladi. Vektorli tasvirning asosiy  elementi chiziq bo'lib hisoblanadi.

Kompyuter xotirasida bu chiziq juda katta joy egallamaydi. 
chunki xotirada chiziqni faqat parametrlari ko'rsatiladi. Unda 
sodda obyektlar murakkab obyektlarga birlashtiriladi, shu sababli 
vektor grafikasini obyektga yo'naltirilgan grafika deb ham aytiladi. 
Kompyuter xotirasida vektor grafikasi chiziqlar sifatida saqlanib 
turishiga qaramasdan, tasvir ekranga nuqtalar sifatida chiqariladi. 
Tasvirni ekranga chiqarishdan oldin har bir parametrni hisoblab 
chiqadi. Shu sababli vektor grafikasini hisoblanuvchi grafika deb 
aytiladi. Vektor grafikasi yordam ida sodda turdagi bezash ishlarini 
olib borish m um kin.

Vektorli grafik tizim ning muhim tavsifi bo’lib. uning sodda grafik 
elementlarining tarkibi xizrnat qiladi. Sodda grafik elementlariga bir 
nechta misol keltiramiz:

-  Koordinatasi ko4rsatilgan nuqtalar boshlanuvchi ma’lum bir 
burchak ostida yo‘ nalgan va berilgan uzunlikka ega bo'lgan chiziq:

-  Markaziv koordinatalari ko'rsatilgan nuqtada joylashuvchi. yarim 
o'qlarining uzunligi. chiziqning rang va qalinligi, hamda uni bo'yash 
rangi berilgan ellips;

-  Chap tomondagi yuqori burchagiga joylashgan nuqtaning koor
dinatalari, tomonlar uzunligi, chiziq qalinligi va rangi ko'rsatilgan 
to'g'ri to‘rtburchak.

Vektorli tasvirni ko'rsatayotganda sodda elementlarning chiziqli 
geometrik atributlari, uning boshlangich va zarur o'lchamlari 
o'rtasidagi munosabatni, hamda chiqarish qurilmalarida (monitorlar, 
chop etish qurilmasi) ruxsat berilgan xatolikni hisobga oigan holda 
hisoblab chiqadi. Bunday usul masshtablashtirish imkoniyatini sezilarli
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darajada oshiradi. Tasvir oichamini qancha ko'paytirsa ham, uning 
sifati o'zgarmaydi. Tasvirning olchamlarini juda kichiklashtirib 
yuborganda, sodda elemenlarning chiziqlari ustma-ust tushib qolishi va 
xatolarni ixchamlash hisobigau o‘zgarishi (buzilishi) mumkin.

F ra k ta l grafik a  vositasida shakllangan tasvirlar ham xuddi vektorli 
grafika kabi matematik hisoblarga asoslangan. Ammo kompyuter 
xotirasida hech  qanday obyektni saqlamasligi bilan undan farq qiladi. 
Tasvir tenglam a (yoki tenglainalar tizimi) bo'yicha quriladi. Shuning 
uchun formulalardan boshqa hech narsani saqlash kerak emas.

«Fraktal» atamasi lotincha Fractus so‘zidan olingan va u «qis- 
mlardan tuzilgan» ma’nosini anglatadi. Frantsuz matematigi Benua 
Mandelbrot 1975-yilda «The fractal geometry of Nature» kitobini nashr 
qildi v a  fraktal so'zi eng ko;p tarqalgan atamalardan biriga aylandi.

E ng sod da  fraktal obyekt sifatida qor uchqunlarini yoki 
paporotnik bargini keltirish mumkin. Shuning uchun ham fraktal 
obyekt ch izish  yoki bezash asosida emas. balki programmalashtirish 
asosida hosil bo;ladi. Kompyuterda tashkil qilingan turli 
o'yinlarda h am  fraktal grafikasidan foydalaniladi. Fraktal grafikasi 
kom pyuter xotirasida saqlanib turmaydi. Har bir tasvir tenglama 
yoki tenglam alar sistemasi asosida quriladi. Fraktal grafikadagi 
tenglam aning biror koeffitsiyentini o'zgartirish orqali butunlay 
boshqa tasv irn i hosil qilish mumkin.

Sanab o'tilgan kompyuter grafikasi turlarini tashkil qilish va ularni 
boshqarish uchun bir qator dasturiy vositalar ishlab chiqilgan.

Rastrli tasvirlar va ularning asosiy xarakteristikalari

R a str  -  bu juda kichik yuzaga ega bo'lgan geometrik figuralar 
(piksellardan), masalan kvadratchalardan tuzilgan matritsa. Har bir 
piksel o’z rangiga ega bo'lishi mumkin. Turli ranglarga ega bo‘lgan 
rastrlar to‘p lam i tasvirni tashkil etadi. Tasvir koTsatilayotgan sirtda 
piksellarni joylashishiga nisbatan rastrlar turli tiplarga boMinadi: 
kvadrat, to'rt burchak. doira va shu kabilar. Piksellar joylashishini 
tasvirlash uchun turli xil koordinata tizimlaridan foydalaniladi. Bu 
tizimlarni ham m asi uchun umumiy bo'lgan xossa, ularda piksel 
koordinatalarining diskret qiymatlar qatoridan (butun son bo'lmasligi 
mumkin) tashk il topgandir. Ko'p hollarda butun sonlar koordinatasidan
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foydalaniladi. Bunda piksellarning boshlang'ich koordinatasi chap 
tomondagi yuqori burchakdan boshlanadi.

Rastning geom etrik xarakteristikalari quyidagilardan iborat:
□ Ruxsat berilgan xatolik;
□ O'icham;
□ Piksel shakli.
Rastrda ruxsat berilgan xatolik o'zaro qobshni (yonma-yon) joy- 

lashgan piksellar orasidagi masofa bilan xarakterlanadi. Ruxsat berilgan 
xatolik bir birlik uzunlikdagi piksellar soni bilan oMchanadi. Eng ko'p 
tarqalgan oMchov birligi boMib, dpi (dots per inch) xizmat qiladi. U bir 
dyuym (25,4 mm) uzunlikdagi piksellar soni.

Rastrning o lch a m i odatda gorizontal va vertikal o'qlar bo‘yicha 
joylashgan piksellar soni bilan aniqlanadi. Shuni ta’kidlab aytish 
mumkinki, har ikki o'qlar uchun bir xil qadamli (ya’ni, dpiX =dpiY) 
rastr kompyuter grafikasi uchun juda qulay. Bu ayniqsa grafik 
obyektlarni chiqarish algoritmlari uchun qulay. Aks holda muammo 
paydo boiadi.

Rastr piksellarining shakli tasvirni chiqarish qurilmasining xu- 
susiyatlari bilan aniqlanadi. Masalan, piksellar quyidagi shakllarda 
bo’lishi mumkin:

1. Kvadrat (yoki to'g'ri to4rtburchak shaklidagi piksellar). Ular 
olcham i bo'yicha rastr qadamiga teng (suyuq kristalli displevda);

2. Doira shaklidagi piksellar. Ular oichami bo‘yicha rastr qadamiga 
teng bo'lmasligi mumkin (printerlar).

R an g lar so n i  (rang chuqurligi) ham rastrning eng muhim xa- 
rakteristikalaridan biri. Ranglar soni faqat rastrli tasvir uchun emas. 
Balki har qanday tasvir uchun ham muhim xarakteristika hisoblanadi.

Savol va topshiriqlar:

1. Kompyuter grafikasi nima?
2. Qanday g ra fik  m u h a rrir la r bor?

3. G ra fikan ing  qanday tu r la r i bor?

4. Kompyuter grafikasi qanday turlari bor?
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IV-ЬоЬ. ADOBE PHOTOSHOP DASTURI

4.1. Adobe Photoshop dasturi faaqida

Adobe Photoshop Windows muhitida ishlovchi elektron ko‘ri- 
nishdagi foto tasviiiarni tahrir qiluvchi dasturdir. Adobe Photoshop 
dasturi Adobe System. Inc kompaniyasi tomonidan ishlab chiqarilgan 
bo'lib, ishlatishdagi alohida qulayliklari bilan mashhur hisoblanadi.

Adobe Photoshop grafik muharriri yordamida fotosuratlarga qo’- 
shimchalar kiritish. fotosuratdagi dogiarni o'chirish va eski rasmlarni 
qayta ishlash va tiklash, rasmlarga matn kiritish. qo'shimcha maxsus 
effektlar bilan boy it i sh, bir fotosuratdagi elementlarni ikkinchi 
fotosuratga olib o4ish, ranglami o¿zgartirish, almashtirish mumkin. 
Adobe Photoshop imkoniyatlari keng qamrovli bowlib, u gazeta va 
jurnallarni turli tuman rasmlar bilan boyitishda juda katta qulayliklar 
yaratadi.

Adobe Photoshop avniqsa dizaynerlar. rassomlarning ijodiv im- 
koniyatlarini to'la amalga oshirishlarida yordam beradi. Jurnalistika va 
bevosita matbuot voki nashriyot sohasiga aloqador bo'lgan shaxslarning 
mazkur dastur bilan ishlashni bilishi ular uchun qo‘shimcha 
imkoniyatlarni yaratib beradi. Adobe Photoshop juda murakkab 
dasturdir. Foydalanuvchilar uning asosiy imkoniyatlaridangina foy- 
dalanadilar xolos.

Dasturni ishga tushirish ketma-ketligi quyidagicha: Windows 
95, 98, ME, 2000, XR yoki N Г operatsion tizimlarida Start (Пуск) 
tugmasi ustida sichqoncha chap tugmasini bosing Program s (Програм
мы) boMimiga kiring so'ngra Adobe Photoshop elementi ustiga vana 
sichqoncha chap tugmasini bilan bosing. Bundan tashqari ish stolida 
mavjud Adobe Photoshop uchun maxsus belgida «sichqoncha»ning
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chap tugmasi ikki marta bosish yo‘li bilan ham dasturni ishga tushirish 
mumkin.

Adobe Photoshop dasturidan chiqish uchun quyidagi usullarning 
biridan foydalanish mumkin:

Alt + F4 tugmalarini bosish.
Файл menyusining Выход buyrug‘ini tanlash.
Ekranning yuqori qismi o'ng burchagida joylashgan x belgili 

tugmachani bosish yoki Файл > Закрыть buyrug'ini berish;
Dasturning har b ir  versiyasi o'zida yangi elementlarni mu- 

jassamlantirgan. Bu o'zgarishlar Photoshop 7.0 versiyasida ham ku- 
zatiladi.

4.2. Adobe Photoshop dasturi oynasi qismlari

Adobe Photoshop dasturi ishga tushirilgandan sowng ekranda Adobe 
Photoshop tasvir tahrir qiluvchi oynasi hosil boMadi.

Adobe Photoshop oynasining yuqori qismida sarlavha satri 
va Windowsga xos elem entlar joylashadi. Sarlavha satridan so‘ng 
menyu satri joylashadi. Menyudagi kerakli buyruqlarni tanlashingiz 
mumkin.

Adobe Photoshop dasturi menyusi 9 banddan iborat. Har bir menyu 
tarkibida ochiladigan m enyu bandlari mavjud. Ularni ko‘rish kursor 
yordamida amalga oshiriladi. Dasturning barcha buyruqlari uchun 
Asosiy menyu (Главное меню) mavjuddir:

Файл (File) m enyusi quydagi holatlarda ishlatiladi: yaratish (соз
дать). ochish (открыть), joylashtirish (разместить), vopish (за
крыть). saqlash (сохранить), skanerlash (отсканеровать). import 
va eksport. qog'ozga chiqarish (напечатать изображение), faylni 
tarmoq orqali uzatish (передать файл по сети), bir nechta Opsiyalarni 
avtomatlashtirish uchun. va albatta Photoshop dasturidan chiqish uchun.

Правка (Edit) m enyusida, tasvirni tahrirlash ya’ni sozlash uchun 
buyruqlar: nusxalash (копирования), o'zgartirish (трансформации), 
joylashtirish va tasvir ranglarini tusini va muyqalam qalinligi va turini 
tanlash mumkin.

Режим (Mode) m enyusi orqali Image (Изображение) menyusi, 
tasvir sakkiz turdagi tasvir urinishlarini tanlash mumkin.
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Слой (Layer) menyusida joylashgan buyruqlar. bir necha qat- 
lamlarda joylashgan tasvir ustidagi amallar ya'ni: qatlamlararo 
bog4anishni qatlamlar ketma-ketligini va qatlamlarni umumiy qatlamga 
birlashtirish imkoniyatini beradi.

Выделить (Select) menyusida joylashgan buyruqlar -  kerakli 
qatlamlarni tanlashda (belgilashda) ishlatiladi.

Филтр (Filter) menyusi o'zida tasvirlarni birlashtirish va umumiy 
holga keltirish uchun kerakli bo4gan filtrlari mavjuddir.

Вид (V iew ) menyusidagi buyruqlar. ekrandagi tasvirni ko'ri- 
nishlarini v a  dastur oynasi qismlarini nazorat qiladi.

Окно ("Window) menyusi buyruqlar i, ekrandagi boshqa tasvirlarni 
aks ettiradi va ulardan kerakli boblgan paytda foydalanish imkonini 
beradi.

П омощ ь (Help) menyusidagi buyruqlar foydalanuvchi uchun kerakli 
bo'lgan maslahatlar orqali ko'mak va hozirda bajarish mumkin bo'lgan 
imkoniyatlar bilan tanishtiradi hamda Photoshop yaratuvchilari rasmiy 
saytiga murojat qilish imkoniyatini beradi.

4 .1-j adval

Dastur menyulari va ulardagi buyruqlar

Ф айл (File) menyusi buyruqlari

Н овый (С1г-нМ) Yangi fayl yaratish

О ткры ть (0 г 1 + 0 ) Bu buyruq yordamida diskda mavjud fayllar 
ochiladi

О ткры ть к а к  ( А И + а г Ю ) Faylni qanday ko 'rin ishda ochishni tanlash

С охрани ть  (Сгг1-^8) Faylni xotiraga mavjud formatda yozish

С охрани ть  как 5ЫА-+-ОгЬ8 Faylni xotiraga bosliqa nom bilan yoz
ish. Ushbu buyruq fayl nomi, format 
va joylashgan papkasi kabi a tributlarin i 
o 'zgartirishda foydalaniladi

С охрани ть  К опию  
(А к + С Ы + Б )

Tasvir nusxasini xotiraga yozish
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Вернуть Tasvirning dastlabki holatiga qaytish

Поместить Boshqa mustaqil fayl bilan birlashtirish

Импорт Boshqa papkada joylashgan faylni Adobe 
Photoshop dasturiga olib kirish

Экспорт Tasvirni boshqa papkaga jo'natish

Файл информация Fayl haqidagi ma’lumotlarni kiritish

Установка страницы 
(ShifHCtrl-^P)

Tasvirni printer yordamida chop etishga 
tayyorlash, qog‘oz shaklini tanlash

Печать (Ctrl~P) Tasvirni printerga jo'natish

Предпочтения Adobe Photoshop dasturini kerakli tartibda 
sozlash

Настройка цвета Tasvir ranglarini sozlash

Adobe online Internet bilan bog4lanish

Выход (CtrHQ) Adobe Photoshop dasturidan chiqish

ПРАВКА (Edit) menyusi

Берн (Ctrl+Z) Tasvir ustida bajarilgan oxirgi amalni bekor 
qilish

Резать (Ctrl+X) Tasvirning ajratilgan qismini buferga (xo- 
tiraga) olish

Копировать (Ctrl+C) Nusxa olish

Вставить (Ctrl+V) Buferdan (muvaqqat xotiradan) kursor ko‘r- 
satgan joyga qo4yish

Вставить (Shift-Ctrb-V) Buferdan (muvaqqat xotiradan) belgilangan 
joyga qo‘vish

Очистить Tasvirda belgilangan maydonni tozalash, 
o'chirish. Bunda o'chirilgan maydon fon 
rangiga bo'yaladi.
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davomi

З алить Ш т р и х Tasvir y u z in i asosiv rang bilan bo'yash

Трансф орм ация (С1гКГ) Tasvirda belgilangan maydonni shtrixlab 
ko'rsatish

Трансформ Tasvir shaklin i o ‘ zgartirish. Tasvir shaklin i 
tu r li ko 'rin ish larda o‘zgartirish

О ч и стка «История» darchasida tasvir o lib  borilgan 
o‘zgartirish am allarin i butunlay olchirish. Bu 
amal bajarilgandan so’ng o 'zgartirish larn i 
ortga qaytarish m um kin  emas

ИЗОБРАЖЕНИЕ (image) menyusi

Р еж им Rang modellarni o 'zgartirish

Н астройка Tasvir ranglarin i sozlash

Д уб л икат Tasvirdan nusxa olish

Н ал ож и ть  изображение Tasvirni qo'shimcha ranglar bilan bovitish

В ы числение Tasvirdagi ranglar kanallarin i o 'chirish

Размер изображения Tasvir shaklin i va 0 ‘ lcham larin i o 'zgartirish

Размер холста Tasvir ramkasi o 'icham larin i o 'zgartirish

Обрезание Belgilangan maydondagi tasvirn i kesib olish

П еревернуть Х олст Soat strelkasi bo'ylab voki soat strelkasiga 
qarshi 180°, 90: burish

Гистограм м а Tasvirdagi ranglar m iqdori haqidagi m a- 
lumDtlar darchasi
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СЛОЙ (Layer) menyusi

Новый yangi qatlamni hosil qilish

Дубл икать слоя qatlam nusxasini hosil qilish

Удалить слой mavjud qatlamni muvaqqat xotiradan 
o*chirish

Эффекты qatlamga turli effektlarni qokshish

Группа с предыдущим 
(СггКО

qatlamlarni bir-biriga birlashtirish

Разгрупировать
^¡Л+СЫ+С)

qatlamlarni bir-biridan ajratish

С клеть все слои mavjud barcha qatlamlarni birlashtirish

ВЫБОР (Select) menyusi

Все (Си-КА) tasvirni belgilash

Убрать выделение (ОгКО) tasvirning belgilangan qismini muvaqqat 
xotiradan o'chirish

Выделить заново qaytadan belgilash

Обратно 51Й-Ог1Ч) so'nggi bajarilgan amalni qavtarish

Цветовой ряд (БЫЛл-ОгЬЧЗ) tasvirdagi ranglar asosida belgilash 
maydonini aniqlash

Модифицировать belgilash chizig‘ini piksellarda kengaytirish

Увеличить belgilash maydonini kengaytirish

Преобразовать выделение belgilangan maydon shaklini o'zgartirish

Сохранить выделение belgilangan maydon shaklini xotiraga 
joylashtirish
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ФИЛЬТР

Последний фильтр Foydalanuvchi tomonidan ohirgi ishlatilgan filtrni 
qo‘llash.

Заточка >

0*rnatiladigan filtrlar ro4yxati

Пиксели >

Пятно >

Стили >

Шум >

Другое > Boshqa filtrlar

ВИД (View) menyusi

Новый вид Asosiy tasvirni yangi darchada ochish

Увеличить (СгЙ^+) Tasvirning ekrandagi ko'rinishini kattalashtirish

ОКНО (Window)
i

Документы > | Очилган хужжатлар (расмлар) руйхати

Рабочее пространство. Инструменты. Опции, 
Браузер файла, Навигатор, Информация, 
Цвет, Образчики. Стили. История. Действия. 
Предустановки инструмента, Слои, Каналы, 
Пути, Кисти, Символ. Параграф, Строка со

Dastur oynasi qismlari

стояния

ПОМОЩЬ (Help)

Помощь Photoshop 
Fl

Photoshop dasturi bo'yicha yordam ma'lumot olish

О программе 
Photoshop

Photoshop dasturi haqida ma’lumot olish. Unda 
dasturning nomi versiyasi ishlab chiquvchilar ha
qida ma’lumot beriladi.
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System info ... Foydalanuvchining kompyuteri haqidagi ma’lu- 
motlarni ko'rsatadi.

Updates ... Internetga ulanish orqali Photoshop dasturini yan- 
gilash (обновления) imkonini beradi.

Registration ... Registratsiya (Adobe Photoshop dasturini roky- 
xatdan o'tkazish)

Adobe Online ... Adobe kompaniyasining Web-saytini ochib beradi. 
Unda dastur bilan ishlash bo4yicha maslahatlarni 
o'z ichiga oigan punktlar beriladi.

Adobe Photoshop dasturida jami 46 ta uskunalar mavjud boclib, 
ulardan 20 tasi bevosita dastur ishga tushirilganda darchada ko'zga 
tashlanib turadi. Qolganlarini qo'shimcha buyruqlarni bajarish orqali 
ishga tushirish mumkin. Agar uskunalar panelida joylashgan tugmaning 
ostki qism o'ng burchagida kichik uchburchak shakli tasvirlangan 
boisa, bu tasvir ushbu tugma tarkibida owshash buyruqni bajaruvchi 
uskunalar yashiringanligidan darak beradi.

Yashiringan uskunani faollashtirish uchun kursorni maxsus belgili 
tugma ustidan sichqonchaning chap tugmasini bosgan holda uskunalar 
panelidan tashqariga olib chiqiladi va kerakli tugma ustida kursorni 
keltirilib sichqonchaning chap tugm asi qo'yib yuboriladi.

Har bir tugmaga kursor yaqinlashtirilsa, kursor belgisi ostidagi 
uskunaning qandav vazifani bajarishi haqidagi axborot paydo bo4- 
ladi. Quyida Adobe Photoshop dasturida ishlash jarayonida keng 
qoilaniladigan uskunalarning qisqacha tavsifi keltiriladi.

П рямоугольная область: Tasvirda to'g'ri to*rtburchak shaklidagi 
maydonni belgilab olish uchun qoilaniladi. Bu uskuna yordamida 
tasvirdagi alohida maydonni belgilab olingandan key in tasvirga 
kiritilgan barcha o'zgarishlar faqat belgilangan maydon ichiga ta’sir 
etadi. Ushbu tugmaga qo'shimcha tarzda Shift klavishi ishlatilsa, 
belgilangan mavdon hududi ortadi. Shift klavish o'rnida Alt klavishi 
qoilanilgan taqdirda belgilangan maydon hududi qisqaradi. Ushbu 
amal Jlacco va Волшебная палочка uskunalari bilan ishlashda 
qollaniladi.
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Эллиптическая область: Tasvirda doira shaklidagi mavdonni 
belgilab olish uchun qoMlaniladi. Bu uskuna yordamida tasvirdagi 
alohida maydonni belgilab olingandan keyin tasvirga kiritilgan barcha 
o‘zgarishlar faqat belgilangan maydon ichiga ta'sir etadi.

Строка пикселей: Tasvirda gorizontal shakldagi chiziqni 
belgilaydi. Am alda bu uskuna juda kam qoMlaniladi.

Столбец пикселей: Tasvir yuzida vertikal chiziqni belgilaydi. 
Amalda bu uskuaa ham juda kam qo’llaniladi.

Кадрирование: Ushbu uskuna, asosan, tasvir chetlarini va 
keraksiz qismlarini kesib tashlash uchun qcrllaniladi. Bu buyruq 
faollashtirilganda tasvir yuzida to‘g‘ri to‘rtburchak shaklidagi ramka 
hosil bo‘ladi. Ramkaning chetlari kichik kvadratchalardan iborat boiib, 
bu kvadratchalar yordamida ramka hajmi o'zgartiriladi. Tasvir ramka 
ostiga olingandan so‘ng Enter klavishi bosilsa, ramka tashqarisida 
qolgan ortiqcha boMaklar kesib tashlanadi. Ushbu buyruqni Esc 
klavishini bosib rad etish mumkin.

Перемещение: Ushbu uskuna tasvirdagi belgilangan maydonni 
yok i qatlamni siljitish va kesib olish uchun xizmat qiladi. Ba'zan Пере
мещение buyrug‘ ini bajaradigan ayni jarayonni boshqa ayrim uskunalar 
(masalan, Волшебная палочка uskunasi) yordamida ham amalga 
oshirish mumkin.

Лассо: tasvirdagi turli shakldagi obyektlarni belgilash uchun ish- 
latiladi.

Многоугольное лассо: Asosan tasvirdagi to‘g‘ri chiziqlardan 
iborat obyektlarni belgilashda ishlatiladi. Alt klavishi bilan 
q o ‘llanilganda oddiy Лассо uskunasi vazifasini bajaradi.

Магнитное лассо: Bu uskuna ishlatilganda Adobe Photoshop 
dasturi tasvirdagi obyekt chegaralarini o‘zi belgilaydi. Ammo bu 
uskuna piksellardagi ranglarni ozgarishiga bogMiq tarzda chegaralarni 
aniqlashi bois kam qo'llaniladi.

Волшебная палочка: Bir-biriga yaqin bo‘lgan rangdagi piksellar 
joylashgan maydonni belgilaydi. Shift bilan birgalikda qo;llansa. 
belgilangan maydon hajmi ortadi. Alt bilan ishlatilganda esa belgilangan 
maydon hajmi kamayadi.

Аэрограф: Tasvirni bo‘yashda ishlatiladi. Aerografni bir joyda 
usshiab turish siyohni tasvir bo‘ylab yoyilib ketish effektini beradi.
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Buyoqning tasvir bo'ylab oqishi kursorni qo'yib yubormaguncha davom 
etadi. Odatda bu uskuna bilan yumshoq chutkalar ishlatiladi. Aerograf 
kursorni ushbu uskuna ustida bosish yoki klaviaturadagi J klavishni 
bosish orqali faollashtiriladi.

Кисть: Aerograf uskunasi kabi tasvirni buyashda ishlatiladi. 
Ammo Kist yordamida tasvirni sifatli bo'yash mumkin. Bu uskuna 
aerografga nisbatan ko'p qoMlaniladi. Kist uskunasini V klavishini 
bosish orqali faollashtirish mumkin. Brushes darchasi yordamida buyoq 
mo'yqalamlarining shaklini o‘zgartirish mumkin.

Штамп: Tasvirdagi kichik bir boiak  nusxasini ko'chirish uchun 
ishlatiladi. Bu uskuna tasvirdagi ayrim nuqsonlarni, dogiarni yo‘qotish 
va eski rasmlarni tiklashda keng qoilaniladi.

Кисть преды дущ их состояний: Bu uskuna tasvir haqidagi 
dastlabki maMumotlar asosida ishlaydi. Uning yordamida tasvirga 
kiritilgan so nggi o'zgartirishlarni bekor qilish mumkin.

Ластик: Tasvirni o4chirish uchun ishlatiladi. U qoilanganda 
tasvirda fon qaysi rangda b o isa , o'sha rangdagi chiziqlar hosil boiadi. 
Alt klavishini qoilash yordamida kompyuter xotirasiga olinmagan 
so^nggi o'zgartishlarni bekor qilish mumkin. Lastik uskunasi E 
klavishini bosish orqali faollashtiriladi.

Карандаш: Turli chiziqlarni chizish uchun foydalaniladi. Alt 
klavishi bosilganda kursorning ekrandagi tasviri o‘zgaradi va bevosita 
tasvirdan kerakli rangni tanlash mumkin. Bu amal bajarilgandan so'ng 
Карандаш o’sha rangda chiziq tortadi.

Линия: To'g'ri chiziqlarni chizishda qoilaniladi.
Размывка: Ushbu uskuna ishlatilganda, tasvirdagi yorqinlik pa- 

sayadi. Alt klavishi bilan qoilanganda yorqinlik ortadi.
Резкость: Ushbu uskuna ishlatilganda tasvirdagi yorqinlik ortadi. 

Alt klavishi bilan qoilanganda esa tasvir xiralashadi.
Палец: Tasvirdagi ranglar chayqaltirib. tasvirdagi obyektlar olr- 

tasidagi chegaralarni bir-biriga qo‘shishga xizmat qiladi.
Осветитель: Piksellardagi ranglar yorqinlashadi. Alt klavishi bilan 

qoilanganda esa piksellardagi ranglar xiralashadi.
Заменитель: Tasvir ustida harakatlantirilganda piksellardagi rang

lar qoramtir tus oladi.
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Губка: Tasvir ustida harakatlantirilganda, tasvirdagi ranglar 
miqdori pasayadi. Gubka bir joyda ko‘p harakatlantirilsa, tasvirning 
o'sha jovi kul rang tus oladi.

Перо: Peroni tasvir ustida harakatlantirilganda, nuqtalar hosil 
b oiad i. Ushbu nuqtalar yordamida chizilgan tasvirni o'zgartirish 
mumkin.

М агнитное перо: Bu uskuna xuddi Магнитное Jlacco kabi 
harakatlanadi. Biror-bir tasvirdagi obyekt atrofida harakatlantirilganda. 
Adobe Photoshop dasturining o'zi obyekt chetlarini belgilab chiqadi.

Произвольное перо: Juda qulay uskuna boiib, xohlagan shakldagi 
tasvirni u yordamida ifodalash mumkin.

Вставить точку: Bu uskuna Pero yordamida chizilgan chiziq 
ustiga qo‘shimcha nuqtalarni qo'shadi.

Удалить точку: Pero yordamida chizilgan chiziq ustidagi ortiqcha 
b oigan  nuqtalarni o¿chiradi.

Н епосредственное выделение: U yoki bu pero bilan chizilgan 
chiziqlarni tahrir qilish uchun xizmat qiladi. Uning yordamida 
chiziqdagi nuqtalarni yakka tartibda harakatlantirish va kerakli joyga 
siljitish mumkin.

Преобразовать точку: Tasvir ustida chizilgan chiziqchalarda 
oi*natilgan liar bir nuqta. burchak yoki voy vazifasini bajaradi. Ushbu 
uskuna yordamida nuqtalarning vazifalarini o'zgartirish, va’ni yoyni 
burchakka va burchakni yoyga almashtirish mumkin. Buning uchun 
kursorni nuqta ustiga olib borib sicliqonchaning chap tugmasi bir marta 
bosiladi.

Текст: Ushbu uskuna yordamida tasvirga turli matnlarni kiritish 
mumkin. Текст uskunasi faollashtirib, kursor tasvir ustida bosilsa. matn 
kiritish uchun alohida darcha hosil boiadi. Bu darchada harf oichami, 
turi. rangi va boshqa koisatkichlari kiritiladi. Bu uskuna yordamida 
kiritilgan matnni qayta tahrir qilish imkoni mavjud emas.

Текст-маска: «Текст» uskunasi kabi bu uskuna faollashtirilib, 
matn ustida bir marta bosilganda. «Текстовый инструмент» darchasi 
hosil boiadi. Lekin bu matn oddiv matndan tubdan farq qiladi. 
Harflarning cheti xuddi Jlacco uskunasida belgilash kabi ko‘rinishga ega 
boiad i. Harflarni turli ranglarga bo‘yash va «Перемещение» uskunasi 
yordamida o'rnidan siljitish yoki boshqa rasmga olib o'tish mumkin.
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Вертикальный текст: Agar tasvirga pastdan yuqoriga shaklda 
(vertikal shaklda) matn kiritmoqchi boMsangiz ushbu uskunadan 
foydalanishingiz mumkin.

Вертикальная текст-маска: Xuddi Текст-маска uskunasi kabi 
bir xil vazifani bajaradi. Ammo bu uskuna qoilanganida harflar ustma- 
ust ustun kabi joylashtiriladi.

Измеритель: Tasvirda turli oichovlarni bajarish uchun ishlatiladi. 
Bu uskuna bilan bir nuqtadan ikkinchi nuqtaga kursor olib borilishi 
kifoya. Shundan so'ng dastur avtomatik tarzda ikki nuqta orasidagi 
masofani oichaydi.

Градиент: Bu uskuna ishlatilganda, tasvirdagi belgilangan may- 
donda ranglar kombinatsiyasi hosil boiadi. Asosiy rangning tasvir 
foniga sizibo'tish effekti hosil b o iad i.

Ковш: Ushbu uskunadan asosan. tasvirni yoki tasvirdagi ajratib 
olingan hududni bo'yashda foydalaniladi. Ranglarni qo'shimcha 
buyruqlarni bajarish orqali tanlanadi. Bu uskunani faollashtirish uchun 
К klavishi bosiladi.

Пипетка: Tasvirdagi asosiy yoki tasvir foni rangini o'zgartiradi. 
Пипетка tasvir ustidagi biror nuqtada bosish bilan o‘sha nuqtadagi, 
ya'ni pikseldagi rang asosiy (faol) rang sifatida tanlanadi. Agar 
ayni jarayonga Alt klavishasi qo'shilsa, tanlangan rang tasvir fonini 
o'zgartirishiga olib keladi.

Выборка цветов: Ushbu uskuna tasvirdagi ranglar haqida axborot 
olishga xizmat qiladi. Info darchasida belgi qo'yilgan nuqtada necha 
foiz qizil, ko‘k va qora ranglar mavjudligi haqidagi axborot hosil 
boiadi.

Рука: Tasvirning ko'zga tashlanmay turgan qismlarini ko'rsatadi. 
Buning uchun ushbu uskuna faollashtirilib tasvir ustida sichqonchaning 
chap tugmasini bosgan holda kerakli tomonga harakatlantiriladi. Ayni 
jarayonni Adobe Photoshop dasturi darchasidagi Navigator yordamida 
ham amalga oshirish mumkin.

Масштаб: Tasvirni kattalashtirish yoki kichraytirib ko'rsatish 
uchun xizmat qiladi. Agar ushbu uskuna bilan birgalikda Alt klavishi 
ishlatilsa. tasvir kichrayadi. Kursor ushbu uskuna faollashtirilgandan 
so'ng o¿z shaklini o'zgartiradi va lupa ko‘rinishini oladi. Kursor 
tasvirning qaysi nuqtasida bosilsa. Adobe Photoshop dasturi
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avtomatik tarzda o'sha nuqtani ekranga yaqinlashtiradi. Masshtab 
uskunasini faollashtirib. Enter klavishi bosilsa, Опция масштаби
рования darchasi ochiladi. Bu darchada maxsus to'rtburchak ichiga 
belgi qo'yilsa. tasvir oichamlari o'zgartirilganda tasvir darchasi ham 
m os tarzda o'zgaradi. Har safar tasvir oichamlarini kattalashtirish 
yoki kichraytirish uchun Масштаб uskunasini faollashtirish zarur 
etnas. Boshqa uskuna bilan ishlash pavtida Ctrl-Probel bosilsa. 
ishlatilayotgan uskuna vaqtinchalik Масштаб uskunasi vazifasini 
bajaradi va tasvir kattalashadi. Ctrl + Probel o in id a  Alt+Probel 
qoilan ilsa , tasvir o;lchami kichrayadi. Shuningdek, tasvir oTchamini 
Ctrl + «+» (plyus) klavishlari yordamida kattalashtirish yoki Ctrl+ 
« —» (minus) yordamida kichraytirish mumkin. Adobe Photoshop 
dasturi darchasi ostida «Строка состояния» satrida tasvir oichamlari 
haqida axborot beruvchi maxsus darcha mavjud. Bu darchada tasvir 
o¿lchamlari sonlarda ifodalangan. Ushbu sonlarni o'zgartirish orqali 
tasvirning aniq oichamlari kiritiladi.

Основной цвет: Ushbu uskuna ustida kursor ikki marta ketma-ket 
bosilganda Adobe Photoshop dasturining yangi darchasi (Выбор цвета) 
hosil boiadi. Bu darchada kerakli rang tanlanib. OK yoki Enter tugmasi 
bosiladi va tanlangan rangni Карандаш, Кисть, Аэрограф. Гради
ент kabi uskunalari yordamida qoilash mumkin. Цвет фона: Ushbu 
tugma ustida kursor (sichqoncha chap tugmasi) ikki marta ketma-ket 
bosilganda Adobe Photoshop dasturining yangi darchasi (Color Picker) 
hosil boiadi. Bu darchada tasvir fonining rangi aniqlanadi. Tasvir 
fonidagi rang Ласточка va Градиент uskunalari uchun qoilaniladi.

Переключение цветов: Ushbu belgi ustida kursorni bosish bilan 
asosiy rang bilan tasvir foni ranglari o‘rni almashtiriladi.

Цвета по умолчанию: Bu belgi ustida kursorni bir marta bosish 
bilan asosiy rang qoraga va tasvir foni ranglari oqqa ayianadi.

Марширующие муравьи: Bu tugma yordamida Adobe Photoshop 
dasturida tez niqoblash holati bekor qilinadi. Ekranda belgilash 
chegaralari chumolilar harakatini eslatuvchi punktir chiziq yordamida 
aks ettiriladi. Bu Adobe Photoshop dasturida odatda standart holat deb 
ataladi.

Быстрая маска: Ushbu tugma ustida kursor bir marta bosilishi 
bilan Adobe Photoshop dasturi tez niqoblash holatiga o'tadi va
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natijada tasvirdagi niqoblanm agan xudud qizil rang bilan bo'yaladi. 
Ushbu uskuna tasvirdagi turli obyektlarni aniq niqoblashda 
ishlatiladi. Кист uskunasi yordam ida niqobga ishlov berish mumkin. 
Blinda qora rang bilan tasvir niqoblanadi. oq rang bilan tasvirdagi 
niqob o’chiriladi.

Стандартное окно: U skuna faollashtirilganda tasvir standart 
holatda boiadi.

Полный экран с меню : Bu holat tasvir kompyuter ekraniga sig¿- 
magan holda ishlatiladi. Ushbu uskuna faollashtirilganda ekranda 
íaqatgina menyu satri hamda uskunalar paneli qoladi.

Полный экран: Ekranda faqat tasvir va uskunalar paneli hamda 
menyu satri qora fonda qoladi.

Tasvir o‘lchami
Adobe Photoshop dasturida ekranda tasvirning barcha qismini yoki 

tasvirdagi kichik detallarni ko'rish uchun xohlagancha kattalashtirish 
yoki kichraytirish mumkin. Masalan. 100% -  bu tasvirdagi piksellar 
soniga ekrandagi piksellar son i tengligini anglatadi. Ya'ni 1:1. 200% 
ga tasvir kattalashtirilganda ekrandagi bir pikselga katta miqdordaga 
piksellar miqdorini to‘g'ri kelayotganligidan dalolat beradi.

Tasvirning haqiqiy o4chami

Adobe Photoshop dasturida 100% li o’lcham tasvirning real o'lchami 
deyiladi. 100% li oMchamda tasvir aniq va ravshan ko‘rinadi.

Tasvirning real o lch am i quyidagi amallarni bajarish orqali о‘гпа- 
tiladi:

□ Menvular satrida В ид menyusida Реальный размер buyrug'ini 
tanlang;

□ Ctrl+ Alt^ 0 (nol) tugmalarini birgalikda bosish orqali;
□ Uskunalar panelidagi Масштаб tugma ustida sichqoncha tug- 

masîni îkk i marta ketma-ket bosish oTqalr.

ToMiq ekranli rejim

Adobe Photoshop dasturi tasvirni birinchi marta ochganda uni 
maksimal o'lchamda ochadi. Tasvir bilan ishlash jarayonida uning 
oMchamini bir necha marta kattalashtirish yoki kichraytirishga tobg'ri
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keladi. Ana shundav holatlarda tasvirni xohlagan paytda dastlabki 
Полноэкранный режим holatiga qaytarish mumldn. Buning uchun 
quyridagi amallarni bajarish lozim:

□  Menyular satrida Вид menyusidagi По размерам экрана 
buyrugin i tanlash;

□  Ctrl+ 0 (nol) tugmalarini birgalikda bosing;
□  Uskunalar panelidagi Рука tugmasi ustida sichqoncha chap 

tugnnasini ikki marta ketma-ket bosing.

Tasvirning bosma shakldagi o‘lchami (Размер печати)

Adobe Photoshop dasturi tasvirning printerda chop qilingandagi 
ko'rinishini chop qilmasdan avval ekranda ko'rish imkonini beradi. 
Buning uchun Menyular satrida Изображение menyusi tarkibidagi 
Размер изображения buyrug'ini tanlanadi. Ammo, hamma vaqt ham 
tasvirning ekrandagi ko'rinishi bilan chop etilgandagi o:lchamlari 
aynan mos tushavermaydi. Tasvir kattaliklari 0,2% dan 16000% miqdor 
o'rtasidagi sonlar bilan belgilanadi.

Navigator darchasi bilan ishlash

A dobe Photoshop dasturida tasvirdagi mayda detallar bilan 
ishlash jarayonida tasvirni bir necha marta kattalashtirishga to'g'ri 
keladi. Tasvirga kiritilgan o’zgartirishlar sifatli chiqishi uchun 
Navigator darchasida amal bajariladi. Navigator darchasi asosan 
tasv ir  o'lchamlarini crzgartirish va tasvirni boshqarish uchun xizmat 
qiladi. Agar Navigator darchasi Adobe Photoshop dasturi ishga 
tushirilganda ekranda mavjud boim asa. uni faollashtirish uchun 
m enyular satrida Окно menyusidagi Показать Навигатор buyrugkini 
bering.

Action darchasi bilan ishlash

A ction  darchasi Adobe Photoshop dasturida ishlashni vanada 
tezlashtiradi va bir nechta tasvir ustida anialga oshiriladigan bir 
xil amallarni har safar takrorlashga zaruriyat qoldirmaydi. Adobe 
Photoshop dasturidagi Action darchasi bilan ishlashni bilsangiz. qisqa 
fursat ichida k o‘p miqdordagi tasvirni tahrir qilishingiz mumkin.
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Buning uchun Action darchasida yangi Action ochiladi. Uni kerakli 
nom bilan nomlagandan so'ng Record tugmasi bosiladi. Shu daqiqadan 
boshlab Adobe PhotoShop dasturi sizning tasvir ustida bajargan barcha 
amallaringizni kompyuter xotirasiga ketma-ket joylashtiradi. Tasvir 
ustida barcha am allar yakunlangandan so4ng Action darchasidagi 
Stop tugmasi bosiladi. Adobe PhotoShop dasturi sizning barcha 
amallaringizni tartibli ravishda Action darchasida joylashtiradi. Boshqa 
tasvirlarga ushbu amallarni qoMlash uchun yangi tasvir ochilgandan 
so4ng Action darchasidagi Выполнение buyrug‘ini ishga tushirish 
lozim. Adobe PhotoShop dasturi avtomatik tarzda yangi ochilgan 
tasvirda ham siz am alga oshirgan vazifalarni hech bir o'zgarishlarsiz 
bajaradi.

Yangi ta s v ir  y a ra tis h , d u b lik a t olish va ta s v irn i 

d o im iy  xo tiraga  jo y la sh tir ish

Adobe PhotoShop dasturida ishlashdan avval yangi fayl tuziladi 
yoki kompyuter xotirasida mavjud bo4lgan tasvir ochiladi. Yangi fayl 
tuzish va avvaldan mavjud bo4lgan fayllarni ochishning quyidagi 
yoMlari mavjud:

□ Файл > Новый. Menyu satrida Файл menyusini ochib Новый 
buyrug'ini tanlang yoki Ctri+N tugmalari kombinatsiyasidan foydalanib. 
yangi fayl yarating. Yuqoridagi amal bajarilganidan so'ng Adobe 
PhotoShop dasturi yangi faylni tashkil etish uchun uning o'ichamlari 
haqidagi ma’lumotlar bitilgan yangi darchani hosil qiladi. Bunda 
yangi tuzilayotgan fayl nomi? uning o'ichamlari kiritilishi talab etiladi. 
Kerakli o’ichamlar kiritilganidan so‘ng OK tugmasini bosish lozim. 
Adobe PhotoShop dasturi oq rangdagi (bo4sh) yangi tasvirni tuzadi. 
Bu tasvirga xohlagan o4zgartirish kiritish yoki boshqa tasvirlardan 
ayrim detallarni ko'chirib o'tkazib, umuman yangi tasvirni ijod qilish 
mumkin.

□ Файл > Открыть: Menyu satrida Файл menyusini ochib Отк
рыть buyrug'ini tanlang yoki Ctrl+O tugmalari kombinatsiyasidan 
foydalanib kompyuter xotirasida mavjud bo4lgan faylni oching. 
Juda kam hol larda Файл -  Открыть Как (Ctrl+Alt+O) buy rug4 i 
tanlanadi.



Tasvir formatlari

A dobe PhotoShop dasturi 20 dan ortiq formatdagi fayllar bilan 
ishlash im koniga ega. Eng ko;p qo'llaniladigan formatlar:

BMP (Windows Bitmap) -  Windows muhitida ishlovchi kompyu- 
terlarda ekran osti tasvirlarini qo4Iovchi dastur Microsoft Paintda keng 
qo‘llaniladi.

JPEG (Joint Phonographic Experts Group) -  hozirgi kunda eng ko‘p 
qoilaniladigan formatlardan biri bolib , uning asosiy afzalliklaridan 
biri m axsus dastur yordamida favl hajmini yetarlicha siqish imkonining 
mavjudligidir. Ammo faylni siqib hajmini kichraytirish jarayonida 
tasvir sifatida o4zgarish bo'ladi. Fayl kuchli siqilganda tasvir sifati 
yom onlashishi mumkin. Ushbu formatdagi favllar kompyuter xotirasida 
ko‘p joy egallamaydi. Hajm jihatidan kichikligi sababli mazkur 
formatdagi tasvirlar bilan ishlashni ancha osonlashtiradi. Aksariyat 
raqamli fotokameralar, videokameralar va skanerlar yordamida olingan 
rasmlar JPEG formatida saqlanadi.

TIFF (Tagged Image File Format) -  bu formatdagi fayllar ham keng 
qoilaniladi. Lekin TIFF formatidagi fayllar kompyuter xotirasida ko'p 
joy ni egallaydi. Adobe PhotoShop dasturida ushbu formatdagi tasvirlar 
bilan ishlashda dastuming ishlash tezligi sezilarli ravishda pasayishi 
mumkin.

GIF (Graphics Interchage Format) -  ushbu formatdagi tasvirlar 256 
turdagi rang bilan tasvirlanadi. Bu formatdagi tasvirlar asosan Internet 
tizimida keng qoilaniladi.

R an g la r b ila n  ishlash

Adobe PhotoShop dasturida uskunalar panelida ranglar bilan ishlash 
uchun to‘rtta uskuna ajratilgan:

□ Основной цвет. Ushbu uskunada qanday rang ko'rsatilgan 
bo'lsa. Ковш. Линия. Карандаш. Кисть, Аэрограф va shuningdek Alt 
klavishi bilan birgalikda qollanganda Палец uskunalari uchun o ;sha 
rang asosiy hisoblanadi. Основной цвет uskunasidagi rang Пипетка 
yoki ushbu uskuna ustida sichqoncha chap tugmasini ikki marta ketma- 
ket bosish orqali o'zgartiriladi.
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□ Цвет фона. Ko'rsatilgan rang Ластик uskunasi bilan ishlaganda 
qo’llaniladi. Цвет фона uskunasidagi rang Основной цвет uskunasida 
rangni o’zgartirish uchun qanday amal bajarilgan bo4sa, bunda ham 
xuddi o’sha amalga rioya qilish  lozim yoki Пипетка uskunasi bilan Alt 
klavishini birgalikda bosish orqali rangni almashtirish mumkin.

□ Переключение цветов. Kursorni ushbu tugma ustida bir marta 
bosish orqali asosiy rang va fon rarigi o'rin almashadi.

□ Стандартный цвет. Kursorni ushbu tugma ustida bir marta 
bosish asosiy rang va fon rangini standart ranglar -  qora va oq rangga 
almashtiradi.

Ranglarni tanlashda A dobe Photoshop dasturida Color yoki 
Swatches darchalaridan ham fovdalanish mumkin.

RGB (Red, Green. B lue-qizil, ko;k, yashil) moduli tasvirni ekranda 
tahrir qilish nuqtai nazaridan kelib chiqqan holda juda qulay va u 24 
razryadli ranglar platasi yordamida deyarli barcha 16 million ranglarni 
monitorda aks ettiradi. RGB ranglar majmuasi bilan ishlangan barcha 
tasvirlarni xohlagan formatda diskka yozish mumkin. RGB ranglar 
majmuasidagi ayrim ranglar umuman tabiatda uchramaydi.

CMYB-tabiatda mavjud bolgan ranglar majmuasi, quyosh 
nurlari inson ko'zlari ajrata oladigan barcha ranglarni o‘zida mu- 
jassamlashtirgan. Quyosh nurlari biror bir jismga tushganda uning ta’siri 
ostida inson ko'zlari jism shakli va rangini idrok etadi. Misol uchun 
binolarning o*t o4chirish burchaklariga osib qo'yilgan o‘t o'chirgichlar 
to’q ko'k va zangori ranglar bilan bowyalgan bo‘lishiga qaramay. bizning 
ko'zimizga to‘q qizil rangda ko'rinadi. Ranglarni bir-biriga qobshilishi 
natijasi boshqa ranglar hosil qilinadi:

S — havo ra n g ; M — binafsha  ran g ; Y -  sariq rang; В -  qora rang.
Bosma mashinalari va bosmaxonalarda tasvirlar yuqorida keltirilgan 

ranglarning kombinatsiyasidan fovdalangan holda to4a tasvirni 
ifodalaydi.

RGB ranglar majmuasi da oq rang uchala ranglarning maksimal 
aralashmasidan hosil qilinadi. Qora rang esa buning aksi ularoq olinadi.

CMYB ranglar majmuasi bilan ishlaganda qora va oq ranglarni 
hosil qilish uchun buning aksini bajarish lozim. Ya’ni to'rt rangning 
minimal qo'shilishida oq rang hosil bo'ladi. Qora rang esa alohida 
kanalda mavjud.
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KGB ranglar majmui keng kolamdagi ranglarni taklif etadi. 
L ekin  ularning kokp qismi (ayniqsa. yorqinlari) tasvirni chop 
etganda monitordagi bilan keskin farq qiladi. Shu bois ham ko'plab 
mutaxassislar tasvirni chop etishdan avval uni CMYB tizimiga 
o‘tkazadilar. Ayrim mutaxassislar esa tasvir bilan CMYB tizimida 
ishlashni maslahat beradilar. Ammo bu tasvir bilan ishlash turli 
qiyinchiliklarni tug'diradi. Ana shunday qiyinchiliklardan biri- 
kompyuter juda sekin ishlaydi. Bunga asosiy sabab Adobe PhotoShop 
dasturi RGB tizimiga sozlangan bcflib, har bir buyruqni bajarib, uni 
RG B tizimidan CMYB tizimiga almashtirgunga qadar kompyuter 
qo‘shim cha vaqt talab qiladi. Bundan tashqari. skaner va monitor 
RG B tizimida ishlashga moljallangan. Ranglar bilan ishlovchi barcha 
uskunalar (rangli printerdan tashqari) RGB tizimida ishlaydi. Shuning 
uchun yaxshisi tasvirni chop etishdan avval CMYB tizimiga o'tkazib 
olish  maqsadga muvofiq. Tasvir ustida barcha amallarni poyoniga 
yetkazib, menvular satrida Изображение -  Настройка tarkibidagi 
CM Y B buyrug'ini tanlang.

H is to ry  darchasi bilan ishlash

Adobe PhotoShop dasturi ishga tushirilganda ekranda History 
darchasi mavjud bo'lmasa. Окно menyusida Показать History 
buyrug‘ini tanlang. History darchasida tasvirga kiritilgan so’nggi 
o'zgartirishlar haqidagi ma’lumotlar joylashadi. Tasvir ustida bajarilgan 
har bir muhim amallar History darchasida ro'vxatga olinadi. Xohlagan 
paytda yoqmagan amallarni History darchasi orqali rad etish mumkin. 
Buning uchun kursor bajarilgan so'nggi amaldan oldingi buyrug'i 
ustida bosiladi voki Ctrl+Alt-r7 klavishlari bosiladi. Adobe PhotoShop 
dasturi bajarilgan so'nggi 20 amalni ro“yxatga oladi, yigirma birinchi 
am al bajarilganda Adobe PhotoShop dasturi avvalgi amallarni 
o'chiradi.

Q atlam lar bilan ishlash

Adobe PhotoShop dasturi tasvirdagi biror obvekt Прямоуголь
ная область. Эллиптическая область. Лассо. Волшебная палоч
ка, Быстрая маска yordamida tasvirdagi detallar belgilanib ularning
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nusxalari olinganda Adobe PhotoShop dasturi yangi qatlam hosil 
qiladi. Bu qatlam alohida obyekt bo'lib, uni tahrir qilish ham alohida 
tarzda bo'ladi. Bir nechta tasvirlardagi ayrim detallarni yagona 
tas\irga jamlanganda Adobe PhotoShop dasturi ko'chirib o'tilgan 
tas\ir bo'laklarni qatlamlarga ajratadi. Ayni jarayon tasvir detallarini 
joylashtirish uchun juda qulay. Bir necha qatlamlar bilan ishlaganda 
iilami boshqarish qiyinlashadi. Adobe PhotoShop dasturi bajarilganda 
yangi darcha hosil boMadi. B u  darchada tasvirdagi yangi qatlamlar 
haqidagi axborotlar joylashadi. Yangi qatlam hosil qilinganda Adobe 
PhotoShop dasturi uni Слой darchasida nryxatga oladi. Bu darchada 
qatlamlar tartibli tarzda joylashtiriladi. Shuningdek, qatlamlarning 
o'rnini almashtirish yoki vaqtincha o‘chirib qo‘yish mumkin. 
Qatlamlarni o'chirish uchun avval kerakli qatlam Слой darchasida 
belgilab olinadi va menyular satrida Слой menyusi tarkibidagi Уда
лить Слой buyrug‘i tanlanadi. Qatlamlarni bir-biriga birlashtirish 
imkoniyati ham mavjud.

F i l t r la r  b ila n  ishlash

Adobe PhotoShop dasturida tasvirni qo4shimcha effektlar bilan 
boyitish uchun filtrlardan foydalanish mumkin. Buning uchun menyular 
satrida Филтры buyrug'i tarkibidagi filtrlardan foydalanishingiz 
mumkin.

Photoshop va ImageReady dasturlariga tasvirni tez ko'rib chi- 
qish moduli kiritilgan. Oldingi vaqtlarda bu ishni amalga oshirish 
uchun tashqi dastur (utilit)lar ishlatilar edi. Masalan ACDSee yoki 
ThumbsPlus. Cho'ntak kompyuterlari uchun rasmni importi va eksporti 
WBMP formatli filtrlari kiritilgan. Kompyuterning ishlash chegarasi 
doirasida avtomatik tarzda rasmning sifatini buzmagan holda moslashuv 
(optimizatsiya)ni bajaradi.

Photoshop 7.0 dasturiga guruh (групповой) boiib  ishlash 
uchun qo'shimcha imkoniyatlar kiritildi. Bu bir kompyuterda turli 
foydalanuvchilar tomonidan Adobe dasturida ishlash imkoniyatini 
beradigan AfterCast kengaytgich qo'shildi. Agar bir foydalanuvchi 
tasvirga o'zgartirish kiritsa bir vaqtning o'zida hamma foydalanuvchilar 
kuzata oladi. Am m o AfterCast sozlashni faqat administrator boshqara
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oladi, lekin bu shaxsiy kompyuterlarda Photoshop dasturida ishlovchi 
foydalanuvchilar bu muammoga duch kelmaydilar. Biz yuqorida 
faqatgina Photoshopning 7-versiyasini asosiv imkoniyatlarini sanab 
chiqdik.

U s k u n a la r  pane li

Ekranda turgan dastur uskunalarini ishga tushirish uchun sichqoncha 
bilan uni ustiga bosing va ekranda ko'rinayotgan piktogrammani ustiga 
bosing. Bir xil piktogrammalar yonida kichik ko'rsatkich (strelkacha) 
lar mavjud. Agar uni ustiga bosilsa tasvirga to’g'ri keluvchi oynalar 
ko'rsatiladi. U yerdan siz kerakli uskunalarni tanlashingiz mumkin. 
Har bir uskuna uchun o6zining oMchamlari ekran tepasida joylashgan 
Opsiyalar panelida mavjuddir (masalan. режим смешивания, значение 
непрозрачности).

Opsiyalar paneli

Opsiyalar paneli har bir Liskunaning parametrlarini sozlash uchun 
ishlatiladi (masalan. shaffoflik darajasi yoki tasvirni aralashtirish 
rejimini) (4.1-rasm). Opsiyalar panelining o’ng tomonida maxsus 
ranglarni saqlovchi bo'lim mavjuddir. Parametrlarni ko'rsatilishi qaysi 
rasmni tanlanganiga bog'liq (4.1-4.6-rasm). Fovdalanuvchi tomonidan 
kiritilgan tasvir ko4rinishi boshqa o6zgartirishlar kiritilgunga qadar 
saqlanadi. Palitra va Opsiyalar panelini ham ekranning istalgan joyiga 
siljitish mumkin.

У Brush:
45

Mode: |Ñorñ3 3  Opacity: [lOCn 1 ► 1 Flow: \S' % \ ► [ ' &

4. J-rasm. Brush uskunasi uchun Opsiyalar paneli.

; _j L ĵ iP □ Feather: |ü px Г" Style: (Normal 3

4 . 2 - r a s m .  Rectangular Marquee uskunasi uchun Opsiyalar paneli.

[ 1 - i H  Ш 1 1 1 j u á j z i a  Mode: [ÑórrriTi 3  Opacity: llOü:& 1 *1

4.3-rasm. Gradient uskunasi uchun Opsiyalar paneli.
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4 . 4 - r a s m .  Pen uskunasi uchun O psiyalar paneli.

J

4 . 5 - r a s m .  Rectangle uskunasi uchun Opsiyalar paneli.

H  I Т р й  3  aa[ihl^ 3

4 . 6 - r a s m .  T ure  uskunasi uchun Opsiyalar paneli.

Opsiyalar panelining ofcng tomonida faol uskuna piktogrammasi 
ko‘rsatilgan. Agar piktogramma yonidagi strelka ustiga bosilsa. 
ko'rinmay turgan menyu ochiladi. unda boshqa kerakli boigan  
uskunani tanlash mumkin. Bu jadvalga o4zgartirishlar kiritish mumkin. 
ya’ni kam ishlatilayotgan uskunalarni olib tashlab o;rniga kerakli 
bo'lgan uskunalarni joy lash mumkin. Har bir Opsiyalar paneliga 
kiritilgan o'zgartirishlar avtomatik tarzda saqlanib qolinadi. Tugmalarni 
qavta tiklash va joylashtirish ishlari paydo bo4uvchi paneldan amalga 
oshiriladi.

Istalgan piktogramma ustida sichqonchani chap tugmasini bos- 
masdan olib boring shunda siz ishlatmoqchi bo'lgan uskunaning nomi 
va uni klaviatura orqali ishga tushiradigan tugmachalar ko‘rsatiladi. 
Shu bilan bir qatorda ishlatilayotgan Opsiyalar oynasi va uning vazifasi 
haqida qisqacha ma'lumot olish mumkin. E d it  >  Preferences >  G e ne ra l 

(Правка > Установки >  Общие) oynasidagi yordamchi maslahatlar 
oynasini ishlatish uchun Show  Too l T ip s  oynasi ustiga bayroqchani 
oTnating (Показывать всплывающие подсказки).

Istalgan tasvirni xohlagan paytda o'zgartirishlar kiritish imkonini va 
12 turdagi Photoshop kengaytmalarida saqlash imkonini beradi. Ammo 
odatda ko'pincha quyidagi Photoshop formatlari ishlatiladi: TIFF, GIF, 
JPEG. EPS.

Yordamchi maslahatlar



Photoshop dasturida ko;pgina operatsiyalar asosan palitralar orqali 
bajariladi. Ekranda ko’p joy egallamasligi nchun palitralar o'zaro 
guruhlarga biriktirilgan: N a v ig a to r / In fo  (Boshqaruv / Ma’lumot). 
C o lo r  /  Swatches / Styles (Rang / Namuna /  Uslublar). H is to ry  / 
A c tio n s  / Too l Presets (Tarixi / harakatlar / Uskunalar tanlash), Layers 

/ C h a n n e ls  /  Paths (Qatlamlar /  Kanallar / Konturlar) va C h a ra c te r / 
P a ra g ra p h  (Shrift / Abzats).

P a l i t r a la r

Photoshop dasturida ko‘p operatsiyalar palitralar orqali bajariladi. 
Ularni o ‘zaro aralashtirish ham mumkin. Istalgan palitrani ochish uchun 
esa W indow  (Окно) menyu buy ruqlari yordamida amalga oshiriladi. 
Belgilangan palitra boshqa shu guruhga kiruvchi palitralardan eng 
yuqorida avtomatik tarzda joylashadi.

P h o to sh o p  dasturidan chiqish: Windows operatsion tizimida bu 
dastur oynasini yopish uchun F ile > E xit (Файл > Выход) buy rug* ini 
bering yoki (C trl+Q ) tugmalar kombinatsiyasini bosing.

Savol va topshiriqlar:

1. Adobe Photoshop dasturi qanday ishga tushiriladi?
2. Adobe Photoshop dasturining asosiy menvusi nimalardan tashkil 

topgan?
3. Opsiyalar paneli nima uchun ishlatiladi?
4. Palitra operatsiyalari orqali nima bajarish mumkin?

4.3. Adobe Photoshop dasturida tasvir va rasm bilan ishlash

Adobe Photoshop Windows muhitida ishlovchi elektron ko*ri- 
nishdagi foto tasvirlarini tahrirlovchi dasturdir. Adobe Photoshop 
dasturi Adobe System Inc kompaniyasi tomonidan ishlab chiqarilgan 
bo'lib, ishlatishdagi alohida qulavliklari bilan mashhur hisoblanadi.

Adobe Photoshop grafik muharriri yordamida fotosuratlarga 
qo‘shimchalar kiritish. fotosuratdagi dog’larni o'chirish. eski rasmlarni 
qayta ishlash va tiklash ishlarini amalga oshirish mumkin. Rasmlarga 
matn kiritish qo'shimcha maxsus effektlar bilan boyitish, bir foto
suratdagi elementlarni ikkinchi fotosuratga olib o;tish. suratdagi
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ranglarni o'zgartirish. almashtirish mumkin. Adobe Photoshop im- 
koniyatlari keng qam rovli bo'lib, u gazeta va jurnallarni turli tuman 
rasmlar bilan boyitishda juda katta qulayliklar yaratadi.

Adobe Photoshop ayniqsa jurnalistlarning, rassomlarning ijodiy 
imkoniyatlarini tobla am alga oshirishlarida yordam beradi. jurnalistika 
va bevosita matbuot y o k i nashriyot sohasiga aloqador boMgan shaxs- 
larning mazkur dastur bilan ishlashni bilishi uchun qo'shimcha 
imkonivatlarni yaratib beradi.

Adobe Photoshop grafik muharriri juda murakkab dasturdir. 
Foydalanuvchilar uning asosiy imkoniyatlaridangina foydalanadilar 
xolos. Opsiyalar panel ida Brush muyqalamni tanlash uchun strelkasi 
ustiga bosing. Har bir piktogramma ustidagi raqamlar muyqalamni 
qalinligini piksellarda ko'rsatadi. Agar siz istalgan muyqalam ustiga 
olib borsangiz shu muyqalamning qalinligi va turi haqida ma'lumot 
chiqadi. Boshqa turdagi muyqalamlarni tanlash uchun muyqalamlar 
kutubxonasini yuklash kerak. Muyqalam panelini yopish uchun 
paneldan tashqaridagi ekranning istalgan joyga bosing va avtomatik 
tarzida panel yopiladi. Mode (Режим смешивания) boMimini tanlang, 
hamda Opacity (Непрозрачность) boMimini foiz ko'rsatkichida Brush 
(Кисть) uskunasi uchun tanlang (4.7-rasm). Agar ko'rsatilgan qism 
parametri 100% ni tashkil qilsa muyqalam shtrixi pastki piksellarni 
mutloq qoplaydi.

Eslatma: Faqatgina shafof bo'lmagan qatlamlarning rangini o'z
gartirish uchun Layers (Слои) palitrasidagi Lock transparent pixels 
(Зафиксировать прозрачные точки) ustiga bayroqchani o'rnating.

Photoshop 7.0 dasturi yordamida siz bir qancha standart muy- 
qalamlar yoki o'zingiz o'lchamlari va ko'rinishini kiritgan holda juda 
qiziqarli rassomchilik ishlarini amalga oshirishingiz mumkin.

Rasmlar bilan ishlash uchun dasturning yangi versiyalari okta 
qiziqarli bo’lgan rasmlarni yaratish imkonini beradi. Photoshop 7.0 
dasturida standart va avvaldan foydalanuvchi kiritgan rasmlarni

Mode: (моггпь! 3  Opacity: \\Q% ►

4.7-rasm. O pacity param etrini belgilash.
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nusxalab unga sayqal berish shu bilan birga tasvirga nam va quruq 
muyqalam usullarida bezak berish mumkin. Muyqalam paketiga barg 
va o‘tlarni tasvirini yaratadigan maxsus effekt muyqalamlari kiritildi. 
Maxsus original tasvirlarni yaratish uchun skanerdan o'tkazilgan 
rasm va matnlarni orqa fon sifatida shaffof ko'rinishda tasvirga 
kiritish murnkin. Photoshop 7.0 dasturida faqat yangi tasvir yaratish 
imkoniyatlari bilan cheklanib qolmay balki, boshqaruvni soddalashtirish 
ham e ’tiborga olingan.

Mavjud bo‘lgan muyqalamni o ‘zgartirish

Photoshop dasturiga qo'shimcha sifatida muyqalamlar bazasi ham 
beriladi va siz u yerdan istalgan muyqalamni tanlab uni xohishingizga 
ko;ra o‘zgartirishingiz mumkin.

1. Opsiyalar panelidan Brushes (Кисть) tugmasiga bosing undagi 
menyudan B rush Tip Shape boMimini tanlang.

2. D iam eter (Диаметр) effektni kerakli joygacha cho'zing yoki 
muyqalam diametirini k iriting(l dan 999 pikselgacha).

3. Muyqalam izi shaffofsizligini belgilovchi H ardness (Жесткость) 
koeffitsentini tanlang yoki uni ham foiz miqdorda kiriting (0-100%  
gacha).

4. Muyqalam qoldirgan izlari oralig'ini Spacing (Интервал) orqali 
belgilanadi (0—99%). Foiz miqdorini oshirilgan sari shtrixlar orasidagi 
masofa kattalashib boradi. Shuningdek bu vazifani kursor yoki 
muyqalam ham bajarishi mumkin. Buning uchun Spacing (Интервал) 
tugm asidan bayroqni olib tashlashni o'zi kifova. Qanchalik kursorni tez 
harakatlantirsangiz shuncha oraliq kattalashadi va aksincha. Ko‘pgina 
itaiidan o^rnatilgan muyqalam lar uchun asosan Spacing va Diameter 
bo'limlaririi o‘zgartirish mumlcin.

5. Muyqalam izini doira yoki boshqa ellips ko'rinishlarini belgilash 
uchun A n gle  (Угол) bo'limidan (—180° dan +180° gacha) qiymatlarni 
ko’rsating yoki ekranning chap tarafidagi rasmdagi strelkani xohishga 
ko‘ra joylashtiring.

6. Muyqalamni tiniqlashtirish uchun Roundness (Округлость) 
(0-100% ) parametrlarini bering. Foiz miqdori ortgani sari nuqta izi 
tiniqlashadi.
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Brush (muyqalam) menyusidan New Brush (Yangi muyqalam) 
buy rug'ini tanlang.

1. Mavjud muyqalamni o‘zgartirish (Изменение существующей 
кисти) bo'limidan 2 dan 8  gacha bo'lgan buyruqlarni tanlang. Create 
New Brush (Yangi muyqalamni yaratish) boMimiga bir marta bosing 
va kerakli o'lchamlarni bering. Agar siz ushbu tayyor muyqalamni 
saqlab qolmoqchi bo'lsangiz, uni nomini kiriting va OK tugmasini 
bosing. Saqlangan muyqalam piktogrammasi tanlash panelining oxirida 
joylashadi.

Tasvirdan iborat b oigan  muyqalamni yaratish uchun quyidagi 
ketma-ketlik bajariladi:

1. Rectangular Marquee (Прямоугольная область) uskunasini 
faollashtirish uchun klaviaturadan M tugmasini yoki Shift+M tug- 
malarini bosing.

2. Berilgan figuralar joylashgan oq fondagi tasvirni chegarasini 
belgilang (maksimum 1000x1000 pikselgacha).

3. Edit > Define Brush (Pravka > Определение киста) buyrug'ini 
tanlang.

4. Yuqorida aytib o'tilgandek ushbu yangi muyqalam nomini kiri
ting va OK tugmasini bosing. Bu muyqalamdan Brush (Кисть) menyusi 
bilan ishlayotganda foydalanish mumkin. Pavdo boluvchi muyqalam 
o'lchamlarini, Spacing (Интервал) tugmasidan shtrixlar orasidagi 
masofani aniqlashtiring (1—99%).

5. Belgilangan hududni qaytib o‘z holiga keltirish uchun Ctrl+D 
tugmalarini birgalikda bosing.

Muyqalamni o‘chirish

Muyqalam tanlash panelini oching:
Bir inchi usul\ Alt tugmasini bosib turib o4chirmoqchi boMgan 

muyqalamni belgilang. B u  harakatni orqaga qaytarish (отменить) 
mumkin emas.

Ikkinchi usul: Keraksiz boMgan muyqalamni ko'rsating va Delete 
Brush (Muyqalamni o^hirish) buyrugMni tanlang.

Background Eraser v a  Magic Eraser uskunalarini ishlatilishi.

Yangi muyqalamni yaratish
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Magic Eraser menyusi sichqoncha tugmasi bilan o‘chirish imkonini 
beradi. U siz ko‘rsatgan rangga yaqin boigan piksellarni o'chiradi. Buni 
aksini esa Paint Bucket (Ведро с краской) uskunasi bajaradi. Agar siz 
shaffofsizlikni 100%dau pastrog'ini tanlagan bo;lsangiz unda Magic 
Eraser uskunasi orqali kerakli joylarni shaffof ko'rinishga keltirishingiz 
mumkin.

Background Eraser uskunasi bu fondagi keraksiz joylarni o’chiradi 
yoki kerakli ranga bo’yavdi. Bu uskunaning ustunligi shundaki u 
bilan aralash fonlarni yakdil holatga va o'chirilayotgan maydonni yoki 
chegaralarni hamohangligini nazorat qiladi.

1. Xohlagan qatlamni tanlang. Eraser (o'chirgich) uskunasi vor- 
damida qatlamdagi keraksiz joylarni o'chirmoqchi bo’lsangiz unda 
Lock transparent pixels (Зафиксировать прозрачные точки) 
bo4imiga bayroqchani cf mating. Shunda o'chirilayotgan qatlam undan 
oldingi qatlam foniga ega bo'ladi. Agar Lock transparent pixels (За
фиксировать прозрачные точки) bo'limidagi bavroqcha olib tashlansa 
unda 0 ‘chirilgan qism shaffof holatga o'tadi.

2. Eraser (o'chirgicli) uskunasini E tugmasi yoki Shift+E tugma- 
larini birga bosib uni ishga tushiring.

3. Opsiyalar panelidan Brush (Кисть) bo'limiga kiring va kerakli 
bo‘lgan muyqalamni tanlang.

M ode (Режим) bo'limidan kerakli rejimni tanlang: u yerda Brush 
(кисть). Pencil (карандаш) yoki Block (Блок)ш tanlang. Xo'l bo'voqni 
akslantiruvchi Brush (Кисть) effektini tanlang. Opacity parametrlarini 
ko'rsating.

Avtomatik tozalash rejimi

A uto Erase (Автоластик) o'z-o'zidan avtomatik tarzda ishlashga 
moUjallangandir. Agar siz uni o*z xohishingizga ko*ra ishlatmoqchi 
bo'lsangiz quydagilarni bajarishingiz shart:

1. Kerakli bo4lgan fon rangini tanlang. Bunda Eyedropper (Пипет
ка) uskunasidan rang tanlashda foydalanishingiz mumkin;

2. Kerakli bo'lgan qatlamni belgilang:
3. Pencil (Карандаш) uskunasini faollashtiring. buning uchun V 

tugm asi yoki Shift+B tugmalarini birgalikda bosing;
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4. Opsiyalar panelidan A u to  Erase (Автоластик) uskunasi ustiga 
bayroqni o'mating;

5. Tasvirga shtrixlarni chi zing. Asosiy pikseldan boshlab kerakli 
hududgacha kursorni tortib boring.

Savol va topshiriqlar:

1. Brush uskunasi imkoniyatlarini sanab bering?
2. Background Eraser buyrugM nima uchun ishlatiladi?
3. Obvekt rangi qanday o4zgartiriladi?

4.4. Matnlar bilan ishlash

Adobe PhotoShop dasturi tasvirlar ustiga matnlarni kiritish 
uchun vana bir keng im koniyatni ochib beradi. Tasvir ustiga matn 
kiritish uchun uskunalar panelida maxsus Текст uskunasi mavjud. Bu 
uskuna, asosan. tasvirga turli matnlarni kiritish uchun xizmat qiladi. 
Текст uskunasi tarkibida Текст-маска, Вертикальный текст kabi 
uskunalar vashiringan. Bu \iskunalar faollashtirilib, kursor tasvir 
ustida bir marta bosish i bilan yangi Текстовый инструмент darchasi 
hosil bo;ladi. Bu uskunalar faqat matnlarni tuzish uchun xizmat 
qiladi. Uning yordamida mavjud matnlarni tahrir qilishning imkoni 
yo;q.

Photoshop 7.0 dasturida matn vektor ko'rinishiga ega. Dasturda matn 
o'zining aniq chegara va konturlariga ega. Chunki dastur matnlarni 
ishlatavotganda vektor konturini qo'llaydi. Shu bilan bir qatorda matn 
ham rasm sifatlarini o‘zida rnujassamlashtirgan. Bu matn printerdan 
chiqarilishiga qaramay u PDF yoki EPS formatlarida saqlanishida o¿z 
tiniqligini saqlab qoladi.

Photoshop dasturi faqatgina matnlarni kiritibgina qolmasdan, balki 
ularni yozilayotgan vaqtida v a  yozilgandan sovng ham utarni tusini. 
rangini. ko'rinishini hamda vo'nalishini o'zgartirish mumkin.

M atn ni kiritish

Photoshop dasturida matn yozish uchun Текст tugmasi tanlanadi 
va avtomatik tarzda kerakli joyda o‘z maxsus qatlamiga ega bo'lgan
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fonda yozila boshlaydi. Istalgan paytda uning ko4rinishini o'zgartirish 
m um kin masalan: shrift, uslub, kegl, rang, kerning, treking, oraliqdagi 
interval, to4g4irlash, chiziqlarni hajmi. Bundan tashqari bir tekstni o'ziga 
bir qancha atributlarni kiritish mumkin.

Shu bilan bir qatorda matnning ma'nosini mexanik tarzda 
o’zgartirish unga har xil effektlar qollash va u jovlashgan qatlam 
ustida bir qancha imkoniyatlarni qoMlash mumkin. Matn qatlami 
ustida qandav amallar qo'llash mumkin? Unga filtrni qo'llash. matndan 
tozalash mumkin. Bu amallarni bajarisli uchun eng avvalo matn 
qatlamini Layer > Rasterize > Ture (Слой > Преобразовать в рас
тровый формат > Текст) uskunasi orqali belgilab undagi buvruqni 
tan lash kerak.

Eslatma. Bitmap. Indexed Color va Multichannel rejimida yaratilgan 
matn o4z qatlamiga ega boimaydi va to’g wridan-tobg’ri ekran foniga 
tushadi hamda uni tahrirlash imkoniyati yoqoladi.

Turli xildagi matnlar (tahrirlanadigan va tahrirlanmaydigan) ko*- 
rinishlari Ture (Текст), Layer (Слой), Character (Шрифт), Paragraph 
(Абзац) uskunalari va Opsiyalar paneli orqali varatiladi.

Tahrirlanadigan matn qatlamini yaratish:

1. Eng avvalo Ture (Текст) uskunasini T tugmasini bosish bilan 
faollashtiring.

2. So'ngra matnni joylashtirish kerak bo'lgan ekrandagi qismning 
o4lcliamlarini sichqoncha orqali belgilang (so'zlar va matnlar bir-biriga 
to'qnashib ketmasligi kerak). Yaxshisi har bir so‘zni alohida qatlamga 
vozing shunda ularni bir-biridan mustaqil ravishda siljitish imkonini 
qo4lga kiritasiz.

3. Opsiyalar panelida quvidagi amallarni bajaring:
° Ture tugmasiga bosing va matnning yo'nalishini ko'rsating (go- 

rizontal, vertikal);
° Shrift va uning oTchamini tanlang;
о Shuningdek Anti-aliased (Moslashtirish) menyusidan matn 

qatlam chegarasini ko'rsating: Sharp (Tiniq) Crisp (qattiq), Strong 
(kuchli) yoki Smooth (yumshoq). Bu matnni soyasi ko'rinishlarini 
tubdan o4zgartiradi va tasvirga moslaydi. Alignment (Выключ
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ка) tugmalaridan biriga bosing va kerakli boMgan matnni yozilish 
chegarasini ko'rsating (o'ngdan. chapdan, o'rtadan).

Opsiyalar panelidan matnni rangini ko'rsating. Bundan tashqari 
matn rangini Swatches (Образцы) va Colors (Цвета) palitralaridan 
ham belgilash muni kin.

4. Ekrandagi oynada matnni kiriting.
5. Yangi matn qatlamini yaratish uchun Enter tugmasini bosing. 

Agar sizga boshqa qatlam kerak boMmasa Esc tugmasini bosing.
Eslatma: A gar siz m atnlar bilan ishlayotganda kompyuter 

to'xtab qolaversa yok i tezligi pasaysa unda ochilgan qolgan kerak 
boMmagan oynalarni yoping. Shunda dastur tezligi o'z holiga 
keladi.

Eslatma: Har safar matn yozishda yangi qatlamdan foydalan- 
ganingiz ma’qul v a  xatolikka eg a  boMgan qatlamlarni o'chirib tash- 
lang.

Matnni tahrirlash. Matnni o'zgartirishdan oldin uni faollashtiring 
va matndagi so*z, jumla va harfni belgilab o'zgartirish kiriting. 
Shuningdek matnni belgilash uchun uning ramkasini ustiga bosish 
kifoya.

Matnni masshtablash

Horizontal Scale (М асштаб по горизонтали) va Vertical Scale 
(Масштаб по вертикали) buyruqlaridan matnni joylashish shaklini 
o'zgartirish uchun foydalaning. B ir xil to'g'ri ko'rinishdagi masshtablash 
uchun quydagi amallarga rioya qiling:

Matn uchun maxsus effektlar

Eng avvalo quyidagilarni eslab qoling. Agar siz matnni ram
kasini masstitabini, hajmini \ a  tuzilishini o'zgartirish uchun uni 
tahrirlanadigan ko^rinishda bajarishingiz kerak bo'lsa va so'ngra matnga 
maxsus effektlar q o ’shish uchun uni rasm sifatiga keltirib undan keyin 
effektlarni qo'llashingiz mumkin.

V  tugmasi orqali ishga tushiriluvchi Move uskunasi orqali matnni 
trasformatsiya qilish mumkin.
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Show Bounding Box (Показать габаритную рамку) uskunasiga 
bayroqchani crrnating Layers (Слои) uskunasi orqali kerakli qatlamni 
belgilang. Ekranda matn qatlami aks etadi.

Yakka holda kiritilgan jumla va so4zlarni quyidagicha o'zgartirish 
mumkin:

• Layers (Слои) oynasiga jumlani kiriting va Edit (Прав
ка) menyusidan Free Transform (Произвольная трансформация) 
buyrug'ini tanlang:

• Sichqoncha bilan matn oynasini kerakli shaklni olguncha 
surib boring. Bu vazifani boshqa uskunalar yordamida ham bajarish 
mumkin.

Matnni rasmli qatlam ustiga joylashtirish:

1. Matnli qatlamni yarating.
2. Shu matn qatlamidan nusxa oling va uni saqlab qo'ying.
3. Matn nusxasini belgilang va Layer > Type > Convert to Shape 

(Слой > Текст > Преобразовать в фигуру) buyrugini bering. Matn 
qatlami avtomatik rasmga avlanadi va uni tahrirlash endi mumkin emas.

4. Layer > Change Layer Content > Levels (Слои > Изменить 
содержимое слоя > Уровни) buyrug'ini bering. Yozilgan qatlam siz 
boshqa qatlamni kiritmaguningizga qadar buferda qoladi va faol boTib 
turadi.

5. Y ozilgan matn boshqa tasvirlar bilan hamohangligini jigarrang 
tusga ega b o’lgan piktogramma Input (Ввод) ustiga bosing va matn 
rangini ochartiring yoki to;qlashtiring;

6. OK tugm asini bosing. Ekran fonining bir qismiga bosing.

Ko’rininaydigan inatnlar yaratish:

1. Matn kiriting va uni qatlamini faol holatda qoldiring.
2. Layers oynasining pastki qismidan Add a mask (Добавить 

маску) tugm asini bosing. Belgilangan joy yonida kichik belgi (маска) 
paydo boTadi.

3. G klavishasini yoki Shift+G tugmalar kombinatsiyasini bosgan 
holda Gradient (Градиент) uskunasini ishga tushiring.

4. Gradient uskunasi yonidagi strelkani bosing va kerakli rangni 
tanlang. Linear gradient (Линейный градиент) tugmasiga bosing va
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Normal (Нормальный) rejimini tanlang shaffofsizlik qiymatini bering 
(1% dan 100% gacha).

5. Matnni ustiga kerakli bo'lgan hududni ramka sifatida sichqoncha 
bilan belgilang va shu qismlar ocharadi yoki to'qlashadi.

Matnni effekt bilan ko^chirish uchun u joylashgan qatlamni 
faollashtiring va  Move (Перемещение) uskunasini ishga tushiring.

Agar sizeffektn i o'zgartirmoqchi bo'lsangiz matn joylashgan qatlam 
ustiga bosing shunda Layer S ty le  muloqot oynasi paydo bo4ladi. Undan 
boshqa effektlarni tanlashingiz mumkin.

Matn qatlamini chegaralarini o4rash:

1. Blending Options (О пции смешивания) oynasidan Layers 
(Слои) buyrug'ini tanlang.

2. Style (Стиль слоя) oynasining chap tarafida joylashgan Stroke 
(Обводка) buyrug'i ustiga bosing va Preview (Предварительный 
просмотр) uskunasiga bayroqcha o'rnatilganligini tekshiring. U yerdan 
quyidagi boklimlarni ko'rib chiqing va kerakli o'lchamlarni bering: 
Structure (Структура) Size (Размер), Position (Joylashish holati) 
(ular tashqaridan va ichkaridan bo'lishi mumkin Outside (Снаружи), 
Inside (Внутри) yoki Center (markaz)), Blend Mode (Режим сме
шивания), Opacity (Shaffofsizlik), Fill Type (bo'yash usuli) va Color 
(rang).

OK tugmasini bosing (yoki Enter tugmasini bosing).

S a vo l va topshiriqlar:

1. Dasturda matn konturini o'zgartirish uchun qaysi buyruqlardan foy- 
dalaniladi?

2. Qaysi uskuna vordamida Photoshop dasturida matnlarni yaratish 
murnkin?

3. Gradient (Градиент) uskunasi qaysi tugmalar yordamida ishga tu- 
shiriladi?

4.5. Adobe Photoshop dasturida tasvirga ishlov berish. Qatlamlar

Qatlamlar xuddi oyna qatlamlariga o6xshagan bo4lib, faqat tasvir 
bo’lgan joylarigina ko'rinishga egadir. Har bir qatlam uchun o'zining
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shaffoflik darajasi bo'lib undan oldingi va keyingi turgan qatlamlar 
bilan  hamohangligini moslash mumkin. Qatiamlarni joylashish o'rnini 
almashtirish yoki ularni yagona qatlamga birlashtirish mumkin. Bir 
vaqtni cfzida har x il  qatlamlarda turgan tasvirni birgalikda o'zgartirish 
va bir qatlamda turgan rasnini faqat bir qismini o'zgartirish mumkin 
em as.

Layers (Слои) oynasida qatlamlar ustida turgan qatlamdan eng 
tagidagi qatlamgacha aks ettirilgan. Bunda fon qatlami oxirida 
joylashadi. Hozirda belgilangan qatlam faol bo4lib ko'rinadi va faqat shu 
qatlam ustida amallar bajarish mumkin.

Istalgan qatlamni faollashtirish uchun Layers oynasidan kerakli 
qatlam ustiga bosish kerak. Faol bo'lgan qatlam nomi dastur nomi 
yonida akslanib turadi.

Eslatma: Katta hajmdagi tasvirlar bilan ishlayotganda bajarilib 
bo'lgan qatiamlarni birlashtirish yoki o'chirib tashlagan ina’qul. Shunda 
dastur ishlash tezlik  unumdorligi oshadi va tasvir hajmi kamayadi.

Yangi qatlam hosil qilish

1. Eng avvalo 100% shaffof qatlam hosil qilish uchun Create New 
Layer tugmasi ustiga bosing.

2 . Agar qatlamni o’lchamlarini o'zingiz bermoqchi boisangiz unda 
Alt tugmasini bosib turgan holda Create New Layer tugmasini bosing:

3. Name (Имя) bo'limida qatlamni nomini kiriting Group With 
Previous Layer (Сгруппировать с предыдущим слоем) bo'limiga 
bayroqchani o4rnating:

4. Layers (Слои) palitrasidan ko'z va muyqalam ko’rinishidagi 
piktogrammalarga bayroqchani o'rnating;

Mode (Режим смешивания) va Opacity (Непрозрачность) 
parametrlaridan tasvir uchun yangi parametrlarini bering (keyinchalik 
bu parametrlar o‘zgartirilishi mumkin).

5. OK tugmasini bosing. Yangi qatlam ishlatilavotgan qatlam ustida 
paydo bo‘ladi.

Eslatma: Tasvir hajmini kamaytirish uchun Layers (Слои) 
menyusidan Palette Options (Опции палитры) buyrug4ini tanlang va 
shu tasvirga to4g4ri keladigan eng kichik hajmni tanlang.
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Belgilangan qismni qatlamga aylantirish

1. Belgilangan qismni hosjjl qiling;
2. Layer > New > Layer Via Soru (Слой > Новый > Посред

ством копирования) menyusidan buyruqni bering (Ctrl+J tugmalari).
3. Tasvirni belgilangan qismini qirqib olib tashlash uchun Layer

> New > Layer Via Cut (Слой > Новый > Посредством вырезания) 
buvrugini bering (Ctrl+ Shift-*-J tugmalari).

Qatlamni siljitish

1. Layers (Слои) oynasida o'zgartirish kiritmoqchi bo4gan qatlamni 
belgilang;

2. Move (Перемещение) uskunasini faollashtiring (V klavishasi);
3. Qatlamni kursorni ushlab turgan holatda siljiting.
Eslatma: Auto Select Layer (Автовыделение слоя) boUimida 

bayroqcha turgan bo'lsa Move (Перемещение) uskunasi yordamida 
tezda qatlamni siljitish mumkin, ammo bu siljitish shaffofligi 50% dan 
kam bolgan qatlamlar uchun ishlamaydi.

Qatlamlar bilan ishlash uchun uskunalar

Barcha uskunalar qatlamlar bilan ishlaydi. Lekin bu bilan qat- 
lamning shaffofsizligiga katta tasir o'tkazadi. Shuning uchun qatlam 
shaffofsizligini doim o nazorat qilib turing.

Qatlamni o'chirish

Qatlamni uchirishdan oldin uni nomini faolligini tekshiring va uni 
belgilab o’chirib tashlang.

Qatlamga effektlar qo'llash

Qatlamga quyidagi maxsus effektlarni qo‘llash mumkin: Drop 
Shadow (Отбросить тень), Inner Shadow (Внутренняя тень), Outer 
Glow (Внешнее свечение). Inner Glow (Внутреннее свечение), Bevel 
and Emboss (Скос и рельеф). Satin (Атлас). Color Overlay (Нало
жение цвета), Gradient Overlay (Наложение градиента) va Pattern 
Overlay (Наложение узора). Effektlarni istalgan paytda istalgancha 
xohlagan qatlamga qoilash  mumkin.
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Eslatma: Uslublar va effektlarni bir-biri bilan chalkashtirib 
yubormang. Uslub (Стиль) -  bu bir qancha qatlam effektiarini ha- 
mohangligidir.

Effektlarni q o ‘yish Layer S tyle  (Стиль слоя) muloqot oynasi orqali 
amalga oshiriladi.

Effekt yonidagi belgi bu effekt shu qatlamga qo'llanilganini 
ko^rsatadi. Qatlam effektiarini asosiv fon uchun qoilash mumkin emas.

Hamma qatlamlarni birgalikda ishlatish

Agar Opsiyalar panelida quyidagi uskunalar ishlatilayotgan bo'lsa: 
Blur (Размытие), Sharpen (Резкость), Smudge (Палец). Paint Bucket 
(Ведро с краской). Magic Eraser (Волшебный ластик) yoki Magic 
Wand (Волшебная палочка) unda Use All Layers (Использовать 
все слои) bo4limiga bayroqchani o'rnating shunda rang va boshqa 
o'lchamlar olinayotganda mavjud bo'lgan ranglarga yaqin bcrlgan 
tuslar birinchi navbatta ko'rinadi. Faqat faol bolgan qatlamda ranglar 
o4zgaradi.

Ikki qatlamni birlashtirish

1. Birlashtirmoqchi bo'lgan ikki qatlamdan qaysi birisi oldinroq 
bo'lsa uni belgilang.

2. Layers (Слои) menyusidan Merge Down (Слить с ниж
ним) buyrug;ini bering yoki Ctrl+E tugmalarini birgalikda bosing. 
Faol qatlam o'zidan pastda turgan qatlam bilan birlashadi. Bir qancha 
belgilangan qatlamlarni birlashtirish uchun Merge Layer Set (Слить 
набор слоев) buy rug’ini bering.

Qatlamlarni birlashtirish

Eslatma: Flatten Image (Плоское изображение) buyrug'i qat
lamlarni pastdan boshlab birlashtiradi va yashirilgan qatlamlarni 
avtomatik tarzda o'chiradi.

Hamma qatlamlar ko'rinib turganligiga amin bo'ling va qaysi 
qatlam faol boMishi muhim emas. Layers (Слои) menyusidan Flatten 
Image (Плоское изображение) buvrug'ini bering. Agar dasturda 
bekitilgan qatlamlar bo‘lsa unda ogohlantirish beriladi va OK tugmasini
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bosing va birlashtirishni davom ettiring. Agarda pastki qatlamlarda 
ko*rinmaydigan nuqtalar boMsa ular oq ranga kiradi.

Layers (Слои) m enyusidan keraksiz qatlam nomini tanlang. So'ngra 
Trash (Корзина) tugm asini bosilgandan keyin Yes (Да) tugmasini ham 
bosing.

Qatlamni o4chirishni у ana bir usuli keraksiz qatlam nomi ustiga 
olib borib sichqonchani o‘ng tugmasini bosing va menyudan Delete  
Layer (Удалить слой) buyrug'ini tanlang hamda Yes tugmasini 
bosing.

Savol va topshiriqlar:

1. Qanday usulda qatlamlar hosil qilinadi?
2. Qatlamlarga qanday effektlar qoMlash mumkin?
3. Ajratilgan qismda yangi qatlamni hosil qilishni ko‘rsatib bering.

171



V-bob. CO R EL DRAW  D A ST U R I

5.1. COREL DRAW dasturi bilan tanishuv

Kanadaning Corel nomi bilan ataluvchi firmasi dasturiy ta’minot 
bilan shug'ullanuvchi peshqadam lardan biri hisoblanadi. Corel 
firmasining dasturiy ta'minoti asosini tashkil etuvchi CorelDRAW 
11 2002-yiln ing avgustida ishlab chiqarildi. U reklama mahsulotlarini 
ishlab chiqarishda, nashrlarni tayvorlashda. hamda Web-sahifalari 
uchun tasvirlarni yaratishda katta imkoniyatga ega.

Corel DRAW  -  bu grafikli dastur boMib. uning yordamida vektorli 
tasvirlarni, grafikli matnlarni, hamda sizning tassavvuringizdagi barcha 
ijodiy g'oyalaringizni amalga oshirishga yordam beradi.

Corel DRAW  dasturi ishlaydigan barcha tasvirlar ikki sinfga 
bo'linadi: nuqtali va vektorli. Vektorli grafikada tasvirning asosiy 
elementi sifatida chiziq qaraladi. Rastrli grafikada bunday chiziqlar 
nuqtalar (piksellar) yordamida yaratilsa, vektorli grafikada esa 
tasvirlar yaratishda nuqtaga nisbatan uinumiyroq bo'lgan chiziqlardan 
foydalaniladi v a  shuning hisobiga tasvirlar aniqroq bo'ladi.

Vektorli grafikaning ixtiyoriy tasviri chiziqlardan tashkil 
topadi va oddiv chiziqlardan murakkablari hosil qilinadi. Vektorli 
grafikaning matematik asosini geometrik figuralarning xossasini 
o'rganish tashkil qiladi. Vektorli tasvirlarni kompyuter xotirasida 
ifodalanishi nuqtaliga qaraganda murakkabroq. Nuqtali tasvirning 
kamchiligi -  kompyuter xotirasida ularni saqlash katta joy talab 
etiladi. N uqtali tasvirlar bilan vuqori aniqlikda ishlashda, ularga mos 
fayllarning o‘lcham i yuzlab megabaytlarni tashkil etadi. Ko’pincha, 
bunday katta obyektlar bilan ishlaganda zamonaWy kompyuterlarning 
tezligi yetm ay qoladi. Vektorli tasvir bilan ishlash juda ham oson. 
Uni katta y o k i kichik qilish uchun, faqat uni boshqaradigan tasvir
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parametrini o'zgartirish mumkin. Bunda vektorli tasvir faylining 
oicham i bir baytga ham  oshmaydi.

MaMumotlar tasvirlar orqali berilganda ularni tahlil qilish va 
qabul qilish tezligi. ma'lumotni eshitish kanallari orqali berilgan 
ina'lumotlardan ko‘ra ancha yuqori bo'ladi. Shuning uchun ham 
tasvirdan iborat birgina reklama plakati (osongina kerakli ta’sirni bera 
oladigan) tomosha qilayotgan odamga bir necha qator e’londan ko'ra 
kuchli ta’sir ko'rsatadi.

Har qanday hajmdagi ma'lumot ko‘rish kanali orqali uzatilsa odam 
tomonidan yaxshi qabul qilinadi (bolalarga rasmlardan iborat kitoblar 
yoqadi). Boshqa formatda esa bunday maMumotni qabul qilib boMmaydi 
(birjalardagi jadvallar). Shu sababli ham grafikli maMumotlarga boigan  
ehtivoj kundan kunga ortib bormoqda.

Bunday grafiklar v a  tasvirlar bilan ishlashga moijallangan dasturiy 
vositalar juda ham ko'p va xilma-xil. Ana shunday dasturlardan biri 
CorelDRAW' dasturidir.

CorelDRAWning 12 versiyasi o‘zida zamonaviy imkoniyatlarni 
birlashtirgan b o lib  2004-vilda ishlab chiqarilgan. Bu dastur sanoat 
dizaynida. reklama inahsulotlarini ishlab chiqishda. nashriyot tizim- 
larida va web sahifalar uchun turli tasvirlar yaratishda ishlatiladi. 
Corel DRAW dasturi paket dastur hisoblanib o;z ichiga bir nechta qism 
dasturlarni oladi. Bu dasturlar o'zaro ma'lumot almashishning yengil 
kechishini ta?minlaydi.

Paketning yaxlitligi uning tarkibiga kiruvchi dasturlarning ma5- 
iumotlarni yengil almashinishi yoki shu ma'lumotlar ustida ketma-ket 
turli xil vazifalarni bajarishi bilan belgilanadi.

«Obyektga voyaitirilgan» -  atamasi tasvirlarni yaratish va o'zgar- 
tirish jarayonidagi barcha operatsiyalar. rasmning o'zi yoki uni tashkil 
qilgan piksellar bilan emas balki tasvirni tashkil qilgan semantik 
belgilangan elementlar ustida boradi. Standart obyektlarni qo'llagan 
holda (aylana, to’g'ri to*rtburchak. matn va boshqalar) foydalanuvchi 
murakkab obyektlar qurishi va ularni birlashtirib vagona butun obyekt 
sifatida qarashi mumkin. Shu tarzda, rasm iyerarxik tuzilishga ega 
bo'lib. eng yuqorisida butun vektorli tasvir boigan, eng quyida esa 
standart obyektlardan iborat boiadi.
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Paket obyektga yo'naltirilishining yana  bir afzalligi har bir 
obyektlarni ng standart sinfiga boshqaruv parametrlari yoki atributlar 
o'rnatiladi. Masalan. tobrtburchak balandligi 200 mm va eni 300 mm. 
kcfk rang bilan toidirilgan, qalinligi 3 punkt bcflgan sariq rangdagi 
chiziq b ilan  chegaralangan. Joylashuvi vertikal bo’yicha 150 mm, 
gorizontal bo;yicha 250 mm, 32 gradusga burilgan kabi boshqaruv 
parametrlariga ega.

Paketning obyektga yo'naltirilishining uchinchi afzalligi obyekt- 
larning har bir standart sinfiga standart operatsiyalar ro¿yxati bel- 
gilangan. Masalan, yuqoridagi to’rtburchakni burish. o'lchamlarini 
o‘zgartirish, burchaklarini o'zgartirish. boshqa sinf obyektlariga 
aylantirish kabi amallar. CorelDRAWning obyektga vo'naltirilganligi 
foydalanuvchiga ish vaqtida obyektlar ustida cheksiz o'zgaruvchanlik 
amallarini bajarish imkonini beradi. Agar buyurtmachi ishning oxirgi 
bosqichida o;z fikrini o4zgartirsa va reklama plakatidagi olma o’rniga 
anorni tasvirlashni xohlab qoldi, bunday holatda ishni boshidan 
boshlash shart emas. Buning uchun ayrim obyektlarni almashtirish 
kifoya. Bunday holatda bir marta qurilgan obyektni saqlab qo'yib 
keyingi yangi ishlarda foydalanish mumkin.

CorelDRAW  paketi quyidagi dasturlardan iborat: Corel CAPTURE. 
Corel BARCODE WIZARD, CorelDRAW, Corel Photo-PAINT, Corel 
OCR-TRACE, CorelTRACE. Corel VENTURA, Corel SCRIPT Editor. 
Corel SCRIPT Dialog Editor.

Corel CAPTURE dasturi CorelDRAW dasturi oynasi va uning 
qismlarini rasmga olish uchun ishlatiladi. Uning yordamida dastur 
oynasi ayn i ko'rinishini to'liq yoki men\ru ko'rinishini hamda biror 
qismni to'rtburchak shaklda. aylana yoki ellips shaklida va ixtiyoriy 
shaklda aylantirib belgilab olish imimkin.

Corel BARCODE WIZARD das-

ЩД Corel BARCODE
Corel CAPTURE

I [kjj 100%

CorelDRAW

turi esa shtrix-kod bilan ishlashga 
mo'ljallangan. Unda berilgan standart- 
lardan birini tanlab, so'ng keltirilgan 
namuna bo^yicha raqam va xarflarni 
kiritamiz.

Corel Photo-PAINT dasturi esa 
rasmlar chizishga mo'ljallangan.
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Dastur paketining versiyalari bo‘yicha tarkibi
5. ! jadval

Dastur nom i I ¿x
i

2.x 3.0 4.0 5.0 6.0
6.0

(rus)
7.0

7.0
(rus)

8.0 9.0
9.0

Office
10.0 l LO 12.0 X3 XA X5

CorelDRAW У ✓ ✓ У У У У У y

Corel
PHOTO-
PAINT

/ ✓ У У У V У >/ У

Corel OCR- 
TRACE

✓

CorelTRACE ✓ ✓ У

Corel
CAPTURE

JC У У У У

Corel
VENTURA

Corel SCRIPT 
Editor

✓ ✓ У У У

Corel SCRIPT 
Dialog Editor

_i_
У ✓



CorelDRAW ni ishga tushirish. Core] DRAW 12 grafik muharririni 
ishga tushirish uchun Пуск > Программы > Corel DRAW 12 buvrugM 
beriladi yoki Windows XP ish stolida uning yorlig‘i ustida sichqoncha 
chap tugmasi ikki marta bosiladi.

CorelDRAW dasturini ishga tushirish Windowsning standart 
usullari singari: asosiy menyu orqali (unda paketni o'rnatganda 
CorelDRAWni yuklash buyrugMni o'z ichiga oigan yangi buyruqlar 
guruhi paydo boMadi) yoki ish stolida jovlashgan yorliq yordamida 
hamda CorelDRAW dasturida yaratilgan fayllar ustida sichqoncha 
chap tugmasini ikki marta bosish y o ii  bilan ishga tushiriladi. Bundav 
fayllarni biz albatta uning kengaytmasidan bilib olamiz. CorelDRAW 
dasturida yaratilgan fayllar CDR. .CMX, .WMF kabi kengaytmalarini 
oladi.

Kengaytmalar haqida 5.2-jadvaldan batafsil ma'lumot olishingiz 
mumkin.

5.2-jadval

CorelDRAW dasturida kengavtmalarning ro‘yxati

№ Kengaytma Izoh

1. CDR CorelDRAW

2. CDT CorelDRAW shabloni

3. CGM Kompyuter grafikasi metafayli

4. CMX Corel Presentation Exchange 5.0.

5. CMX Corel Presentation Exchange

6. CSL Corel simvollari kutubxonasi

7. DES Corel DESIGNER

8. DWG AutoCAD

9. DXF AutoCAD

10. EMF Kengaytirilgan Windows metafayli

11. FMV Vektorli freym metafayli

12. GEM GEM fayli
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13. PAT Uzor fayli

14. PCT Macintosh PICT rasmlari

15. PLT HPGL plotter fayli

16. SVG Masshtablanadigan vektor grafikasi

17. SVGZ Siqi SVG

18. WMF Windows metafayli

19. WPG Corel WordPerfect grafikasi fayli

20. CLK Corel R.A.V.E.

Dastur yuklangandan so'ng ekranda foydalanuvchi interfeysining 
asosiy elementlaridan iborat CorelDRAW oynasi paydo bo‘ladi (5.1- 
rasm).
Menyu qatori Standart uskunalar paneli Atributlar paneli

I !•** T̂oK до
C5 ï'- Ф U • Я

'S

й;

4
«L
ft
А

w Uwio.i’mn. 
Д ¿'ff С nii.
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«UEJjSJ

" f c

.....T..

Ish qog'ozi

rUskunalar to‘plami

Ish maydoni

uaIjsj

wvdch: *

- Jet;*™ ••
** CblKt H<na9«f 
:d ьь' C? lw,;« «  Leyer J
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Sahifadan-sahifaga oktish Holat qatori
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5.1-rasm. CorelDRAW oynasining ko'rinishi.

Palitra J
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CorelDRAWda ishchi muhitni sozlash mexanizmi juda rivojlangan. 
Windows standartidan farqli oynaning sarlavha satri ostida menyu 
qatori joylashgan.

5.2. Corel DRAW  dasturi ovnasi qism lari

□ Sarlavha satri. Bu yerda: Corel DRAW 12 -  dasturning nomi.
[Risunok 1] -  hujjatning formal nomi. Ish yakunida formal nomga

real (haqiqiy) nom beriladi.
□ Menyu satri.
Windows standartlariga mos bo'lgan menyu satri. CorelDRAWda 

menyu satri murakkab bo'lib, qism menyu va ularga mos buyruqlardan 
iborat. Boshqa dasturlardagi kabi bu menyu ham Corel Drawning 
ko^pchilik funksiyalariga kirishni ta’minlaydi. Lekin ko'pchilik ha- 
rakatlar u siz ham bajarilishi mumkin. Menyuni sozlashning 
chegaralanmagan imkoniyatlari foydalanuvchini chalkashtirib yuboradi. 
Foydalanuvchi xohlagan vaqtda СorelDRAWning har qanday buyruq 
va uskunalarini boshqa menyuga kokchirish mumkin. Shuning uchun 
keyingi paragraflarda birinchi navbatda menyusiz ishlash yoilarini, 
zarur boiganda uning buyruqlariga murojat qilishni o'rganamiz. 
Menyu satri 11 ta menyudan iborat. Har bir menyu o4ziga xos buyruqlar 
tobplamidan tashkil topgan. Corel DRAW' menyusi murakkab tuzilgan 
bo4lib. har bir menyuda bir necha ichki menvular bo'lishi mumkin.

Standait uskunalar paneli

Menyu satrining ostida Standart uskunalar paneli joylashgan. Bu 
satrda eng ko‘p bajariladigan buyruqlarga mos boshqarish elementlari 
joylashgan. Masalan, Открыть (ochish), Закрыть (yopish). Сохранить 
(saqlash) buyruqlari. tizimli almashtirish buferining operatsiyalari. 
rasmlarni ko'rish holati uskunalari joylashgan.

i 32мНмЯИНННННННИВИНН1НВННННИН1НИ1НННИНННННИЫ,
? ^  Ы ¡w, o-ч r , 4^ ▼  100% V Привязать к - I

1 г i t  i i T и  i H i t -------- 1------------ 1
1 2 3 4 5 6 7 8 9 10 11 12 13 14

Standart uskunalar paneli tugm achalarining vazifalari:
1 -  yangi hujjat yaratish: 2 -  mavjud hujjatni ochish; 3 -  hujjatni saqlash; 4 -  
hujjatni chop qilish; 5 -  qirqish: 6 -  nusxa olish: 7 -  qo'vish: 8 -  oxirgi harakatni
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bekor qilish; 9 -  oxirgi harakatni tak ro r la sh :  10 -  import (bir hujjatni ikkinchisiga 
ulash); 11 -  eksport (fayllarni jo ‘natish); 12 -  ilovani yuklanish moduli: 13 -  Corel 
DRAWning sayiiga k ir ish : 14 -  massh tabni kattalashtirish darajasi.

□ Atributlar paneli.
Standart uskunalar panelining ostida «atributlar paneli» (панель 

атрибутов) satri jovlashgan. U  belgilangan obyektning parametrlarini 
o'zgartiradigan boshqarish elementlari to4plamidan iborat. Atributlar 
paneli ichidagi elementlar belgilangan obyektning shakliga qarab 
crzgarib turadi. B u  panel foydalanuvchining asosiy ish paneli deb 
ataladi.

¡\: S3,943 им !7,698пн 100,0 А О 00 . с и 5 'С ШЗ 0,2ми v|у: 163.895 им 1 Г;.891 ну 100.0 \ А

Ranglar palitrasi. O ynaning o4ng chegarasi bo4ylab «Палитра цве
тов» (ranglar palitrasi) paneli joylashgan. U rangni toidirish va rasmli 
obyektlarning atrofini himoyalash, aylantirib bo'yash uchun qo4llaniladi.

Uskunalar paneli. Ish maydonining chap qismida uskunalar to4plami 
(toolbox) oynasi joylashgan. TJndagi kerakli uskunani tanlash uchun 
uning ustida sichqoncha chap tugmasi bosiladi. Kerakli uskunani 
tanlash bilan foydalanuvchining tasvir ustida barcha harakatlari 
boshlanadi.

Ь'5кипа1аг panelidagi а з с ^ у  и5кипа1аг \ а  ularning \  azifalari:
1 -  Указатель (ко’гБагкюЬ), 1а5\тгш Ье1^ИаусИ; 2 -  Форма (5Ьак1) иБкипаБк 3 -  
В ырезать (<3*1гц1Ь оГ1зЬ); 4 -  М асш таб  (о’1сЬат). Obyektni ко‘пш$Мш o■zgartiradi 
(к:аГ1а1а5Ь11гас1*1 уа к1сЫк1а5ЬП1жН); 5 -  Свободная рука. 1хиуопу shakldagi 
сЬ1щ1атп1 сЬТгасП: 6 — А втори сован ие иБкипаБГ. ЕгТап сБшц1агп1 Ьоб! 1 цПаЗг. 7 -  
Прямоугольник ш к и п азк  То‘ПЬигсЬак1аг бшАш ЬобИ qiladi; 8 -  Ау1апа \ а  uning 
sinfiga 1ее;’̂ ЬП оЬуекЫагш chizadi; 9 -  М ногоугольник (ко'рЬигсЬак) и$кипа$1 
Ко*рЬигсЬак1агт chizad i: 10 -  П р о сты е  формы (oddiy Аэгта1аг); 11 -  Текст 
(плат) изкипаБК 1 2 -  Т абли ца. Jadval иБкипаэк 13 -  Интерактивное перетекание 
и5кипа5к 14 -  П и п етк а  изкипаБК 15 -  К онтур изкипаБК 16 -  Заливка иБкипазк 
1 7 - И нтерактивная зал и в к а  и5кипа$к
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5 . 2 - r a s m .  Fill uskimasining yoyilgan paneli.

Uskunalar panelidagi ayrim tugmalarning pastki o'ng burchagida 
uchburchak shakli berilgan. Bu ko'rsatkich tugmachaga aslida bitta 
em as balki bir nechta uskuna o'rnatilganligini bildiradi. Tugmaga 
tegishli boshqa uskunalarni birga ko'rish uchun uni sichqoncha chap 
tugm asi yordamida bosamiz.

5.2-rasmda Fill (Заливка) uskuna tugmasi ostida joylashgan panel 
ko‘rsatilgan.

Ochilgan paneldan zarur tugmani tanlash va bosish y o ii bilan turli 
vazifalar bajariladi.

CorelDRAW oynasining pastki qismida holat qatori joylashgan 
(status bar). Unda ish jarayonida belgilangan obyekt haqidagi va 
dasturning ish rejimi haqidagi boshqa yordamchi ma'lumotlar beriladi. 
Holat qatorini ish stolining ixtiyoriy joyiga ko'chirish mumkin. Ammo 
tajribalarning ko’rsatishicha holat qatorini ish stolining pastki qismiga 
jovlashtirgan m a ’qul.

CorelDRAW ish maydonining asosiy qismida hujjatlar oynasi 
(drawing windows) joylashtirilgan. CorelDRAW yangi hujjat yaratish 
buyrrug‘i berilgandan su‘ii& illyustratsiya jovlashtiriladigan sahifa paydo 
bo‘ladi. Sahifaning chegaralari ramka ko'rinishida joylashtirilgan bo‘lib 
ular tasvirning elementlari hisoblanmaydi. Bo'lajak illyustratsiyani 
tashkil qiluvchi obyektlari ana shu ramkalar ichida joylashgan boiishi 
lozim. Illyustratsiya oynasining qolgan înavdoni ish stoli deb nomlanib, 
ulardan obyektlarni vaqtincha saqlash maqsadlarida foydalaniladi. 
CorelDRAW  ish  stoli o4lchami aning ekranda ko’rinib turgan qismidan 
kocra juda ham  katta. Oynaning ko4rininaydigan qismini ko’rish uchun 
o‘n g  va pastki tomonda ikkita prokrutkalar joylashgan. Gorizontal 
prokrutkadan chapda ko4p betli hujjatlarning alohida betlariga o'tish 
im konini beruvchi (harakatlanish) tugma va vorliqlardan (betning nomi 
berilgan) iborat boshqaruv elementlari joylashgan. Ularni birgalikda 
n a v ig a to r  deb ataladi.

180



Hujjat oynasining chap va yuqori chegaralarida koordinatali 
chizg ichlar (rulers) joylashtirilgan. Ular yordamida obyektlarning 
koordinatalarini va jovlashuvi yo'nalishini aniqlab olinadi.

CorelDRAW interteysida birlashgan (dockers) oynasi ulkan 
ahamiyatga ega. Bu o y n a  yig'ilgan paytida nomlangan vorliqlardan 
iborat bo'lib. ranglar palitrasidan chapda joylashgan. Ular o'zining 
funksiyasiga ko*ra muloqot oynasini eslatadi. Ammo ularning muloqot 
ovnasidan farqli tomoni ish muhitida doimo ko'rinib turishidadir.

5.3. Hujjatlar bilan ishlash
Yangi hujjat yaratish

Har doim CorelDRAW  dasturi yuklangandan so'ng yangi hujjat 
ochiladi. Agar ish jarayonida yana bitta yangi hujjat yaratish kerak 
bo'lsa u holda. File (Файл) menyusidan New (Новый документ) 
buyrug'ini bering yoki standart uskunalar panelining chap qismida 
joylashgan New (Новый документ) tugmasini sichqoncha chap tugmasi 
yordamida bosing.

Agar uskunalar panelidagi tugmalarni vazifalarini yaxshi bil- 
masangiz yoki unutib qo‘ygan bo'lsangiz u holda. shu tugma ustida 
sichqon korsatkichini biroz ushlab tursangiz. uning ustida nomi aks 
etgan eslatma paydo bo'ladi.

Hujjatni ochish va yopish

CorelDRAW dasturida avvaldan tayyorlab quyilgan hujjatlar 
Windowsning boshqa amaliy dasturlari singari quyidagi yo'llar bilan 
ochiladi: CorelDRAWda yaratilgan faylni bosib ochish orqali yuklash; 
File (Файл) menvusidagi Open (Открыть) buyrug'ini berish orqali 
yoki standart uskunalar panelidagi Open (Открыть) tugmasini bosish 
orqali amalga oshiriladi. Oxirgi ikki holatda ekranda Open Drawing 
(Открыть документ) muloqot oynasi paydo bo4ladi (5.3-rasm). Bu 
muloqot oynasida W indowsning barcha amaliy dasturlaridagi hujjatlarni 
ochish oynasining standart elementlari mavjud. Undan tashqari. 
fay liar ro'yxatining o 'n g  tomonida (Preview (Предварительный про
смотр) belgisi faollashganda) tanlangan faylda saqlanayotgan tasvirni 
ko’rish mumkin. Bu esa  biz ochmoqchi bo'lgan faylni aynan shu tasvir
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■■ НвДвМИб i. документы
ш

Рабочий cwmi

Мои > докумнтъ».

Мой
хоипьютвр:

Ответа .•*.•• окружение

*• • bunny 1 flower 7 ^pmpbevC
Д.. burr y2 h flcv»er8 К  reptiles

ЬитуЗ '№■ Novier 12 H  snowflakes
■i: checkers flower H ««SQja'CS
[IJ chrome flovierl9
ИМ cubes 1 'V̂ ; flower 20

cvbtoZ tkv<&Z\ $ 5QUdreS4
■  c ut*53 gv f̂e J* SOUS'«S
В  cut>€-s4 **- gcldbev] Sjijctari
ЩcubesS gddbev2 stars2
[3 CLlbcsi. Vll bds |  tileGI
:>-*dots7 Ц  octagons ■tile03

dotse pa», tern H'>le05
ii* dots i : M  dm

flower з SSjp̂ Pbevl

File came: giraffe

Files of type: All Fie Formats

Sort type: Default

Code Раде: 
Keywords:

; Notes:

1251 (AfiSl - кисмп.пиш!

file Version: Version 10 
Concession ratio: 78.3% 
Last saved b/: CorelDRAW 10 (pc) buM427
Last saved in: ДнглиЗос**« (США)

*  tjartam layers and pages

Options « Open

5.3-rasm. Open Drawing muloqot oynasi.

ekanligini bilib olish uchun imkon beradi. CorelDRAW  hujjatlarini 
saqlashda berilgan  kalit so'zlar yoki eslatmalar Keywords (Ключевые 
слова) va N o te s  (Замечания) maydonida paydo bo‘ladi.

Hujjatlarni yopish uchun esa File >  Close buvrugin i berish yoki 
ekranning yuqori o‘ng burchagida joylashgan Close tugmasini bosish  
kerak. Shundan so‘ng agar hujjat yaratilgandan keyin unda biror 
o‘zgarish b o ‘lgan b o isa  u holda hujjatni saqlash yoki saqlamaslik  
haqida o y n a  chiqadi. Agar bu oynada Да tugmasi bosilsa, Save 
m uloqot o y n asi (hujjatni saqlash oynasi) paydo b o iad i. Aks holda, Нет 
bosilsa, u holda hujjatdagi barcha o'zgarishlar saqlanmasdan o‘chib 
ketadi. B u ogohlantirish oynasida ikki tugm a bilan birga uchinchi
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tugma Cancel ham mavjud. Ayrim hollarda hujjatni bekitishga buyruq 
berilgandan so‘ng muloqot oynasi avtomatik holda chiqqandan keyin, 
foydalanuvchining fikri o'zgarib yuqoridagi ikki holatdan birini 
emas, balki uchinchi holat, ya’ni hujjatga qaytib, ishni davom ettirishi 
mumkin. Buning uchun Cancel tugmasini bosish kerak.

Hujjatni saqlash

CorelDRAW hujjatini saqlash standart uskunalar panelidan Save 
(Сохранить) buyrug‘ini berish orqali bajariladi. Agar avval bu hujjat 
saqlanmagan bo4Isa, ekranda 5.4-rasmda berilgan Save Drawing (Со
хранить документ) muloqot oynasi paydo bo'ladi.

Hujjatni saqlash uchun File name (Имя файла) maydoniga fayl 
nomini kiritish, fayl saqlanishi kerak boigan papkani tanlash va 
Sa\e (Сохранить) tugmasini bosish kerak. Shuningdek Save (Co-

x|
Папке; _J Мои документы

Мойкоигъютер

Сетевоеокружение

фМ/Afiïhivëi 
_jur.rvyr.frd 5Ле 1 
_2ÍMoh рисуиси 

ну)ы»'.д

Version: 
Veision 12.0
Thurojbnad:
10К (color)

Flleoeme: 0***1 
Save «s type: COR - CorelDRAW 
Soit type: C-efault 
keywords: ¡
Notts:

Advanced...

£eb_frafejitoftames
Embed Fonts using TrueOoc (TM)

5.4-rasm. Save Drawing muloqot oynasi.
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хранить) tugmasini bosishdan oldin muloqot oynasidagi Keywords 
va Notes maydonchalariga kalit so'zlar va eslatmalarni kiritib saqlash 
ham mumkin (yuqorida aytilganidek fayllarni ochish paytida bu 
ma'lumotlardan foydalanish mumkin).

Endi diqqatingizni ochiluvchi Version (версия) robyx.atiga qarating. 
Bu ro'yxatdan siz faylni CorelDRAWning avvalgi versiyalarida 
saqlamoqchi bo'lsangiz. u holda bu ro4yxatdan o'zingizga kerakli 
alternativ versiyani tanlashingiz kerak bo'ladi. Agar fayl avval 
saqlangan bo'lsa, u holda diskda takroriv saqlashda Save Drawing (Со
хранить документ) muloqot oynasi ochilmasdan amalga oshiriladi. 
Agar faylning nusxasini olishingiz kerak boisa, u holda uni boshqa 
papkaga saqlang. Options tugmasi saqlash rejimining ikkinchi darajali 
funksiyalaridan iborat boshqaruv elementlarini ochish voki yopish 
imkonini beradi.

5.4. Sahifaning param etrlarin i o ‘zgartirish

Yangi hujjat varatilgandan so’ng gohida uning oicham ini o’z- 
gartirishga to4g4ri keladi. Buning uchun atributlar panelining ele- 
mentlariga murojat qilinadi. Rasmda birorta ham obyekt bel- 
gilanmagan bo'lsa. u holda atributlar panelida sahifaning o'lcham- 
larini o'zgartirishga imkon beruvchi elementlar paydo bo'ladi (5.5- 
rasm).

Qog4oz fonnati Sagifa oriyentatsiyasi Ko'p qatorli hujjat rejimi

Sahifaoichami
O’lchov birli^i

A4 t l  297.0 mm 
(□ 210.0 mm

«□►.2,54 mm \ !?x 6-35 mm 
T ! 6.35 mm lix m  !ij Ц  kz

5 . 5 - r a s m .  B elgilangan obvektlar b o ’lm agan holda atributlar panelining ko'rinishi. 
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Hujjatning chop etilad igan  sahifa o’lchami atributlar panelining 
eng chap qismida joylashgan  Paper T ype/Size (Тип/формат бума
ги) bekiladigan ro'yxatdan tanlanadi. Chop etiladigan sahifaning 
o’lchami illyustratsiya chop etiladigan qog4ozning formatiga mos 
kelishi shart emas. Faqatgina illustratsiya qog'ozning o'lchamidan 
ortib ketmasa b o id i.  Agar chop etiladigan sahifa o4lchami 
qog'ozning o'lcham idan kichik bo'lsa, u holda qog'ozning chetida 
toza bo'sh joy qoladi. Shuning uchun chop etiladigan sahifaning 
o'lchamini bo‘lajak illyustratsiya o'lchamidan (standart qog'ozning 
o'lchamlaridan em as) kelib chiqib oldindan belgilab olinadi. Agarda 
illyustratsivaning o’lch am i kichik bo4lsa, u holda bitta qog'ozga bir 
nechta nusxani joylashtirib  chop etish maqsadga muvofiq. Bunga 
misol qilib. kichik ta klifnomalar, tashrif qogkozlarini aytish mumkin. 
Nostandart o ’lcham da chop etiladigan sahifani yaratish uchun uning 
o'lchamlarini qog4oz formatlari ro’yxatidan o4ngda joylashgan Paper  
W idth and H eight (Ш ирина и высота листа) maydoniga kiritiladi. 
Undan yana o4ngda esa chop etiladigan sahifaning orientatsiyasini 
(kitob yoki albom ko4rinishi) belgilashda ishlatiladigan P ortra it 
(Книжная) va L a n d sc a p e  (Альбомная) tugmasi joylashgan. Bu 
tugmalarda standart A4 qog4ozning tasviri nomiga mos ravishda 
vertikal va gorizontal ko'rinishda joylashtirilgan. Shuningdek 
D raw ing U nits (Единицы  измерения) ochiladigan ro'yxatdan 
CorelDRAWda koordinatani va o’lchamlarni aniqlash uchun o'lchov 
birligini o'zgartirish mumkin.

5.5. CorelDRAAVda oddiy shakllarni chizish im koniyatlari

To^g'riburchaklar chizish

Yuqorida aytilganidek CorelDRAWda tasvirlar bilan ishlashning 
asosini obyektlar tashk il qiladi. Buni quyidagilarda ham ko'rish 
mumkin: bu dasturda foydalanuvchi tomonidan bajarishi lozirn boigan  
barcha grafikli obyektlarni ikkita kategoriyaga ajratish mumkin -  
chiziqlar va belgilar (matnlardan tashqari).

Berilgan obyektLardan eng chapda -  «классик» to4g*ri burchak. 
To4g*riburchaklar yaratilgandan keyin aynan shunday namoyon boladi. 
Ikkinchi obyekt esa yaratilganidan keyin 45° ga burilgan ko4rinishi.
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5.6-rasm. TcTg’riburchaklilar sinfi elementlari.

Uchinchi obvektda esa yaratilgandan keyin, to'rttadan uchta burchagi 
dumaloqlangan.

Agarda sizda biror chizilgan obyektning qaysi tipga tegishliligiga 
shubha o^'g^nsa. u holda o'sha obyektni sichqoncha yordamida 
belgilang v a  holat qatoriga qarang. Holat qatorida Rectangle on 
Layer 1 (Прямоугольник на слое 1) xabari paydo bo‘lsa. u holda 
uning to'g'riburchaklar sinfiga tegishli ekanligiga hech qandav shubha 
qolmaydi. CorelDRAWda barcha primitivlar tegishli uskunalar 
yordamida quriladi. Yuqorida biz uskunalar paneli bilan tanishib 
chiqdik. Shuningdek uskunalar orasida Rectangle (Прямоугольник) 
tugmasini ham ko'rib crtdik. Endi shu uskuna yordamida birinchi 
obvektim izni quramiz.

Tcfg^iburchak chizish

Ushbu mashqni bajarish bilan biz to'gïiburchak qurishning asosiy 
imkoniyatlari va shu bilan birga CorelDRAW 12 ish muhitining 
qo'shimcha elementlari bilan tanishamiz.

1. Yangi hujjat varating. Bu mashqni bajarish uchun ixtiyoriv 
o‘lchamdagi sahifa qog'ozini olish mumkin.

2. Uskunalar panelidan Rectangle (Прямоугольник) uskuna tug
masini bosing. Shundan keyin sichqon ko;rsatkichi ekranda krest 
shakliga o;tib, uning oldida toVriburchak ham paydo bo'ladi (5.7-rasm). 
Bu esa ayni vaqtda to'g'riburchak chizish uskunasi faolligini bildiradi.

Rectangle (Прямоугольник) uskunasini boshqa y o l bilan ham 
faollashtirish mumkin, masalan, sahifaning bo'sh joyida sichqonchaning 
o¿ng tugmasini bosish va kontekstli menyudan F6 buyrug6ini oling.
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Ramkali belsilash markerlari

r
Obyekt markazidagi marker

Obyekt uzeli

□

Rectangle uskunasi uchun 
sichqoncha ko‘rsatkichi

Rectangle on Layer 1

\7-rasin .  Belgilangan to 'g 'r iburchak va holat qatoridagi xabar.

To'g'riburchak chizishda diqqatingizni holat qatoriga qaratsangiz, 
u yerda chizilayotgan to‘g tariburchakning bo4yi va eni oMchamlari 
(pikselda) ko4rsatiladi. Ekranda esa chizilayotgan tokg4riburchakning 
doimiy o'zgarib borayotgan ko'rinishi tasvirlanadi. Holat qatorida 
esa yuqorida aytilganidek uning o'lchamlari to'xtovsiz o'zgarib 
borayotganini ko'rishingiz mumkin. Chizilayotgan to'g'ri burchak 
foydalanuvchi xohlagandek yuzaga ega bo'lganda sichqoncha tugmasi 
qo*yib yuboriladi. Bunda esa  to4g*riburchak shu oxirgi o'lchamdagi 
holatda ekranda paydo boiadi. Sichqoncha tugmasini qobyib 
yuborgunga qadar to'g'riburchak bo'yi va enini o'zingiz xohlagandek 
olchamga yaqinroq qilib chizib olishingiz mumkin.

Ellips uskunasi (Ellipse)

Ellips uskunasi ellipslar va aylanalar chizish uchun moijallangan.
Ellips oLziga tashqi chizilgan to'rtburchak burchaklaridan boshlab 

chiziladi. Ellipsni chizish uchun markazda <Shift> tugmasi. aylana
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uchun <Ctrl> bosilishi lozim. Obyekt xossalari paneli yordamida ellips 
parametrlarini o'zgartirish mumkin. Ellips tugmachasining vuqori 
qismidagi belgi orqali ellipsning tipini tanlash mumkin. Ellips, Sektor, 
Yoy tugmalari xossalari uskunalar qatorida qaytariladi.

Uchta uskuna, ko'pburchak (многоугольник). Spiral (Спи
раль). Koordinata sahifasi (Разлинованная бумага), obyekt guruhiga 
yig'ilgan bo‘lib uskunalar panelidan alohida panel ko'rinishida ajratish 
mumkin.

Spirallar yaratish uchun moljallangan yoki uzluksiz egri chi- 
ziqlar shaklidagi geometrik shakllarni chizish mumkin. Spiral 
chizish  jarayoni to ’rtburchak chizish jarayoni bilan bir xil. Faqatgina 
foydalanuvchi semetrik va logorifmik tugmalar orqali spiral turini 
tanlash mumkin. Muntazam spiral yaratish uchun Ctrl tugmasini bosib 
turish kerak. Spiral parametrlarini atributlar panelidan o;zgartirish 
mumkin.

1. Dasturda kvadrat chizish uchun qaysi standart tugma bosiladi?
2. To4g;ri to'rtburchak uskunasi yordamida nimalar chizish mumkin?
3. Dasturda geometrik figuralar qanday yaratiladi?
4. Kontur va tayanch nuqtalar haqida ma’lumot bering?

5.6. COREL DRAW dasturida murakkab chiziqlar va shakllar

L nalar bor: Chizish (Freehand). Bez?e 
(Vezier). Pero (Natural Pen). Chiziq 
o'lchami (Dimension). Bogiovclii chiziq (Connector Line) va BogMovchi 

(Connector).

Spiral uskunasi

Savol Vit topshiriqlar:

Egri chiziqlar guruhi uskunalari (Curve)

Egri chiziqlar guruhi usku
nalari panelida quyidagi usku-
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Ko'pburchak uskunasi (Многоугольник)

Ko'pburchakni kerakli tomonlarga ega bo'lgan geometrik obyekt 
sifatida tushunish murnkin. Ko'pburchakning bir varianti sifatida 
yulduzchani olish mumkin. Bunda ichki chizilgan ko'pburchakni 
maydonini kesib o'tadi. Ko'pburchakni yoki yulduzchani chizish 
tortburchak chizishdan farqi yo‘q. Ctrl tugmasini bosib turgan holda 
niuntazam ko'pburchak chiziladi. Ko'pburchak parametrlarini atributlar 
paneli orqali o'zgartirish mumkin.

Ko'pburchak belgisini tanlab atributlar panelida uning qirralar 
sonini kiritish mumkin. Qirralar o'tkirligi maydonida shartli birliklarda 
qirraning o'tkirlik darajasini kiritish mumkin.

Koordinata qog'ozli uskunasi (Разлинованная бумага)

Kordinata qog'ozli uskuna berilgan parametrli panjara yaratish 
imkonini beradi. Bunday panjarani grafiklar yoki diagrammalar uchun 
koordinatali asos qilib olish mumkin. Bu instrument parametrlarini, 
parametrlar muloqot oynasida koordinatali qog'oz bo‘limida o'zgartirish 
mumkin. Katakchalar soni maydonida eniga (Number of cells wide) 
bo'yiga (Number o f cells high) ko‘ra katakchalar miqdorini o'zgartirish 
mumkin. Kvadrat katakchali panjaralarni tayyorlash uchun <Ctrl> 
tugmasini bosib turish kerak.

Chizish uskunalari (Freehand)

Chizisli uskunalari istalgan chiziqlarni chizish uchun mo‘ljallangan. 
Bu uskuna ishi natijasida vektorli kontur hosil boiib. bu kontur tayanch 
nuqtalari dastur vordamida avtomatik qo‘viladi. Bu konturlar ustida 
erkin tahrirlash imkoni mavjud. Bu uskunalarda chizayotgan paytda 
chiziqlar qalinligi va rangini o'zgartirish mumkin.

Chizib bo'lingan chiziqni istalgan paytda davom ettirish mumkin. 
Buning uchun kursorni uning oxirgi nuqtasiga olib kelib (kursorning 
egri chiziqlari ko'rsatkichga aylanadi). sichqoncha chap tugmasini 
bosgan holda chiziqni davom ettirish hamda chizish uskunalari 
vordamida to'g'ri chiziq chizish mumkin.

Безье uskunasi vordamida maksimal aniqlik va maksimal rat- 
sionallik bilan ixtiyoriv konturni yaratish mumkin. Bu uskuna
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foydalanuvchini grafik dizaynda barcha narsani hal qiluvchi Forma 
yaratuvchisiga aylanishiga imkon beradi.

To‘g ‘ri chiziqli segmentlar tuzish

To^g'ri chiziq yaratish uchun Безье uskunasi qulay keladi. Buning 
uchun Безье uskunasini tanlash kerak. Kursorni boshlang;ich nuqtaga 
olib kelish va sichqonchaning chap tugmasini bosish kerak. Tugma 
bosilgan joyda segmentning boshlang'ich tayanch nuqtasini ifodalovchi 
qora nuqta paydo bo4ladi. U kevingi nuqtayaratilgunga qadar faol bo'lib 
turadi. So'ng kursorni keyingi nuqta joylashadigan yangi joyga olib 
o4tish kerak. Ikki nuqta tcrg'ri chiziq bilan tutashadi.

Tayanch nuqtalarning turlari

Bir necha segmentlarning tutashishida tayanch nuqtalari Corel Draw 
dasturida uch tipli bo'lishi mumkin:

1. Ikki egri chiziqni «bukilishda» tutashtiruvchi tayanch nuqtasi 
-  burchak tayanch nuqtasi deyiladi. Bunday tayanch nuqtasida boshqa- 
ruvchi chiziqlar ham yo‘nalishi ham uzunligi bo'yichamustaqildir.

2. Ikki egri chiziqni sinishsiz tutashtiruvchi tayanch nuqtasi -  silliq 
tayanch nuqtasi deyiladi. Bunday tayanch nuqtalarda boshqaruvchi 
chiziqlar bir-biridan faqat o’lchami bilangina mustaqil. yo'nalishi 
bo'yicha esa umumiy tutashuvchi to4g'ri chiziqni tashkil qiladi. 
Boshqaruvchi chiziqlardan birining o'rin almashishi ikkinchisining ham 
o4rin almashishiga olib keladi.

3. Sinishsiz va bir xil qiyalik bilan tutashgan tayanch nuqtasi 
simmetrik tayanch nuqtasi deyiladi. Bunday tayanch nuqtalarda 
boshqaruvchi chiziqlar bir-biriga yo’nalishi bilan bogiiq  boladi.

SavoI \>a topsh iriq la r:

1. Egri chiziqlar guruhi uskunalari panelida qanday uskunalar bor?
2. Dasturda ko'pburchaklar qanday yaratiladi?
3. Koordinata qog‘ozli uskunasi (Graph Paper)ning imkoniyatlari?

5.7, COREL DRAW dasturida ranglar bilan ishlash

Imitatsiya uskunasi nuqtali grafika dasturlarida ko4proq ishlatiladi. 
Shunga qaramay vektorli dastur ham bu uskunani taqdim etadi. Bu
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uskuna orqali Peroda chizish owrnini bosa oladi, shu bilan birga bezakli 
shtamp o4rnini ham bosadi. Bu uskunaning ajoyibligi shundaki u asosiy 
konturni chizib. bu kontur bo'ylab turli obyektlar joylashib manzarali 
\a grafik effektlarni beradi.

Nainuna rejimida shunday obyektlarni yaratish mumkinki, bunda 
bu obyektlar tayyor namunalarga qarab o‘z shaklini o‘zgartiradi. Bu 
rejimda shaklli chiziqlarni ishlatish mumkin.

Muyqalam rejimi (Brush) -  bu rejimda murakkab tuzilishga ega 
bo'lgan bezakli shakllarni yaratish mumkin.

Purkagich rejimi (Object Sprayer) kontur trayektoriyalari bo‘ylab 
turli grafik obyektlarni joylashtiradi. Bu rejim murakkab ramkalar, 
bezakli qatorlarni yaratish uchun mo4ljallangan.

Kalligrafiya rejimi (Calligraphic) -  bu rejimda qalin pero yoki 
enli muyqalam egri chiziqlarini chizish mumkin.

Rgessure rejimi — bu rejimda shunday chiziqlarni chizish mum- 
kinki bu chiziqlarni klaviatura orqali boshqarish mumkin.

Xossalar uskunalar qatorida bu rejim tanlansa quyidagi para- 
metrlarga ega boUamiz: tekislash maydoni (Freehand Smoothing) asosiy 
chiziqni 0 dan 100 diapazonigacha tekislash imkoniyati (rasmda 1 
raqami bilan ko'rsatilgan).

0 ‘lcliam maydoni (Size) (2 raqam) bezakli shtrixlarning o'lchamini 
foizlar hisobida o'zgartish imkonini beradi 1 dan 99% gacha.

Obyektlar ro'yxati maydoni (3 raqam) -  bu ro'yxatda turli for- 
matdagi purkaladigan obyektlarning namunalari keltirilgan.

Save tugmachasi (4  raqam) muyqalam rejimida ish yuritish bilan bir
xil.

O'cliirish tugmachasi (Delete) ro'yxatdagi xohlagan variantlardan 
birini o'chiradi.

12

1 3 4 5 

5.8-rasm.  Property Bar paneli.
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Purkash tartibi (Srau Order) obyektning kontur bo'ylab joylashish 
ro'yxatini taqdim etadi: tasodifan (Ramdom). ketma-ketli (Sequentially), 
yo'nalish bo'ylab (By Direction).

Obyektlar ro‘yxatiga qo'shish tugmasi (Add to SprayList) 
obyektlar r o ‘yxatiga yangi elementlarni qo^shish imkoniyatini beradi. 
Ulardan keyinchalik  «Ijrochi» qatorini (play list) tashkil qilish 
mumkin.

Savol va topshiriqlar:

1. Imitatsiya uskunasi (Artistic Media) -  deganda nimani tushunasiz?
2. Kalligrafiya rejimi (Calligraphis)da qanday chiziqlarni chizish mum- 

kin.
3. Obyektlarni purkash nima?
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Vl-bob. F L A S H  D A ST U R I H AQ IDA

Flash MX -  Web sahifalaridagi animatsiyalar, bezaklar va  
bcshqa manbalarni o'z ichida saqlagan yuqori darajali dizaynlar 
yaratish uchun m o'ljallangan dasturiv vosita hisoblanadi. Flash MX  
dasturi yuqori darajadagi imkoniyatlari mavjud bo'lgan texnologik  
vositalar sirasiga kirib u n i bir so'z bilan Flash texnologivasi deb 
atashimiz inumkin. Flash texnologiya vordamida animatsiyalar. 
W eb-saytlar va ular uchun bannerlar. har-xil multimediali prezen- 
tatsiyalar yaratish mumkin. Flash texnologiyasi vordamida yaratil- 
gan turli loyiha va m ahsulotlar -  har doim harakatni vorqin aks 
ettirib. undagi tovush v a  video ko'rinishlar Internet loyihalarida 
harakatliligi bilan ajralib turadi. Shuning uchun bu texnologiya 
vordamida savtlar yaratish imkoniyati juda yuqori [5], [6], [7]. 
Lekin Flash texnologiyasin ing Internet tizimida ishlashda ayrim 
kamchiliklari mavjud. Jumladan:

1. Flash elementlarini saytda tasvirlab berish uchun. brauzerda 
Flash-player o'rnatish zarur. Internet Explorerda esa dastlabki o’r- 
natishdan key in Flash-player o'rnatiladi. Agarda siz boshqa brauzerlarni 
qo'llaydigan b o isan giz. u holda Flash-playerni o'rnatishga to'g'ri keladi.

2. Flash-saytlari HTML saytlariga qaraganda katta hajmni egal- 
laydi, shuning uchun ularning yuklanishi birmuncha sekin.

3. Flash-texnologiyani ko'pincha reklama maqsadida qoilaniladi. 
Shuning uchun informatsion portallarda qo'llashga ta\siya qilinmaydi. 
Cliunki bunday portallar hajmi juda kattalashib ketadi.

4. Flash-saytni yaratish biroz mehnat talab qiladi. Shuning uchun 
ham bunday saytlarning narhi. HTML saytlar narhiga qaraganda ancha 
yuqori baholanadi.
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Ayrim hollarda juda chiroyli saytlar o'ziniag tashrif buvuruvchilarini 
vaqtning hisobiga yo‘qotadi. Ya'ni sayt kompyuter ekranida to liq  
tasvirlanib boigunga qadar ketgan vaqtning evaziga foydalanuvchilarni 
yo'qotadi. Ammo bunday saytlar har qanday foydalanuvchini opining  
yuqori darajali grafikasi; ko’pqirrali imkoniyatlari, rang-barangligi 
bilan foydalanuvchilarning asosiy qismini yo'qotgani yo'q. Natijada 
Flash dasturi Web — ishlab chiquvchilar orasida otezining keng qamrovli 
o’rniga ega bo'lib bonnoqda.

Flash usulida tayyorlangan prezeatatsion saytlar yuqori darajadagi 
grafik almashinuvlar. boy interfaol g'oyalari va rasmlarning yuklanish 
tezligi yaxshiligi bilan tashrif buyuruvchilarda katta taassurot qoldiradi. 
Bundan tashqari harakatlanuvchi panellar. dinamik harakatlar. 
sinxron tovushli kliplar ham har qanday foydalanuvchini diqqatini 
o'ziga tortadi. Siz xattoki informatsion sayt yaratayotgan bo'lsangiz 
ham, flash-texnologiyani qisman qoilash y o li  bilan ham. tashrif 
buyuruvchilaringiz uchun yaxshi taassurot qoldiradigan Internet re surs 
yaratishingiz mumkin.

Umumiy ma'lumot va yordamchi jihozlar

Flash dasturi bilan tanishishni boshlaymiz. Bu yerda roliklar ustida 
ish olib boradigan oynani ko'rish mumkin. shuningdek uskunalar 
paneli va bir necha yordamchi panelkr mavjud. Bu yordamchi panellar 
obyektlarning turli xossalarini tanlashga yordam beradi (masalan. rang, 
qalinligi va kontur ko'rinishi va boshqa xususiyatlar). Flash dasturi 
boshqa dasturlar kabi o6zining vorlig‘iga ega.

Savolva topshiriqlar:

1. Flash qanday tip dasturlarga kiradi?
2. Flash dasturidannima maqsadlarda foydalanish mumkin?
3. Flash texnologiyasini Internet tizimida ishlashining qanday’ kam- 

chiliklari mavjud?
4. Flash saytlari oddiy saytlardan nimasi bilan farqlanadi?

6.1. Flash MX dasturining oynasi qismlari

Flash dasturi oynasi bir nechta qismdan iborat. Ular bilan 
tanishib chiqam iz. Dastur oynasiniag asosiy qismlaridan biri uning
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6 . 1 - r a s m .  F la s h  dasturi oynasi ko'rinishi.

ish maydonidir. Ish m aydonida biz obyektlarni chizish. tahrirlash. 
harakatlantirish im konivatini amalga oshiramiz. Undan yuqorida 
esa -  vaqt diagrammasi yok i vaqt shkalasi (timeline) joylashgan (6.1- 
rasm).

Uskunalar paneli rasmda ko'rsatilgandek to‘rt qismdan iborat. 
Yuqoridagi qismida Tools (uskunalar) obyektlarni yasash (chizish) va 
ularni transformatsiyalaydigan uskunalar joylashgan. Keyinroq ular 
bilan batafsil tanishib chiqamiz. Keyin tasvirni Viev (Вид) boshqaruvchi 
uskunalar keladi: bu qo‘l (Hand tool) rasmi va lupa (Zoom tool).

U sk u n a la r  paneli

6.2-rasm.  Tools uskunalar paneli.
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B u  uskunalar boshqa dasturlarda ham tez-tez uchrab turadi. Qo'l 
uskunasi yordamida ishchi sohani ko‘chirish mumkin. Lupa uskunasi 
yordamida kattalashtirsa yoki kichiklashtirsa boiadi (kichraytirish 
uchun ishchi sohada ALT tugmasini bosish kerak). Bu uskunalar faqat 
rolik tasvirini boshqaradi uning mazmuniga ta’sir o‘tkazmaydi.

Endi dastur oynasining navbatdagi qismlari bilan tanishib chiqamiz. 
Ular quyidagilar:

Yorliq qatori: dastur nomi va faol fayl nomini tasvirlab turadi.

Dasturning gorizontal menyu qatori

Flash M X dasturining gorizontal menyu qatori quyidagilardan 
iborat: File, Edit, View, Insert, Mudify, Ttxt, Control, Window, Help.
Endi menyulardagi asosiy buyruqlar ketma-ketligi, ularning vazifalari 
va ularning mos funksional tugmalar bilan tanishib chiqamiz.

6.1-jadval

File menvusi buvruqlari

Buyruqlar tugmalar (Windows)

New Yangi film <Ctrl>-<N>

Open Ochish <Ctrl>-<0>

Close Yopish <Ctri>-r<W>

Save Saqlash <Ctrl>-<S>

Import Import qilish <Ctrl>-<R>

Export Movie Eksport qilish <Ctrl>-<Alt>-<Shift>-<8>

Publish Settings Nashr o‘lchamlari <Ctrl>+<Shift>-<F 12>

Publish Preview Nashrni ko'rish <F12>

Print Chop etish <Ctrl>-<P>

Exit Dasturdan chiqish <Ctrl>-<Q>
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Edit menyusi buyruqlari
6.2-jadval

Buyruqlar tugmalar (Windows)

Undo Bekor qilish <Ctrl>^<Z>

Redo Takrorlash <Ctrl>+<Y>

Cut Qirqib olish <Ctrl>-<X>

Copy Nusxa olish <Ctrl>+<C>

Paste Qolyish <Ctrl>+<V>

Clear Tozalash <Backspace>, <Delete>

Duplicate Aynan nusxa olish <Ctrl>+<D>

Select All Hammasini belgilash <Ctrl>a-<A>

Deselect All belgilanishni bekor qilish <Ctrl>+<Shift>-<A>

Cut Frames Kadrlarni qirqib olish <Ctrl>-<Alt>+<X>

Copy Frames Kadrlardan nusxa olish <Ctrl>-<Alt>^<C>

Paste Frames Kadrlarni qo‘yish <Ctrl>+<Alt>+<P>

Edit Symbols Simvollarni tahrirlash <Ctrl>+<E>

6.3-jadval

View menyusi buyruqlari

Buyruqlar tugmalar (Windows)

Goto kadrga o’tish -

Zoom In masshtabni kattalashtirish <Ctrl>+< = >

Zoom Out masshtabni
kichiklashtirish

<Ctrl>+<—> .

Magnification kattalashtirish -
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dctvomi

100% 100% <Ctrl>+<l>

Show Frame kadrni ko'rsatish <Ctri>-<2>

Show A ll hammasini ko’rsatish <Ctrl>-<3>

Outlines Konturlar <Ctrl>-<Alt>+<Shift>-<0>

Fast tez <Ctrl>-<Alt>-<Shift>4-<F>

Timeline vaqt diagrammasi <Ctrl>-L<Alt>-<T>

Work area ish maydoni <Ctrl>-<Shift>-<W>

Rulers chizg'ich <Ctrl>-<Alt>+<Shift>+<R>

Hide Edges qirrani bekitish <Ctrl>^<H>

Hide Panels panelni bekitish <Tab>

6.4-jadvaI

Insert menyusi buvruqlari

Buyruqlar tugnialar (Windows)

Convert to Symbol simvolni holatini o'zgartirish <F8>

New Symbol yangi simvol <Ctrl>^-<F8>

Frame kadr <F5>

Remove Prames kadrlarni okchirish <Shift>-<F5>

Keyframe bog'langan kadr <F6>

Blank Key frame bo'sh bog‘langan kadr <F7>

Clear Keyframe bog'langan kadrni o'chirish <Shift>^<F6>

Create Motion Tween harakat hosil qilish
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Modify menyusi buyruqlari
6.5-jadval

Buyruqlar tugmalar (Windows)

Layer... qatlam parametrlari <Ctrl>+<F>

Scane ... sahna parametrlari <Ctrl>+<M>

Document hujjat parametrlari <Ctrl>+<Alt>+<Shift>+<C>

Transform ko’rinishni o'zgartirish -

Scale o‘lchamni olzgartirish 
uchun belgilash

<Ctrl>+<Alt>+<S>

Rotate Burish

Frames kadrlar ustida amallar

Lock bekitish (qulflash) <Ctrl>-<Alt>+<L>

Unlock All bekitish (qulflash)ni bekor 
qilish

<Ctrl>+<Alt>+<Shift>+<L>

Group Guruhlash <Ctrl>+<G>

Ungroup guruhni boTaklash <Ctrl>+<Shift>+<G>

6.6-jadval
Text rnenyusi buyruqlari

Buyruqlar tugmalar (Windows)

Font shriftni o'zgartirish -

Size shrift oMchamini o'zgartirish <Ctrl>+<Shift>+<B>

Style shrift stilini o‘zgartirish <Ctrl>+<Shift>+<l>

Align matnni tekislash -

Scrollable markerni o'rnatish <Ctrl>+<Shift>+<C>
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Control menvusi buyruqlari
6.7-jadvaI

Buyruqlar tugmalar (Windows)

Play ijro etish <Enter>

Test Movie filmni ko'rish <Ctrl>-<Enter>

Test Scene sahnani namoyish qilish <Ctrl>-<Alt>+<Enter>

6.8-jadval

Window menvusi buyruqlari

Buyruqlar tugmalar (Windows)

Ne^w Window yangi oyna <Ctrl>T<Alt>-<N>

Toolbars Panellar -

Tools maTumot <Ctrl>-<Alt>-<!>

Timeline tekislash <Ctrl>-<K>

Properties belgi <Ctrl>-<T>

Actions Protseduralar <Ctrl>-<Alt>-<A>

Movie Explorer filmlarni boshqaruvi <Ctr 1>+<A lt>-<M>

Library Kutubxona <Ctrl>-<L>

6.9-jadval

Help menyusi buyruqlari

Buyruqlar tugmalar (Windows)

What's new Yangi imkoniyatlar -

Lessons Flash bo'yicha darslar -

Using Flash Yordam maTumotlari FI

Samples Flash faylga misollar I
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Buyruqlardan foydalanishni tegishli boiimlarda batafsil ko'rib 
chiqamiz.

V aqt diagram m asi

Ish maydoni ustida vaqt diagrammasi (Timeline) paneli joylashgan. 
Vaqt diagrammasi, filmning aniq sahnalashtirilishiga xizmat qiladi. 
L yaratilgan qatlamlarni alohida-alohida sahnaga yozib qo'yishni 
ta'minlaydi. Sahnada namoyish qilinadigan obyektlarning o'zgarishi 
ketma-ketligini ifodalavdi. Vaqt diagrammasi shuningdek animatsiya 
yaratishda. film interfaol elementlari xatti-harakatini belgilashda asosiy 
uskuna hisoblanadi. Vaqt diagrammasi murakkab tuzilishga ega bo‘lib, 
krp sonli boshqaruv elementlaridan iborat. Vaqt diagrammasi panelida 
quyidagi umumiy elementlar berilgan (6.3-rasmda):

• filmning mavjud sahnasi uchun qatlamlar ro'yxati (ustma-ust 
ustun kcrrinishida) ko'rsatilgan. Qatlamlarning nomi va atributlari 
krrsatilgan:

• vaqt diagrammasi har bir qatlam uchun kadrlar shkalasidan
iborat;

• vaqt diagrammasidagi kadrlarni formatini o‘zgartirishning yig‘ma 
menyusi:

• filmning ay rim parametrlarini ifodalavdigan vaqt diagrammasidagi 
holat qatori mavjud.

Vaqt diagrammasining kadrlar shkalasi bilan tanishib chiqamiz. 
Shkala sahnaning barcha qatlamlari uchun umumiy bo4lib, ammo har 
bir qatlam o'zining kadrlar qatoriga ega. Unda kadrlar o'sish tartibida

Timeline

|| < * a n 1 5  10 15 20 25 30 35 Hj j
Wf Layer 7 /  • • ■ 1

*ij . . ____  . _

▼
i i i • ^  < 1 12 0 fps ; 0.0s j J J  _►]

LlP. Laver 6 • • E3 
ZJ Layer 5 • • □  

Layer 1 ♦ • IS

■* a —I 0

6.3-rasni. Vaqt diagram m asi.
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nomerlangani tasvirlangan. Nomerlanish har 5 qadamda berilgan bo4 lib. 
kadrlarning har qanday formatida o4zgartirib boMmaydi.

Vaqt diagrammasi ko'rsatkichi (Play head) animatsiyaning faol 
kadrini ko'rsatadi. Qaysi kadr sichqon vordamida tanlansa. o4sha kadr 
ustida kcfrsatkich paydo bo'ladi. Ko'rsatkich faol kadming nomerini 
ko'rsatib turadi. Bu esa animatsiyaning tasvirlanayotgan jarayonga 
sinxronligini ta’minlavdi.

Kadrlarni formatlash menyusidagi bnvruqlar kadming katakchasini 
gorizontal bo'yicha oichamini belgilavdi: Tiny (mayda); Sm all (kichik); 
N o r m a l (odatdagi); M edium  (o’rta); Large (katta).

Boshqaruv elementlari paneli (Properties)

Yuqorida boshqaruv elementlari panelida berilgan ma'lumotlarga 
q o 4shimcha ravishda quvidagilarni aytish mumkin:

• matnli maydonda URL ish maydoni matnli qismini belgilaymiz 
v a  shu maydonda to‘liq Web-manzilni ko'rsatamiz (URL -  Universal 
Resources Locator). Bog'langan resurs uchun siz haqiqiy giperhavolaga 
ega bo'lasiz;

Boshqa vizual tahrirlagichlardan farqli tomoni. gipermatn namovish 
vaqtida ostiga chizilgan shrift bilan emas balki. shtrixli chiziq bilan 
beriladi. Flash texnologiyada giperhavola hosil qilishning ikkita 
kamchiligi bor: birinchidan, LR Lni noavtomatik (qolda) vo4l bilan 
kiritiladi va ikkinchidan. Flash URLning xatto lokal fayllar uchun 
aniqligini tekshirmaydi;

• Target (Целевой) ro'yxati; u resursni qanday brauzer oynasida 
nam oyish qilin ishini (yuklanishini) ko‘rsatishda qoilaniladi (ko*r- 
satilgan URL b o 4yicha chaqirilgan resursni). URL maydoniga hech 
b o 4lmaganda bitta simvol kiritilgandan keyin ro'yxat faollashadi, 
y a ’ni o4nga murojaat qilish mumkin. Ro'yxat quyidagi variantlardan 
iborat (ular HTML tilining TARGET atributi qiymatlari bilan 
o4xshash):

о -  blank -  chaqirilayotgan hujjat har doim yangi oynada yuklanadi 
(asl oynaning o4zida emas);

c -  self -  chaqirilayotgan hujjat xuddi shu oynaning o'zida yuk
lanadi (qaysiki havola o'rnatilgan oynaning o'zida);
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° -  parent -  chaqirilayotgan hujjat bosh oynada yuklanadi; agar 
bu oyna bosh oynaga ega b o im asa . u holda yuklanish xuddi _ self  
ko'rsatkichidagidek bo'ladi:

0 - to p  -  chaqirilayotgan hujjat eng yuqori qismdagi oynada yuk
lanadi (agar ushbu ovnaning o*zi eng yuqori qismda bolsa. u holda _  
self ko'rsatkichdagidek yuklanadi):

• Selectable (Выделяемый) tugmasi; bu tugma xuddi bayroqchadek 
qoilaniladi: tugmani bosish bilan matnga tegishli xususiyatlar panelini 
o'rnatish yoki aksincha o'rnatilgan bo isa  uni bekor qiladi;

• Change Direction of Text (matn yo'nalishini o’zgartirish) foyda- 
lanuvchi menyuni ochib inatnning yo'nalishini tanlab olishi mumkin: 
gorizontal yoki vertikal. Menyu o'z ichiga quyidagi uchta buyruqni 
oladi:

° H orizonta l (Горизонталь);
° Vertical, Left to Right (Вертикаль, chapdan o‘ngga);
° Vertical, Right to Left (Вертикаль, o'ngdan chapga);
Matnning vertikal yo'nalishini o'rnatishda formatlashning tugmalar 

tarkibi owzgaradi va undan tashqari Rotation faollashadi:
• Rotation (burish) tugmasi bayroqcha vazifasini bajaradi va 

matndagi simvol joylashuv holatini o'zgartirishni ta'minlaydi:
• Use Device Font belgisi -  agar belgi o'rnatilgan bo‘lsa. Flash -  

pleyerda filmni namovish qilish mobaynida o'quvchining brauzeri uchun 
o'rnatilgan shriftlar qoilaniladi. Bu film fayli oichamini kichraytiradi 
va kichik shriftning qulay o'qilishini ta'minlaydi.

Xususiyatlar paneli o*ng chegarasi vaqinida Format (Формат) 
tugmasi joylashgan. Uni bosish bilan. qo‘shimcha muloqot oynasi 
ochiladi va undan fovdalanib matn maydonini formatlash parametrlarini 
o'rnatish mumkin.

Format Option oynasi to'rtta matnli maydondan tarkib topgan:
• Indent -  yangi qator uchun abzatsning oichami (pikseida);
• Line Spacing -  yon atrofdagi qatorlar bilan joylashuvi (satrlar 

orasidagi interval): vertikal matnlar uchun bu parametr matnning 
ustunlari orasida beriladi:

• Left Margin (chap maydon) -  matn maydonining chap chegarasi 
va qatorning birinchi simvoli orasidagi masofa:
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•  R igh t M a rg in  (o'ng maydon) -  matn maydonining o’ng tomon 
chegerasi va qatorning oxirgi simvoli orasidagi masofa.

F o rm a t O p tio n  muloqot oynasi matn maydonining har qanday 
ko'rinishi uchun o'rinli.

Dasturning ish maydoni va uning ko‘rsatkichlarini o‘zgartirish

Agar ishchi maydonida birorta ham obyekt tanlab olinmagan bo'lsa 
yoki umuman mavjud bo'lmasa. u holda boshqaruv paneli xossalari 
film ning umumiy parametrlarini ko'rsatadi. Qandaydir obyektni 
olsangiz uning formati avtomatik ravishda crzgaradi.

• Document (Документ) matn maydoni. tahrirlanadigan fayl nomi 
tasvirlanadi;

• Size (Размер) tugmasL ish stoli olchamini tasvirlab beruvchi 
tugma;

• Publish (Публикация) tugmasi; uni bosish bilan avval o'rnatilgan 
parametrlar asosida film nashrini boshlaydi:

• B ackground (Фон) tugmasi; uni bosish bilan filmning fon rangini 
tanlash palitra oynasi hosil bo'ladi. Shu oynadan filmning kerakli foni 
rangi tanlab olinadi:

• F ram e R a te  (Скорость кадров) matnli mavdon. animatsiyaning 
kadrlar almashish tezligini belgilaydi;

• ? (so4roq) belgisi tasvirlangan tugma HTML-formatidagi kontekst- 
li ma’lumotnomani chaqirib beradi:

• Yulduzchalar tasvirlangan tugma. Bu tugmani bosish bilan 
Accessibility (Доступность) panelini ochiladi. Bu panel filmning 
barcha element lari uchun qo'shimcha xususiyatlarni o‘rnatishga moijal- 
langan.

Ish maydoni ovnaning butun markaziy qismini egallaydi. Ish 
maydonida obyektlar ustida har qanday tahrirlash ishlarini amalga 
oshirish mumkin. Faqatgina montaj stolining tegishli kadriga obyektlar 
mos kelsa maqsadga muvofiq boladi. Ish maydoni keng boiishidan  
maqsad:

• sahnadan tashqari ishlarni bajarish;
• obyektni sahnaga kirishidan oldin yoki chiqib ketgandan keyingi 

holatlarni hosil qilish uchun zarur bo'ladi;
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• ish maydoni ostid a  unga tegishli uskunalar paneli joylashgan. 
Linda quvidagi interfeys elem entlari joylashgan:

• strelkali tugm a butun sahnani tahrirlash rejimiga qaytishni 
ta'nunlaydi: agar siz  alohida sim vol ustida tahrirlash rejimida ish- 
lavotgan bo'lsangiz. tu gm a faollashadi;

• tahrirlanadigan sahna nom li matnli maydon;
• sahnani tanlash tugm asi; bu tugm ani bosish bilan film sah- 

nalaridan tashkil topgan r o ’yxatli m enyu ochiladi;
• sim volni tanlash tugm asi; bu tugmani bosish bilan film  tugm a- 

laridan tashkil topgan ro'yxatli m enyu ochiladi;
• masshtab, uning yordam ida ish maydonini tasvirlash masshtabi 

tanlanadi.
Ish m aydonining ixtiyoriy joyida sichqon o ‘ng tugm asi bosilsa, ish  

maydonining parametrlarini o'zgartirishga m o‘ljallangan buyruqlar 
to‘plamini o 'z  ichiga o lg a n  kontekstli menvu ochiladi. Bu menyu  
hammasi bo'lib yigirm ag.a yaqin buyruqlarni o‘z ichiga oladi.

Scene paneli yordam ida siz quvidagi imkoniyatlarga ega bolasiz:
• film ning sahnalari ro‘yxatini ko‘rish; sahnalarning filmda na- 

m oyish qilinish ketm a-ketligi;
• film ning ro'yxatidagi har qanday sahnasiga o‘tish;
• tanlangan sahnadan nusxa olish (asl sahnadan keyin nusxa hosil 

bo'ladi):
• yangi (bo'sh) sahna qo‘shish (tanlangan sahnadan keyin bo'sh 

sahna qo'shiladi);
• tanlangan sahnani o ‘chirish.

Ish  m a y d o n i k o ‘ rs a tk ic h la r in i o ‘ zg a rtir is h

Flash M X da ish m aydoni ko‘rsatkichlarini o ‘zgartirish uchun 
Modify m enyusidan Document Properties buyrug‘i beriladi. Xuddi shu 
vazifani ish m aydoni ustida sichqonning o‘ng tugm asini bosib kontekstli 
menyudan Document Properties buyrug'i tanlanadi. Natijada rasmdagi 
Document Properties m uloqot ovnasi hosil boMadi.

Bu oynadan foydalanib. ish m aydonining bo‘yi (height), eni (width) 
peksillarda ko'rsatiladi. Ish m aydoniga quyiladigan rang Background  
Colorni tanlash orqali o ‘rnatish, shuningdek kadrlar alm ashish chas- 
totalarini (Frame Rate) b elg ilash  m um kin.
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Flash dasturida kutubxonadan foydalanib quyidagi funksiyalarni 
bajarish mumkin:

• import qilinadigan va hosil qilinadigan simvollarni avtomatik 
ravishda film kutubxonasiga qo'shilishi;

• fayllar tizimining butunligini nazorat qilish va avtomatik kuzatuv:
• simvollarning nomlari bir xillarini yo‘qatmaslik;
• to^g'ridan-tcTg'ri manipulyatsiva qilish texnologiyasi asosida vangi 

simvollar yaratish (drag-and-drop).
Kutubxona oynasida simvollar bilan ishlashning ko'pgina imko- 

niyatlari faqat kontekstli menyu orqali amalga oshiriladi. Masalan. 
simvolni nusxasini hosil qilish uchun, kontekstli menyudan tegishli 
buyruqni berish kifoya.

K u tu b x o n a n in g  y a n g i  k o ' r in i sh la r i

Flash MXda ikki ko'rinishga bo’lingan kutubxonalar mavjud 
(Shared Library):

A u th o r-tim e -  kutubxonasi. simvollar qayta ishlash vaqti bo*yicha 
bo'lingan:

R im -tim e  — qo*yilgan vaqti bo'yicha bo'lingan kutubxona.

Savol va topshiriqlar:

1. Dastur oynasi nechta qisindan iborat?
2. Dastur oynasining vaqt diagrammasi nima vazifani bajaradi?
3. Uskunalar paneli nima vazifalarni bajaradi?
4. Dastur ni ng kutubxonasi qanday imkoniyatlarga ega?

6.2. Flash MXda qatlamlar bilan ishlash

Boshqa dasturlarda boMgani kabi Flashda ham animatsiyalar hosil 
qilishda yangi obvektlar yaratilib. ularni alohida harakatlantirishga 
to'g'ri keladi. Flashda ushbu imkoniyatni taminlab berish. ya’ni 
obyektlar ustida ishlash, ularga alohida harakatlar biriktirish uchun 
qatlamlardan (слои -  layer) foydalaniladi. Soddaroq qilib aytganda. 
har bir obyekt qo'yilishidan oldin unda alohida qatlain hosil qilinadi.

FLASHda kutubxona bilan ishlash
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Buning uchun rasmda kowrsatilgan Insert layer tugmasini bosish kerak 
boiadi.

Tugma bosilgandan keyin qatlamlar orasiga yangi qatlam qo‘shiladi. 
Yangi qatlamga foydalanuvchi xohishiga ko‘ra chizish y o ii bilan 
yoki oby^ektlarni import qilish y o ii  bilan biror obyekt biriktiriladi. 
Obvektlarni har birini alohida vaqt mobaynida, bir-biridan keyin, har- 
xil katta kichiklikda harakatlanishi, hosil boiish i yoki yo‘qolib ketishi 
imkoniyatlarini ta’minlavdi. Bunga quyidagi sodda animatsiyani misol 
qilib beramiz:

>  Flash ishga tushganda yangi ish maydonida bitta qatlam bo'- 
ladi.

>  o*sha qatlamni birinchi kadrini belgilab biror aylana chizamiz. 
Hosil bolgan aylana shu qatlam ga tegishli boiad i. Navbatdagi 
qatlamlarni qo'yganda adasliib ketmaslik uchun qatlam nomini 
obyekt nomiga o'zgartirgan m a ’qul. Buning uchun qatlamning layer 
matni ustida sichqonni chap tugm asini ikki marta bosish bilan 
nomini ozgartirishga im kon beradi. Qatlam nomini aylana deb 
olamiz.

> endi navbatdagi qatlamni qo'yamiz. Buning uchun Insert 
layer tugmasini bosamiz. H osil boigan qatlamga endi to'rtburchak 
jonlantiramiz.

> Ikkala qatlamning ham birinchi kadrlari ustida sichqonning o4ng 
tugmasini bosib, menvudan Create Motion Tween (harakat hosil qilish) 
buyrug’ini beramiz.

> navbat bilan qatlamlarda bir necha kadrdan keyin Insert 
Ketframe buyrugin i beramiz; qatlamlarda kadrlar orasida harakat hosil 
boiadi.

> faqat uni sezilarli b o iish i uchun yangi qo'yilgan kadrni 
tanlab tegishli obyektni kerakli yo’nalishda harakatlantiriladi. Ya?ni 
koordinatalari okzgartiriladi. Buning uchun Properties panelidan X va 
U koordinatalari keraklicha o'zgartiriladi.

> animatsiyani ko’rish vaqtida dastlabki kadrda obyekt joyida 
boiadi. oxirgi kadrga o igu n ch a  esa obyektning harakati hosil 
boiadi.

Quyidagi rasmlarda yuqoridagi aylana pastga qarab harakatlanib 
kattalishib boradi. to6rtburchak esa aksincha.
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S a v o l  v a  t o p s h i r i q l a r :

1. Flashda qatlamlar va ularning va.zifalari nimalardan iborat?
2. Yangi qatlam qo'yish uchun qanday buyruq beriladi?
3. Qatlamning nomi qanday o'zgartiriladi?
4. Qanday holatlarda yangi qatlam qo'viladi?

6.3. Obyektlarni chizish imkoniyatlari

Dasturning grafik imkoniy^atlari ham ko'pqirralidir. Dasturning 
barcha grafiklar bilan ishlash imkoniyatlari Tools uskunalar panelida 
joylashgan. Ushbu paneldan foydalangan holda turli xil rasmlarni 
chizish mumkin. Line Tool uskunasi yordamida to'gi'i chiziq. siniq 
chiziqlar, botiq chiziqlar va xatto ko’pburchaklar chizish mumkin. Oval 
Tool uskunasi yordamida oddiy aylana, ellipslar chizish va ulardan 
boshqa aylanaga o'xshash shakllar hosil qilish mumkin. Rectangle 
Tool uskunasi esa to'rtburchak. kvadrat kabi shakllarni chizish uchun 
ishlatiladi. Pencil Tool oddiy qalani kabi chizish vazifasini bajaradi. 
Brush Tool uskunasi aylana shaklidagi har xil o'lcham bilan rasm 
chizish, bo'vash imkoniyatlarini beradi. Paint Bucket Tool uskunasi 
tanlangan rangni quyish imkoniyatini beradi. Eyedropper Tool ish 
maydoni boshqa qismidagi biror rangni tanlab berish imkoniyatini 
beradi. Eraser Tool chizilgan rasmlarni biror qismini o*chirish uchun 
ishlatiladi.

Chizishdan oldin rang tanlash

Uskunalar panelida Colors ranglarni tanlash vositalari joylashgan. 
Bu uskunalar yordamida osonlik bilan obyekt konturi rangi va uning 
ichiga quviladigan ranglarini tanlash imkoniyati mavjud.

Kontur rangini tanlash uchun Stroke color uskunasini tanlang. Agar 
sichqoncha tugmasini darrov qo'yit* yuborilsa rang tanlash palitrasi 
ochiladi va sichqoncha koi'satkichi pipetka ko'rinishini oladi. Palitra 
216 xil rangni o'zida saqlaydi.

216 xil rang palitraning chap tomonida va o*ng tarafida esa 
qora usiunlar joylashgan. Chap yon ustun standart 6 ta kulrang 
gradatsiyalarni (qora va oqdan tashqari), shuningdek 6 ta kompyuter
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ranglarini (qizil, yashil, ko*k, sariq, havo rang (cyan) va pushtirang 
(magenta)) o*z ichiga oladi. Albatta bular 216 xil rang ichida bor lekin 
qulaylik uchun chap kolonkada nusxalari o'rnatilgan.

K ontur ra n g in i tanlash ovnasi

Rasmlarning katta elementlari va qalin konturlarini bo'vashda 
oldindan jarayonni obyektiv baholash kerak.

Windows operatsion tizim i uchun rang tanlash standart oynasida 
16 million True Color ranglardan ixtiyoriysini tanlash mumkin. 
Bundan tashqari Color oynasining o'ngida ranglarni och yoki 
to'qligini belgilovchi chizg'ich mavjud. Shuningdek rangning sonli 
parametrlarini ham berish yoki «tur -  to'yinganlik -  och yoki to'qligi» 
(shunday nomlanadigan shkala HSB: Hue Saturation, Brightness), yoki 
kompyuterdagi RGB «standart» formatida, qizil, yashil, ko’k ranglarni 
tashkil qiladigan kattaliklarni ko4rsatadi.

Masalan. qizil ranglarni tashkil qiladigan 255 (maksimum), yashil 
va ko'kdan -  0 (bo'larni qisqacha shunday yozish mumkin: RGB 255. 
0. 0). Natijada faqat qizil rangga ega boMamiz. RGB 0, 255, 0-yashilni. 
RGB 0. 0. 255 ko'k rangni beradi.

Har rangning ochiqligi 0 dan 255 gacha o'zgaradi. Masalan. RGB
0. 0, 127 ifodani ko‘rsatib b iz to‘q-ko4k rangga ega boMamiz. Qizil va 
yashil ranglarni teng proportsiyalarda aralashtirib (RGB 255, 255, 0), 
biz sariq rangga ega boMamiz. RGB shkala bilan ishlash juda nozik 
bo’lganligi uchun ko'pgina kompyuter dizaynerlari va rassomlari HSB 
shkaladan foydalanishadi.

Windows operatsion tizim ining standart ranglar tanlash oynasi 
odatda tus burchak ifodasiga ega (0° dan 360°), rangning to'qligi esa 0 
dan 1 oraliqdagi oraliqda o'zgaradi. Lekin Windows muloqot oynasida 
bu parame triar 0 dan 240 oral ig; ida o'zgaradi.____________

Quviladigan rangni tanlash

Demak. yuqori sifatli rang tanlash oynasi yordamida yangi kontur 
ranglarini ham hosil qilish mumkin. Obyekt ichiga quviladigan rangini 
tanlash uchun (Fill color). Заливка belgisi yonida sichqoncha tugmasini
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bosiladi. Bunda deyarli shundav rang tanlash oynasi chiqadi. Rang 
tanlash xuddi yuqoridagidek amalga oshiriladi.

Chiziqli gradient

Agar bu oynaga diqqat bilan qaralsa bir qancha farqlarni sezish 
mumkin. Flashda rang quyish nafaqat bir ranglarni balki gradiyentli 
ham  boiishi mumkin. Bu degani bir hil rang suzib boshqasiga o4tadi.

D oiraviy gradiyent

Gradiyentlar nafaqat chiziqli balki doiraviy ham boiishi mumkin. 
Quviladigan rangni tanlash oynasi pastki qismida bir nechta tayvor 
gradiyent) to'plami bor: uchta chiziqli va 4 ta doiraviy. Bundan tashqari 
216 xil ranglar palitrasi oynasidan foydalanishingiz mumkin.

Savol \a  topshiriqlar:

1. Dasturda grafiklarni chizish uchun qaysi panel uskunalaridan foy- 
dalaniladi?

2 . Line Tool. Oval Tool. Rectangle Tool. Pencil Tool. Brush Tool 
uskunalarining vazifalarini aytib bering?

3. Grafiklar chizishda rang tanlashning qanday imkonivatlari bor?

6.4. Grafikli form atlarni konvertatsiyasi

Flash -  filmlari nafaqat harakatli fayllarni balki, oddiy rasm 
ko’rinishidagi fayllarni ham import, eksport qilish imkoniyatiga 
ega. Quyida Flashda qoilanilislii mumkin boigan grafikli formatlar 
keltirilgan.

6 . 1 0 - j a d v a l

Flashda qo‘llanadigan ayrim grafikli formatlar

Fayl turi Kengaytmasi Eksport Import

Adobe Illustrator (6.0-yoki 
oldingi versi} alari)

.eps, .ai -
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Bitmap .bmp + +

Enhanced Windows Metafile .emf + -

FreeHand .ft7. .ft7, .fog, J8, 
.fli9, .ft9

+ +

GIF •gif 4- +

JPEG •jpg -Г +

PNG •png + _i_

Flash Player .swf +

Windows Metafile .wmf -U -f

Agar kompyuteringizda QuickTime 4 o'rnatilgan bo'lsa.
qo’shimcha ravishda quyidagi fayllarni qo41ash mumkin:

PhotoShop .psd -

QuickTime Image .qtif -h +

Silicon Graphics .sai -I-

TIFF .tiff -r 4-

Flash — filrnlarni eksport qilish

Flashda varatilgan filmlardan boshqa dasturlarda foydalanish uchun 
ularni eksport qilib, har xil formatlarda saqlash mumkin. Buning uchun 
File > Export Movie yoki Export Image buyruqlaridan foydalaniladi. 
Bu yerda Export Movie film ni harakatli fayllarga (swf, avi, gif, spl, 
wav va boshqalar) aylantirish uchun ishlatiladi. Export Image esa 
rasmli fayllarga (bmp, Jpg, gif, png va boshqalar) aylantirish uchun 
ishlatiladi.

Quyidagi ketma-ketlikda Flash -filmdan g if -  animatsiya eksport 
qilish ketma-ketligini kcTrib chiqamiz:

о avval yuqorida ko'rsatilgan misollardan foydalanib, Flash -  film 
yarating;

211



° uni saqlab bo4gach. File > Export Movie buyrugini bering. 
Export Movie muloqot oynasi hosil boiadi.

о oynada faylga nom berib. Тип файла bandidan g if favlni 
koi*satib, «Сохранить» tugmasini bosing.

Natijada kiritilgan nomdagi va tipdagi fayl koi'satilgan joyda hosil 
b oiad i. Hosil boigan fayldan boshqa turli maqsadlarda fovdalanish 
m um kin. Bu imkonivatdan Web-tahrirlagichlar bilan ishlashda saytlarni 
chiroyini boyitishda keng fovdalanish mumkin.

Flash MX obyektlarini boshqa dasturlarga 
qo^yish va ulardan fovdalanish

Flashda yaratilgan sw f filmlar yoki g if animatsiyalar Web- 
sahifalarni yuqori darajadagi dizaynga ega boiishi uchun xizmat 
qilib kelmoqda. Qaysiki saytga qaramang. Flash-filmlari yoki Gif 
animatsiyalari har qanday foydalanuvchini o'ziga tortadi. Web- 
saytlarning nafaqat biror qismi. hattoki sahifaning butun qismi Flashda 
tayyorlanayotgani dasturning keng qamrovli ekanidan dalolat beradi. 
Flash-savtlarga bir nechta misollar keltiramiz: www.flash-art.ru, www. 
costroff.r-vision.ru. w w w .artflasher.com ,www.rusmaster.com, www. 
jasmin.ru

Web-sahifalarda esa Flashning swf yoki Gif animatsiyalari oddiy 
rasm ni joylagandek qcrviladi. Sw f favlini Dreamweaver dasturida 
qo'yish ketma-ketligi bilan tanishib chiqamiz:

° buning uchun avval web sahifani yaratib olib kerakli joyiga 
koi'satkichni qo'yib Insert > Media > Flash buyrugi beriladi:

о Select File muloqot oynasi hosil boiadi. Oynadan qo'ymoqchi 
b o ig a n  sw f faylni ko'rsatiladi:

о Swf fayl web-sahifaga qo'yilganda. ya;ni tahrirlash vaqtida 
ishlamaydi. Web-sahifani saqlab, bekitgandan keyin. faqat koiish  
rejimida, ya’ni Internet Explorer yordamida ko4rishimiz mumkin.

G if animatsiyani esa Dreamweaverda biroz osonroq, xuddi oddiy 
rasm qo'vgandek qo'yiladi. Buning uchun quyidagi ketma-ketlik 
bajari ladi:

о Insert > Image buyrugi beriladi;
о hosil boigan Select Image Source muloqot oynasidan qo'yi- 

ladigan fayl ko'rsatiladi;
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о W e b - s a h i f a n i  s a q l a b  y o p i l a d i ;
с W e b - s a h i f a n i  kcTrish  u c h u n  Internet Explorer d a s t u r i d a  o c h i l a d i  

v a  y a r a t i l g a n  f a y l n i n g  k o kr i n i s h i  p a y d o  b o i a d i .

FL A SH da ta y y o r  fay llarn i qo ‘yish

F l a s h d a  o b y e k t l a r n i  c h i z i s h  i m k o n i y a t i d a n  t a s h q a r i  y a n a  t a y y o r  

r a s m la r ,  v i d e o l a r  v a  b o s h q a  m a ’l u m o t l a r n i  f a y l l a r d a n  q o 'y i s h  

i m k o n i y a t i  bor. Y a 'n i  t a y y o r  f a y l n i  i m p o r t  q i l i s h  i m k o n iy a t i  m a v ju d .  

B u n i n g  u c h u n  File m e n y u s i d a n  Import b u v r u g i  b e r i l a d i .  N a t i j a d a  

Import m u l o q o t  o y n a s i  h o s i  1 b o i a d i .  O y n a d a n  f o y d a l a n ib  im p o r t  

q i l m o q c h i  b o ' l g a n  f a y l n i  k o ' r s a t i b ,  Открыть t u g m a s i  b o s i l s a ,  t e g i s h l i  

q a t l a m g a  t a n l a n g a n  f a y l d a  s a q l a n a y o t g a n  r a s m  y o k i  b o s h q a  o b y e k tn i  

qo*yib  b e ra d i .

I m p o r t  q i l i n g a n  r a s m l a r  u s t i d a  b i r  q a n c h a  a m a l l a r  b a ja r i s h  m u m k in .  

E k r a n d a  im p o r t  q i l i n g a n  r a s m n i  b e lg i l a n g .  Insert >  Convert to 
S y m b o l n i  yoki F 8  n i b o s i n g .  K l i p g a  n o m  b e r in g .  U n i  k l ip  ( M o v ie  clip) 

y o k i  g r a f ik  (G ra f t s )  s h a k l i d a  j o y l a n g  v a  O K  t u g m a s i n i  b o s in g .

E n d i  r a s m  u s t i d a  b i r  q a n c h a  t a h r i r l a s h  i s h la r i  o l ib  b o r i s h  im k o n i  
bor. E f f e k t l a r  p a n e l i n i  o c h i n g  Proporties > Colors v a  r o 'v x a t d a n  

« A d v a n c e d »  b u y r u g ’in i  t a n l a n g .  B i r  q a r a s h d a  b u  q iy i n d a y  tu y u l i s h i  

m u m k i n .  lek in  b u n i n g  o r t i d a  m a t e m a t i k  m a n t iq  y o ta d i .  U  q u y id a g i l a r n i  

a n g la ta d i :
>  F la s h  h a r  b i r  k a n a l  u c h u n  r a n g  b e lg i s ig a  e g a  b o ' la d i .  M a s a l a n .  R  

(q iz i l )  v a  u n in g  b e l g i s i  255  (tolq  q iz i l ) .
>  F la s h  f o i z l i  b e l g i s i n i  t e k s h i r a d i  v a  q iz i l  r a n g n i  y a n g i  b e lg is in i  

h i s o b la y d i .  M a s a l a n .  R  u c h u n  b e lg i  —1 00 %  b u  n o r m a l  h o la t  h i s o b -  

lan ad i .

>  F la s h  « q o ' s h i m c h a »  m a y d o n g a  y a n g i  b e lg i  b i la n  q o 's h a d i .  B u  

n i i s o ld a  q o ’s h i m c h a  m a y d o n  b e l g i s i  0  g a  te n g ,  d e m a k  q iz i l  r a n g  b e lg is i  

R  2 55  g a  t e n g  b e 4 i b  q o te tv e fa d i .
>  A n a l o g i k  r a v i s h d a  o b y e k t n i n g  b o s h q a  r a n g  k a n a l l a r i  -  

y a s h i l  ( G ) ? k o ’k (B ) .  K o ’r i n i b  t u r i b d i k i  b u  m i s o l d a  h a m m a  k a n a l l a r  

a s l i d a g i d e k  q o l a d i .  A g a r  u la r  o ' r n a t i l i s h i g a  b i r o z  o ' z g a r t i r i s h  k i r i t s a k  

n i m a  b o ’lad i?

K e y in g i  b a n d l a r d a  b u  s a v o l g a  j a v o b  t o p i s h i n g i z  m u m k i n .
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Rang kanallarini saralanishi

R a n g l a r n i  s a r a l a s h n i n g  o s o n  y o i l a r i d a n  b i r i  k a n a l l a r d a n  b a 'z i  
b i r l a r i n i  o ' c h i r i s h  k e r a k .  M a s a l a n .  q u y i d a g i  b e l g i l a r n i  i s h l a t i b  k o ‘- 
r i n g :

K a n a l Q iy m a t i Q o 4s h i m c h a  q iv m a t l a r i

R ed 100% 0

G re e n OYo 0

Blue 0% 0

A lp h a 100% 0

Y a sh i l  v a  k o ' k  k a n a l l a r n i  s a r a la b  q iz i l  t u s d a g i  r a n g g a  eg a  b o i a m i z .  

K a n a l l a r d a n  b i r i n i  q o ‘s h s a k  b u  a jo v ib  n a t i j a g a  o l ib  ke lad i :

M a s a l a n :

K a n a l Q iy m a t i Q o ‘s h i m c h a  q iv m a t l a r i

R ed 100% 0

G ree n 100% 0

Blue 0% 0

A lp h a 100% 0

B u n d a n  k e y i n  sa r iq  im id j g a  e g a  b o i a m i z .

Rang kanallari manipulyatsiyasi

Y u q o r i d a g i  k a n a l l a r n i  s a r a la s h  h a r  d o im  h a m  y a x s h i  n a t i ja  

b e r a v e r m a y d i .  E ’tib o r l i  o d a m  d a r r o v  o l i n g a n  i in id j k a m c h i l i k l a r d a n  
h o l i  e m a s  e k a n l i g i n i  p ay q a y d i .  B u n d a  k o n t r a s t .  v o r u g i i k  v a  b a ?zi 

c h e g a r a  c h i z i q l a r i  y o 'q o l ib  k e ta d i .  L e k i n  k a n a l  s a r a la n i s h in i  b i r  n e c h a  

m a n i p u l y a t s i y a l a r i  m a v ju d .  M is o l  u c h u n  h a m m a  k a n a l l a r n i  b i r  v a q t n i n g  
o ‘z i d a  o ‘z g a r t i r a m i z .
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K a n a l Q i y m a t i Q o ‘s h im c h a  q iy m a t l a r i

Red 2 0 0 % 0

Green 2 0 0 % 0

Blue 2 0 0 % 0

Alpha 100% 0

B u  im idjni y o r q i n r o q  q i l i s h g a  y o r d a m  b e ra d i .

E s l a t m a .  %  b e l g i s i  o r q a l i  0 %  d a n  1 0 0 %  g a c h a  b e l g i l a r n i  o ’r-  
n a t i s h  m u m k i n .  L e k i n  t a h r i r l a n g a n  m a y d o n d a  2 0 0  n i  h a m  o ‘r n a t i s h  
m u m k i n .  Y u q o r i  d a r a j a l i  a n i m a t s i y a  f o i z l a r i  0 %  d a n  1 0 0 %  g a c h a
o ' z g a r i s h i  m u m k i n .  

m u m k i n .
M a s a la n :

K a n a l l a r n i  m a n f i y q i v m a t l a r i n i  h a m  b e r i s h

K a n a l Q iy m a t i Q o ‘s h im c h a  q iy m a t l a r i

Red - 1 0 0 % 256

Green - 1 0 0 % 256

Blue - 1 0 0 % 256

A lpha 100% 0

A m a l i y  m iso l la r :

« H a q iq iy »  k o n t r a s t

K a n a l Q i y m a t i Q o ‘s h im c h a  q iy m a t l a r i

R ed 6 0 0 % - 5 / 2

Green 6 0 0 % - 5 / 2

Blue 6 0 0 % - 5 / 2

Alpha 100% 0
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«Haqiqiy» yorqinlik

K a n a l Q iy m a t i Q o ‘s h i m c h a  q iy m a t l a r i

R e d 100% 256

G r e e n 100% 256

B lu e 100% 256

A lp h a 100% 0

S a r i q

K a n a l Q iy m a t i Q o6s h i m c h a  q iy m a t l a r i

R e d 2 0 0 % - 2 0

G re e n 2 0 0 % - 9 0

B lu e 2 0 0 % - 2 5 6

A lp h a 100% 0

Pushti rang

K a n a l Q iy m a t i Q o‘s h i m c h a  q iy m a t l a r i

R e d 2 5 0 % - 5 0

G re e n 2 5 0 % - 1 8 3

B lu e 2 5 0 % - 5 0

A lp h a 100% 0

M o v i y  r a n g

K a n a l Q iy m a t i Q o^ sh im ch a  q iy m a t l a r i

R e d 2 5 0 % - 2 5 6

G re e n 2 5 0 % - 2 0 0

B lu e 2 5 0 % - 5 2

A lp h a 100% 0
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Ikki kanal aralashm asi -  1

Kanal Qiymati Qo‘shimcha qiymatlari

Red 100% 256

G reen 100% 0

Blue 100% 256

Alpha 100% 0

Ik k i  k a n a l  a r a l a s h m a s i  -  2

Kanal Qiymati Qo‘shimcha qiymatlari

Red 100% 256

G reen - 1 0 0 % 256

Blue - 1 0 0 % 256

A lpha 100% 0

R e l e f

Kanal Qiymati Qo‘shimcha qiymatlari

Red - 1 0 0 % 256

G reen - 1 0 0 % 256

Blue - 1 0 0 % 256

A lpha 5 0% 0

Y a n a  r a s m l a r  u s t id a  o l i b  b o r i l a d i g a n  i s h la rd a n  b ir i  b i la n  t a n i s h ib  

c h iq a m iz .  B u  i m k o n i v a t  r a s m n i  t u r g a n  jo y i d a n  y o 'q o l ib  k o ' r i n m a y  
q o l i s h  y o k i  a k s i n c h a  r a s m  y o ‘q  j o y d a n  a s t a - s e k i n  h o s i l  b c r l i sh in i  

t a ’m in la y d i .  B u n i n g  u c h u n  q u y i d a g i  k e tm a - k e t l i k n i  k o ' r i b  c h iq a m iz :
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• r a s m n i  i m p o r t  q i l ib  olib , Insert > Convert to Symbol b u y r u g ' i n i  

y o k i  F 8  t u g m a s i n i  b o s in g ;
• Proporties > Color > Alpha b a n d in i  ta n l a n g .
« A l p h a » n i n g  k o i ' s a t k i c h i n i  o 'z g a r t i r i s h  n a t i j a s id a  r a s m  q u y id a g i c h a  

o ‘z g a r a d i :

K a n a l Q iy m a t i K o i i n i s h  d a r a j a s i

A lp h a 0% ko 'r inm ayd i

A lp h a 50% 5 0 %  ga noan iq  k o i ' in a d i

A lp h a 100% to ‘liq k o 'r in ad i

X u d d i  sh u  e f f e k t l a r d a n  o‘x s h a s h  o b y e k t l a r n i  b i r -b i r ig a  a v l a n t i r i s h -  
d a  f o y d a l a n i s h  m u m k i n .

S a x o l va to p s h iriq la r:

1. G ra f ik l i  fo rm atla r  konver ta ts iyas i  d eg an d a  n im a n i  tu sh u n as iz?
2. F a y l l a rn i  im p o r t  q il ish  n im a?
3. F a y l l a rn i  ek sp o r t  q il ish  n im a?
4. F la s h d a  qan d ay  fo rm a td a g i  fayllarn i im po rt  q il ish m u in k in ?

6.5. F lashda oddiv h arak a tla r hosil qilish

F l a s h d a  a n i m a t s i y a l a r n i  o i 'g a n i s h i i i  e n g  s o d d a  h a r a k a t l a r n i  k o ' r i s h -  

d a n  b o s h  lay m i z .
1-m isol. D a s t l a b  b i r o r  c h iz i lg a n  o b y e k tn i  b i r  k o o r d i n a t a d a n  b o s h q a  

k o o r d i n a t a g a  o ' t i s h  j a r a y o n i  b i l a n  t a n i s h i b  c h iq a m iz :

o File >  New b u y r u g ' i n i  b e r i s h  b i l a n  y a n g i  i sh  m a y d o n i  h o s i l  

q i l a m i z :
o i s h  m a y d o n i d a g i  y a g o n a  q a t l a m n i n g  ( lay e r )  b i r i n c h i  k a d r i n i  

s i c h q o n  c h a p  t u g m a s i  b i l a n  b o s ib  b e lg i l a y m iz ;
o e n d i  s i c h q o n n i  Took p a n e l i g a  o l ib  k e l ib  c h i z i s h  u c h u n  

m o i j a l l a n g a n  ix t iy o r iy  u s k u n a n i  t a n l a y m i z ;
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o s ic h q o n  v o r d a m i d a  i x t i y o r i y  r a s m  c h iz a m iz ;  

o q a t l a m n i n g  k a d r i  u s t i g a  s i c h q o n  k o ' r s a t k ic h i n i  q o 'y i b .  o ‘n g  

t u g m a s i n i  b o s a m iz .  H o s i l  b o i g a n  m e n y u d a n  Create Motion Tween 
b u y r u g i n i  b e r a m iz .

o s i c h q o n  k o ' r s a t k i c h i n i  b i r  n e c h t a  k a d r d a n  k e y in g a  q o 'y i b  Insert 
Keyframe b u y r u g i  b e r i l a d i .  X u d d i  s h u  Keyframeni b e lg i l a g a n  h o la t d a  

r a s m n i  o 'z in i  k e ra k l i  k o o r d i n a t a g a  o ' t k a z a m i z .  B u n i n g  u c h u n  P r o p e r t i e s  

p a n e l i d a n  X  v a  Y  k o o r d i n a t a l a r i n i  o ' z g a r t i r a m i z .

o h a r a k a t n i  k o ' r i s h  u c h u n  Control > Test Movie b u y r u g i  b e r i la d i .  

N a t i j a d a  d a s t l a b k i  n u q t a d a  t u r g a n  r a s m  b i r o z  v a q t  i c h i d a  b o s h q a  

k o o r d i n a t a g a  o i a d i .

2-misol. 1 -m iso ln i  b i r o z  o ' z g a r t i r s a k ,  sh u  o b y e k tn i  k a t t a l a s h g a n i n i  

k u z a t i s h i m i z  m u m k i n :

o y u q o r i d a g i  m i s o l n in g  5 t a  q a d a m i n i  b a ja r ib  b o i g a c h .  r a s m n i n g  

k o o r d i n a ta s i  o 'z g a r g a n  k a d r  u s t i g a  s i c h q o n  t u g m a s i n i  b o s i s h  b i l a n  

b e lg i l a v m iz :

o n a t i j a d a  r a s m  b e l g i l a n a d i .  r a s m n i  k a t t a l a s h t i r a m i z .  B u n i n g  u c h u n  

Properties p a n e l i d a n  W : va H :  q i y m a t l a r i n i  k a t t a l a s h t i r a m i z ;

o h a r a k a t n i  k o i i s h  u c h u n  Control > Test Movie b u y r u g i  b e r i la d i .  

N a t i j a d a  a y la n a  h a r a k a t l a n i b  b o s h q a  k o o r d i n a t a g a  o i i s h  b i l a n  

k a t t a l a s h ib  b o ra d i .

3-misol. N a v b a t d a g i  m i s o l d a  e s a  x u d d i  1 -m iso ld a g i  c h i z i l g a n  s h a r  

b o s h q a  k o o r d i n a t a g a  o ' t i sh i  b i l a n  r a n g i  o ' z g a r i b  b o ra d i .  B u n i n g  u c h u n  

q u y id a g i  k e tm a - k e t l i k  b a j a r i l a d i :

o 1 -m is o ld a g i  b i r in c h i  5  t a  b a n d i n i  b a ja r ib  b o i g a c h ,  r a s m n i n g  

k o o r d i n a ta s i  o 'z g a r g a n  k a d r  u s t i g a  s i c h q o n  t u g m a s i n i  b o s i s h  b i l a n  

b e lg i l a v m iz ;

o n a t i j a d a  r a s m  b e l g i l a n a d i ,  k e y i n  P ro p e r t i e s  p a n e l i d a n  C o lo r  

ro 4y x a t i d a n  A d v a n c e d  b u y r u g i  b e r i l a d i ;

o e k r a n d a  ho s i l  b o i g a n  Advanced Effect oy n a s i d a n  o ' z i m i z g a  

k e r a k l i  r a n g  k o ‘r s a t k i c h l a r i n i  t a n l a b  O K  t u g m a s i n i  b o s a m iz ;

c h a r a k a t n i  k o 4r ish  u c h u n  Control > Test Movie b u y r u g i  b e r i la d i .

4-misol. E n d ig i  m i s o l d a  o b y e k t l a r n i  h a r a k a t l a n i s h  b i l a n  b i r o r  

b u r c h a k k a  b u r i l i s h i  b i l a n  t a n i s h i b  c h iq a m iz .  B u n i n g  u c h u n  q u y id a g i  

k e t m a - k e t l i k  b i l a n  t a n i s h i b  c h i q a m i z :
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o 1 -m iso ld a g i  b i r i n c h i  5 ta  b a n d in i  b a ja r ib  b o i g a c l i .  r a s m n i n g  
k o o r d i n a t a s i  c r z g a r g a n  k a d r  u s t ig a  s i d i q o n  c h a p  t u g m a s i n i  b o s i s h  b i la n  

b e l g i l a y m i z ;

o n a t i j a d a  r a s m  b e lg i l a n a d i .  Modify > Transform > Scale and 
Rotate b u y r u g i  b e r i l a d i ;

o e k r a n d a  h o s i l  b o ' l g a n  Scale and Rotate m u l o q o t  o y n a s id a  t e g i s h l i  
b u r c h a k  q iy m a t i n i  k o i s a t i b .  O K  t u g m a s i n i  b o s a m i z ;

o k o ’r s a t i l g a n  b u r c h a k k a  r a s m  b u r i lad i .

S a v o l va to p s h ir iq la r:

1. O ddiy h a rak a t  hosil q ilish ke tm a-ke t l ig in i  tu s h u n t i r ib  bering?
2 .  F lashda oddiy  h a ra k a t  hosil q il ing?
3. O byek tn ing  ha rak a t i  na ti jas ida  ka tta lash ish i  an im a ts iy as in i  hosil qil

ing?
4 .  O byekt h a rak a t lan ish i  na ti jas ida  b o sh qa  ra n g a  o ' t i sh  an im a ts iy as in i  

hosil qil ing?

6.6. D asturning tovushlar bilan ishlash im koniyatiari

F l a s h d a  f i lm la r g a  t o v u s h  h a m  b e r i s h  m u m k i n .  K o m p y u t e r d a  

s a q l a n a y o t g a n  t o v u s h  fay l i  y o k i  t o v u s h n i  y o z d i r i s h  o rq a l i  h a m  h a r  x i l  

t o v u s h  f a y l l a r in i  i m p o r t  q i l i sh  y o i i  b i la n  q o ’y i s h  m u m k i n .  B u n in g  
n a t i j a s i d a  F l a s h d a  to v u s h l i  f i lm  h o s i l  b o ' la d i .  Y a ?n i  a n im a t s iy a  n a m o y i s h  

q i l i n a v o t g a n  v a q t d a  h a r a k a t  b i l a n  b i r g a  u n g a  m o s  y o k i  u n g a  te g i s h l i  

t o v u s h  h a m  ijro q i l in a d i .  B u n i n g  u c h u n  q u y i d a g i  k e t m a - k e t l i k  a m a l g a  

o s h i r  i l ad i :

■ a v v a l  F l a s h d a  ix t iy o r iy  f i lm  y a ra t i l a d i ;

■ f i lm g a  o ' r n a t i l i s h i  lo z im  b o l g a n  t o v u s h n i  m a x s u s  d a s t u r l a r  

y o r d a m i d a  k o m p y u t e r g a  y o z i l a d i  y o k i  k o m p y u t e r  x o t i r a s id a  t a v y o r  
t o v u s h  s a q l a n a y o tg a n  b o ' l s a ,  u n d a n  h a m  f o v d a l a n i s h  m u m k i n ;

■ to v u s h n i  t a y y o r l a b  o lg a n d a n  s o 'n g .  File m e n y u s i d a g i  Import 
b u v r u g ’i b e r i l a d i ;

■  n a t i ja d a  Import m u l o q o t  o y n a s i  h o s i l  b o ' l a d i .  O y n a d a n  foy-  

d a l a n i b  o ' r n a t m o q c h i  b o i g a n  to v u s h  f a y l in i  k o ’r s a t a m i z .  M a t i ja d a  

t o v u s h  fa y l i  i m p o r t  q i l in a d i .
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S ic h q o n  y o r d a m i d a  i x t i y o r i y  q a t l a m d a g i  b i r i n c h i  k a d r n i  t a n l a b ,  

P r o p e r t i e s  p a n e l i d a n  S o u n d  r o ' y x a t i n i  o c h a m iz .  R o ' y x a t d a n  o ' z i m i z  

i m p o r t  q i l g a n  t o v u s h  f a y l i n i  t a n l a g a n i m i z d a .  o ' s h a  q a t l a m d a  t o v u s h  

o i n a t i l a d i .
Eslatma. F i l m d a g i  t o v u s h  b i l a n  a n im a t s io n  h a r a k a t  s i n x r o n  r a v i s h d a  

b e r i l i sh i  u s t id a  t e s t  o ' t k a z i s h  k e r a k .  A g a r  u la r  s i n x r o n  b o i m a s a  f i lm d a g i  
a n im a ts iy a  q a t l a m l a r i d a g i  k a d r l a r  s o n i n i  k o 'p a y t i r i s h  ( b u n i n g  u c h u n  

k a d r l a r  o r a s ig a  s i c h q o n  c h a p  t u g m a s i n i  b o s ib .  F5 t u g m a s i n i  b o s i s h  y o i i  

b i l a n  k a d r  q o 'y i l a d i .  N a t i  j a d a  a n i m a t s i v a n i n g  n a m o y i s h  v a q t i  c h o 'z i l ib  

to v u s h g a  v a q i n l a s h a d i )  v o k i  k a m a y t i r i s h  y o i i  b i l a n  s i n x r o n l a s h t i r i s h  

m u m k in .

Tovushli tugmalar yaratish

Y u q o r id a  k o ' r s a t i l g a n  m i s o l d a n  f o v d a l a n ib  t u g m a l a r g a  h a m  t o 

v u s h  b e r i s h  m u m k i n .  B u n i n g  u c h u n  q u v id a g i  k e t m a - k e t l i k  a m a l g a  

o sh i r i l a d  i:
■ avva l t u g m a  q o ’v i l a d i  v o k i  F l a s h n i n g  o ‘z ig a  c h i z i s h  y o i i  b i l a n  

h o i l  q i l in a d i :
■ q o 'y i l g a n  y o k i  c h i z i l g a n  r a s m n i  t u g m a g a  a y la n t i r i s h  u c h u n  

lining u s t id a  s i c h q o n  c h a p  t u g m a s i n i  b o s i sh  y o i i  b i l a n  b e lg i l a n a d i .  

S id iq o n c h a i l in g  o 'n g  t u g m a s i  b o s i l g a n d a  q u y id a g i  m e n y u  h o s i l  b o i a d i ;

■ m e n y u d a n  Convert to Symbol b u y r u g i  b e r i l a d i .  Convert to 
Svnbol m u l o q o t  o v n a s i  h o s i l  b o i a d i .  O y n a d a n  B u t t o n  b a n d i  t a n l a n a d i .  
N a i j a d a  t a n l a n g a n  r a s m  t u g m a g a  a y l a n a d i ;

■ t u g m a  u s t id a  s i c h q o n  c h a p  t u g m a s i  ik k i  m a r t a  b o s i l a d i ;

■ hosil b o i g a n  o y n a d a  Over k o ' r s a t k i c h i  o s t i d a g i  k a t a k k a  y a n g i  

kacr q o ’y a m i z ;
■ s h u  k a d r n i  b e lg i l a b  o l a m iz ;

■ File > Import b u y r u g i  y o r d a m i d a  t u g m a g a  o ' r n a t m o q c h i  
b o * ta n  t o v u s h  f a y l in i  i m p o r t  q i l a m i z  ( i m p o r t  q iU n g a n  t o v u s h  a v t o m a t i k  

r a v i h d a  Properties p a n e l i n i n g  S o u n d  r o ‘y x a t i d a  h o s i l  b o i a d i ) :

i P ro p erties  p a n e l i n i n g  S o u n d  r o 'y x a t i d a n  t o v u s h n i  t a n l a y m i z  

(b u  i l a n  b iz  t e g i s h l i  t u g m a g a  s h u  t o v u s h n i  o ' r n a t g a n  b o i a m i z ) :

i b o ' l g a n  o ' z g a r i s h l a r n i  s a q l a b ,  f i l m n i  k o i i s h  u c h u n  Control
>  Tst Movie b u y r u g i n i  b e r a m i z ;  f i l m  n a m o y i s h i  v a q t i d a  t u g m a
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u s t i g a  s i c h q o n  k o ' r s a t k i c h i n i  o l i b  k e l s a n g i z  o i n a t i l g a n  t o v u s h  

e s h i t i l a d i .
X u d d i  s h u  y o i  b i lan  t u g m a  u s t i g a  s i c h q o n  k o i s a t k i c h i n i  olib  

k e l i n g a n d a  y o k i  b o s i l g a n d a  f a q a t  t o v u s h  c h iq i s h i  b i l a n  c h e g a r a l a n ib  

q o l m a s d a n ,  b a l k i  t u g m a  b o s h q a s ig a  a y l a n i s h i h a m  h o s i l  q i l ish  m u m k i n .  

B u  b i l a n  f o y d a l a n u v c h i  m e n y u d a n  t a n l a n g a n  t u g m a n i  b o s h q a s id a n  

a j r a l i b  t u r i s h i n i  t a ’m i n l a y d i .  B u n i n g  u c h u n  y u q o r i d a g i  m i s o l n i  b i ro z  
d a v o m  e t t i r i s h  z a r u r .  Y a ’n i.  v a q t  d i a g r a m m a s i n i n g  O v e r  k a ta k c h a s ig a  
k a d r  q o ' y i b ,  u n g a  s h u  t u g m a n i n g  b o s h q a  r a n g l i s i n i  o ' r n a t a m i z .  D o w n  
k a t a k c h a s i g a  e s a  b o s h q a  r a n g l i  t u g m a c h a n i  o ' r n a t i b .  f i lm n i  k o ' r i s h  

u c h u n  Control >  T e s t  Movie b u y r u g ' i n i  b e r a m iz .  N a m o y i s h  v a q t id a  

t u g m a  u s t ig a  s i c h q o n  k o ' r s a t k i c h i n i  o l ib  b o r s a k ,  t u g m a c h a  b c s h q a  

r a n g g a  o ' t a d i ,  u n i  b o s a d i g a n  b o i s a k  y a n a  b o s h q a  r a n g g a  o ‘tad i .  

B u  b i l a n  b i z  m e n y u d a g i  t u g m a l a r d a n  q ay s i  b i r i  u s t i d a  k o ;rsatk:ich 
t u r g a n i n i  y o k i  q a y s i  t u g m a  b o s i l g a n i n i  o s o n g i n a  a j r a t ib  o l i s h im iz  

m u m k i n .

S a v o l va to p s h ir iq la r:

1. C h i z i l g a n  ob y ek tn i  t u g m a g a  ay lan t ir ish  u c h u n  qaysi buyruqdan 
fo y d a la n i l a d i?

2. T u g m a g a  to v u s h  b ir ik t ir ish  ke tm a-ke t l ig in i  ay t ib  bering?
3. F i l m g a  to v u s h  b i r ik t i r i sh  u c h u n  das t lab  qaysi buyruqdan 

f o y d a la n i l a d i?
4. F i l m g a  to v u sh  berish  ke tm a-ke t l ig in i  sanab be r ing ?

6.7. Obyekt harakati trayektoriyasini boshqarish

F l a s h d a  a s o s iy  q a t l a m  -  Guide Layer t u s h u n c h a s i  m a v ju d .  A s)siv  

q a t l a m l a r  i k k i t a  x u s u s iy a tg a  eg a :

• b i r i n c h i d a n ,  s iz  u n g a  f a q a t  t a h r i r l a s h  r e j im id a  k o ï i n a d i g a n  izd i la r  

j o y l a s h i n g i z  m u m k i n .  B u  i z o h l a r  S W F  f o r m a t ig a  e k s p o r t  q i l inm .yd i;  

s h u  m a ’ n o d a  G u id e  so’z i n i  « b o s h q a r i s h » .  « k o ' r s a t m a »  d e b  tu sh in ish  

m u m k i n ;
• i k k i n c h i d a n ,  a s o s iy  q a t l a m  y o r d a m i d a  o b y e k t n i n g  b ir  jcvdan 

i k k i n c h i  j o y g a  k o ‘c h ish  h a r a k a t i  t r a y e k to r iv a s i n i  b o s h q a r i s h  m u n k in  

( t w e e n e d - a n i m a t s i y a  h a r a k a t i  y o rd a m id a ) .
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Guide q a t l a m n i  y a r a t i s h  u c h u n  q u y id a g i  k e t m a - k e t l i k n i  a m a l g a  

o s h i r i s h  k e ra k :

1. V a q t  d i a g r a m m a s i  p a n e l i d a  q a t l a m l a r  r o 'y x a t i d a n  ix t iy o r iy  

q a t l a m  u s t id a  s i c h q o n  o ‘n g  t u g m a s i n i  b o s in g  v a  k o n te k s t l i  m e n y u d a n  

I n s e r t  L a y e r  b u y r u g i n i  b e r in g .

2. Y a n g i  h o s i l  q i l i n g a n  q a t l a m  u s t id a  s i c h q o n  o 4n g  t u g m a s i n i  b o s i n g  

v a  k o n te k s t l i  m e n y u d a n  G u id e  b a n d i n i  t a n l a n g .  N a t i j a d a  q a t l a m l a r  

r o 4y x a t i d a  q a t l a m  n o r n i  y a q i n i d a  b o l g 4a c h a  k o 4r i n i s h i d a g i  b e lg i  h o s i l  

b o i a d i .  B u  b e lg i  f a q a t  t a h r i r l a s h  u c h u n  m o l j a l l a n g a n i n i  b i ld i r ib ,  

f o y d a l a n u v c h i l a r  b u n i  k o i ' i s h d a n  m u s ta s n o .

Y u q o r id a  a y t i l g a n i d e k  b o s h  q a t l a m n i n g  i k k i n c h i  k o ' r i n i s h i  

h a r a k a t l a n a y o t g a n  o b y e k t  t r a y e k t o r i y a s i n i  ( b o s ib  o ' t i s h i  k e r a k  b o i g a n  

y o i n i  c h i z m a s i n i )  b e l g i l a y d i .

O b y e k tn i  k o ' r s a t i l g a n  t r a y e k t o r i y a d a  h a r a k a t l a n t i r i s h  u c h u n  q u y id a g i  

k e tm a - k e t l i k n i  b a j a r i s h  k e r a k :

1. A n i m a t s i y a l a n g a n  o b y e k t  q a t l a m i n i n g  n o m i  u s t i d a  s i c h q o n  o 4n g  

t u g m a s i n i  b o s in g .

2. K o n te k s t l i  m e n y u d a n  A d d  M o t io n  G u id e  b u y r u g 4in i  b e r in g .  

N a t i j a d a  q a t l a m l a r  r o ' y x a t i d a  m a x s u s  b e lg i  o s t i d a  a s o s iy  q a t l a m  h o s i l  

boMadi.

3. A s o s iy  q a t l a m n i  f a o l l a s h t i r i s h  u c h u n  u n i  n o m i  u s t id a  s i c h q o n c h a  

c h a p  tu g m a s i  b i l a n  b o s a m i z .

4. C h i z i s h n i n g  ix t i y o r iy  u s k u n a s i  y o r d a m i d a  (P e n ,  P e n c i l ,  O v a l ,  

B ru s h ,  R e c ta n g le )  o b y e k t  h a r a k a t l a n i s h  t r a y e k t o r i y a s i n i  ta s v i r l a n g .

5. A n i m a t s i y a n i n g  b i r in c h i  k a d r i  k a t a k c h a s in i  s i c h q o n c h a  c h a p  

t u g m a s i  b i la n  b e l g i l a n g  v a  P r o p e r t i e s  p a n e l i d a n  Orient to Path 
( m a r s h r u t  b o 'v i c h a  m o i j a l  o l i sh )  b a y r o q c h a s i n i  o ' r n a t in g .

6. A n i m a t s i y a n i n g  o x i r g i  k a d r i  k a t a k c h a s in i  s i c h q o n  c h a p  t u g m a s i  

y o r d a m i d a  b e l g i l a n g  v a  k a d r n i n g  P r o p e r t i e s  p a n e l i d a n  x u d d i  s h u  

b a y r o q c h a n i  0‘r n a t i n g .

7. A n i m a t s i y a l a n g a n  o b y e k t d a n  b e lg i l a s h n i  o l ib  t a s h la b ,  f i lm n i  

n a in o y i s h  q il ish  u c h u n  Control > Test Movie b u y r u g ' i n i  b e r in g .

E s l a t m a .  A g a r  s i z  k e s i s h a d i g a n  t r a y e k to r iy a  h o s i l  q i l g a n  b o i -  

s a n g i z ,  u  h o ld a  o b y e k t  k e s i s h i s h  n a t i j a s id a  h o s i l  q i l g a n  y o 4l b o 4y ic h a  

h a r a k a t l a n a d i .
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S a v a  I  v a  t o p s h i r i q l a r :

1. A so s iy  q a t l a m  n im a  va  un ing  q and ay  xusus iya tla r i  bor?
2. O b y e k t n i  b e lg i lan gan  y o 'n a l i s h d a  h a rak a t lan t i r i sh  u c h u n  qaysi 

b u y r u q l a r d a n  foyda lan ilad i?
3. B iro r  o b y e k t  olib u n i  ix tiyoriy  y o ’nalish b o 'y lab  ha rak a t lan t ir in g ?

6.8. Flashda niqobli animatsiyalar yaratish

N i q o b  o ' z  ic h ig a  o d d iy  q a t l a m l a r n i  o lad i .  F a q a t  b i t ta  q a t l a m  n iq o b l i  
( b e k i t a d i g a n )  q a t l a m  b o i i b ,  u f a q a t  o ' z in i n g  o s t id a g i  q a t l a m g a  te g i s h l i  
o b y e k t n i  b e k i t a d i  (n iq ob lay d i) .  Q a t l a m l a r d a n  n iq o b  h o s i l  q i l ish  u c h u n .  

q u y i d a g i  k e t m a - k e t l i k l a r n i  b a ja r i s h  k e ra k :

1. N i q o b  q o 'y m o q c h i  b o ' l g a n  q a t l a m n i n g  n o m i  u s t id a  s i c h q o n n in g  
o ‘n g  t u g m a s i n i  b o s i l ib ,  k o n te k s t l i  m e n y u d a n  Insert Layer b u y  rug* in i 
b e r i n g  ( q o ' y i l g a n  y a n g i  q a t l a m  e n d i  n iq o b  (T rn ida  x i z m a t  q ilad i) .

2. N i q o b  q a t l a m i g a  r a n g  q u y in g .  A g a r  a n im a t s iy a l i  n iq o b  
y a r a t m o q c h i  b o i s a n g i z ,  u n d a  f a q a t  b i r  m a r t a  r a n g  q u y i l g a n  b o ' l i sh i  

k e r a k .
3. N i q o b  q a t l a m i  n o m i  u s t i d a  s i c h q o n  o ;n g  t u g m a s i n i  b o s in g ,  

k o n te k s t l i  m e n y u d a n  Mask (М а с к а )  b u v r u g ’ini b e r in g .  Shu d a q iq a d a n  
b o s h l a b  y a n g i  q a t l a m  n iq o b g a  a y la n a d i .  S h u n d a n  k e y in  q a t l a m la r  
t o ^ l a m i d a  q u y i d a g i  o ' z g a r i s h l a r  b o ' la d i :

с q a t l a m l i  n iq o b  n o m i d a n  c h a p d a  n iq o b g a  t e g i s h l i  b e lg i  h os i l  

b o ' l a d i ;
о n i q o b l a n g a n  q a t l a m n i n g  n o m i  o 'n g g a  s u r i l a d i  v a  u n in g  y o n id a  

h a m  s h u n i n g d e k  y a n g i  b e lg i  p a y d o  b o ' l a d i ;
з i k k a l a  q a t l a m  h a m  a v t o m a t i k  r a v i s h d a  b e k i t i l a d i  ( q a t l a m n in g  

n o m i d a n  o ‘n g d a  h o s i l  b o i g a n  q u l f  b e lg i s i  s h u n d a n  d a lo la t  berad i) .

N i q o b g a  b i r i k t i r i l g a n  r a n g n i n g  a s l i  k o kr i n m a s d a n ,  b a lk i  u n i n g  

h a r a k a t i  n a t i j a s i d a  o r t i d a g i  q a t l a m n i n g  o c h i l i s h i  k u z a t i l a d i .  B o s h -  

q a c h a  a y t g a n d a  b e k i t i l g a n  o b y e k t  n i q o b  o rq a l i  h a r a k a t  b i l a n  o c h i l a d i .  

S iz  n i q o b n i n g  h o la t i n i .  k o ’r i n i s h i n i  h a r  d o i m  o ' z g a r t i r i s h i n g i z  
m u m k i n .  U n i  t a h r i r l a s h  h o l a t i g a  k e l t i r i s h  u c h u n  q u l f  b e lg i s i  
u s t i d a  s i c h q o n n i  c h a p  t u g m a s i n i  b o s i s h  k i f o y a .  B u  b i l a n  s i z  q u l f n i  

a v t o m a t i k  r a v i s h d a  o l ib  t a s h l a g a n  b o ' l a s i z .  T a h r i r l a s h  r e j i m i n i  i s h g a
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t u s h i r i s h  u c h u n  n i q o b l i  q a t l a m  n o m i n i  s i c h q o n  o ' n g  t u g m a s i  b i l a n  

b o s i s h  v a  k o n t e k s t l i  m e n y u d a n  Show All ( H a m m a s i n i  k o ;r s a t i s h )  
b u y r u g ' i m  b e r i n g .

N iq o b n i  k o ' r i s h  r e j im in i  y o q i s h  u c h u n ,  s i c h q o n  o 'n g  t u g m a s i n i  
n iq o b l i  q a t la m  n o m i g a  y o k i  n i q o b  o s t i d a g i  q a t l a m  n o m i g a  b o s i s h  v a  
k o n te k s t l i  m e n y u d a n  Show Masking b u y r u g ' i n i  b e r i s h  k e ra k .

Savoi va topshiriqlar:

1. Niqob hosi l q il ish  k e tm a -k e t l ig in i  a y t ib  b e r in g ?
2. A n im a ts iv a la sh g an  n iqob  hosi l  q il ing?
3. Q o 'sh im ch a  fonli n iq o b  h o s i l  q i l ish  ke tm a-k e t l ig in i  ay tib  ber ing ?
4. A n im a ts iv a la sh g an  n iq ob  va  q o 's h im c h a  fonli n iq o b la rn in g  fa rq la r i  

n im ada?
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XULOSA

X u lo s a  q i l ib  a y tg a n d a .  j a m i y a t n i n g  b a r c h a  j a b h a l a r i d a  ro*y b e -  

r a y o t g a n  h a m m a  y a n g i l ik l a r ,  k a s h f i j o t l a r  v a  r i v o j l a n i s h n i n g  to 'x t o v s i z  

o ‘s i s h i  z a m i r i d a  t a ’l im  t i z i m i d a  e r i s h i l a y o tg a n  y u tu q l a r  y o ta d i .  B u n g a  
t a ’l i m  t i z i m i d a  e r i s h i l a y o tg a n  y u t u q l a r  s a m a r a l a r i  d e b  b a h o  b e r i s h  

m u m k i n .  F a q a t  t a ’l im  t i z i m i d a g i n a  j a m i y a t n i n g  b a rc h a  j a b h a l a r i  u c h u n  
z a r u r  y u k s a k  b i l im l i ,  iq t id o r l i  k a d r l a r  t a y y o r la n a d i .  T a ’l im  t i z i m i d a  
s a m a r a d o r l i k k a  e r i sh is h  u c h u n  e s a  p r o f e s s o r - o 'q i t u v c h i l a r d a n  o ;z  u s t i d a  

t i n i m s i z  i s h la s h ,  f a n - t e x n i k a  y a n g i l i k l a r i d a n  o’z  v a q t i d a  x a b a r d o r  

b o 4 i s h  v a  u l a r n i  o ‘z  m e h n a t  f a o l iy a t ig a  t a tb iq  q i l ish .  c h e t  t i l l a r i n i  b i l i sh .  

a x b o r o t  t e x n o l o g i y a l a r i d a n  o q i l o n a  f o y d a la n a  o l i sh la r i  t a l a b  e t i lad i .
A x b o r o t  te x n o l o g iy a l a r i  v a  u n i n g e n g  s o 'n g g i  y u t u q l a r i d a n  x a b a r d o r  

b o 6lish v a  u l a r n i  o ¿z  s o h a l a r ig a  ta tb iq  q i l ib  s a m a r a l i  m e h n a t  f a o l iy a t in i  

t a s h k i l  q i l i s h  m u h i m  a h a m i y a t  k a s b  e tad i .  Y u q o r id a  a v t i l g a n i d e k .  t a ’ l im  

t i z i m i d a  o 'q u v  m a t e r i a l l a r in i n g  v i z u a l l a s h i s h i  b ilan  t a ’l im  s a m a r a d o r l ig i  

o r t i b  b o r a d i .  B u n d a  e sa  e l e k t r o n  o ;q u v  r e s u r s l a r id a n  ( E O ;R) k e n g  
f o y d a l a n i l a d i .  T u r l i  f a n la r  b o 4y i c h a  E O ’R l a r i n i  y a r a t i s h  v a  j o r i y  q i l ish  
o r q a l i  t a ’l im  t i z i m i d a  o 'q i t i s h  s a m a r a d o r l i g i g a  e r i sh i l a d i .  E O 'R l a r i n i  
y a r a t i s h  u c h u n  e s a  a v v a lo  b o s h l a n g ' i c h  k o m p y u t e r  s a v o d x o n l ig i g a  e g a  
b o ' l i s h ,  s h u  b i l a n  b i r g a m a x s u s  d a s t u r i y  v o s i t a l a r d a n  f o y d a la n i s h  v a  b ir  

q a n c h a  d a s t u r l a s h  t i l l a r in i  b i l i s h  ta lab  q i l in a d i .  B o s h l a n g 4 c h  k o m p y u t e r  

s a v o d x o n l i g i  i n f o r m a t i k a  v a  a x b o ro t  te x n o l o g iy a l a r i  f a n l a r i n i  o 'q i t i sh  
o r q a l i  o ' r g a t i l s a ,  E O 'R l a r i n i  y a r a t i s h  e s a  W e b - d i z a y n  k a b i  f a n l a r n i  
o ‘q i t i s h  o rq a l i  o ‘rg a t i la d i .  S h u  m a q s a d d a  u s h b u  q o ' l l a n m a d a  h a m  
E O ‘R la r i  u c h u n  tu r l i  i l lu s t r a t s iy a la r  t a y y o r l a s h g a  m o ’l j a l l a n g a n  g r a f ik  
m u h a r r i r l a r .  w e b  s a y t l a r n i  y a r a t i s h g a  m o M ja l lan gan  d a s t u r i y  v o s i ta la r ,  

a n i m a t s i y a l a r  t a y y o r l a s h g a  m o l j a l l a n g a n  d a s t u r l a r n i  o i g a t i s h g a  o id  

m a ’ lu m o t l a r  k e l t i r i lg a n .
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